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QUICK START GUIDE

This quick start guide gives a brief introduction to Forensic Explorer. More detailed information is available
from:

User Guide: ‘Forensic Explorer User Guide.en.pdf’ is in the installation folder.
C:\Program Files\GetData\Forensic Explorer v4

Online: https://getdataforensics.com/

By Phone or email: USA: +1.844.300.0552 (Pacific Time) or support@getdata.com

WIBU CODEMETER ACTIVATION DONGLE

A Wibu CodeMeter USB activation dongle is shipped with a Forensic Explorer purchase. Each dongle is uniquely
identified by a serial number stamped on the USB insert. It contains an activation key for:

e Forensic Explorer.
e  Mount Image Pro.

Important: The dongle is for activation purposes only and cannot be used for USB storage.

SYSTEM REQUIREMENTS

Forensic Explorer and Mount Image Pro are optimized for an Intel® Core i7 with 16GB RAM. Forensic Explorer is
a 64bit application which will run Windows 7, 8, 8.1 or 10. Forensic Explorer should run with local administrator
permissions where possible. (Contact support@getdata.com if a 32bit version is required).

DOWNLOAD

Forensic Explorer: The latest version of Forensic Explorer is available for download at:
https://getdataforensics.com. Customers should download and install the Full
Version Dongle Only.

Mount Image Pro: Mount Image Pro is required for Live Boot. The latest version of Mount Image Pro is
available for download at: https://getdataforensics.com.

Virtualization Software: Oracle VirtualBox (recommended) is free and is available for download at
https://www.virtualbox.org;

Or.

VMWare Workstation Pro is commercial software available for purchase and
ddownload at: https://my.vmware.com/web/vmware/downloads. VMWare Player

(free for non-commercial use) may also be used, but has limited functionality (i.e.,
multiple disks cannot be added to a Live Boot session).

Important: VMWare must be activated at the program splash screen on first run.
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INSTALLATION

It is recommended that Forensic Explorer and Mount Image Pro be installed and run with local administrator

user rights. Run the setup files and follow the installation instructions. To set Forensic Explorer and Mount Image
Pro to run as administrator, right click on the desktop icons and select Properties > Compatibility > Run this
program as an administrator.

Important: Mount Image Pro installs two system drivers which require a reboot of the forensic workstation.
Once installed, run Mount Image Pro and check that the driver status is in the information bar at the bottom of
the GUI.

FORENSIC EXPLORER MODULE OVERVIEW

Forensic Explorer is made up of modules which are accessed via tabs at the top of the program GUI. Each module
contains a toolbar where analysis functions are launched. Within a module, right click in the data view window
to access a drop-down menu of available options relevant to that window.

1.1.1 EVIDENCE MODULE

The Evidence module is the default window that appears when Forensic Explorer is run. The Evidence module
is where a case is created, opened or previewed and evidence is added. Evidence can be added in the form of a
physical device, a forensic image or individual files.

To add a forensic image, select the Add Image button. When evidence is added, the Evidence Processor window
enables the investigator to select and run automated processing tasks. This includes Triage, which sends registry
files to the Registry module, automatically bookmarks items of interest and uses this information to populate
the Triage report in the Reports module.

For more information on the Evidence module see Chapter 10 of the Forensic Explorer User Guide.

1.1.2 FILE SYSTEM MODULE

The File System module is typically where most of the forensic analysis will be conducted. Use the branch plate,
filtering, highlight and sorting functions to navigate around the filesystem. Use the various data views, such as
gallery, text, hex and display to examine file content. The toolbar menu gives access to programs that assist with
automated analysis, including tasks such as folder recovery, file carving, file signature analysis, skin tone analysis
and more.

For more information on the File System module see Chapter 11 of the Forensic Explorer User Guide.

1.1.3 KEYWORD SEARCH

The Keyword Search module allows a low-level search across raw case data for user created search expressions.
Keywords can be simple text words or more complex search formulas such as Regular Expression (RegEx), and
hexadecimal values. User CTRL+N from any module to add a new keyword, or import lists of keywords from the
Keyword module, Keyword Management toolbar button.

For more information on the Keyword Search module see Chapter 13 of the Forensic Explorer User Guide.
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The Index Search module uses dTSearch indexing technology to create a real-time keyword searchable index.
The index can also be exported and used as a dictionary to break passwords.

For more information on the Index Search module see Chapter 14 of the Forensic Explorer User Guide.

The email module supports the analysis of a variety of email formats, including:

e EDB Microsoft Exchange

e EML Email Message format

e .MBOX Mailbox format

e .MSG Microsoft Message file

e .OST Microsoft Offline Storage Table

e PST Microsoft Personal Storage Table

These files can be passed into the Email module by right clicking on a selected file and using the Send to Module
> Email option.

For more information on the Email module see Chapter 15 of the Forensic Explorer User Guide.

The Registry module is used to expand and examine Windows registry files. A Windows registry can contain a
great deal of information that can be of value to the forensic investigator, including computer and user
information. The toolbar buttons automate the process of extracting data from relevant keys.

For more information on the Registry module see Chapter 16 of the Forensic Explorer User Guide.

Bookmarks are used to identify items of interest. Forensic Explorer enables almost any item (e.g., file, folder,
keyword, search hit, etc.), or a selection from an item (e.g., a fragment of text from a file or unallocated clusters),
to be bookmarked. To create a bookmark, select the item of interest, right click > add bookmark, choose a
folder where it will be saved within the Bookmark module and include any comments associated to it.

Important: Forensic Explorer Reports are generated from Bookmarked items.

For more information on the Bookmarks module see Chapter 17 of the Forensic Explorer User Guide.
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1.1.8 REPORTS

Reports are generated from bookmarked items. The Report Editor is used to design a report and populate it with
data from the specified bookmark folders. Reports can be saved as templates for use in future investigations.
Default templates, such as the Triage report, are provided with Forensic Explorer for fast access by the
investigator. Any report component can be easily moved or edited from one report to another. Hyperlinks can
be associated to a file of interest within a report, with the actual file being exported when it is finalized and
created. Reports can be exported as DOC, RTF, PDF, and HTML formats.

For more information on the Reports module see Chapter 18 of the Forensic Explorer User Guide.

1.1.9 SCRIPTS

Forensic Explorer sits on top of a Delphi scripting language. Scripts are written and run in the scripts module or
launched in other modules via toolbar buttons or by other scripts.

For more information on the Scripts module see Chapter 19 of the Forensic Explorer User Guide.

LIVE BOOT

Forensic Explorer Live Boot enables an investigator to boot a forensic image or write-protected physical hard
drive containing a Windows, Linux or MAC Operating System.

To Live Boot you need the following software installed:

1. Mount Image Pro (MIP). A Forensic Explorer dongle comes with a license of MIP. MIP can be
downloaded from www.mountimage.com.

2. VMWare Workstation or VMware Player, https://my.vmware.com/web/vmware/downloads (Player is

free for non-commercial use. Player does not support the addition of additional disks within the virtual
machine);

OR,

Oracle Virtual Box, https://www.virtualbox.org (Recommended: Live Boot of MAC will work only with
VirtualBox).

Ensure that the forensic image file is an image of a bootable file system (Windows, UNIX or MAC [APFS not
supported at this time]) and that it contains a Master Boot Records (booting of logical volumes is not currently
supported).

Click the Live Boot button in the File System module and follow the onscreen instructions.

For more information on Live Boot see Chapter 28 of the Forensic Explorer User Guide.
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1.2 [INTRODUCING FORENSIC EXPLORER

Forensic Explorer is a computer forensics software program written by GetData Forensics Pty Ltd
(https://getdataforensics.com/). Forensic Explorer is a tool for the analysis and presentation of electronic

evidence. Primary users of this software are those involved in civil or criminal investigations.

Forensic Explorer combines a flexible graphic user interface (GUI) with advanced sorting, filtering, searching,
previewing and scripting technology. It enables investigators to:

e Access and examine all available data, including hidden and system files, deleted files, file and disk slack
and unallocated clusters;

e Automate complex investigational tasks.
e Document a case and produce detailed reports; and,

e  Provide other parties with a simple to use tool to easily review evidence.

1.3 SUPPORTED FILE FORMATS

Forensic Explorer supports the acquisition of the following file formats:
e DDorRAW,;
e EnCase® .E01;

Forensics Explorer supports the analysis of the following file formats:

Type Extension
Apple DMG .DMG

DD or RAW .DD, .BIN, .RAW
EnCase® .E01, .Ex01, .L01, .Lx01
Forensic File Format .AFF

FTK® .E01, .AD1

ISO .ISO
Macquisition .00001
Microsoft VHD .VHD

NUIX .MFS
ProDiscover® .EVE

Safeback® v2 .001

SMART .S01

VMWare® .VMD, .VMDK
Xways Container .CTR

1.4 SUPPORTED FILE SYSTEMS

Forensic Explorer supports analysis of:
e  Windows FAT12/16/32, exFAT, NTFS,

e Macintosh HFS, HFS+ (no journal processing), APFS (decryption and Live Boot not currently supported)
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EXT 2/3/4 (no journal processing)

CD/DVD ISO, UDF

e Hardware and Software RAID: JBOD, RAID 0, RAID 5

1.5 KEY PROGRAM FEATURES

Key Forensic Explorer features include:

Fully Customizable Interface: The forensic explorer interface has been designed for flexibility. Drag, drop and
detach windows for a customized module. Save and load module configurations to suit investigative needs.

International Language Support: Forensic Explorer supports Unicode. Investigators can search and view data in
native language format.

Complete Data Access: Access all areas of physical or imaged media at a file, text, or hex level. View and analyze
system files, file and disk slack, swap files, print files, boot records, partitions, file allocation tables, unallocated
clusters, etc.

Powerful Pascal Scripting language: Automate analysis using a provided script library or write your own analysis
scripts.

Fully Threaded: Run different analysis functions in separate threads.
Data Views: Powerful data views including:

e  File List: Sort and multi sort files by attribute, including, extension, signature, hash, path and created,
accessed and modified dates.

e Category Views: Show files by extension, date etc.

o Disk: Navigate a disk and its structure via a graphical view. Zoom in and out to graphically map disk
usage.

e Gallery: Thumbnail photos and image files.
e Display: Display more than 300 file types. Zoom, rotate, copy, search.
e Filesystem Record: Easily access and interpret FAT and NTFS records.

e Text and Hexadecimal: Access and analyze data at a text or hexadecimal level. Automatically decode
values with the data inspector.

e File Extent: Quickly locate files on disk with start and end sector runs.

e Byte Plot and Character Distribution: Examine individual files using Byte Plot graphs and ASCII
Character Distribution.

e File Metadata: Examine metadata properties within files.

RAID Support: Work with physical or forensically imaged RAID media, including software and hardware RAID,
JBOD, RAID 0 and RAID 5.
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Hashing: Apply hash sets to a case to identify or exclude known files. Hash individual files for analysis.
Keyword search: Sector level keyword search of entire media using RegEx expressions.
Keyword index: Built in DTSearch index and keyword search technology.

Bookmarks and Reporting: Add bookmarks to identify evidence and include bookmarks in a custom report
builder.

Data Recovery and Carving: Recover folders and files. Use an inbuilt file carving tool to carve more than 300
known file types or script your own.

File Signature Analysis: Validate the signature against file extension.

Export to LEF: Export a subset of files in a case to a LEF (Logical Evidence File).
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Chapter 2 - 30 Day Evaluation Version
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2.1 30 DAY EVALUATION VERSION

To request a 30-day evaluation version of Forensic Explorer, visit https://getdataforensics.com/ and complete

the online registration form. Download instructions and an evaluation version software activation key and will
be sent to your email address.

Note: It is not possible to activate the evaluation version in Virtual Machine.

The Forensic Explorer 30-day evaluation version is a standalone program. It has:
e Aseparate installation file: “ForensicExplorer-Evaluation-Setup.exe” and;
e Isinstalled in its own path “C:\Program Files\GetData\Forensic Explorer Evaluation vX\”.

The evaluation version is marked as “Evaluation” in the status bar at the bottom of the Evidence Module and in
the program “About” tab.

The 30-day evaluation version has the following limitations:
e Does not allow the saving of case files;
e Does not allow the exporting of files from a case; and,

e  Will expire in 30 days.

2.2 ACTIVATING THE 30-DAY EVALUATION VERSION

The 30-day evaluation version is activated by a software key only (a purchased version is activated by dongle
only).

If your computer is connected to the internet, enter the 30 day evaluation version key into the field provided
and click Next (as shown in Figure 1 below):
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Figure 1: Online activation, 30-day trial version

B ' Forensic Explorer - Evaluation

(®) Online Activation

Online activation is an automated process that reguires an
v internet connection. Mo personal information is sent.

() offline Activation

Offline activation is a manual process which can
be used if internet access is limited.

An evaluation key input message will display the following screen, as shown in Figure 2 below:

Figure 2: 30-day evaluation key input activation message

B ' Forensic Explorer - Evaluation *

Activation (Online)

Enter the Evaluation Key that you received via email when vou
registered at:

| http: ffforensicexplorer.comjrequest-evaluationkey |

Evaluation Key || |

< Back MNext = Cancel

Once the 30-day evaluation version is activated, the number of evaluation days remaining is shown on the
program splash screen (see Figure 3 below). Click on the “Continue Evaluation” button to use the software, or
the “Buy Online” button to visit the purchase page at https://getdataforensics.com/.
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Figure 3: 30-day evaluation version splash screen

FORENSIC EXPLORER

Evaluation Version: GetData Pty Ltd

icexplorer, com

Continue Evaluation Buy Online

2.2.2 OFFLINE ACTIVATION (30 DAY EVALUATION)

Where the computer on which the software is being installed is not connected to the internet, a separate
internet connected computer can be used to activate. The activation process involves:

e  Exporting a license file from the software;

e Uploading the license file, together with your purchase email address and license key at a web site
(using any internet connected computer);

e Downloading the validated license file and importing it back into the software.
To activate an offline computer:

1. Click the Offline Activation button and click Next;
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Figure 4: Activation wizard

B ' Forensic Explorer - Evaluation >
Activation

() Online Activation

Online activation is an automated process that requires an
w internet connection. Mo personal information is sent.

(®) Offline Activation
e =i

cilo Offline activation is a manual process which can
w be used if internet access is limited,

< Back Cancel

2. Click on the Export button to export and save the license file "GetData.GDActRequest":

Figure 5: Offline activation (evaluation version), export of license file

B ' Forensic Explorer - Evaluation >

Activation - Offline

Web Browser Activation

Step 1: Step 2: Step 3:

A W o)
IUpload your activation

Export your request file, license key Import your new

activation : activation
request file ?;ﬁ)iﬁ;"ﬁgg;i? at the response file
Export | getdata.com/offline Import

Mext = Cancel

3. Using a web browser on any internet connected computer, go to http://getdata.com/offline (or
https://support.getdata.com/offline-wibu.php) and enter the required details:
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Figure 6: Offline activation (evaluation version), upload of license file and activation details

) ==~ .
Get reT L GETDATA PRODUCTS CONTACT SUPPORT MY CART & #» ACCOUNT
Software Development Company

GetData Product - Manual Activation H=EFEEE

What is your purchase Email address?
support@getdata.com

What is the License Key (found in purchase confirmation email)?
B2A5-5723-CoA2

Upload your Activation Request File:

Choose File | GetData. GDActRequest

Upload

© GetDatz 2002-2019 All Rights Reserved. Home | Resellers | About Us | Sitemap | Privacy | User Agreement | Edit Page usa21

Click the Upload button to send the details to the activation server:

The details are validated by the activation server and the file "GetData.GDActResponse" is returned to you.

Figure 7: Offline activation (evaluation version), download of license file

GetData Product - Manual Activation

Your activation response file will begin to automatically download shortly.
Click here to begin the download manually.

Save "GetData.GDActResponse" and take it back to the offline computer on which you will be activating the
software.

Once the "GetData.GDActResponse" file is back on the offline computer, click the Import button to import the
file into the software. The software is now activated.-+-
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3.1 PURCHASE

Forensic Explorer is dongle activated only. A dongle is provided for each license purchased.

Forensic Explorer is available for purchase online, via purchase order, or via forensic software resellers.

Forensic Explorer can be purchased online at https://getdataforensics.com/ by following the purchase links.
Please see the purchase page for pricing, volume discounts and software bundle options.

Purchase Orders can be placed by Government and Corporate entities by contacting GetData head office:

GetData Pty Ltd

Suite 204, 13A Montgomery Street

Kogarah,

New South Wales, 2217

Australia

Ph: +61 2 82086053

Fax: +61 2 95881195

Email: sales@getdata.com Or support@getdata.com

Or via your forensic reseller.

GetData fulfil purchase orders in accordance with the laws of the State of New South Wales and the
Commonwealth of Australia and any dispute relating a purchase order shall be governed by these laws,
without regard to any other Country or State choice of law rules. This supersedes all prior proposals,
negotiations, representations, agreements and understandings between the parties, including those contained
in any confidentiality agreements, and all terms and conditions contained in any Customer-provided purchase
orders, and constitutes the complete and exclusive agreement between Customer and Company regarding the
subject matter hereof. Any reference to a purchase order or similar documentation on an invoice or other
acceptance thereof is solely for Customer's convenience in record keeping, and no such reference or the
provision of Services to Customer shall be deemed an acknowledgement of or agreement to any terms or
conditions associated with any such purchase order or other provided documentation. Any such associated
terms and conditions shall be of no force and effect and do not apply to and have no effect.

For a list of approved resellers, please contact GetData via: sales@getdata.com or via the contact details
above.
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3.2 LICENSE MAINTENANCE

A Forensic Explorer license purchase includes 12 months’ maintenance giving access to updates and support.

When the maintenance for a dongle has expired, Forensic Explorer will continue to work, however you may
only use the latest available version prior to the expiration of your maintenance period.

The expiration date for the maintenance of a dongle is displayed in the program splash screen, shown in Figure
8 below:

Figure 8: Forensic Explorer splash screen showing maintenance date

FORENSIC EXPLORER

w i Registered To: Graham Henley

GetData

When the maintenance is nearing the expiration date, an email is sent to the purchaser with the option to renew.

3.2.1 PURCHASE LICENSE MAINTENANCE

To purchase additional Forensic Explorer maintenance online:

1. Visit the following web page: https://getdataforensics.com/

2. Select the option to purchase maintenance renewal for existing Forensic Explorer dongles.
3. Complete the checkout process.

Forensic Explorer maintenance is sold in increments of 1 year. A purchase of two years’ maintenance can be
used to extend a single dongles maintenance by two years.

To apply the maintenance update to your dongle and follow the instructions in section 5.5.
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4.1 SYSTEM REQUIREMENTS

Forensic Explorer minimum recommendations:
e  Windows 10 or above.
e Pentium i7 processor or above.
e 16GB RAM.
e  Forensic Explorer is 64bit (version 3.5.7.5134 and above).

When processing large volumes of electronic evidence, a high specification forensic workstation is

recommended.

4.2 DOWNLOAD

Full purchased version:

Download the full version of Forensic Explorer from https://getdataforensics.com/product/forensic-
explorer-fex/download/.

30-day evaluation version:

Download the evaluation version from: https://getdataforensics.com/product/forensic-explorer-

fex/download/

See Chapter 2 - 30 Day Evaluation Version, for further information on the evaluation version.

4.3 INSTALLATION

IMPORTANT: Ensure that you have a separate and secure backup of case files before you make installation
modifications.

To install Forensic Explorer:

e Run the installation file ForensicExplorer-Setup.exe (or ForensicExplorer-Evaluation-Setup.exe if you
are installing the 30-day evaluation version).

e Follow the setup instructions.

The following windows will appear during the installation process:
1. Forensic Explorer License agreement. Answer the question and click Next.
2. Select the installation language. Click Next.

3. Enter the correct installation path or accept the default path (e.g., C:\Program Files\GetData\Forensic
Explorer vX) and click Next;
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Figure 9: Selecting the installation folder

ﬁ!fe:.:-::e'szi-::i i —

Select Destination Location
Where should Forensic Explorer v5 be installed?

Setup will install Farensic Explarer w5 into the following folder.

To continue, dick Mext. If you would like to select a different folder, dick Browse,

C:'Program Files'\GetData\Faorensic Explorer w5 Browse...

At least 31.5 MEB of free disk space is required.

< Back Cancel

1. Follow the setup instructions and confirm the setup summary by clicking the Install button.

Figure 10: Finalize installation

ﬁ!fe:.:-::e'szi-::i i —

Ready to Install
Setup is now ready to begin installing Forensic Explorer w5 on your computer,

Click Install to continue with the installation, or dick Bad: if yvou want to review or
change any settings.

Destination location:
C:\Program Files\GetData\Forensic Explorer v5

Start Menu folder:
Forensic Explorer w5

Additional tasks:
Additional shortcuts:
Create a desktop shortout

< Back Cancel
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2. Asuccessful installation will display the following screen. Click Finish to confirm.

Figure 11: Finish installation

(%mpleting the Forensic Explorer
v) Setup Wizard

Setup has finished installing Forensic Explorer v5 on your
computer, The application may be launched by selecting the
installed shortouts.

Click Finish to exit Setup.

FORENSIC Launch Forensic Explorer v5.1.0.8900
EXPLORER

3.  Run Forensic Explorer from the installed desktop icon:

Figure 12: Desktop icon

Forensic
Explorer

4.3.1 CHECK FOR UPDATES

Forensic Explorer updates and change log are located at https://getdataforensics.com/product/forensic-

explorer-fex/download/

To check for updates from Forensic Explorer:

1. Run the software and go to the Evidence module.

2. Onthe toolbar, click the Check for Updates button:
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Figure 13: Evidence module tool bar, Check for Updates

&

Check For
Updates

@ Check For Updates

¢ Configuration

3. The Configuration option in the menu enables the following options:

Figure 14: Check for Updates Configuration

B Forensic Explorer — O x

Check For Updates Configuration

Chedk on FEX launch

(®)Dnline - htips: //getdataforensics, com product/forensic-explorer-fex /download

() Offiine - From Selected Folder

C:\Usersigraha\Downloads

K Cancel

Check on FEX Launch: This checkbox will enable the check when Forensic Explorer is launched from the

desktop icon. The check takes place during the period when the program splash screen is displayed.

Online: When the Online radio button is selected, a comparison is made between the currently running
version number and the version number available at the Forensic Explorer download page:

https://getdataforensics.com/product/forensic-explorer-fex/download/. If the version on the web page is

more recent, an option to go to the web pages is provided.

Offline — From Selected Folder: For security purposes, many forensic workstations are air-gapped from
the internet. The offline option can be used to check for updates in a specified folder (either locally or a
network folder). If a version exists in the specified folder that is more recent that the running version, a

message is displayed to open this folder (the most recent version is shown in the message window):
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Figure 15: Check for Updates (Check on Launch is selected)

Checking Folder:
ChUsers\graha\Downloads\ChUsers\grahatDownloads?,

Installed: 5.4.2,1365
In Folder: 54.2,1369

An update is available,

Open the folder?

iing Startup Events. ..

F

) &4bit [EM]

4.3.2 INSTALLED FILES

Folder paths are managed via the Forensic Explorer > Options menu:

Figure 16: Forensic Explorer menu

= |
k4

a8
i] Layout r
2 lcon Editors r

l@ Feedback...

& License Manager...
& About.

& Help

&) Exit
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The Options window provides access to user and system folder paths.

Figure 17: Forensic Explorer > Options

Options n

General | Case

Uzer Folder Paths

Cases: |C:'\Userskgraha\DDcuments’\FDrensic Explorer v3\Cases E|

Systemn Folder Paths

Application Logs: |C:'\Users\grahaiDocuments\FDrensic Explorer viApplogs @|
Hashes: |C:KUsers\grahaiDDcuments‘\FDrensic Explorer viHashSets @|
Scripts: |C:'\Userskgraha\DDcuments‘\FDrensic Explorer v3\Scripts E|
Filters: |C:'\Userskgraha\DDcuments’\FDrensic Explorer v3\Filters E|
Report Ternplates: | Ch\Users\graha\Documents\Forensic Explorer v3\Report Templates = |
Startup: |C:'\Users‘-lgraha\Dncuments\FDrensic Explorer v3\Startup [B|
Startup File: C:h\Users\ grahatDocurments' Forensic Explorer v3\5tartuptStartup.pas =
Default Layout: =
Leg File Viewer: =

Show Preview button

— Reset Default
|_|Log Searches in Index Module = !

Reset All Options: Save as Ini.. Save Cancel

 PROGRAM PATH
The default Forensic Explorer installation folder is:

C:\Program Files\GetData\Forensic Explorer vX\

WORKING PATH
The working path for a case is in the user profile documents folder.

C:\Users\[user folder]\Documents\Forensic Explorer vX

Applogs Forensic Explorer usage logs.

Bookmark Templates Bookmark templates folder.

Cases Contains the investigator created case folders.
Databases Holds case database files use to store case data, investigator names,
etc.
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Filters

Hash Sets

Keywords

Previews

Reference Library

Reports Templates

Scripts

Startup

Filters are created in the Scripts module and used in the Folder view of
the File System module. See 8.2.2 - Tree view filter, for more
information.

Holds the database files used to store hash set information.

This folder is used to store sample keyword search import lists. They
can be imported in the Keyword Search module.

A device or image can be previewed without first creating a case. A
unique preview working folder is created within this folder using a
Global Unique Identifier (GUID, e.g., 8709A41C-38B6-4F9E-BA18-
633B394721C5).

Is to put personal reference resources within easy reach of the
investigator from within the Forensic Explorer interface. Reference
information can be citation information only, or a link to an online
resource or a local file.

Reports template folder.

Holds Forensic Explorer scripts (created and/or used in the Scripts
module). “.pas” are un-compiled. “.bin” are compiled.

Holds the startup.pas script used to store button positions etc. (see
the chapter on Scripts for further information).

| CASE FILE FOLDER

The following folders are created within each case folder:

C:\Users\[user folder]\Documents\Forensic Explorer\Cases\[Case Name]\

Attached Evidence
DTSearchindexes
Expanded
Exported

Logs

Reports

CaseName.FEX

External files (photos, documents etc.) attached to the case.

DT Search keyword indexes.

Stores expanded compound files (e.g., ZIP) in BatesNumber.L0O1 format.
File export folder.

Program audit logs.

Reports folder.

Case file.

 REGISTRY KEYS

At the time of installation Forensic Explorer registry keys, including user and system folder path details, are
written to the HKEY_CURRENT_USER as shown in Figure 18 below:
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Figure 18: Forensic Explorer registry keys

48 Computer
- || HKEY_CLASSES_ROOT
4| HKEY_CURRENT_USER
4. | Software
4. GetData

e

, ForensicExplorersd
- Configuration
- CurrentCase
- ) DataBase

- Jy Folders

- 4y Forms

- Images
& Links
| Search

PROBLEMATIC SCREEN RESOLUTION (DPI)

In some circumstances where a non-standard monitor resolution is used (for example, running Forensic
Explorer through a data projector) resolution issues may appear in the Reports module or when creating PDFs.

It is possible to manually override the resolution setting by editing the DPI value in the ForensicExplorer v5 >

Configuration > DPI registry key. This can also be set using the FEX_CommandLine5.ini file described below.

Figure 19: Manually set display resolution (DPI)

B Registry Editor
File Edit View Favorites Help

Computer\HKEY_CURRENT_USER\Software\GetData\ForensicExplorer vS\Configuration

i v GetData

! EVSDK
ExplorerView
FEX Imager
FEXImager

Y L

ForensicExplorer CLI
v ForensicExplorer v5
i Configuration
CurrentCase
Database
Feedback
Links
- LiveBoot
5> =7 MRU
f Search

Forensic Image Converter v1

v5

Name

ab| (Default)
ab|BasePath

ab| CasesPath

ab| CurrentLayoutFile
5| CurrentTip

ab| DarkMode

ab| DefaultLanguage
74| DefaultLogLevel
ab| DefaultReport
ab| Disclaimer

L2 0P |
ab|FilterScriptsPath
ab| ForceDPI

ab| HashesPath

Type

REG_SZ
REG_SZ
REG_SZ
REG_SZ
REG_DWORD
REG_SZ
REG_SZ
REG_DWORD
REG_SZ
REG_SZ
REG_DWORD
REG_SZ
REG_SZ
REG_SZ

Data

(value not set)
C:\Users\graha\Documents\
C:\Users\graha\Documents\

0x00000001 (1)

0

EN

0x00000002 (2)

Triage

0

0100000050 95) 4
C:\Users\graha\Documents\
0
C:\Users\graha\Documents\

FORENSIC EXPLROER.INI

From Forensic Explorer versions 5.4.8(2771) the Options window contains a Save as Ini button (shown in
Figure 17 above). This button is used to create a ForensicExplorer.ini text file with the current configuration
settings. Paths within this file can be manually edited as desired.
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When Forensic Explorer is launched it first checks for the presence of ForensicExplroer.ini in the installation
folder (i.e., the folder containing ForensicExplorer.exe). If ForensicExplorer.ini is present, its settings are used,
otherwise it reads the settings from the registry.

To manually set the display resolution (described above) add the following values to the .ini file and adjust the
DPI number as desired.

Figure 20: Manually setting the display resolution (DPI).

[Configuration]
DPI=59&
ForceDPFI=0

4.3.3 DARK MODE

Dark mode changes display to a dark background using a dark theme or color inversion.

Note: Dark mode is work-in-progress and will be improved over multiple version releases. Please contact
support@getdata.com for specific dark mode issues.

Activating dark mode requires a registry edit to: HKEY_CURRENT_USER\Software\GetData\Forensic Explorer
v5\Configuration\DarkMode.

1. Close Forensic Explorer.

2.  Run Windows RegEdit and select the above key.
a. For dark mode set Value data to 1.
b. For light mode set Value data to 0.

3. Launch Forensic Explorer.

Figure 21: Set dark mode in the registry

B Registry Editor
File Edit View Favorites Help
Computer\HEEY_CURREMT_USER\Softwareh GetData\ ForensicEx plorer w3 Configuration

> FEX Imager Mame Type Data
’ FEKIma.ger ab| (Default) REG_SZ (value not
= Forenscbuptonr il || “Basepath REG_SZ CAUsersg
- Foren 5icExE|u:urer v5 2] CasesPath REG_SZ Cihlsers\g
P R —— ab| CurrentLayoutFile REG SZ
CurrentCase #ie| CurrentTip REG_DWORD (0000000
Database ab| DarkMode REG_SZ
Feedback ab| DefaultLanguage REG 57 EM

4.3.4 NON-ENGLISH INSTALLATION

The Forensic Explorer GUI has been translated into the following languages:

Copyright GetData Forensics Pty Ltd 2010 - 2024, All rights reserved.


mailto:support@getdata.com

Chapter 4 - Installation 42 | Page

e  Chinese (Simplified)
e French
e German
e Indonesian (Bahasa)
e Spanish
e Turkish
During the installation process, select the desired language:

IMPORTANT: It is recommended that a case be conducted in a single GUI language. Changing language mid
case may affect modules which rely on path and field names, such as Scripts and Reports.

STARTUP LANGUAGE
The startup language is controlled by the registry setting:
HKCU\Software\GetData\ForensicExplorer v5\Configuration\DefaultLanguage

Where the key is set to: EN (default), DE, ID, ES, ZH, TR for the required language.

BOOKMARK FOLDER TRANSLATION
Bookmark folder translations can be managed by using the “bookmark folder translations.txt” file located in

the install folder. Currently the translations operate on the first level bookmark folder only.

4.3.5 COMMAND LINE TOOL

Forensic Explorer v5 introduces the FEX CLI as stand-alone Command Line tool. The FEX CLI can be launched
from USB for triage, run at a workstation level, or expanded to operate at an enterprise level virtual
environment spawning multiple simultaneous processing instances.

The FEX CLI can automate all standard forensic processing tasks, including signature analysis, hash verification,
hash match, file carve, registry triage, metadata extraction etc.

FEX CLI is licensed separately from the Forensic Explorer GUI. Contact sales@getdata.com for more
information.

Copyright GetData Forensics Pty Ltd 2010 - 2024, All rights reserved.



43 | Page

multiple

IMPORTANT: Ensure that you have a separate and secure backup of all evidence and case files before you

make installation modifications.
To uninstall Forensic Explorer:
e  Open the Windows Control Panel and in the Programs, section use the Uninstall a program option.

The following window will display:

Figure 22: Uninstall process

Forensic Explorer v5 Uninstall

Are you sure you want to completely remove Forensic Explorer
v3 and all of its components?

A successful removal will show the following message:

Figure 23: Successful un-install

Forensic Explorer v5 Uninstall >

Farensic Explorer v5 was successfully removed from your
computer,

N
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Uninstalling Forensic Explorer removes the installation from the C:\Program Files\ folder (check this folder for
residual items such as log files that are not automatically removed and deletes them as needed.)

The working path: \My Documents\Forensic Explorer vX\ where case file data is NOT automatically removed
and if it is no longer required can be manually deleted.

Copyright GetData Forensics Pty Ltd 2010 - 2024, All rights reserved.



45 | Page

Chapter 5 - Dongle Activation

In This Chapter

5.1 Dongle activation of the purchased VErsion ..........ccceoiieriiieiie e 46
5.1.1  Successful dongle actiVation ........c..oeieciiiiiiiiie e 47
5.1.2  Troubleshooting Dongle ACtIVation ........c.ccoiviiriiiiinienii e 47
5.2 GEtDAta LICENSE IMANAGET ... . iiiiiiieee ettt ettt e e e e e sttt et e e s s ettt e e e e s s e aabateeeeesesanbataeeeesssnsannnees 49
5.3 Wibu CodeMeter Runtime for WINAOWS USEF..........coueiiiiienieniieiieeesieesieeiee et 51
5.4 NETWOIK LICENSING ...uvviiiiiiiee et ettt et e sttt e e e tte e e et e e e s ta e e e etbaeeeeabaaeesabaaaeestaeeeasssaeessseeesnssaneeannes 53
5.4.1 Configure a Network dongle with multiple liCENSES .........eeeeeciiiiiiiiiieecee e, 53
LR Y < AU oI i [ =1 Y= PN 54
5.4.3  Setting up the client (forensic Workstation)..........cceceeeeieieieeeirieesie e e 55
5.5 Applying maintenance updates to your Wibu dongle .........cooocveiiiciiei e 57

Copyright GetData Forensics Pty Ltd 2010 - 2024, All rights reserved.



Chapter 5 - Dongle Activation 46 | Page

5.1 DONGLE ACTIVATION OF THE PURCHASED VERSION

Forensic Explorer is activated using a Wibu (www.wibu.com) USB hardware dongle which is delivered to you
by courier following your purchase (see Chapter 3 - Purchase, for more information on purchasing Forensic
Explorer).

Figure 24: Wibu USB hardware activation dongle

Your Wibu dongle has a unique identification number inscribed on the part of the dongle that is inserted into
the USB port, as shown in Figure 25 below. Include this number in correspondence with GetData:

Figure 25: Unique Wibu dongle identification number

The Wibu dongle is driverless and requires no special installation.
To run Forensic Explorer:

1. Ensure you have installed the full version of Forensic Explorer using the link provided in your purchase
confirmation email (the dongle will not activate the evaluation version. See Chapter 2 - 30 Day
Evaluation Version, for more information on the evaluation version).
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2. Insert your Wibu dongle into a USB port on your forensic workstation. Wait up to 30 seconds to ensure
your forensic workstation has the time to detect that the dongle has been inserted.

3. Run Forensic Explorer from the desktop icon.

5.1.1 SUCCESSFUL DONGLE ACTIVATION

When the dongle is successfully installed, the following screen will display on startup of the application:

FORENSIC EXPLORER

Q Registered To: GetData Office Testing Dongle
. - Maintenance Valid To: 01 January, 2020

GetData r

014) 64bit [EN]
The splash screen identifies:
1. The name, or company name, of the registered owner.
2. The date upon which the current maintenance license expires for that dongle (see page 29 for

information on purchasing).

5.1.2 TROUBLESHOOTING DONGLE ACTIVATION

If the Wibu dongle is not detected on application startup, the splash screen will display “DONGLE NOT FOUND”,
as shown in Figure 26 below:
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Figure 26: Dongle not found error message

GetData '

v5.1.2(9014) 64bit [EN]

To troubleshoot dongle activation:
1. Press the “x” button to close the splash window
2. Remove and re-insert the Wibu dongle.

3. Ensure that your forensic workstation has sufficient time to detect that new hardware has been
inserted. Wait for the Windows USB device message to show that new hardware has been recognized.

4. Re-run the software from the desktop icon.
If you are still not able to activate Forensic Explorer:

1. Run the GetData LicenseManager.exe from the Forensic Explorer installation folder, or available for
download here: http://download.getdata.com/support/LicenseManager.exe (LicenseManager is

described in more detail below).

2. Download and install Wibu CodeMeter Runtime for Windows (described below):
https://www.wibu.com/support/user/downloads-user-software.html.

Contact us via support@getdata.com (see Appendix 1 - Technical Support for full contact details) and provide:
. Your dongle ID number.

e  Ascreenshot of the GetData License Manager.
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. A screenshot of the CodeMeter Control Center.

We will then contact you with further instructions.

5.2 GETDATA LICENSE MANAGER

GetData License Manager is a stand-alone executable that is used to provide information about and manage
activation. The LicenseManager.exe is in the Forensic Explorer installation folder or is available for download
from: http://download.getdata.com/support/LicenseManager.exe

The License Manager gives information about licenses including software maintenance dates. It is used to
program dongles and apply maintenance updates (see 5.5 below).

Figure 27: GetData License Manager

GetData License Manager (4.3.0.259) - O X
My FEX Dongle r, -
Software Development Company
My FEX Dongle
Wibu Dongle 34753296
Product Quantity | Borrowed Registered To Invoice Maintenance Expires
EForensic Explorer 1 - GetData Forensics 3 01 0Oct, 2020
|] Mount Image Pro 1 - GetData Forensics 3 01 0Oct, 2020
&0 Forensic Image Converter {(v1) 1 - GetData Forensics 3 01 0Oct, 2020

Add New License...

Getbata License Manager (4.3.8.259)

CodeMeter Library version: @.8.8.8
codeMeter server version: 6.81.8.3477
CodeMeter Service version: 6.81.3477.588

éUPDATE DONGLE FIRMWARE FROM GEDATA LICENSE MANAGER

Wibu CodeMeter dongle firmware should be updated from time to time. If the firmware is out of date a red
UPDATE will display in the GetData License Manager next to the version number. Right click on the dongle and
select Update Firmware from the drop-down menu, as shown in Figure 28 below:
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Figure 28, Update Wibu Firmware from GetData License Manager

Local Dongles

Add Mew License...

Export Activation Request...
Import Activation Response...

Update Firmware
Find Metwork Dongles...

Delete Virtual Dongle
Create New Virtual Dongle

Initialize Dongle

IMPORTANT: Do not remove the Wibu dongle from the computer during the firmware update. Remove only
once the Update Success message shown in Figure 29 below is received:

Figure 29, Successful Wibu Firmware Update

GetData Liceng

F4763231

GetData License Manager (4.5.8.273)

CodeMeter Library version: e.8.8.8
CodeMeter Server Version: 7.8.8.3925
CodeMeter Service Version: 7.8.3925.581

B L L T T T T T T T

mEE WARNING!!! mEE
*=*= po not unplug dengles until all updates are complete =*==

B T P P P P P T T T T T

Updating 3-4763231 From 4.12...
Update Success
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5.3 WIBU CODEMETER RUNTIME FOR WINDOWS USER

Wibu CodeMeter Runtime is the management tool for the Wibu Codemeter activation system. Download it
here: https://www.wibu.com/support/user/downloads-user-software.html

When Wibu CodeMeter Runtime is successfully installed, insert your Forensic Explorer Wibu dongle. Double click
on the Wibu icon in the Windows task bar, or launch “Codemeter Control Center”:

Figure 30: Wibu CodeMeter Windows task bar icon

The CodeMeter Control Center will open, shown in Figure 31 below. Note that the dongle serial number shown

in the CodeMeter Control Center is the same as that which is engraved on the dongle as shown in Figure 25
above:

Figure 31: Wibu CodeMeter Control Center

& CodeMeter Control Center I}, — O x
File Process View Help
License Events
@ CmStick 7
2-47637206 Mame: CmStick
Serial: 3-4763296 &
Version: CmStick 4,12 @
Capacity: 100 % free (317440 Bytes)
Status: (O @Disabled
@] {2y Enabled until unplugged
O] @ Enabled
License Update Eject Change Password
CodeMeter is running. WebAdmin
Confirm that:

1. Your dongle (CmStick) is identified by the CodeMeter Control Center.
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2. CodeMeter is running (this is the Windows Service responsible for activation).

3. The Status is Enabled.

RENAME WIBU CODEMETER DONGLE

&

The CmStick can be given a custom name by clicking on the edit button:

Figure 32: Creating a custom name for the Wibu dongle

& Change name ? >

Enter the new name of the CmStick 3-4763296 (up to 64 characters).

|I'~"I*_r FEX Dongle| |

UPDATE DONGLE FIRMWARE USING CODEMETER FOR WINDOWS USER

W

Wibu CodeMeter dongle firmware should be updated from time to time. Click on the update button

Figure 33: Wibu CodeMeter - Update firmware

& CodeMeter ? *

[

Firmware Field Update for CmDongle 3-4763296 successfully done,

Information:
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5.4 NETWORK LICENSING

Wibu CodeMeter allows for network license activation. For example, a single dongle can contain 20 licenses

which allows 20 remote computers to activate. More information is available here:
https://www.wibu.com/products/codemeter/network-license-server.html

Figure 34: Wibu CodeMeter network activation

TCPIIP | Port 22352

APl Interface

Web CodeMeler TCPIIP | Port 22350 CodeMeter

License Server

Admin License Server

Network License Server Client

When a network license is purchased from GetData the suppled dongle is pre-configured with the required
number of licenses. However, it is possible for the end-user to program a dongle with the required number of
licenses using the GetData License Manager (described in 5.2 above) and using the license number selection at
the bottom of the add license screen.

Figure 35: GetData License Manager - Creating a network dongle

G0 Add Licenses - Dongle: 3- - >
License: |593ﬁ | | Search |
Invoice | Product | Registered To | Expires Maintenance | Quantity Available
3158778 .Forensic Explorer GetData Forensics 10 10
|10| %l | Masimum Apply | | Cancel
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5.4.2 SETUP THE SERVER

On the computer to be used as the Network Server:

1. Download the latest CodeMeter Runtime for Windows User from
http://download.getdata.com/CodeMeterRuntime.exe (case sensitive)

2. Run CodeMeter WebAdmin from the button in Codemeter Control Center (shown in Figure 31 above)
or by browsing to http://localhost:22350

3. Select Configuration > Server Configuration from the menu, as shown in Figure 36 below:

Figure 36: CodeMeter WebAdmin

— O X
@WebAdmiMServerAcce;s X o+
€ O localhost:22350/configuration, c Q, Search ﬁ’ B + i » = i) -
LIBU CodeMeter WebAdmin
SYSTEMS

Dashboard Container v License Monitoring v DIET R Configuration v

E Server Configuration Server Access (2] BE English (US) ~

Server Access License Access Permissions

—Network Server
O Disable
@ Enable

MNetwork Port *: 22350

—~CmWAN Server
® Disable
O Enable

Restore Defaults

Current Server: localhost (127.0.0.1) (% i WebAdmin Version: 6.20

4. Inthe Network Server window click Enable and press the Apply button.
5. Ensure that the selected Network Port 22350 is not blocked by your firewall.
6. Restart the CodeMeter Service.
a. Runthe CodeMeter Control Center by clicking the CodeMeter icon in the Windows Task tray.

b. Select Process > Stop CodeMeter Service.
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c. Then Start CodeMeter Service.
The Wibu CodeMeter Network Server can also be configured using the following registry setting:
HKEY_LOCAL_MACHINE\SOFTWARE\WIBU-SYSTEMS\CodeMeter\Server\CurrentVersion

IsNetworkServer=1

5.4.3 SETTING UP THE CLIENT (FORENSIC WORKSTATION)

On the client computer:
1. Install Forensic Explorer full dongle version. Close Forensic Explorer.

2. Browse to http://localhost:22350 and select the Configuration tab:

Figure 37: Wibu CodeMeter Local Host Configuration

(& WebAdmin | Server Search... X+

B o calhost:2 2350/ configuration, Q, Search Px =] 4+ H# = -
LIBU CodeMeter WebAdmin
SYSTEMS

Dashboard  Container v  License Monitoring ¥+  Diagnosis v [EE®sllils[¥ig=Yule]s I

'ﬂ' Basic Configuration Server Search List (2] B English (US) ~

Server Search List Proxy WebAdmin Backup

—Server Search List

1. 192.168.100.10

e add new Server

Restore Defaults

Current Server: localhost (127.0.0.1) (% i WebAdmin Version: 6.20

3. Inthe Basic menu click the add new server button and add the IP address of Network Server and press
Apply.

4. Start Forensic Explorer. It should detect the remote dongle license and activate.

The client computer can also be configured using the following registry key setting:
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HKEY_LOCAL_MACHINE\SOFTWARE\WIBU-
SYSTEMS\CodeMeter\Server\CurrentVersion\ServerSearchList\Serverl
Address=192.168.100.10
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5.5 APPLYING MAINTENANCE UPDATES TO YOUR WIBU DONGLE

Once a maintenance update has been purchased, to update maintenance on your Wibu dongle:
1. Remove any other Wibu dongles that you may have for other products (e.g., EnCase, FTK, etc.).
2. Onacomputer that has internet access, insert your Forensic Explorer Wibu dongle into a USB port.

3. Run the GetData License Manager located in the installation folder of Forensic Explorer. The default
location is: C:\Program Files\GetData\Forensic Explorer vX\LicenseManager.exe

4. The GetData License Manager will detect your Wibu dongle, as shown in Figure 38 below. The existing
Maintenance expiration date is displayed in the Maintenance column:

Figure 38: GetData License Manager

GetData License Manager (4.3.0.259) - [m] *

My FEI);;[:_Iongle G‘et Naf>

Software Development Company

My FEX Dongle
Wibu Dongle 34763296

Product Quantity | Borrowed Registered To Invoice Maintenance Expires
EForensic Explorer 1 - GetData Forensics 3 01 0Oct, 2020

|] Mount Image Pro 1 - GetData Forensics 3 01 0Oct, 2020
&0 Forensic Image Converter {(v1) 1 - GetData Forensics 3 01 0Oct, 2020

Add New License...

Getbata License Manager (4.3.8.259)

CodeMeter Library version: @.8.8.8
CodeMeter Server version: 6.81.8.3477
codeMeter service version: 6.81.3477.580

i

5. Do NOT delete any existing licenses from the dongle.
6. Click on Forensic Explorer in the Product list and press the Add New License button.

7. Inthe Add Licenses window, enter the License key that you received with your maintenance renewal
order. Press the Search key.

8. Select the renewal from the available product list. Then click the Apply button.

9. Return to the main screen of the License Manager. The dongle should now show the updated
maintenance date.

For further assistance in applying maintenance updates to your Forensic Explorer dongle, please contact
support@getdata.com (see Appendix 1 - Technical Support for full contact details).
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6.1 WRITE BLOCK

IMPORTANT:

An accepted principle of computer forensics is that, wherever possible, source data to be analyzed in an
investigation should not be altered by the investigator.

If physical media such as a hard drive, USB drive, camera card etc. is a potential source of evidence, it is
recommended that when the storage media is connected to a forensics workstation it is done so using a Forensic
write block device.

A Forensic write blocker is usually a physical hardware device (a write blocker) which sits between the target
media and the investigators workstation. It ensures that it is not possible for the investigator to inadvertently
change the content of the examined device.

There are a wide variety of forensic write blocking devices commercially available. Investigators are encouraged
to become familiar with their selected device, its capabilities and its limitations.

Shown in Figure 39 below is a Tableau USB hardware write block. The source media, an 8 GB Kingston USB drive
is attached and ready for acquisition:

Figure 39: Tableau USB write block with USB as the source drive

ZTABLEAU Forensic USB Bridge |
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6.2 GETDATA’S FORENSIC IMAGER

In May 2020 GetData released an update to ‘Forensic Imager’. It was renamed to FEX Imager v2 and is supplied
in the Forensic Explorer installation folder as FEXImager.exe.

FEX Imager is a Windows based program that will acquire a forensic image into one of the following common
forensic file formats (described in more detail later in this chapter):

e DD /RAW (Linux “Disk Dump”)
e EO01 (EnCase®) [Version 6 format]

e L01 (EnCase®) (when Folders and Files are acquired).

FEX Imager is installed with Forensic Explorer into its installation folder:

C:\Program Files\GetData\Forensic Explorer v5\Forensicimager.exe

FEX Imager should be run as local Administrator to ensure that sufficient access rights are available for access
to devices.

FEX Imager requires the following minimum specification:
e Windows 7 or above.
e 32 and 64bit compatible.
e |7 processor.
e 8GBRAM.

FEX Imager does NOT support DOS acquisition. If acquisition from a DOS boot disk is required, alternative

forensic acquisition software should be used.

Host Protected Area (HPA) and Device Configuration Overlay (DCO)

The HPA and DCO are two areas of a hard drive that are not normally visible to an operating system or an end
user. The HPA is most used for booting and diagnostic utilities. For example, some computer manufacturers use
the area to contain a preloaded OS for installation and recovery purposes. The DCO “allows system vendors to
purchase HDDs from different manufacturers with potentially different sizes, and then configure all HDDs to have
the same number of sectors. An example of this would be using DCO to make an 80 Gigabyte HDD appear as a
60 Gigabyte HDD to both the OS and the BIOS” (1)
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Whilst the HPA and DCO are hidden, it is technically possible for a user to access these areas and store/hide
data. FEX Imager does not currently support the acquisition of HPA or DCO areas.

6.2.4 RUNNING FORENSIC IMAGER

FEX Imager is in the Forensic Explorer installation folder as a stand-alone executable. When FEX Imager is run,
the investigator is presented with the Source window:

Figure 40: Forensic Imager

B FEXImagerv2.1.0(225) — [} x

FEX lmager= = [g oo =

Advanced Forensics

SOURCE

DESTINATION

PROGRESS

Image Entire Drive
o 3

Sector Size | 512 ~ |

© GetData Forensics 2020 Hash... Destination >

6.2.5 SELECTING THE SOURCE

The source describes the data to be acquired. The source can be:
e A physical drive (i.e., a physical hard disk)
e Alogical drive (i.e., a partition such as C:\ or D:\)
o Afolder or files located on a partition
e An existing Forensic Image (i.e., an EO1 or DD image file)
e Aremote drive accessed using the Forensic Explorer servlet.

To select the source, click on the Select button drop-down menu:
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Figure 41, FEX Imager Select source

Physical Drive

Laogical Drive
Folder and Files

Forensic Image

Hl 0 O

Remote

The Select option chosen will determine what is shown in the Select Source window. Figure 42 below shows the
result of selecting the Physical Drive option.

NOTE: If physical drives are not displayed in this window, it is usually because FEX Imager was not launched as
administrator, and it does not have sufficient privileges to access the physical drives. Re-launch FEX Imager by
right-click on the icon and run as administrator.

Figure 42: Forensic Imager - selecting the source device (Verify or Hash option shown)

El select source — | >
Select the Device you want to analyse:
Device Label Size F5 Type
_3:.4 Image Files
=] ;bh‘ My Computer ﬂ Add Image
a Hard Disk 0 \% \PHYSICALDRIVED 233,47 GB SATA (Win) . Add RAID
a Hard Disk 1 W \PHYSICALDRIVEL 1.82TEB SATA (Win)
a Hard Disk 2 W \PHYSICALDRIVE2 1.82TEB SATA (Win) o=
= (&= Remote
a Hard Disk 3 W PHYSICALDRIVES 1.82TEB LISE {Win)
) "
|2 Hard Disk 4 \\. \PHYSICALDRIVE4 39.3MB USB (Wir) G Remove
&% Refresh
0K Cancel
The device selection window includes the following information:
Label: Physical drives are listed with their Windows device number.

Logical drives display the drive label (if no label is present then "{no label}" is used). Image
files show the path to the image.

Size: The size column contains the size of the physical or logical device, or the size of the image
file.
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FS:

Type:

(Note that the reported size of a drive is usually smaller than the size printed on the drive
label. This is because manufacturers report the size in a decimal number of bytes while the
Operating System reports the size in 1,024 chunks for each KB).

The File System on the drive, e.g., FAT, NTFS, HFS, APFS.

Describes the way in which the drive is connected to the computer. An image file will show
the type of image (e.g., EnCase® or RAW).

Acquisition of physical vs. logical device

In most situations, pending compliance with any overriding case specific legal requirements, an investigator will

forensically image a physical device. Imaging the physical device gives access to the content of the entire media,
for example, the space between partitions. Carrier, 2005, observes: “The rule of thumb is to acquire data at the
lowest layer that we think there will be evidence. For most cases, an investigator will acquire every sector of a

disk”. (2 p. 48)

In specific circumstances, an investigator may need to acquire a range of sectors from the device. In this case,

start and end sector information is entered in the sector range fields at the bottom of the source selection

window.

Figure 43, Select FEX Imager start and end sectors

Image Entire Drive

0 o
=

0 o
&

When a source device is select the source selection window will populate with the device information:

Figure 44. FEX Image source drive information

Source

| WAPHYSICALDRIVED

Source Mame
Description
Serial Mo
Froduct ID
Froduct Rev.
Size

Sectors
Sector Size

WAPHYSICALDRIVED

Hard Disk 0

141997403308

SanDisk SDESBE1M256G1002
K231600

238.47 GB

500118192

512 bytes
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6.2.6 HASH OR ACQUIRE

Once a source is selcted, two options become available at the bottom of the Source window:

Hash: Hash is selected when the users wishes only to calculate a hash for the device (for example,
to verify the hash of an existing forensic image file).

Figure 45: Verify\Hash

Verify Source l} *

Verify \ Hash Source

~IMDs
CsHa1

[=Hazs58

Destination: The Destination button is selected to acquire a forensic image. It is described in more detail
below.

6.2.7 SELECTING THE DESTINATION

The image destination screen, shown in Figure 46 below, is where the parameters for the image file are set,
including type, compression, name, location etc.

Figure 46: Setting destination options

E Destination E
FEX Imager image Type (EnCase CEON ]
Advanced Forensics ﬁ Filename [test | (no extension)

Folder |H:\ |
SOURCE > Segment Size |2000 21| (MB. No Limit=0) B

W IPHY,

Image Hash Compression

(O Best (Smallest and slowest)

] Verify image after creation

[1MD5 (O None
[1sHA1 () Fast
DESTINATION > [IsHA256 @® Good (Smaller but slower)

PROGRESS S Case Details ﬁ

Case Name Evidence Mo

|test acquisition ||1 |
Description Examiner

|1hi5 is a test acquisition ||Graham Henley |

MNotes

This is a test acquisition of physical drive 0 using FEX Imager v2.
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1. IMAGE TYPE
The investigator has the choice of creating the forensic image in one of the following forensic file formats:
DD / RAW:

The DD / RAW format originates from the UNIX command line environment. A DD /RAW image is created from
blocks of data read from the input source and written directly into the image file. The simplicity of a DD image
makes it possible to compare the imaged data to the source, but the format lacks some of the features found in
more modern formats, including error correction and compression.

EnCase®.EO1

The EnCase® EO1 evidence file format was created by Guidance Software Inc. It is widely accepted in the forensic
community as the image file standard. Further information is available at www.guidancesoftware.com. The

structure of the EnCase®.E01 format allows for case and validation information (CRC and MDS5) to be stored
within the image file. The structure of the EnCase® file format is shown below:

Figure 47: EnCase® header

Header CRC
Header: Data Data
Case . Block Block
Information
Source: (3)

3. FILE SEGMENT SIZE
Sets the segment size of the created forensic image file:

This setting enables the forensic image file to be broken into segments of a specific size. Setting an image
segment size is primarily used when the forensic image files will later be stored on fixed length media such as
CD or DVD.

For the EnCase®.E01 image format, Forensic Imager uses the EnCase® v6 standard and is not limited to a 2 GB
segment size. However, if an investigator plans to use larger file segments, they should consider the limitations
(RAM etc.) of the systems on which the image files will be processed.

4. OUTPUT FILENAME

Sets the destination path and file name for the image file:
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The output file name is the name of the forensic image file that will be written to the investigator’s forensic
workstation. Click on the folder icon to browse for the destination folder.

5. HASH OPTIONS
Calculates an MD5, SHA1 and/or SHA256 acquisition hash of the imaged data:

A hash value is a mathematical calculation that is used for identification, verification, and authentication of file
data. A hash calculated by Forensic Imager during the acquisition of a device (the “acquisition hash”) enables
the investigator, by recalculating the hash later (the “verification hash”), to confirm the authenticity of the image
file, i.e., that the file has not changed. Any change to the acquired image will result in a change to the hash value.

Calculation of HASH values during the acquisition process requires CPU time and will increase the duration of an
acquisition. However, it is recommended, in line with accepted best forensic practice, that an acquisition hash
is always included when acquiring data of potential evidentiary value. It is also recommended that the
investigator regularly recalculate the verification hash during the investigation to confirm the authenticity of the
image.

Forensic Imager has three independent hash calculation options, MD5, SHA1 and SHA256. The investigator
should select the hash option/s which best suits:

MD5 (Message-Digest algorithm 5):

MDS5 is a widely used cryptographic algorithm designed in 1991 by RSA (Ron Rivest, Adi Shamir and Len
Alderman). It is a 128-bit hash value that uniquely identifies a file or stream of data. It has been
extensively used in computer forensics since the late 1990’s.

In 1996 cryptanalytic research identified a weakness in the MD5 algorithm. In 2008 the United States
Computer Emergency Readiness Team (USCERT) released vulnerability Note VU#836068 stating that the
MD5 hash:

“...should be considered cryptographically broken and unsuitable for further use”. (4).
SHA1

In 1995 the Federal Information Processing Standards published the SHA1 hash specification which was
adopted in favor of MD5 by some forensic tools. However, in February of 2005 it was announced that a
theoretical weakness had been identified in SHA1, which suggests its use in this field may be short lived.

(5) (6)
SHA-256:

From 2011, SHA-256 is expected to become the new hash verification standard in computer forensics.
SHA-2 is a set of cryptographic hash functions (SHA-224, SHA-256, SHA-384, and SHA-512) designed by
the National Security Agency (NSA) and published by the USA National Institute of Standards and
Technology.

For more detailed information on hashing and how the strength of a hash value applies to the forensic
investigator suggested reading includes: “The Hash Algorithm Dilemma—Hash Value Collisions”, Lewis, 2009,
Forensic Magazine.
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6. ENCASE® COMPRESSION
Sets the compression level for the EnCase® forensic image file

The EnCase®.E01 file format supports compression of the image file during the acquisition process. Compressing
a forensic image file during the acquisition process takes longer, but the file size of the forensic image on the
investigator’s workstation will be smaller. The amount of compression achieved will depend upon the data being
imaged. For example, with already compressed data such as music or video, little additional compression will be
achieved.

DD/RAW image formats do not support compression.

7. VERIFY IMAGE HASH AFTER CREATION

During the acquisition of a device the “source” hash (MD5 and/or SHA1 and/or SHA256 as per the investigator
selection) is calculated as the data is read from the source disk. Once the acquisition is complete, the source
hash is reported in the event log in the format:

Source MD5Hash: 94ED73DA0856F2BAD16C1D6CC320DBFA
For EnCase®.EOQ1 files the MD5 acquisition hash is embedded within the header of the image file.

When the “Verify image hash after creation” box is selected, at the completion of writing the image file Forensic
Imager reads the file from the forensic workstation and recalculates the hash. The verification hash is reported
in the event log in the format:

Verify MD5Hash: 94ED73DA0856F2BAD16C1D6CC320DBFA

After the verification process a comparison is made between the source and verification hash. An exact image
of the source disk to the image file should result in a “match”:

MD5 acquisition and verification hash: Match

Should the acquisition and verification hash not match, it is an indication that a problem has occurred, and the
device should be re-acquired.

8. DETAILS

For EnCase®.E01 files, information entered into the “Details” field are written into the image file header and
stored with the image. DD/RAW and AFF files do not store this information as part of the image, however they
are still required to be entered as for all formats the information is included in the Forensic Imager event log.

6.2.8 3. PROGRESS

The progress screen displays source information (the drive being acquired) and destination information (location
where the forensic image files are being written). Progress information, including elapsed time, time remaining,
and transfer speed is displayed. The progress window is shown in Figure 48 below:
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Figure 48: Forensic Imager Progress screen
. = Source: W \PHYSICALDRIVED
L4 oo
LIy FEX lmager Destination: H:\test. E01
“af Elapsed R Speed
. apsed: emaining: peed:
Advanced Forensics Acquisition Progress 00-01-27 00:32:54 12456 MBis
A&
Imager v2. ~
Source : \\.\PHYSICALDRIVECQ
PROGRESS Description : Hard Disk 0
- Serial No : 141997403308
Product ID : SanDisk SDESB1M256G1002
Product Rev. : X231e00
Size 1 238.47 GB
Sectors : 500118192
Sector Size : 512 bytes
Image File Type : Encase v.6.10
Image Compression 1 Good
Segment Size : 2000 MB
Acquisition started : 05-May-2020 4:53:09 oM
v
© GetData Forensics 2020 [4 Back Cancel

The bottom half of the progress window provides summary information about the acquisition process,

including hash information.

If the EO1 image format was selected the acquisition hash is stored within the forensic image. If the verify

image after creation option was selected in the FEX Imager Destination window, the progress window will

include a comparison between the:
Stored [Hash Type]: A hash of the data taken during the acquisition and stored in the EOQ1; and

Computed Hash: A hash of the data in the created forensic image file.

Figure 49, FEX Image Progress window hash information

Computed MDS Hash : T6e0266f66T7e57ed6440Efdf0E6T1decT
Verification started : 05-May-2020 4:58:27 AM
Verification finished : 05-May-2020 4:58:27 AM

Elapsed time : 0 sec

Stored MDS Hash : Teel2eefeeT7ebT7eded40Efdf0e7T1decT
Computed MDS Hash : Teel266f66T7e57ed6440Efdf06T1decT

Source and Computed MDS hash : Match

Bocquisition completed!

Note that if the DD image format is selected a hash value is not stored within the DD image file.
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The event log for each acquisition is automatically saved to the same folder as the image file/s. A typical event

log contains the following type of information:

Disk errors can occur during the image process due to a problem with the entire drive or a problem isolated to
specific sectors. If a bad sector is identified, Forensic Imager writes 0’s for the data that cannot be read and logs
the location of bad sectors in the event log as they are found.
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7.1 MODULES

The Forensic Explorer interface is broken down into modules which separate the programs primary functions.
Each module is accessed by a tab at the top of the main program screen. The functions of the module are
summarized in the following table. More information about each tab can be found by referring to the module
specific chapter:

Tab Function Chapter
ﬁ Evidence Case management. Chapter 10
Detailed analysis of file systems added to the Chapter 11
File System Y y P
case.
Artifacts Artlfa(.:ts can |ncIud(.e browsing history, char, Chapter 12
7 call history, Operating System records, and

other potential evidence.

p 4 h Keyword search raw case data using simple or Chapter 13
Keyword Searc RegEx keywords.
p q h Create and search indexed data using dtSearch  Chapter 14
Index Searc technology.
@ Email Examine PST files. Chapter 15
n ) View and analyze registry files. Chapter 16
Eﬂ Reqgistry

Add investigator bookmarks to document the Chapter 17

Bookmarks analysis.

Create reports. Chapter 18
D Reports
. Program, manage and run scripts against case Chapter 19
g Scripts d
ata.
Custom Modules: It is possible to create a custom module. See 18.6 - Custom Modules, for more
information.

Hide Modules at Startup: It is possible to hide specific modules at program startup. This can be useful when
you are providing Forensic Explorer to a non-technical investigator and wish only to
show certain modules, such as Index Search and Bookmarks. See 19.4 for more
information.

7.1.1 UNDOCKING AND DOCKING MODULES

Forensic Explorer has been designed for use on forensic workstations with multiple monitors. Module tabs can
be undocked from the main program window and moved across multiple screens.
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To undock a module:

1. Select the module tab with the mouse.
2. Hold down the mouse and drag the module tab free of the bar, as shown in Figure 50 below:

Figure 50: Un-docking a module

D Case Notes D Bookmark g Scripts Ea. Registry

hA |32 Qe

Click and drag the tab to
undock the module

To dock a module:
1. Select the top bar of the module window.

2. Dragand drop the module back into the module tab menu bar, as shown in Figure 51 below:

Figure 51: Re-dock a module tab

D Bookmarks

Ea' Registry

pe B Timestamp

Data Timestamp

Re-dock by draging . & scripts
the module back into é .
the top bar Scripts

Mame
= [ﬁ Scripts
e [ 24 My Scripts
- [ 4 Filters
-] LT mdshash.pas
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7.2 MODULE DATA VIEWS

Within each module are one or more “data views” which display the data in the case. Data views occupy the
three lower panes of the Forensic Explorer module. They operate in a similar fashion to the layout to Microsoft’s
Windows Explorer, with a tree (top left), list (top right) and display (bottom) window, as show in Figure 52 below:

Figure 52: Forensic Explorer module layout

H@vﬂva e Bl 13 LB 66 —amx
Oyewdence [ e Srtem o anocs ﬂwwam O mex search @sml smw E soomars [ repans §sm IMERUIES]
6 N F O3 M 0 0. ® O o o ®. ® # 4. 86 R
Fecowr  fierame e Smoon Somiwe * Epad  famc T Amiss | Tage | ek T fle T Rsh  Mmh T Amn T vl " Ceocam  Wmoms T foewic T Toos
Foges  Sero Cane oy Amiyss Fies  Meoia  Frograms Fegistry o les  Math  SeiCiote | LveBoot | Amivins  Pogms  Pogams e
] Fokders | [T Categeries [ FieLet |[T3] Galery view [£2) Vidoo Wiew  (uy Ok view ) Catogory Gragh
Fiers | T Rl CElaE e e 8" Ext | ) Comsfcotor |19 Flogs g o [Ty (Fywer— i p——r— —r— ] = & Accemaed
Flerame Exemgon Cosbatn  Fans Pain awbutes Logeaisae idredsae  Phscise  vodfed Created accesoed 0
FOLBERS LISTAVIEW.
VIEW, e o/
C 2
N < W2
N 01 0 Visible [0 bytes] 0 Highlighted [0 bytes] 0 Checked [0 bytes] ﬁ"
b e N o
Q}P‘; \Q}?-‘- ot ==
DATAVIEWS
Sector: ) Device Offses 0 File Offet: O Selection: 0 Ho Date
i tex | = Text = info T¥ Bocknark . Byie lot || Display = Flecyetem Record | =/ Fle Meladats = i Eximt
SIS R e——————

Data views are conduits to the examined data. Each data view is designed to expose the investigator to specific
information, whether it is lists of file attributes, displaying photos or graphics, detailing file metadata, or dealing
with data at a sector or hex level. Data views also contain the tools that are used to display, sort, decode, search,
filter, export and report.

More information about each data view is provided in Chapter 8, “Data Views”.

-

Any data view window showing this icon can be undocked and used as a standalone window.
To undock a data view:

1. Click on the title bar or the data view tab.

2. Hold down the mouse and drag it away from its position, as shown in Figure 53 below:
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Figure 53: Undocking a view using drag and drop

[ File List ) Disk View Gallery View
Gallery View

e Smaller . . . . U Larger

Undock by dragging the
titlebar or the tab

Mo file selected

To dock a data view:

A data view can only be re-docked to its parent module. For example, the File List data view can only be re-

docked inside the File System module. It can however be docked to any position inside its parent module,
including inside another data view. To dock a data view:

e Click on the data view header and drag and drop the header into next to the other data view tabs in

the required position; or,

e Drag and drop the data view over the required position arrow as detailed in Figure 54 below:

Figure 54: Dock positioning arrows

Dock to top
border

Dock to left

Dock to right
border

border

Tab with parent
window

Dock to bottom
border

Copyright GetData Forensics Pty Ltd 2010 - 2024, All rights reserved.



76 | Page Chapter 7 - Forensic Explorer Interface

7.3 CUSTOMIZING LAYOUTS

The position of modules and data views can be saved to a file at any time. This allows the investigator to
customize a module for different types of investigations. For example, the module layout for an investigation
involving graphics may be different to fraud investigations involving documents.

To save a custom layout:

1. Inthe top bar of the program click on the Forensic Explorer button to open the drop-down menu and
select Layout > Save Layout, as shown in Figure 55 below:

Figure 55: Accessing the Layout Options

fomacooire R

B save File System ‘ ,(* 2
‘ Investigators... -
(@ Options x . .-._? L
Layout L Default Layout

49 Icon Editors » | Savelayout

kd Feedback.. ™ Load Layout

&0 License Manager... T
@ About..

@ Help

(@ Ext

2. Enter the name of the .xml layout file and click the Save button.

To load a custom layout:

1. Inthe top bar of the program click on the Forensic Explorer button to open the drop-down menu and
select Layout > Load Layout, as shown in Figure 55.

2. Select the desired .xml layout file and click the Open button.

To return to the default layout:

In the top bar of the program click on the Forensic Explorer button to open the drop-down menu and select
Layout > Default Layout, as shown in Figure 55.
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7.4 TASK PROCESSES LIST

In a Forensic Explorer case numerous processing tasks will be performed on the evidence. This includes:

e administrative tasks: such as creating and saving case files;
e  processing tasks: such as reading and displaying a file system; and

e investigations tasks: such as signature analysis, file hashing, file carving, running scripts, create indexes
etc.

Process are tracked in the processes list, accessed from any Forensic Explorer Module in the bottom right-hand
corner of the main program screen:

Figure 56: Forensic Explorer processes window

§)] Hide W
MNew Case Completed: NIST Windows 7 Test Image
=  Time Taken: 00:00:01 3:55:44 PM
-
Search for Known MBERs
=)  Time Taken: 00:00:00 3:56:23 PM
-
Search for FileSystems
=  Time Taken: 00:00:01 3:56:23 PM
w
Verify Device Hashes
=  Verifying device hashes....
—— | [. | M

The purpose of the list is to:

Visually show the progress of running processes.

o Identify processes which have completed, their duration and the time completed.
e Cancel the running process. The cancel button terminates a thread gracefully.

e  Terminate a thread that not responding to the cancel process:

e Allow access to process logging (see 7.5 below).

Figure 57: Accessing Process Cancel and Terminate options via the Processes window drop-down menu

& | Cancel

El Terminate

(& Log
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7.5 PROCESS LOGGING AND PRIORITY

When a task is run in Forensic Explorer the investigator can set Logging and Priority options, as shown in Figure
58 below:

Figure 58: Setting Logging and Priority options

L T L e I I L L L T T i W N ]

Logging: | None - Pricrity: [Nonnal - ]

o< J[ conce |

The “Logging” setting determines the detail of case process logging. Case log files are accessed by clicking the
drop-down arrow for the process in the process list (Note: If logging is set to “None” then the link to the log file
will be greyed out):

Figure 59: Access Process Log Files

Time Taken: 00:00:22 4:36:03 PM

5

Case log files are stored in the path: “[User]\Documents\Forensic Explorer\[Case Name]\Logs\".

Application log files are stored in the path: “[User]\Documents\Forensic Explorer\AppLogs\”.

Priority setting is used to determine the number of computer processors allocated to the task. Minimum is
allocated a single processing core. Normal and above are allocated multi-processing cores (if available).

Important: The speed of multi-core process is influenced by computer hardware. With insufficient hardware
resources, multi-core can lead to data bottlenecking and be slower than single core process. It is recommended
that users test the speed of their hardware to ensure maximum processing speed.

Priority settings are:

e Minimum 1 thread.

e Normal 0.5 times the number of processors

e High 1.0 times the number of processors (-1 to stop overload)

e Maximum 2.0 times the number of processors in Maximum priority - 2 (2 to stop overload)
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7.6 REFERENCE LIBRARY

The purpose of the Reference Library is to put personal reference resources within easy reach of the investigator
from Forensic Explorer interface.

In Forensic Explorer v5.4.8.2587 and above the Reference Library is uses a third-party application called Zotero,
https://www.zotero.org. Zotero is:

- Free.
- Imports from other reference managers.
- Single click extensions are available for most browsers.

- Works on-line or off-line.

Download Zotero from https://www.zotero.org and follow the on-screen default installation steps.

To Add a Zotero toolbar button to Forensic Explorer:

1. In the File System module, select Tools > Add/Remove — Reference Library (Zotero).

Figure 60: Add Reference Library Zotero button

{0 Z

Tools = Reference
Library

Add/Remove - Bockmark CETS Categories
Add/Remove - Bookmark Interpol Categories

Add/Remove - CLI Launcher
Add/Remove - Investigator Motes
Add/Rermove - Log File Viewer
Add/Remove - Quick Word Report

Add/Remove - RamDisk 3rd Party Tools
Add/Remove - RamDisk FFmpeg
Add/Remove - RamDisk VLC

NSNS BUOE 8E

Add/Remove - Reference Library (Zotero)
Add/Rermove - Screen Capture (IfanView)
Create Drop Down Filter

Clear Column Content

Show/Hide Metadata Columns

i B AR

2. Select the modules to add the Zotero toolbar button.
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Forensic Explorer

Interface

7.6.2

IMPORTING ZOTERO REFERENCE INFORMATION

 BROWSER CONNECTOR

References can be added directly to Zotero whilst web browsing using a browser connector. To install a

browser connector:

In Zotero

1. Select Tools > Install Browser Connector > Install

Figure 61: Zotero Browser Connector

z Lotero
Eile Edit View Help
o IE 7 Create Timeline

RTF Scan

= My Library

T Duplicate Add-ons
Unfiled It

) Developer

1l Trash

Manage Attachments

My Publi Install Browser Connector

I

IMPORTING REFERENCES

It is possible to import existing references to Zotero from other reference managers.

A default set of references is provided with Forensic Explorer. The import file is located in:

...\Documents\Forensic Explorer v5\Reference Library\FEX References.rdf

To import default Forensic Explorer references:

1. In Zotero, select File > Import and navigate to the above FEX References.rdf file.

2. Selecting the option to Place imported collections int a new collection will create a new collection

folder for the import (see Figure 63 below). This enables the Forensic Explorer user to manage

different reference collections.
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Figure 62: Import reference collection to Zotero

Import

Options
@ Place imported collections and items into new collection
File Handling

© Copy files to the Zotero storage folder

() Link to files in original location

Linked files cannot be synced by Zotero.

Figure 63: Creating a new Zotero collection folder

z Zotero

File Edit View Tools Help

@ @'

w [Z] My Library

BB FEX References

Acqusition
Artifacts
Date Time
Hashing

Metadata
Random Sampling

Recycle Bin

Registry

SANMNS Posters/Guides
Shadow Copy
Signatures

Test Data

My Publications

77 Duplicate [tems
' Unfiled ltems
‘1l Trash

For additional information on using Zotero visit: https://www.zotero.org/support.
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Chapter 8 - Data Views
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8.1 DATA VIEWS SUMMARY

Each of the Forensic Explorer module tabs contains one or more of the following data views:

Data View Tabs

Function

Shows the folder structure of the examined device.

Folders
Separates items into categories, including files by extension, files by modified
A= date and flagged files.
] Fie List Lists individual items and displays their metadata in columns.
&) Disk View A graphical display of the sectors which make up the examined device.

A thumbnail presentation of the graphics files.

Shows time segment video thumbnails and individual video playback.

[ Diisk: View

A graphical display of the sectors which make up the examined device.

@ Category Graph

A graphical display items in “Categories”.

Hexadecimal view of the currently highlighted item. Automatic interpretation

b Fex of user selected data.

= Text Text view of the currently highlighted file.

=] info Property item information, value and type.

=E Bookmark Shows the bookmark details associated with the item.

i Byte Plot A graphical representation of byte level data within the currently highlighted

file.
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Display Content display of currently highlighted file. Displays of 300 + different file
types including video and audio.

=| Filesystem Record Displays information contained in the MFT record or FAT entry for the
currently highlighted file.

A breakdown of files metadata components.

File Metadata

= File Extent Details the start, end and length of each data run on the disk.

These views are described in more detail below.

8.1.1 COMPONENTS OF A DATA VIEW

Figure 64: Data view layout

View name Options ——Pp ~

-~

Data Area

View information bar '

View Name: The view name describes the function of the view, e.g., “Hex” displays a hexadecimal view of the
currently highlighted item. The options button ¥ provides the option to rename a view with a custom name.

Data Area: The data area of the view is where the content of the highlighted item is displayed to the investigator.
View information bar: The information bar at the bottom of a view. It provides details on the data currently
displayed in that view. It is an important navigational reference. The information bar can contain information
such as:

e The full path to the currently highlighted item.

e The currently selected physical sector.

8.1.2 DATA VIEWS RELATIONSHIPS IN THE FILE SYSTEM MODULE

Forensic Explorer data views within a module co-exist in linked relationships. In simplest terms, when a file is
highlighted in one view, the other views also change to show that data.
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Note: Data views between different modules are NOT linked. For example, the Hex data view in the File System
module acts independently from the Hex data view in the Keyword Search module.

Figure 65: Relationships between data views

Tree

List View -#———— DiskView <€———> GalleryView

HH =3 L ES) = = F
Hex Text Byteplot  Display Filesystem File File
Record Metadata  Extent
Key:
<+“—> Multi relationship. A selection in view changes the selection
in all other connected views.
—_— Asingle relationship. A change in the parent view changes the

view in the child view.
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8.2 TREE VIEW

A Tree view is a hierarchical display of items (e.g., devices, partitions, folders, registry key folders, keywords
etc.). Like Microsoft’s Windows Explorer, the Tree view is most used to select a folder, causing the contents of
the folder to be displayed in the adjacent List view.

The default position for a Tree view is in the top left window. The actual name of the Tree view changes per the
module, i.e.:

Module Tree view Name More Information
File System Folders Chapter 11
Keyword Search Keyword Tree Chapter 13
Bookmarks Bookmark Tree Chapter 17
Registry Registry Tree Chapter 16

To navigate Tree view:
e Use the keyboard arrow keys to traverse, expand and contract the tree.
e Double click a Folder to drill down into its sub folders; or
e Click the # and [# symbols to expand and contract the tree hierarchy; or

e  Right click options:

Figure 66: File System, Folders — right-click options.

Il Add Bookmark...
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Refresh
Refresh Checks
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Expand
Expand all
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Clear All Checks
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Copy cell

C+ Branch plating *
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Add Bookmark:

Export:

Modify time setting:

Remove: Remove user added items (expand, carve, etc.).

Refresh: Refresh the current view.

Refresh Checks: Refresh the checkmarks.

Expand: Expand the currently highlighted folder.

Expand All: Expand all folders.

Contract: Contract the current branch.

Contract All: Contract all branches.

Reset view: Remove: branch plate, checks, folders filter, and contracts all.

Clear All Checks:
Copy Cell:

Branch plating:

8.2.2 TREE VIEW FILTER

Bookmarks the current highlighted item (folder).
Options to export the item/s from the tree.

Modify evidence time settings during a case.

Removes all checks (checked items count will be zero).

Copies the text of the currently highlighted item.

Turns branch plating on or off (off makes the tree like Windows Explorer).

Some Tree views contain a filter drop-down menu, as shown in Figure 67:

Figure 67: Tree view filter

Folders Categories [F7] File List Galler
* 0 B File List
Filter: [Graphics Files.pas v] 2 =] |la2 Filename
20O g Test Case 1 (1) ] Filename
=+ T [ [4] Lexar 7GB USB MKII.EO1 (3) [Local Time] | [Z) LostFile_IPg
B > [ s Partition @ 63 (5) [1 = [Z) LostFile_IPG
= G [ [ Root (33) [ [2) Lostrile_JrG
C>[O [ soth Birthday Cake (7) L [Z) Lostrile_IrG
T [ Architecture (205) (| [Z) LostFile_IrG
[0 [ Bvw - TEST SEQUENCE (50) = |2 LostFile_1Pg)
C+[1 Fish (5) 4
C» [ - F2Helden Photos (108)
CO Flowers (15)
C-[ [ Foop (72)
CO Landscape (3) 0 1 3
0000:0000 | 43 4T 4
10 Mew York City (5) . =

A tree view filter is used to display only the folders which match set criteria. For example, applying the Graphics
Files.pas filter will show only folders containing graphics files. The File list view in the right-hand window will
also only show the applied filter criteria.

Tree view filters are created using scripts. For more information on creating a Tree view filter, see O- Filters.
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8.2.3 BRANCH PLATE

One of the most powerful features of Tree view is the “branch plate”. When a branch plate is selected, all items
beneath that plate are displayed as a single list in List view. For example, this action can be used to display the
contents of a folder and all its sub folders and files.

To branch plate, click the required plate with the mouse.
e  When the plate turns orange, [B: it is active.
e Asemi-filled branch plate, [C* indicates that a sub-folder of that branch has been plated.
To plate multiple branches:
1. Click the first required plate with the mouse.

2. Hold down the CTRL key and click the other required plates.

Figure 68: File System module, Folder’s view, branch plate with “Aquatic” and “Landscape” folders plated

Faolders Categories
Filter: |= No Filter v,

pOE (1) fLocal Tme]
S0 oy ——
= DD =] (5 __
= ;
=[] (4
=0
B[] Aguatic (13)
=[O (4
id
DO g
]
= | Landscape (5)

0 of 63 Checked [0 bytes]

Plated folders are displayed in normal font. The non-plated folders are in grey italic.

The blue number in brackets, e.g. (13) counts the number of items inside the folder (but does not count the

contents of sub folders).
To turn off the branch plate:

e Right click in the File System module Folders View, or in the like tree view of other modules (plating
operated independently in each module) and select Branch Plating > Branch Plate Off. When branch
plating is turned off the tree works in a similar fashion to Windows Explorer.
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8.3 LIST VIEW

A List view displays individual items (e.g., files) and their metadata (e.g., file name, size, modified date, created
date, etc.) in a table format.

The default position for a List view is in the top right window. The actual name of the List view changes per the
module, i.e.:

Module List View Name More Information
File System File List Chapter 11
Keyword Search Keyword Result List Chapter 12
Bookmarks Bookmarks List Chapter 17
Registry Registry List Chapter 16

List view allows items (such as: files, notes, keyword search results and registry entries) to be sorted, highlighted,
checked, flagged, opened and exported. For more information, see

Chapter 9 - Working with data.

8.4 DISK VIEW

The default location for Disk view is the top right-hand window of the File System module, accessed via the Disk
View tab:

Figure 69: Disk View tab
(G5 Disk View
Disk view is a graphical display of the sectors which make up the examined device. Disk view can be used to:

e Obtain a graphical overview of items which make up the device (e.g., MBR, VBR, FAT, MFT, files,
deleted files, unallocated clusters etc.).

e Quickly navigate to a desired sector on the device (see “Navigating Disk view” below).

e Select sectors for examination in other Forensic Explorer views (e.g., Hex view, Text view etc.). The
selection can include a single sector, a range of sectors, or an entire item.

To open Disk view:
e Open a case or preview evidence.
e  Go to the File System module.
e Inthe left pane, select the device (or an item in the file system of the device) to view.

e Inthe right pane, select the Disk View tab
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Figure 70: Disk view
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8.4.1 RESIZING THE DISK VIEW DISPLAY

The number of sectors shown in Disk view can be dynamically adjusted using the slider bar:

Figure 71: Disk view scale bar

Sma" LI R B B | I@I L I I R B A | Large

Large scale can be used for examining small groups of individual sectors. Small scale can provide a graphical
representation of the data structure on the disk and can also be used to quickly identify content (see 8.4.2 -
Color Coded Content below).

8.4.2 COLOR CODED CONTENT

Disk view opens with the following default color coding representing the content of sectors (color coding sourced
from http://en.wikipedia.org/wiki/Web colors):

The start sector of a file

Currently selected sector

g dv

One type overlays another

MBR/VBR (Red)
FAT 1 (DarkViolet)
FAT 2 (WebViolet)

SMFT (DarkViolet)

N AR

System files (WebTomato)
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o

SMFT resident file (the file overlays the SMFT)
Folder (Deepskyblue)

Allocated File (CornFlowerBlue)

H H u

Unallocated space (LtGray)

Y|

Deleted file (A deleted file overlays unallocated space)

74

Carved file (DarkOrange: Carved file overlays unallocated space)

_CUSTOM DISK VIEW COLORS
Disk view colors can be customized. For example, it is possible to:
e show afile type, e.g., JPGs as a specific color; or
e change the color of a file type over a certain size to a specific color; or
e show a specific file, e.g., “sample.txt” as a specific color.

Custom Disk view colors are defined using Forensic Explorer scripts located in the “Scripts > Disk View” folder.
(Learn more about scripting in Chapter 19 - Scripts Module).

To change Disk view colors using a script:
1. Right click in the Disk view window.
2. Select “Disk Colors” from the drop-down menu.

3. Select the required Disk view colors script.

Figure 72: Right-click Disk View menu links to scripts

Goto

Disk Colaors k Default Colours

Export Selection... Bookmarked - Green.pas
Carve Selection... Checked files - Red.pas

Deleted - Orange.pas
Faolders - SkyBlue.pas
Free space - Black.pas
JPG - Yellow.pas

Multi color change.pas
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To reset Disk view
colors to default.

Navigate sectors using the arrow keys Right click in the Disk

view window.

Select Disk Colors >

First and last sectors are reached using the Default Colors.

home and end keys:

Pages of sectors can be scrolled using the
Page Up or Page Down keys.

Scroll by row using the mouse. Hold down the

M Il
ouse Scro SHIFT key to scroll by page.

Or use the following keyboard shortcuts to go to:

D Next deleted file

E Entry

F Free Space

N Next File

P Previous file

Ctrl P Previous different type
S System

U Unallocated

8.4.3 NAVIGATING DISK VIEW

 DISK VIEW MAP

The vertical bar on the right-hand side of the disk view window (shown in Figure 78 below) is a map to allocated
space on the examined device. Use the vertical scroll bar to quickly navigate to the colored section which
identifies allocated disk space.

KEYBOARD NAVIGATION

The following commands are available for navigation in Disk view:
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. DISK VIEW GOTO
Disk view has a Goto command that allows the investigator to quickly jump to the desired sector.
To open and use the Goto Offset window:
e  Right mouse-click in the Disk view.

e The following window will appear.

Figure 73: Disk view Goto Offset window

Goto Offset... o
Unit
) Byte
@ Sector
(JCluster | Partition @ 2048

Start End
ginning of Device Count: |El |
(®) Current Sector Sector: |E] |
End of Device
O @ Dec O Hex
Sector: 0 Sector: 0
Go Cancel

e Select the Unit required, Byte, Sector or Cluster
e  Select the Start position on the disk:

o Beginning of Device (i.e., go forwards from the first sector)

o Current Sector
o End of Device (i.e., go backwards from the last sector)

e Enter the End position. This can be entered either as a Count of the unit required (byte, sector cluster),
or a disk Sector.

GOTO Example, Figure 74 below:
e The currently selected sector is 445.

e The sector to GOTO is 89, which is -356 from the currently selected sector.
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Figure 74: GOTO Example
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8.4.4 ADD PARTITION

It is possible in Forensic Explorer to add an unallocated partition (for example, when a drive has been formatted
but the unallocated partition structure is still intact).

To Add Partition:
1. In Disk View, locate the required Volume Boot Record (VBR):

Manually: Users who are familiar with the VBR format and disk position may use Disk View to find
the sector manually.

Figure 75: NTFS VBR in HEX view
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File Carve: To automate the search for Volume Boot Records, File Carve for Operating System
volumes, as shown in Figure 76 below:
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Figure 76: File Carve for Volume Boot Record (VBR)
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The file carve will return the position of found VBRs with the file name representing the
sector number on the device:

Figure 77: File Carve results for Operating System Volumes

Filename Extension
1 E Carved NTFS_2048.ntfs ntfs
E Carved_MTFS_2384.ntfs ntfs

L\E %, Carved_NTFS_206847.ntfs  ntfs

Carved_MTFS_206843.ntfs ntfs
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Carved_FAT_538668.fat fat

3
B

I
e

2. In Disk View, click on the sector of the VBR, right click and select Add Partition. The partition will then
be added to the File System Folder tree.
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To select a sector:

e  (Click on a sector with the mouse. The selected sector will be marked with a red border.
To select a range of sectors:
e Click on a sector with the mouse.

e Hold down the mouse key and drag the mouse over the required range of sectors. The range of sectors
will show as selected, as see Figure 78 below. This enables other views, such as HEX view to see the
selected range.

Figure 78: Selecting a range of sector in Disk view
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To select a file:
e Double click on a sector. All sectors used by the file will be identified.

e The name of the selected file is displayed in the status bar at the bottom of the Disk view window, as
shown in Figure 79 below.
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Figure 79: A selected file in Disk view
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8.5 GALLERY VIEW

The default location for Gallery view is the top data view window of the File System module, accessed via the

Gallery View tab:

Gallery View ‘

Gallery view is also present in Bookmarks and Email modules. Gallery view is fast ways to thumbnail graphics
located in the case.

Figure 80: Gallery view thumbnails
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65 LEXAR with gallery\Lexar 7GB USB E01.E01\Partii}

The default setting for Gallery view is to display Jpeg, Bmp and Png file types.

The file icon at the bottom of the thumbnail is a visual identifier of the status of the file (e.g., bookmarked,
deleted, carved, etc.).
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8.5.1 DISPLAY VIEW — HEIC, HEIV

To preview HEIC or HEIV files in the Forensic Explorer Gallery View or Display View the following Microsoft
extensions must be installed on the forensic workstation:

e High Efficiency Image File Format (HEIC): Microsoft Image Extensions,
https://apps.microsoft.com/store/detail/heif-image-extensions/9PMMSR1CGPWG?hl=en-us&gl=US

e High Efficiency Video Coding (HEVC): Microsoft Extensions Package,
https://apps.microsoft.com/store/detail/hevc-video-extensions/9INMZLZ57R3T7?hl=en-us&gl=US

e Or anon-Microsoft equivalent such as: https://www.copytrans.net/copytransheic/

8.5.2 GALLERY VIEW FOLDER LEVEL FILTERING

Gallery View content is first controlled by the selection made in the File System module Folder view. If a single
folder is highlighted, the graphics inside that folder will be displayed. When the branch plate option is used (see
paragraph 8.2.3 - Branch plate) all graphics in the plated path will be displayed, as shown in Figure 81 below.

Figure 81: Gallery view as determined by a folder/branch-plate selection
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8.5.3 GALLERY VIEW — FILE LEVEL FILTERING/SORTING

In addition to Folder level filtering described above, the content and sort of Gallery view can also be determined
by filters and sorting in the File List. For example, in Figure 82 below, the File List has had a Text Typing filter
applied for the word “Cat” which filters out only files containing that word in the file name:

Figure 82: Gallery view filtered or sorted by a File List selection
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Any filter or sort applied in the File List will dictate the content of the Gallery view. The result of applying the

above filter is shown in Figure 83 below where the Gallery view contains only graphics that match the filter:
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Figure 83: Gallery view with a File List filter applied
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TIP: To see File List filters and their effect more clearly on Gallery view it can assist if the Gallery view is detached
and viewed on a second monitor so that both the File List and Gallery view can be viewed simultaneously.

8.5.4 CACHING THUMBNAILS TO DISK

When a thumbnail is displayed, it is written to the disk cache file:
...\User\Documents\Forensic Explorer\Cases\[Case Name]\thumb.cache

When changing between Gallery view folders, Forensic Explorer first checks the cache file to determine if the
graphic has previously been displayed. If so, the cached graphic is used.

In some situations, it may be advantageous to cache all available images. For example, if running the “Skin Tone
Analysis” script (from File System module > Analysis Programs button > Skin Tone Analysis) the script will run
50% faster when reading images from the cache.

To cache all thumbnails to disk:
1. When adding evidence:

a. Whenan evidence item is added to a preview or a case, there is an opportunity in the Evidence
Processor window (see 10.5) to “Cache Thumbnails”.

2. During a case:
a. Select or branch plate the required folders in the File System module.
b. Right click in the gallery view window and select “Cache All Images”.

The cache progress will show in the processes window.
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8.5.5 INCREASE THE NUMBER OF GRAPHICS DISPLAYED

The size and number of graphics displayed is controlled by moving the slide-bar or by clicking the — or + button
graphics.

Figure 84: Gallery view scale bar

y i ’

The Gallery view tab can also be detached from the File List view pane and re-sized displayed as a standalone
window (see 7.3.1- Save a custom layout, for more information).

8.5.6 WORKING WITH DATA IN GALLERY VIEW

Graphics in Gallery view can be highlighted, checked, flagged, exported, bookmarked, and opened with an
external application. These commands are access by the right click display menu. For more information on these
actions, see Chapter 9 - Working With Data.

To highlight a continuous group of multiple files in Gallery view, hold down the SHIFT key whilst selection files
with the mouse.

To highlight a non-contiguous group of multiple files in Gallery view, use the CTRL key when selecting files with
the mouse.

To check highlighted files, press the space bar.

8.5.7 BLUR

Gallery view blur enables the investigator to blur the content of a graphic in the Gallery view. Once blurred in
the Gallery view, the graphic will also be blurred in Display view and Reports.

The blur is intended to distort the fine detail of a graphic. It is most commonly used in child protection cases
where display of a full resolution graphic may not be possible on legal or ethical grounds.

To blur a graphic:

1. In the File System module Gallery view, use the mouse to select the required picture in the Gallery
view (or use the CRTL, SHIFT and mouse to select multiple graphics).

2. In the Gallery view toolbar, click on the blur button. The graphic will blur both in Gallery and Display
view, as shown in Figure 85 below.

To un-blur a graphic.
1. Inthe File System module Gallery view, click on the blurred graphic.

2. In the Gallery view toolbar, click on the un-blur button. The graphic will now display at normal
resolution in both Gallery and display view.
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Figure 85: Gallery view blur
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Blur can also be associated with keyboard hotkeys.

8.5.8 CLASSIFICATION KEYS [0-9, -] (HOTKEYS)

In some circumstances the investigator may need to manually classify graphics based on their content. A
classification can be added to a graphic using a keyboard shortcut.

To classify a graphic in Gallery View:

1. In Gallery view right-click and select Classify > Enable Classification. A classification legend will also
appear to the right of the Gallery view graphics (see Figure 88 below).

Figure 86: Enable classification
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Figure 87: Gallery view toolbar options
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2. Pressing a keyboard key from 0 to 9 will classify the currently graphic item selected according to the
keyboard number pressed. (- removes the classification, see below).

3. Visual confirmation of the classification is provided:

a. In the bottom right-hand corner of the information bar of the Gallery view graphic is the
classification number.

b. The background color of the graphic changes according to the classification.

c. The classification legend will increment with each classified item.

Figure 88: Gallery View classification
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d. A Classification column can also be added to the File List view showing the classification
number:

Figure 89: File List Classification column
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To remove classification from a graphic in Gallery View:
1. Select the graphic/s with the mouse.
2. Press the — (minus) button on the keyboard.
3. The classification number is removed.
To remove classification from a group of classified files:
1. Use the SHIFT or CTRL key to select a group of files.
2. Press the — (minus) button on the keyboard.
3. The classification for the entire group is removed.
To remove all classification:

1. In the File System module (File List view), click on the Tools button > Clear Column Content > select
Classification > Run, or right-click on the column header and select Clear Column from the menu.

2. Classification will be removed from all items.

8.5.9 GALLERY CLASSIFICATION FILE INDEX

When manually classifying graphics, it can be beneficial to number the display items in order to keep track of
the current position.

To change the information displayed under the graphic in Gallery view:
1. Right click in Gallery view and select Caption from the drop-down menu.
2. Select an available option: Filename, Index, or Blank.

The index option adds a numeric counter to the bottom of the Gallery view image, as shown in Figure 90 below:

Figure 90: Classification with index numbering

8.5.10 CLASSIFICATION AND BOOKMARK USING HOTKEYS [0-9, -]

Important: Classification and Bookmarking are separate functions, i.e., you can classify without bookmarking.
Note that:

e Afile can have only one Classification.

e A file can have multiple bookmarks.
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To hotkey classify then bookmark a file from Gallery view:
1. Right-click and Classify > Enable Classification.
2. Check the Bookmark checkbox at the top of the Gallery view.

3. Press a hotkey (0 to 9). The item will be classified (given a number according to the key pressed) and
bookmarked to the bookmark folder designated for that key.

The default path for hotkey bookmarks is My Bookmarks\Pictures\Classification 01, Classification 02,
etc. The bookmark path and folder can be changed in the Gallery Classification Options window. To
open the Gallery Classification Options window, click on the cog icon in the Gallery view toolbar
(shown in

4. Figure 87 above).

Figure 91: Gallery Classification Options
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Base Bookmark folder:  Assigns the bookmark folder where items will be bookmarked.

Classification type: There are a number of different classification systems in use, including:
Interpol Baseline; Project Vic; COPINE; SAP; and SOD.
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In recent years Interpol Baseline has increased in popularity as it offers a
simplified 4 category system. For an overview refer to:
https://www.sentencingcouncil.qld.gov.au/ data/assets/pdf file/0017/5
31503/cem-final-report-july-2017.pdf.

To create a custom classification type, refer to the following section.

Enabled: The enabled checkbox makes the key active.

Key 1, Key 2, etc.: Assigns the keyboard number with a bookmark folder.

Blur checkbox: If checked, the hotkey will blur the item in Gallery view.

Bookmark Folder: Assigns the bookmark folder when the item/s will be bookmarked. If the

folder does not exist in the Bookmarks module it will be created.

Color: Sets the color of the category number in the gallery view information bar via
Gallery Classification Options > use the drop-down color selection menu.

To re-classify then bookmark:

1.

Check in the Bookmark checkbox at the top of the Gallery view.

Highlight the file that needs reclassification and press the new classification key, i.e., 1 to 10.
The classification number in the Gallery view overlay (shown in Figure 69) will update.

A new bookmark will be created.

Note: The original bookmark will not be removed from original bookmark folder. It is recommended
that at the end of the classification process, add the Classification column to the Bookmarks module,
and sort by classification, and review and remove any bookmarks that no longer belong in the
classification folder.

To remove a bookmark:

8.5.11

Switch to the Bookmark module.
Select the required bookmark/s with the mouse.
Right click on the Filename in Bookmarked Items List and select Delete Bookmark\s from the drop-

down menu.

CUSTOM CLASSIFICATION TYPE

The Default classification system access from the Classifications Options window shown in Figure 91 above

can be customise by creating and placing a DefaultClassification.ini file in the Forensic Explorer Startup folder

(My Documents\Forensic Explorer vX\Startup\).

The text in Figure 92 below can be used to create the DefaultClassification.ini file. It sets the first 4

classification categories and associated color:
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Figure 92: DefaultClassification.ini

[Classification 01]

Bookmark=CAM - Real Child Pre-Pubescent <13yo
Color=255

Blur=0

HotKeyEnabled=1

[Classification 02]

Bookmark=CAM - Other Illegal Content, Child <18yo
Color=26367

Blur=0

HotKeyEnabled=1

[Classification 03]
Bookmark=Investigative Interest
Color=65535

Blur=0

HotKeyEnabled=1

[Classification 04]
Bookmark=Ignorable
Color=32768

Blur=0
HotKeyEnabled=1

[Classification 05]
Bookmark=Classification 05
Color=42495

Blur=0

HotKeyEnabled=0

[Classification 06]
Bookmark=Classification 06
Color=11823615

Blur=0

HotKeyEnabled=0

[Classification 07]
Bookmark=Classification 07
Color=13688896

Blur=0

HotKeyEnabled=0

[Classification 08]
Bookmark=Classification 08
Color=8894686

Blur=0

HotKeyEnabled=0

[Classification 09]
Bookmark=Classification 09
Color=4678655

Blur=0

HotKeyEnabled=0

[Classification 10]
Bookmark=Classification 10
Color=9470064

Blur=0

HotKeyEnabled=0
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8.6 CATEGORY GRAPH

This section is currently being updated.

8.7 HEX VIEW

The default location of the Hex view window is the bottom data view window, accessed via the Hex tab:

i Hex

Hex view shows a hexadecimal/ASCII view of the currently highlighted item. The slide bar to the right of the
hex/ASCIlI windows separates the data inspector. Data highlighted in hex view is automatically analyzed in the
data inspector to determine its type:

Figure 93: Hex view and data inspector
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The right-click menu in the Hex view provides options to select and copy Hex. It also allows investigators to:

e Add bookmark: Highlight a selection of Hex and bookmark it. See Chapter 17 - Bookmarks Module, for
more information.

e Carve Selection: Highlight a selection of Hex and carve this data and add it to the File System module
as a file. When this option is selected, the following window appears:
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Figure 94: Carving files from Hex view

m Carve — O W
MName: |Hex 256 [-201] ls |
Available Folders: |File Carve w Mew,.,
Bookmark: [ ]
coce

Name: The default name is the Hex Offset and the length of the selection in bytes. The default name can be
edited.

Available Folders: This is the folder name in File System Folders view which will hold the carved file. A new folder
can be added as required.

Bookmark: Adds the carved file to the Bookmarks module.

8.8 TEXT VIEW

The default location for the Text view window is the bottom data view window, accessed via the Text tab:

Figure 95: Text view tab

= Text

The Text tab shows the highlighted item as ASCII text.

Figure 96: Text view
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8.9 INFO

The default location of the Info view is in the bottom data view window, access via the Info tab:

Figure 97: Info view tab

Info

The Info view displays the properties of the currently highlighted file. This includes File System information, such
as Created, Modified and Access dates, and information about how the file is displayed by Forensic Explorer,
such as checked status and file signature. It is a convenient location to quickly view the entire list of properties
for afile.

Figure 98: Info data view

= Info

Property Value Raw Value Type

=+ Item Information
= m Accessed 28-Jan-14 11:21:36 AM  28-Jan-14 11:21:36 AM Date
— ] Attributes P S . —J———g——  UString
— 12 BIAS Time 0 0 Ints4
—Eﬂ Bates # 301,354 301354  Integer
— %/ Bookmark Folder Binary
- J Bookmarked False False  Boolean
— 123 Byte Start 12,403,8567,648 12403867548 Inte4
- m Created 28-Jan-14 11:21:36 AM  28-Jan-14 11:21:36 AM Date
— 2 Data Size 12,788 12788  Ints4
- Eﬂ Directory Level 14 14  Integer
— 4] Extension ipg jpg  UString
— |i| Extension Mismatch Binary
— |3 File Category Binary
— % File Signature Binary
— ﬂ Filename stor-9225 top_ten_1... shor-9225_top ten_14... UString
—Eﬂ Flags 0 0  Integer
— |#] HashSet Binary
— |%| HashSet Category Binary
— % HashSet Indentified... Binary
— 1| Intact Size 0 0 Ints4
— g IsChecked False False  Boolean
= ‘ IsCompressed False False  Boolean

8.10 DISPLAY VIEW

The default location of the Display view window is the bottom data view window, accessed via the Display tab:

Figure 99: Display view tab
52 Display

The File Display tab uses GetData’s Explorer View technology to display the content of the currently highlighted
file (see HEIC and HEIV below):
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Figure 100: Display view

Note that the file Display tab is NOT intended as an exact render of how the file would have appeared to the end
user. If this is the objective, it is best achieved by exporting the file and opening it with the same application
available to the end user.

If a file type is selected where a display is not available, or the file is corrupt, an error message will display in this
window. The display view will default to Hex or Text view.

Right click on the image to display the options menu:

Figure 101: Display view right-click menu

Add Bookmark...

Viewer 3
% Copy Ctrl+C
< Find Ctrl+F

it Counter Clockwize Rotate
24 Clockwize Rotate
s Zoomn

= Zoom Out

The following buttons are displayed for audio and video files.

Auto Play
Fewind

Play

Pause

Fast Forward

Stop

00000 BO

Repeat
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To preview HEIC or HEIV files in the Forensic Explorer Gallery View or Display View the following Microsoft

extensions must be installed on the forensic workstation:

e High Efficiency Image File Format (HEIC): Microsoft Image Extensions,
https://apps.microsoft.com/store/detail/heif-image-extensions/9PMMSR1CGPWG?hl=en-us&gl=US

e High Efficiency Video Coding (HEVC): Microsoft Extensions Package,
https://apps.microsoft.com/store/detail/hevc-video-extensions/9INMZLZ57R3T7?hl=en-us&gl=US

e  Oranon-Microsoft equivalent such as: https://www.copytrans.net/copytransheic/

The Video view tab shows time segment video thumbnails. Individual videos can be played in this view by
drawing the mouse across the thumbnail. The zoom slide bar has been increased to enhance viewing.

2] File List  [%) Gallery view }V'deov'ew EQD&M @ category Graph

@ (0O sodkmark: [

0:36
][ my new stuff 020.mov

When viewing a video, it is possible to thumbnail the video by click on the thumbnail icon in the bottom right-
hand corner of the display window, as shown in Figure 102 below:
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Figure 102: Video Thumbnails

=%) Display v 0

0:02.320

———
e

0:10.000

g !

0:17.680 ] ) 0:21.520 -

0:28.200 —~

Test Case 1\Lexar 7GB USB E01.E01\Partition @ 63\Root\EVW - TEST SEQUENCE\MPEG

To jog image thumbnails, click on the jog button.
To play all thumbnails, click on the play button.

To play in full screen from a specific thumbnail, double click the thumbnail.

8.11 BYTE PLOT AND CHARACTER DISTRIBUTION

The default location for the Byte Plot window is the bottom data view window, accessed via the Byte Plot tab:

Figure 103: Byte Plot tab

[ils| Byte Plot

Byte Plot

Byte Plot is a graphical representation of byte level data within the currently highlighted file. It is a visual means
to gauge the consistency or regularity of a file. In a Byte Plot.

“..each byte in the binary object is sequentially mapped to a pixel. The plotting of byte values in the
object starts at the top left of the image. Subsequent byte values in the object are plotted from left to
right, wrapping at the end of each horizontal row”. (7 pp. $3-512)

Byte Plot is emerging as a future means of file type analysis by binary content or “fileprint” (8).

In the status bar of the Byte Plot data view is an entropy score for the displayed data. The entropy score is an
expression of randomness where the more random the data, the higher the score. For example, a compressed
zip file will have a higher entropy score than a text document.
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Character Distribution

A character distribution bar graph is used in conjunction with Byte Plot and displays the distribution of ASCII
characters per the currently displayed segment of file. ASCIl is a 7-bit character encoding scheme that allows
text to be transmitted between electronic devices in a consistent way (See http://www.ascii-code.com (9)). The
extended ASCII character set comprises codes 0—256, where codes.

e 0-31are non-printing control characters
e 32-127 are printable characters; of which:
o 48-57 are numbers0-9.

o 65-90areA-7Z;and
o 97-122area-z.
e 128 - 256 are extended characters

The Character Distribution X-axis represents ASCII character codes 0-256. The Y-axis represents the number of
times each ASCIl code appears in the current view. Like Byte Plot, Character Distribution gives a visual
interpretation of file content.

Color Coding

In the Byte Plot data view, ASIl characters are color coded, where:
Blue - Non-printable / extended characters
Red - Numbers (0 - 9)
Yellow - Text (atozand Ato 2)

Display Options

To change display options, right click on the Character Distribution graph to display the drop-down options
menu:

Figure 104: Byte Plot right click display options menu.

Add Bookmark...

~  Highlight Murnerals and ASCIl characters
~  Logscale

Show labels
To change Byte Plot to grayscale, de-select “Highlight Numerals and ASCII characters”.
To change the scale of Character Distribution, select Log scale.
8.11.1 BYTE PLOT EXAMPLES

Microsoft Word document:
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Figure 105 shows a Byte Plot and Character Distribution for the Microsoft Word file “Golf.doc”. The visualization
is consistent with a Word document, where.

e Non-printable ASCII characters (blue) are prominent in the header of the file.

e  Text characters predominantly (yellow) follow the header.

Figure 105: Byte Plot and Character Distribution of a .doc file

Byte Plot i

Character Distribution

10004 |, A=

100 (R

Count

] 50 100 150 200 250
Character

JPG Photograph:

Figure 106 shows a Byte Plot and Character Distribution for a JPG digital photograph. The visualization is
consistent with a JPG file where:

e Non-printable ASCII characters (blue) are prominent in the header of the file.
e JPG metadata text (yellow) follow the header.

e The body of the JPG shows regular compressed data.
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Figure 106: Byte Plot and Character Distribution of a .jpg file

Byte Plot -

= Character Distribution
L

1,000

100

Count

10

] 50 100 150 200 250
Character

A

Preview\FAT32-Photos.EDL\Partition @ 63 [NO NAME]\Roct\Animals\Buffalo.jpg

RTF document:

Figure 107 shows a Byte Plot and Character Distribution for an RTF document. The visualization is consistent
with an RTF file where there is no defined file header and much of the file appears as text.

Figure 107: Byte Plot and Character Distribution of an .rtf file

Character Distributicn

1,000 4

1 T LI | L |
0 50 100 150 200 25
Character

0.1-

ZIP file:

Figure 108 shows a Byte Plot and Character Distribution for a ZIP document. The visualization is consistent with
a ZIP file where:

e There is even distribution of the ASCII character set typical of compressed data.
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Figure 108: Byte Plot and Character Distribution of a .zip file

Byte Plot

ot Pl

Character Distribution

50 100 150 200 250
Character

Preview\File Type Test.E01\Root\Text Documents\Flowers.zip

8.12 FILESYSTEM RECORD VIEW

The default location for the Filesystem Record view is the bottom data view window of the File System module:

Figure 109: Filesystem Record tab

= | Filesystem Record

Filesystem Record view decodes and displays the full attributes of highlighted item, including FAT, MFT, HFS file
system records and Windows registry entries.

To display the Filesystem Record view for a file:
1. Highlight afile in File List view.

2. Select the Filesystem Record view tab in the bottom window.

The details of the highlighted file are then displayed. A Filesystem Record view of a highlighted file on a FAT file
system is shown in Figure 110 below:
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Figure 110: Filesystem Record view

Filesystem Record ) E -
Property Value Raw Value Type _{j 0 1 2 3 4 5 & 7 8 9 &
= FAT Record ~ 0? 0000:0000 S50 45 4E 47 55 49 4E 53 4R 50 47 | EENGUINSJEG
S d otreme oGl roGS.. A [0 el |- L e
Deleted False False  Boolean | (¢ 0000:0021 | 50 00 €5 00 6E 00 &7 00 75 00 OF | E.e.n.g.u--
—% A 32 Byte ﬂé 0000:002C 00 32 €9 00 €E 00 73 00 2E 00 4R | .:i.n.3...J
_}Eﬂ Reserved 1] 1] Byte 0@ 0000:0037 00 S0 00 00 00 47 00 00 00 =
12 Created (10ms) 185 185 Byte §
—}Eﬂ Created Time 1:09:24PM 26924 Word 1
—}Eﬂ Created Date 19-Mar-11 15987 Waord &
—Eﬂ Accessed Date 19-Mar-11 15987 Word |E 3y
) EAIndex (FAT12/16) 0 0 word g
—}Eﬂ Written Time 352:26 PM 32397 Word H
25 \Written Date 14-1ul-03 15086 Word 5
25| Start Cluster (FATL... 2,017 2017 Word {
1§ Start Cluster (FAT32) 2,017 2017 LongWare 3
7Eﬂ Filesize 777,835 777835 LongWorc! ’{
=+ Longfile Record 1 I 3
E] LFM String Penguins.JPG  Penguins. JPG UString 3
2 LFN Sig. byte 65 65 Byte {
1] LFN Attribute 15 15 Byte %
o 91 Eni e = n n =, 5
Preview\FAT32-Photos.E01\Partition @ 63 [NO NAME]\RDot\Animals\Aquat\c\Peng |};nguin5.JPG
The Filesystem Record view shows:
Value: The value of the property entry as interpreted by Forensic Explorer.
Raw Value: The raw data as read from the file system record or registry entry.
Type: The type of data read from the file system record or registry entry.

The adjacent window displays the raw data from which the individual records have been decoded.

Figure 110 above shows the records for the file “Pengins.JPG”. Clicking on the “Attributes” property on the left
highlights (in blue) the raw byte on the right from which the attribute data is decoded.

The yellow highlighting differentiates the section of the FAT directory entry which is dedicated to the long file
name data.

8.13 FILE METADATA

Metadata is loosely defined as “data about data”. Essentially it is information within a file which further
describes the content or the layout of the file.

An example of Metadata is found in Microsoft Word documents where additional information is stored by word,
including:

e Author.
e  Subject.
e Title; etc.

The File Metadata view breaks down and displays the metadata values for specific file types. File support
includes:

e OLE (.doc, .xls, .ppt).

e  Open XML format (Office 2007 .docx, .xIsx, pptx).
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e JPEG.
o ZIP.
Figure 111 below show the metadata of a Microsoft Word .doc file:
Figure 111: Metadata view of a Microsoft Word .doc file
= File Metadata
Property Value Raw Value Type
- OLE Data
+ OLE Header
=} OLE Summary
d| Author LT LT  UString
13| Subject Binary
ﬂ] Title Accounting Data Accounting Data LIstring
E Created (LUTC) 13-Jul-06 4:39:00 AM 13-Jul-06 4:39:00 AM Date
E Modified (LTC) 13-Jul-06 4:43:00 AM 13-Jul-06 4:43:00 AM Date
E}] Edit Time 2 mins 2 Integer
Eﬂ PageCode 1,252 1252 LongWar
|is| Keywords Binary
|is| Comments Binary
d| Last Saved LT LT  UString
Eﬂ Pages 1 1 LongWaor
125 \Words a2 92  LongWor
=i "

e  Starting with Microsoft Office 2007, the Office Open XML file format has become the default for
Microsoft Office. These file types, e.g., docx, are compressed container files for XML content.

Viewing a docx file in the File Metadata view will show the properties of the compressed file. To view the
metadata of the content files it is first necessary to Expand Compound Files so that the metadata for individual
content files can be examined (in docx files, core.xml and app.xml hold much of the commonly used metadata).

Metadata for both Office and Office 2007 files can be extracted to columns by running the Extract Metadata to
Columns script (see below) without the need to first expand compound files.
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8.13.1 EXTRACT METADATA

EXTRACT METADATA - EVIDENCE PROCESSOR

The option to Extract Metadata can be selected in the Evidence Processor when evidence is added to a case:

Figure 112: Evidence Processor - Extract Metadata

Evidence Processor [Image: DEMO 7.E01 (1)]

Tasks Enabled
= FileSystem

£ @ Process in Parallel

Verify Device Hashes =

[} ik Search for Known MBRs

£} 5 Search for FileSystems

Signature Analysis |

Expand Compound Files O

(- =@, Process in Parallel

5 Triage &b

Hash Files O
TS A

File Carve O

Cache Thumbnails O

Selecting the Extract Metadata option gives access to the configuration window where it is possible to select
individual metadata types and to bookmark results:

Figure 113: Extract Metadata Options

B9 Extract Metadata Options - O >

Process Mame:

|Extract Metadats |
Extract

Digital Cameras (Make Model)

[Flooc, ¥Ls, PPT by Author %
DOC, ¥LS, PPT by Date Printed

GPS Photos

LMK by Target Volume

M3 Jump List

PDF by Author

Bookmark
[ bigital Cameras (Make Model)
[Jpoc, %Ls, PET by Author
[Jooc, ¥Ls, PPT by Date Printed
[JGPs Phatos
LMK by Target Volume
[IM™s Jump List
[]PDF by Author

Logging: | Mormal v Priority: | Normal ~
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EXTRACT METADATA — ANALYSIS PROGRAMS

The metadata extraction options are also available from the File System module, Extract Metadata toolbar

button, shown below:
Figure 114: Metadata extraction scripts, File System module, Extract Metadata menu
- - — = -
© 3

Extract i Analysis v Triage v Quick
Programs Reqistry

=S Extract Metadata To Columns
] &\, Extract Metadata To Columns and Bookmark
<f>| Extract XMP Metadata

The Extract Metadata to Columns menu item opens the following window:

Figure 115: Extract Metadata to Columns

About Exfract

Source

(®) All Ttems (197755 items)

() Chedked Items {0 items)

Run a Signature Analysis I,},
Metadata
Camera Windows
[ ]Photos [ ]LmK
[ Jvidea [ IMS Jump List
Documents [|NTFS 30 Date/Time
[IMs Office [prefetch
[JroF [1Print Spoal
oth [ ]Recyde Bin
er
[zip
o Clear Run Cancel

Select the types of metadata to extract and select the Run button.
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At the completion of the metadata extraction the following window will appear which summarizes the result.
Click on specific column names and click the Show Column button to add that column to the File System module
(or manually add the column in the module using the right click columns menu option, see 9.4 - Columns):

B | Bookmark Cameras by Make/Model (Al lterms: 198443) - O 4
Results
Metadata Column Name Count ?
Description 3
Hake 420
: Device Model 420
: Orientation 510
2: XResolution €07
: YResolution €07
Exif 305: Software S24
Exif 306: Date/Time 837
Exif 315: Artist 104
Exif 33432: Copyright lzz
Exif 3€8¢€7: DateTimelriginal 435
Show Column Close

EXTRACT METADATA TO COLUMNS AND BOOKMARK

The Extract Metadata to Columns and Bookmark will also extract metadata data to columns and bookmark
results by the selected criteria shown in Figure 116 below:
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Figure 116: File System > Analysis Programs > Bookmark Metadata

B | Extract Metadata — O >
About Exfract
Source
(®) all Ttems (197755 items)
() Checked Items (0 items)
Run a Signature Analysis
Bookmark By: Ib
Camera Make/Model Other
[ ]Photos [ LMK by Target Volume
[ ]video [ MKV Video Multiplexing
[]GPs [ ]M3 Jump List LMK
Author [_]Ms Office by Date Printed
[]Ms Office [JPrefetch
[]roF []Print Spool by User + Doc,
o Clear Run Cancel

Bookmarks are added to the Bookmarks module under the Script Output folder. The output of Bookmark by
Camera Make/Model is shown in Figure 117 below:

Figure 117: Bookmarks by Metadata

Bookmarks ~ 1

Bookmark Mame &
L# L] [™7 lndex search (U]

T 17 Tlicit Images ()
- O O] F Seript Output (2)

2 T+ [ ¥ Digital Cameras (17)
=[O Apple -iPhone 5 {135)
> [ canon - Canen EQS 10D (1)
O S Canon - Canon EOS 20D (4
T+ [ canon - Canon EQS 4000 DIGT
C+ [ canon - Canon EQS 600 (7)
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8.13.2 XMP METADATA

The Extensible Metadata Platform (XMP) is: an ISO standard, originally created by Adobe Systems Inc., for the
creation, processing and interchange of standardized and custom metadata for digital documents and data
sets (source: https://en.wikipedia.org/wiki/Extensible Metadata Platform Accessed 01 September 2020).

XMP metadata can usually be found in documents that have been edited with Adobe products, including
Adobe Photoshop. XMP metadata can be important for forensic investigators as it can provide additional
information including edit date and time and software used.

XMP metadata for a camera file can be seen in HEX or Text views in the following format:

Figure 118: XMP Metadata shown in the Text data view for file 001.jpg

________________________________ ¥al http://ns_adobe _com/xap/l.0/_ <?xpacket begin='iw»;"' id="
MOMpCehiHzreSzNTczskeSd ' ?> . .<x:xmpmeta xmlns:x="adobe:ns:meta/"><rdf:RDF xzmlns:rdf="http://w
.W3.org/lass/02/22-rdf-syntax—ns#"><rdf:Description rdf:about="uuid:fafSkbdd5-ba3d-llda-ad3l
33d75182£f1b" xzmlns:xmp="http://ns.adobe.com/xap/l.0/"><xmp:Creatorlool>Microsoft Windows Ph
o Viewer &.1.7€00_1e385</xmp:CreatorToocl»</rdf :Description><rdf:Description xmlns:Microsoft
oto="http://ns microsoft.com/photo/l _0/">»<MicrosoftPhoto:Datelcgquired=201&6-12-20T05:40:50_4
“</HicrosoftPhoto:Datelboguired=</rdf:Description»</rdf :RDF></x xmpmeta>. .

The File System module > Metadata > Extract XMP Metadata option enables the forensic investigator to scan
a case and identify those files which contain XMP metadata. Click on the file in the left-hand column to display
the XMP metadata in the right-hand side:

Figure 119: XMP Metadata for file 001.jpg

B Embedded XMP Metadata - O X
Results

Search ¥MP Data: | | = | XMP Metadata Preview:

. . Filename: 001 .JP:

Filter Filename: | | Batess: P

3RZFJO01U (naughty but nice ;-) 1l2&).JPZ FS File Size: 1.0%mk (1147307 bytes)

$RE503NH (naughty but nice ;-) 132).JPG File System Created: 28-May-12 €:13:27 BRM

$RRMZIVTC (naughty but nice ;-) 134).JPC File System Modified: 28-May-12 €:13:27 RM

3RCT5YSI (naughty but nice ;-) 135) .JPG XMP starts at File QOZfset: 11101

$BMEYZ2F (naughty but nice ;-) 131).JPE = | [T0 = T T T T T T T T T T T T T T T T

$EMTW7U7 (naughty but nice ;-) 138).JPC XIxmpmeta

$RP1GMEW (naughty but nice ;-) 133).JPZ rdf:RDF S

$RUCE03€ (naughty but nice ;-) 135) .JBG rdf:Description ...

FBXIQOZI0 (naughty but nice ;-) 140).JPZ photoshop:DateCreated 05-27T13:13:27

001.JPG xmp:CreateDate 05-27T13:13:27

TS N | | o £ypaca 2012-05-28T10-41:04

001.jpg xmp:CreatorTool QuickTime 7.€.%€

0oz .J0C MicrosoftPhoto:Datekoquired 2015-01-15T16:24:06.73%

0032.JBG

003.JBG

002 .png

004 . JBG

004 . JBE

005.JPC:

005.JBG

00€.jpg

00&. JBG

007.3pg

007.JBG

008. JBG

008, ipg v

Showing files containing XMP metadata: |712 of 713 i 2
Bookmark Copy to Clipboard Export All XMP Close
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8.13.3 FILE INFO

Another way to view file information, including Metadata and XMP metadata is to use the File Info button in

the File System module:

Figure 120: File System module File Info button

File
Info

The File Info button works with highlighted files and provides options to view:

1. Basis Forensic Explorer fields (including Created, Modified, Accessed).

2. Extended Forensic Explorer fields (including signature and hash information).

3. Filesystem Record fields (as shown in the Filesystem Record data view tab).

4. Metadata (as shown in the Metadata data view tab).

5. XMP metadata (as described above).

Figure 121: File System module File Info button

B " Highlighted File Information

Display Options

FEX Basic

FEX Extended
Filesystem Record
Metadata

Highlighted:

001.JPG

iPhone 6 001.JPG

my new stuff 001, PG
001.JPG

Highlighted File Information

FEX Basic: 20013T02 - Dell Laptop.E0l%Partition @ 20£343\Root\$Recycle. Bin\5-1-5-21-507552:
Filename 00l .jpg

Path 2001JT02 - Dell Laptop.E0l\Partition @ 20&£848%
RAccessed 04-May-1€ 2 EM
Modified 04-May-1€ 2 mM
Created 04-May-1€ 2 EM
Sector Start 211320

Logical Size ag, 887

Physical Size 80,112

FEX Extended: 2001JT02 - Dell Laptop.E0l\Partition @ 20€243\Root\jRecycle . Bin\5-1-5-21-5075952:
Attributes  m————————— a—-——==
Bates # 853¢4

BIAS Time a

Boockmarked Ho

Byte Start 102155240

Data Size 80,112

Directory Lewvel 7

Extension jpg

Extension Mismatch Ho

File Category Graphics

File Signature JB=

Flags a

Initialized Size ag, 887

Intact Size a

Isklternate Ho

IsChecked Ho

IsCompressed No

IsDeleted Ho

IsDevice Ho

IsDirectory No

IsEncrypted No

IsFreeSpace No

IsSystem No

Mrdd Fiad Dacned FA-Tiar—T& 11-012-23 M
£

Copy To Clipboard Bookmark Close
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8.14 FILE EXTENT

The default location for File Extent view is the bottom data view window, accessed via the File Extent tab:

=| File Extent
The File Extent view identifies the location of the highlighted item on the disk. It details the start, end, and length
of each data run for the item, giving the relevant sector, byte and cluster location.

The file shown in Figure 122 below is a fragmented file with three data runs:

Figure 122: File Extent data view

File Extent b
Run Start Sector End Sector Length Start Byte
1 11,205 13,468 2,264 5,736,960
2 34,313 51,324 16,512 17,824,255
3 58,357 4 064,444 4,006,088 29,878,754
' m | P
Bp% 512 EpB: 4096 Preview' FAT32-Photos.E0L\Partition @ 63 [MO I

BpS: Bytes per Sector

BpB: Bytes per Block (cluster).

Using the information displayed in the File Extent view it is possible to switch to Disk view and quickly locate the
start or end sector of each data run.
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8.15 PERMISSIONS

Each user account on a Windows NTFS formatted computer is assigned a unique number called a security
identifier (SID). Actions that take place on the computer can be associated with a specific SID. In more detail:

“In the context of the Microsoft Windows NT line of operating systems, a Security Identifier (commonly
abbreviated SID) is a unique, immutable identifier of a user, user group, or other security principal. A
security principal has a single SID for life (in a given domain), and all properties of the principal, including
its name, are associated with the SID. This design allows a principal to be renamed (for example, from
"Jane Smith" to "Jane Jones") without affecting the security attributes of objects that refer to the
principal.” https.//en.wikipedia.org/wiki/Security ldentifier, accessed 20 April 2020.

There is a large volume of computer forensics literature relating to the use of a SID to track user behaviors,
particularly in relation to identifying a user-account responsible for deleting files found in the Windows Recycle

Bin.

In Forensic Explorer, to identify the SID associated with a file on an NTFS file system:

1.

2.

3.

In the File System module, click on the file in question.

Switch to the Permissions tab in the bottom data views.

The User SID and Group SID is displayed in the information window, as shown in Figure 123 below (the
abbreviated User SID for Marijuana_2011.jpg is 1000):

Figure 123, Permissions

[ File List Gallery View Video View [, Disk View &% Category Graph

%3 = (ﬁ_ﬁ'l"-"larijuana_lﬂll.jpg J(f~_£'jpg J1_5 Classificatior |18/ Flags
Filename Extension Classification Flags

O] 1 & Marijuana_2011.jpg ipg

£

1 of 197754 Visible [446 KB] 1 Highlighted [446 KB] 0 Checked [0 bytes] 2001JT02 - Dell Laptop.ED
I ———————

Mame D Property

User SID 5-1-5-21-507952373-705505546-3123652967-1000

Group S5ID 5-1-5-21-507952373-A05505546-3123652967-513 Domain Users

Discretionary ACL
-Basic ACE 5-1-5-80-2375682873-768044350-3534595160-1005545. ..
-Basic ACE 5-1-5-18 Local System
-Basic ACE 5-1-5-32-5%4 Administrators
-Basic ACE 5-1-5-21-507952373-705505546-3123652967-1000

PO0TOZ - Dell Laptop.E01\Partition @ 206848\Root\Users'\John Thomas Hamilten'\Pictures\iCloud Pho
B Hex |= Text |= Info Bookmark .. Byte Plot |__| Display | = permizsionz | 1= Filesyste

Copyright GetData Forensics Pty Ltd 2010 - 2024, All rights reserved.


https://en.wikipedia.org/wiki/Security_Identifier

130 | Page Chapter 8 - Data Views

8.15.1 ASSOCIATING A SID TO A USER ACCOUNT

The process of connecting a SID to a specific user account name involves examining data in the Windows
Registry.

éTHE FORENSIC EXPLORER TRIAGE REPORT

In Forensic Explorer if a Triage has been run (see 18.3.1):
Figure 124, Running a Triage.

©

Triage

.2 Triage and Bookmark (MAC, Windows)
|
File Systermn (MAC, Windows)

The SID/User Account association is made in the Reports module, Triage report, in the section titled User
Accounts (SAM parsed data). In the example shown below information parsed from the Windows SAM registry
file identifies that User ID 1000 is associated with the account of John Thomas Hamilton:

Figure 125, Extract from the Triage Report, User Accounts (SAM parsed data)

User Name: John Thomas Hamilton

User ID: 1000 (503EE)

Aocount Created: 14-Jan-2015 21:55:06 [UTC]
Aocount Last Modified: 289-Dec—-2019 21:47:11 [UTC]
Bocount Expires: [{Hever}

Boccount Type: (50000)

Account Status: Password not reguired

Normal user account
Password does not expire

Number Logins: 100

Last Login: 29-Dec-2019 21:47:04 [UTC]
Password Last Set: 289-Dec—-2019 21:47:04 [UTC]
Password Hint: 0tBilbol2 34

Last Password Fail: 28-Dec—-2019 21:45:27 [uUTC]
Invalid Password Count: 0

Country Code: 0 (Default)

Source: 2001JT0Z - Dell Laptop.E0l\Partition @
206848 \Root\Windows\System32\config\SAM\SEM\ Domains\Rccount\Users\00000 3E8

PROFILEIMAGEPATH - SOFTWARE HIVE REGISTRY KEY

A manual method of linking a SID with a user account is by examining the values of the
HKLM\SOFTWARE\Microsoft\WindowsNT\CurrentVersion\ProfileList registry key. For a more detail on this
process see:

e International Journal of Network Security & Its Applications (IJNSA), Vol.4, No.2, March 2012, DOI :
10.5121/ijnsa.2012.4209 121, FORENSIC ANALYSIS OF WINDOWS REGISTRY AGAINST INTRUSION, 5.3.
Forensic Evidence from Security Identifiers, Haoyang Xie, Keyu Jiang, Xiaohong Yuan, Hongbiao Zeng;
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e  Mastering Windows Network Forensics and Investigation, Steven Anson, Steve Bunting, John Wiley &
Sons, 2 Apr 2007, page 234, Registry Evidence.

To examine the Profile ProfilelmagePath in Forensic Explorer:

1. Inthe File System module, locate the ...\Windows\System32\Config\SOFTWARE registry file.

2. Right click and select Send to Module > Registry from the drop-down menu to send this file to the

Registry module.

3. Inthe Registry module, filter for the SOFTWARE\Microsoft\Windows NT\CurrentVersion\ProfileList\

registry key.

4. Identify the SID in question and then examine the data in the ProfilelmagePath subkey. The Key Data
will list the path to the user’s profile and display the username, as shown in Figure 126 below:

Figure 126, ProfilelmagePath registry key

L] Registry Tree EY 8 registry List
Filter: [ L] No Fiter ~| BE (42 profiemage )isl Fags AZ¥ KeyType
o 227 profileimage ) g

= [B(m] i Profilelist (11) - Key Name Flags Key Type Key Data
gg 5-1-5-18 (5) = 1 ab) proflelmagePath REG_EXPAND_SZ Ysystemroot\system32\configisystemprofl
=0 5-1-5-19 (4) O 2 k) ProfilemagePath REG_EXPAND_5Z C:\Windows\ServiceProfiles\LocalService
del 5-1-5-20 (4) ] 3 ab] ProflelmagePath REG_EXPAND_5Z C:\Windows\ServiceProfiles\NetworkService
B0 e R 3 gt g (] 4 ab) ProfilelmagePath REG_EXPAND_SZ C:\Users\John Thomas Hamilton

5-1-5-21-507952373-705505546-3123652967-1003 {8) id) 5 aﬂ ProfilelmagePath REG_EXPAND_SZ C:\Wsers\UpdatusUser

B[] [ 5-1-5-21-507952373-705505546-3123652967-1005 (9) =l £ abl ProfleTmanspath RFG FYPAND 57 W lemrelMary Thamas

| 2 <

# Rg 6 of 51 Visible [394 bytes] 1 Highlighted [60 bytes] 1 Checked [60 bytes] Sent from 2001JT02 - Dell Laptop EOT\SOFTWARE!
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9.1 WORKING WITH DATA

Forensic Explorer modules and data views share common functions used to view, analyze, and manage case
content. These functions are either performed directly within the view, or are access by a right-click menu, as
shown Figure 127 below:

Figure 127: Right-click menu in the File System list view

Add Bookmark...

Open
Open with...
Determine file signature

Expand compound file(s)

Export... r
Hash...

ClamAY scan...

Send to module r
Classify r
Columns k
Sorting r
Flags r
Date Filter Tool

" Column Filter Tool

Explorer Tool

Copy row(s) to Clipboard
|._|j Copy cell

9.2 HIGHLIGHTED AND CHECKED ITEMS

In Forensic Explorer actions are performed on “items”. An item is an addressable piece of data. An item can be
a device (e.g., physical drive, logical drive, or image file), a file, folder, partition, metadata entry, FAT, MFT, VBR,
MBR, unallocated clusters, directory entry, or other such data.

To perform an action on an item it is usually either first “highlighted” or “checked” (or both). An action on a
highlighted file is independent of an action on a checked file.

A highlighted item is one that has been selected with the mouse and the item has changed color. It is possible
to highlight one or more items.

To highlight multiple consecutive items:

1. Highlight the first file with the mouse and then press and hold the Shift key.
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2.  While holding the Shift key down click the last file. This will highlight all the files in between the first
and last file.

To highlight multiple not consecutive items:
1. Highlight the first required file with the mouse and then hold the Ctrl key.

2. While holding down the Ctrl key, highlight each of the other required files.

Figure 128: Highlighted items

[] File List Gallery View | Disk View @ Category Graph
2= A2 Filename #-Z¥ Ext A2
Filename Extension Flags Path
] 19 ® African Elephant.jpg ipg Fal
] 20 & Buffalo.jpg ipg FAT
| 21 ) _unny.jpg ipg FAT
] 22 %) Koala.JPG PG Fal
23 ¥ pigs.ipg jpa FAl
] 24 ‘.rﬂ redpanda.jpg ipa Fal
] 25 O .. . Fal
£
62 of 62 Visible [9.71 GE] 1 Highlighted [691 KB] 1 Checked [691 KB] FAT32-Photos.ED1\Pa

The information bar at the bottom of the list view identifies the number of visible, highlighted and checked items
in the File List.

9.2.2 HIGHLIGHT ITEM IN MOULE

In certain modules (Bookmarks, Keyword Search, Index) there is a right-click menu option to Highlight Item in
Module. The purpose of this it to take the user back to the item in the source module. For example:

In the Bookmarks module:
1. Highlight a bookmarked item.

2. Right-click and select Highlight Item in Module from the drop-down menu.
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Figure 129: Bookmark module right-click Highlight Item in Module

[##] Bookmarked Items List Gallery View Video View
i = | (Az* Filename AZ¥ E
Filename Extensig

| 1 M lowerball PG PG
-l 2 # lowerball2. PG PG
™ 3 #l| NOSEGEAR.IPG PG
] 4 # rapIO. PG PG
el 5 # starting1.JPG IFG
| & W starting2.PG IFG
™| 7 #A startir == a6
™ g ﬂ starti E Add Bockmark... G
-l 9 tm TAILG Edit Bookmark comment... £}
[ 10 ) Tanc Delete Bockmark/s G
| 11 ) Tanc G
] 12 # upper @ Open G
% 13 ﬁ WAST Open with.., G

14 1.IPG . G &1
W s A w09 Determine file signature -
] 15 ﬂ 11,1 Highlight Item in Module e

| Y I

Forensic Explorer with then jump to the File System module (the source module of the bookmark) and
highlight this item.

NOTE: There may be a situation where the source module has a branch plate or filter which excludes the
subject item from view. If this is the case the following message will appear:

Item not found. Remove branch plate and/or filtering and try again.

Resent the branch plate and/or filter and try again.
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Figure 130: Highlight Item in Module

H&-@-e
1T Evidence File System ﬁﬂrtifacts ﬁ Keyword S
a 9 N ¢y o O M

Recover File Mame File Shadow Signature Expand Extract
Folders Search Carve Copy Analysis Files Metadata
Folders Categories [ File List Gallery View
Filter: L[ Bitcoin v | =N = iﬁé‘ AZ¥ Filename
Filename Filename

C+[1 =2 New Case 4 (0) [Local Time]

Forensic Explorer v5.4 et

[tem not found.
Remowve branch plate and/er filtering and try again.

9.2.3 CHECKED ITEMS

A checked item is one which has been a tick in its selection box:

User checked item;

[®] A folder in which not all items inside that folder (or its sub-folders) have been
checked.

To check an individual item, use the mouse to place a tick in the selection box.
To check multiple items:
1. Follow the instructions above to highlight multiple files.

2. Then press the Space Bar to turn the check ticks on, or off.

 COUNTING CHECKED ITEMS

It is useful in many situations to quickly identify how many items are currently checked. This information is
provided in the status bar of a Folders view, as shown in Figure 131 below:
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Figure 131: Checked item count in Folders view.

Folders
Filter: | - |

= O ] & Preview (1) ]

=k ] Lexar 7GB USE E0L.E01 (3) [Local Time]
= > W] = Partition @ 63 (7) [0
C: ] [ Orphaned (12)
= O W] [ Root (28)
2 O[O $Extend (4)
= OO sRmMetadata (4)
- DO st ) (s
O $Txflog (5)
- [ [ s0th Birthday Cake (7)
&0 ®] [ | Aircraft Photos (8)
~ DO B24(39)
B [ ]| Bomber (51} =

Checked 43 of 887

9.3 BOOKMARKS (ADD OR EDIT)

Forensic Explorer enables any item (file, folder, keyword, search hit etc.), or sections of items, to be marked and
listed in the Bookmarks module. Bookmarks are used to note items of interest. Bookmarked items in a list view
can be identified by a “yes” entry in the “Bookmarked” column.

To add a bookmark:
e Right-click in the data view and select Add Bookmark from the drop-down menu.

This will open the Add Bookmark window. See Chapter 17 - Bookmarks Module, for more information on adding
and editing bookmarks.

9.4 COLUMNS

To add columns or remove columns in a list view:

1. Right click on the List view and select Columns > Edit Columns from the drop-down menu. The Column

Headers window will open.
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Figure 132: Column Headers

ﬂ Column Headers

*

Available: Current Columns: (in order)
AZ¥  Available Fields AZY  Available Fields

Module Fields 1| Filename
E Attributes 11| Extension
| Base Bates # o] Path
E Baze Filename E Logical Size
E Baze Path E Physical Size
3] B1AS Time J— 2] Modified
E Bookmarked . B Created
E Byte Start Add > E Accessed
a| Classification E Bookmark Folder
u| Data Level E Bates #
u| Data Size
E Deleted
E Directary Level
E Duplicates
M= - . . -

Faormat... Move Up Mave Down

Default Custom Cancel

Add available columns to the current columns and Move Up or Move Down for the required position

(position can also be controlled by dragging and dropping column titles once they are added). Remove
unwanted columns with the remove button.

3. Default: Returns to the default column selection (shown above).
4. Custom: Enables the user to save custom column layouts.

a. Change Current Columns to the require layout.

b. Inthe Column Headers window select Custom > Save...

c. Enter the name for the Custom Columns:

Figure 133: Create custom columns.

Mew Custom Mame >

New Custom Name Filename + Extension|

Cancel

Custom column layouts are saved as XML files in the following folder:
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\Documents\Forensic Explorer v5\Startup\Custom Columns\FileSystem-Filename +
Extension.xml

Custom columns are specific to each module and are automatically prefixed with the module name.
5. Custom columns are accessed from:

a. The Custom button:

Figure 134: Access custom columns.

Save..

Filename + Extension

b. The right-click File List menu:

Figure 135: Access custom columns.

(7] File List Gallery View Video View || Disk View Category Graph
=]
9= ﬁ}' AZ¥ Filename AZ¥ Eyt ||[AZ¥ Path
Filename Futension Path
[T] Edit Columns...
Custom Default
] Autofit Column Filenarme + Extension
B Autofit &l Columns

Clear columns:

1. Columns that have been populated by a user driven process such as Extract Metadata, Skin Tone, etc.
can be cleared:

e Right-click on the column header and select Clear Column from the menu. The clear process will
be applied to that column only. Or,

e Inthe File System module, select Tools > Clear Columns. Select the columns to be cleared in the
GUIl and run.

9.5 OPEN AND OPEN WITH

The Open and Open With command uses the standard Windows Open With function to open a file from a list
view using an external application (such as Windows Paint, or Microsoft Word) using the standard Windows. To
use Open With:

1. Highlight the required file.
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2. Right-click and select Open With from the text menu.

If the highlighted file is not already associated with a program, the Windows Open With window will display and
allow the file type to be associated.

The file to be opened is copied to the case “Temp” folder: “\My Documents\Forensic Explorer\Cases\[Case
Name]\Temp\” and then opened by the external application.

9.6 EXPAND COMPOUND FILE

A compound file is a file that is a container for other files or data. A simple example is ZIP compressed file.

An investigator should be selective about the compound files that are expanded. Expanding all compound files
could rapidly increase the volume of data in a case.

Typically, user-created compound files should be expanded early in a case to enable Forensic Explorer full access
to the content. This should be performed prior to a keyword or index search so that they may include the
expanded data.

There are two ways to expand compound files:
1. Using the Expand Files toolbar button.

2. Using the right-click, expand files menu option.

9.6.1 TO EXPAND COMPOUND FILES:

. TOOLBAR BUTTON

To expand files using the toolbar button, click the button:

Figure 136: File System toolbar, Expand Compound Files

e

_

Expand
Files

The following options window shown in Figure 137 below:
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Figure 137: Expand Compound Files

B Compound File Expansion Options — O >

Source
O searchable items (736251 items 92,46 GB)

Checked items (0 items 0 bytes)

0 simple () advanced
Common Documents Other
[]7zIP [ Jooc, xLs, PPT [ IMAC F3Events
[P [ |DoCy, PPTX, XLSX [C]zIP (Other) | ?
[_IrRAR || Open Office OOT
[CITar [_|FoF
[ | Thumbs
[~ Jruaiz
Video Frames
[ video
Key Frames
Time sliced: &0 =
Divided: 10 =
Options

B run Signature Analysis on Expanded Content

Logaing: Mormal e Priarity: Mormal o

RIGHT-CLICK MENU
To expand an individual compound file using right click:
1. Highlight the file in the list view.
2. Right-click and select Expand compound file(s) from the drop-down menu.

7-Zip files are now decompressed into individual Logical Evidence files (LO1) and exported to the Cases\[Case
Name]\Expanded folder (this process is seamless to the user). Each LO1 is identified by the Bates number of the
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originating file. Reading expanded content from LO1 considerably speeds up random access to compound data
in Forensic Explorer.

Once a compound file has been expanded the file icon changes to a container which holds the expanded content
(like a folder). For example:

. B “HLA_IT_University_HI-RES_Photos_EXTERIORS.ZIP” is the original file.

. L; “HLA_IT_University_HI-RES_Photos_EXTERIORS.ZIP” is the container for the expanded content.

To display only expanded files in the File System module:
e Inthe File System module Folders Filter, select the required filter, for example:
a. Expanded: Displays all expanded files.
b. Jump List (Windows): Shows expanded MS Jump List files.
c¢. Thumbs.db: Shows expanded Thumbs.db files; etc.

Important: Applying a Folders Filter during the expand process will slow the process due to multiple GUI
refresh. It is recommended that the Folders Filter be turned off prior to the expand process.

9.7 EXPORT

The export Folders and Files function is used to copy files from the case to the local disk.
To export folders and files:

1. Highlight or check the required items.

2. Right click and select “Export > Folders and files...” from the drop-down menu.

3. The following Export Files window will then open.

Copyright GetData Forensics Pty Ltd 2010 - 2024, All rights reserved.



Chapter 9 - Working with data 145 | Page

Figure 138: Export files window

Export Files Options - O x
Process Mame:
|

Source

(®) Highlighted items (3 items 126 KE)

Checked items (0 itemsz 0 bytes)

Advanced options:
[Jindude file sladk

Destination
(®) Separate files
i) Single merged file
keep folder structure
Include empty folders
[Jstart path from: "en-US" (Highlighted Tree Item)
Keep file date/times
[] add Bates ID to flename | Prefix w

[ split large files into 1024 kB files

Destination Folder:

|C: \Wsers\graha\Documents\Forensic Explorer v5\CasesMew Case 1'\Exported), = |

Logging: | Mormal ~ Priority: | Mormal ~

Source:
e  Files can be exported with their logical or physical size.
Include File Slack

e File Slack is the unused space in the last cluster of a file where the logical size of the file does not
fill the complete cluster. The file slack can contain fragments of old data previously stored in that
cluster that may not relate to the actual file being exported.

Destination:
e Separate files: The exported files may be saved individually or as a single merged file.

e Keep folder structure: Will determine whether the exported files are saved with their full path
structure. If not checked all files will be written directly into the export folder.

o Include Empty Folders: Includes empty folders with the export.
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o  Start path from: This option is active when the right-click: Export > Folders and files is run
from the folder tree. Selecting this option will start the save path from a selected folder. For
example, when the right-click is executed on the Cat Pictures folder:

[Case Name]\Partition @ 2048\Root\My Pictures\Cat Pictures\cat_picl.jpg
[Case Name]\Partition @ 2048\Root\My Pictures\Cat Pictures\cat_pic2.jpg

the export path will start from ‘Cat Pictures’.

e Keep date/times: Specifies whether the date and times of the exported files will retain their
metadata as displayed by Forensic Explorer, or whether dates and times will reflect the creation of
the exported files.

e Split large files: large files can be split into designated sizes.

e Destination folder: The destination folder specifies the location where the files will be saved. The
default location is the “Exported” folder in the case path.

EXPORT FOLDERS AND FILES USING A SCRIPT

One of the default scripts provided with Forensic Explorer is Scripts\File System\Export File Types.pas. This
script will export files by type (extension) and can be edited as required. For more information about scripts, see
Chapter 19 - Scripts Module.

9.7.2 EXPORT LOGICAL EVIDENCE FILE (.LO1)

A Logical Evidence File (LEF) is a forensic image containing selected individual files, rather than the image of an
entire partition or physical device. LEF’s are usually created when:

1. A device is previewed, and evidence worthy of preservation is identified, but an image of the entire
partition or device is not warranted; or

2.  When a subset of a files from an existing forensic image is be provided to a third party.

Common LEF formats are .LO1 (Guidance Software - www.guidancesoftware.com) and .AD1 (Access Data -

www.accessdata.com). Forensic Explorer will read both LO1 and AD1 formats and can export files to .LO1 format.

To export files to an .LO1 file:
1. Select or highlight the required file/s.

2. Right click and select Export > Logical evidence file (.L01) from the drop-down menu. The following
window will appear:
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Figure 139: Export to Logical Evidence File (.L01)

[ E Export Files to LO1 Options - O *

Process Mame:

| Export Files to LO1

Source
O Highlighted items (22 items 344 KE)

Checked items (0 items 0 bytes)

Advanced options:
[ Indude file slack
[_|Folder data {FAT Folder Records; Empty Folders, Expanded)

Destination

Case Mame: TestCase 1

Evidence Mumber:

Unigue Description:

Examiner: GetData Forensics

Motes:
Image type: Encase® (*.L01) ~  File Segment Size (MB): 2000
File Entry Hashes Compression
@ vos () Mone
© Good (Smaller but slower)
() Best (Smallest and slowest)
! [(Juse 05 safe filenames !

Start path from: Unavailable - Mo Highlighted Tree Item

Destination Folder:

C:\Users'graha\Documents'\Forensic Explorer w5\Cases\Test Case 1'Expaorted’, =

Destination File:

ExportFiles.L01 =

Logging: Mormal e Priority:  Mormal e

Include file slack: File Slack is the unused space in the last cluster of a file where the logical size of the
file does not fill the complete cluster. The file slack can contain fragments of old data previously stored
in that cluster that may not relate to the actual file being exported.

Folder data: If selected, the folder is treated as a file and its content included in the image. This may
not be desirable, as the folder data can contain information about other files that have not been
selected to be part of the LO1 content. If this option is disabled, the image will contain only the folder
name.
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File Entry Hashes: MD5: If selected, an MD5 is calculated for each file and stored within the LO1. At a
future time, a new hash of the file in the LO1 can be compared to the acquisition hash to determine that
the data has not changed.

Compression: Sets the level of compression for the image file.

Use OS safe filenames: This option is used to ensure that filenames within the LO1 are safe in cross-
platform use (e.g., Linux to Windows). When this option is checked:

e Characters: #0 .. #31, "', '\', '/, 2", '>', '<', "*', '|", """ are replaced by space.
e Blank spaces at the end of filenames are trimmed.

Start path from: This option allows for the shortening of the file path within the LO1. The option is only
available from the right-click menu in the Folder tree. In the example below, the Helicopters folder is
selected in the tree:

Figure 140: Start path from

e ETTTENTe T

[ uge 05 safe filenames
B start path from: "Helicopters™ (Highlighted Tree Ttem)

Destination Folder:

C:Wsersigraha\Documents\Forensic Explorer v5YCases Test Case 1'Exported),

Destination File;

helicopters|L01

The root folder of the LO1 is the selected folder:

Figure 141: Start path from (root folder)

Folders Categories [F7] File List Gallery View Videq
Filter: . Mo Filter W 8}- = f ALY Filename
Filename i Filename
B0 1) Local Time] B ] 1 & air-ambulance-at-broomf
IJ:'I—DD (1) ool [ 2 h] airborne-division-howitzg
I—|E‘>|:| Helicopters (22) ] 3 h] all-hands-on-deck-1.JPG
- 4 | bajo-fuegos-1.JPG
- 5§ CH-1.JPG
- & ®| COBRA-26.JFG

VALIDATING .LO1 FILES
To validate an .LO1 files in Forensic Explorer

1. Add the .LO1 file to a case, or a preview:
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Add the File Acquisition Hash (MD5) column to the list view of the File System module (refer to

paragraph 9.4 for information on adding a column). This column shows the MD5 hashes created at the

time of acquisition and stored within the .LO1 file.

Use the Hash Files button to calculate the current MD5 hash for each file:

Figure 142: Hash Files button in the File System module toolbar

Hash
Files

Compare the Hash (MD5) to the File Acquisition Hash (MD5). The acquisition hash and the recalculated
hash should be identical, as shown in

Figure 143: Comparing Hash (MD5) to File Acquisition Hash (MD5) in a LO1

e
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(=]
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i 1| ®| air-ambulance-at-broomfield-,., | d1868cibea2Seads003f04a631d94.,., | d1863cibealS6ad5003f04a631da4, .
i 2 | ®| airborne-division-howitzer-1.... | 00dsbbbef2atc720def64d51ea968... | 00dsbbbcf2a6c720defa4d5 122963, .
D 3 1‘.] all-hands-on-dedk-1. PG ba07f2913f5601f1232df45041bf 778 b&07f2913f56c1f1232df45041bf 778
D 4 1‘.1 bajo-fuegos-1.IPG h415995h425a83095cF7ch3573cae56 | th41599%b42aa53095cf Fcha573cae56
D 5 1‘.1 CH-1.2PG ac68bb9639b7b519e762812d99063...  ace8bb9639b7h515e762812d99063. ..
D ] 1‘.1 COBRA-26.IPG 8e3bc05781423a3d355ce83b7ebi2. .. | Be3bc057814e3a3d3550e83b ebb. ..
i 7 1—.1 EH-1.JPG ca33568833cb536b7faB3fBoeclcbecada | ca3368833ch536b7faB3fBoclctecada
|:| 3 1‘.1 eurocopter-ec-1.JPG 328529da2e625b427fd43e645f506.,. | 32e529dalet25b427fd43e645f506. ..
|:| g 1‘.1 helicopter-bell-w-1. PG a3b561115cd07342be05954b0dd 15...  a3b561115cd07342be95954b0dd 15. ..
=] 10 1—.1 helicopter-ecureuil-as-1.JPG 8672de7362749f5b4c8a49fce9852,.. | 8672de7362740f5b4c8a49fce9852. ..
D 11 1‘.1 helicopter-hh-1.JPG 742d7504e9670bebab5186df2cc70... | 742d7504e9670bebab5186df 2070, .
=] 12 ‘r.] helicopterdanding-1. PG 615e4fab08c72315ccafoa18de9de356 | 615e4fab08c72315ccafta 18de9de 356
D 13 111 helicopter-mi-1. JPG 0fb7a4caff2074d3%beb7846c07a991b | OfbFadcaff2074d39beb 7846007299 1b
=] 14 1‘.1 helicopters-mh-1. PG 1a128dba8b02b36c36f37544bbfaa... | 1a128dboab02b36c36f37544bb aa. ..
|:| 15 ‘Fu] helicopters-mi-1. PG 75208903e216ea9777cb46ce4ci3e...  75208903e216ea3777ch46ce4cie. .
D 16 ‘Fu] heli-waterfall-australia-1. PG T21271cd477a1afd6a4403edd 1747... | 721271cd477alafd6a4403edd 1747. ..
D 17 ‘Fu] large-as-ife-1. PG 392ed65ccd756b3a 168050231933, .. 392ed65ccd 756b3a 168050331938, ..
D 18 1‘.] light-helicopter-1. PG ecfa544fcied bsfeff24afof197747d ecfas44fcied bsfeff246f9f 197747d
D 19 1‘.1 MI-1.1PG 095ea7fadeed33b3d 2fdasd5600af. .. 0953 7fad6ed33b3d2fdasd5680af ..
D 20 1‘.1 military-helicopter. JPG 2d5b2401f073d9f726a83219943F1abf  2d5b240 1f073d9f 7262832 19943f 1abf
=] 21 1—.1 puma-helicopter-1. PG 9datce50bagbfc240782fc07bf7b965f | SdascoS0basbfc240782fc0 7bf Thoesf
D 22 1‘.1 tornado-3.JPG 9585e4c1c00 1d5bd0edf 7239449602, . 95832401000 1d5bd06df 723944602, ..
9.7.3 EXPORT DELIMITED ROWS (.CSV OR .TAB)

The export delimited rows function is used to copy list view data into a format suitable for import into a

spreadsheet or similar program.

To export delimited rows:

Copyright GetData Forensics Pty Ltd 2010 - 2024, All rights reserved.




Chapter 9 - Working with data 150 | Page

1. Highlight or check the required files.
2. Right click and select “Export > Export Rows (tab, csv, html)...” from the drop-down menu.

The following window will appear:

Figure 144: Export delimited rows

B Bxport Rows — O >

Source

(®) Highlighted Items (1 rows)

Chedked Items (0 rows)

Export As
i) Tab delimited {.tab)

(®) Comma delimited {.cav)
(IHTML (html)

Destination File:

|C:‘n,leers‘n,'l.-'eraEDncuments‘n,Fnrensic Explorer v5YCases\Mew Case 37\Exportediexported_rows.csy ﬁ|

Carc

Select the source and whether the file is to be TAB or comma delimited. Enter the name of the destination file
and click OK to proceed with the export. Only currently visible columns will be exported.

9.8 OCR (OPTICAL CHARACTER RECOGNITION)

Optical character recognition (OCR) is the automated conversion of images of typed, handwritten or printed
text into computer text. Once in computer text the content can be keyword searched, indexed, etc.

Forensic Explorer uses the Tesseract Open-Source OCR Engine (https://tesseract-ocr.github.io/).

Important: In Forensic Explorer, OCR operates on graphics files. However, other file types with embedded
graphics (such as PDF, DOC, and DOCX) can also be processed if the files are expanded (right-click, expand
compound files) to expose the internal graphics.

To apply OCR in Forensic Explorer:

1. Select the graphics to be examined. As OCR is a resource intensive process it can be faster to work
with Highlighted or Checked items rather than processing all Searchable items.

2. Inthe File System module > File List > Right-click menu, select OCR:
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Figure 145: File System right-click menu option, OCR (Graphics)

E Add Bookmark...

& Open
Open with...
Determine file signature
Expand compound file(s)
Export... r
Hash...
OCR graphics files...

3. Select the required options in the OCR File Options window:

Figure 146: OCR File Options

OCR Files Options - O X
Source
() searchable iteme (71items 28.3 ME)
Unallocated space

(®) Highlighted iteme (44 items 28.9 ME)

Checdked items (0 items 0 bytes)

Options
OCR Dictionary: |eng b
[ ] Force recalculation of OCR

File Size Range

Minirnum: |EI = | Mb
Maimurm: | 1024 = | Mb (0 = no limit)
Legging: | Marmal L Priority: | Narmal L

OCR Dictionary: Select the required OCR language (English is selected by default).

Support for additional languages is achieved by adding Tesseract .traineddata language files (available
from: https://github.com/tesseract-ocr/tessdata best).
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The required language files are added to the tessdata folder in the Forensic Explorer installation folder.
Once added they will appear in the OCR Dictionary drop-down menu.

Figure 147: Tesseract .traineddata language files (English and Chinese shown).

pws (C:) * Program Files » GetData » Forensic Explorervd » tessdata w ]
Mame Date modified Type Size
D chi_sim_vert.traineddata 15-Feb-2023 12:44 PM TRAIMEDDATA File 12,772 KB
D chi_tra_vert.traineddata 15-Feb-2023 12:44 PM TRAIMEDDATA File 12,682 KB
D eng.traineddata 29-Dec-2020 4:15 PM TRAIMEDDATA File 4017 KB
D osd.traineddata 29-Dec-2020 4:15 PM TRAIMEDDATA File 10,316 KB

If a graphic contains OCR text, then:
e An alternate data stream is created as a child of the file.
e The alternate data stream has the same name as the parent with ~OCR appended.

IMPORTANT: ~OCR results are added to the Forensic Explorer GUI. If a branch plate is active, it will be
necessary to re-branch plate to see then newly added ~OCR files.

An example of Forensic Explorer OCR output is shown in Figure 148 and Figure 149 below:

Figure 148: A graphic file to which OCR has been applied.

Folders Categories / [E] File List Gallery View Video View () Disk View @9 Category Graph
Filter: I:_T OCR and Parent 4~ v | = Mi5= AZ Filename AZ Exte AZ
B g New Case 4 (0) [Local Time] Filename Extension File Signature|
=B [} 20013702 - Dell Laptop.E01 (0) [Local Time] 1 & azdriverlicense-standard-5a70ed4d43a1030037b292c8.3pg g »G
=-B>[] = Partition @ 206848 (0) Z:‘;I—D [ azdriverlicense-standard-5270ed4d43a1030037b292¢8.jpg~OCR ipg Text
=B = Root (0) [0 2 & azdriverlicense-standard-5a70ed4d43a10300 irg PG
E-B[] [ Users (0) LA B azdriverlicense-standard-5a70ed4d43a1 3 ipg Text
E-B>[] [/ John Thomas Hamilton (0)
B[] AppData (0) < 2
®[] | Pictures (1) 4 of 4 Visible [226 KB] 1 Highlighted [113 KB] 0 Checked [0 bytes] 2001JT02 - Dell Laptop.EQ1\Partition @ 2

04-&.1101441 DRIVER LICENSE  USA

NOT FOR FEDERAL IDENTIFICATION

e
it «owv D08954142
RESTNONE » DoB 01/01/1974

. SAMPLE

. JELANI m

% 123 MAIN ST > <
PHOENIX, AZ 85007 X

wexe 01/01/2039 . 55 03/01/2016

15 SEX M 12 EYES BRO
D s HR oRO VETERAN

17 WGT 1851b 01 I°1I74

DONORY

(‘KMM Jer .
| 5 DD 9001A9691S1427J4

2001JT02 - Dell Laptop.E01\Partition @ 206848\Root\Users\John Thomas Hamilton\Pictures\azdriverlicense-stanc
i Hex =i Text = Info @Boo... Lw/Byte... |ED) Display | = Files... |=|File... [ =|File... [=lPer...

0 of 199905 Checked [0 bytes]
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Figure 149: The resulting [filename}~.jpg~OCR output

Folders Categories [E7] File List Gallery View Video View (| Disk View @) Category Graph
Filter: |£|' OCR and Parent v | = l@ = A2 Filename A2l Exte [AZ
B[] S Mew Case 4 (0) [Local Time] Filename Extension  File Signature|
=-E>[] [ 2001702 - Dell Laptop.E01 (1) [Local Time] 1 i azdriverlicense-standard-5a70ed4d43a1030037b292c8.jpg ipg PG
15-B>[] = Partition @ 205848 (0) 1 [2) azdriverlicense-standard-5a70ed4d43a1030037b292c8. jpg~OCR. ipa Text
BB [] [ Root (1) 2 i azdriverlicense-standard-5a70ed4d43a1030037b292c8[1].jpg ipg PG
E’!—DD 2] Users (0) I—|:| 2 azdriverlicense-standard-5a70ed4d43a 1030037b292¢8[1].jpg~OCR ira Text
E—DD [ John Thomas Hamilton (0)
B Appata 0) ¢ i
B[] | Pictures (1) 4 of 4Visible [226 KB] 1 Highlighted [343 bytes] 0 Checked [0 bytes] 2001JT02 - Dell Laptop.E01\Partition €

CPuzona DRIVER LICENSE USA

NCT FOR FEDERAL IDENTIFICATICH
2 CLASSD a Btn DOBS54142

2 RESTNCNE —>.-: 008 01/01/1974
1 SZMPLE

> JELANI

8 123: MAIN 5T
PHOENIX, AZ 85007

a ExP 01/01/2039 a 1ss 03/01/2016 _

a) 15 SEX M *EYESBRO VETERALN
3 le HGT 5'-08" 15 HAIR BRO

17 WGT 185 Ib 01/01/74

DONOR @
T o
2001JT02 - Dell Laptop.E0T\Partition @ 206848\Root\Users\John Thomas Hamilton\Pictures\azdriverlicense-stant
[ Hex = Text |=|Info EE Boo... |.|Byte.. @Display =Files... | =|File... |=[Fle... =|Per..

0 of 199905 Checked [0 bytes]

9.9 SEND TO MODULE

Send to Module is a method of passing specific files from one module to another. For example, a Windows

registry file can be highlighted in the list view of the File System module and passed to the Registry module for
processing (see 16.2 for more information).

9.10 SORTING

Sorting is conducted in a List view where the attributes of a file, email, Bookmark, keyword search etc. are
displayed in the relevant columns.

To sort by a single column:

1. Double click on the column heading, e.g., “Filename”. An arrow will appear showing the direction of
the sort.

2. Double click again on the column heading to reverse the sort:

Figure 150: Single column sort

Filename W

The same single column sort result can be achieved by right clicking on the column and in the drop-down
menu select “Sort Ascending [column name]” or “Sort Descending [column name]”.
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Ascending column sort is denoted by an upward arrow:
To sort by multiple columns using the SHIFT key:

1. Double click on the first column heading, e.g., “Filename”.

2. Hold down the SHIFT key on the keyboard.

3. Double click on the second column heading, e.g. A “1” will appear for “Filename” and “Path” a “2” to

indicate that it is the second column in the sort.

4. Continue to add columns to the sort by following steps 2 to 3 above. (Maximum of 5 columns)

Figure 151: Sort multiple columns by Filename, then Full Path, then Logical Size

Filename 1 path a2 Logical Size 22 Extension Clag]
__________ DEMO 7.E01\Root\Aircraft Photos'H. .. 3,854 PG
Add Bookmark... s o
ds... 152
Open =Y. 553,804 IPG
Open with... =0 298,272 LOG
= I 2,048
£ Lost Determine file signature Cakel 5,341,184 ipg
1—.1 LostF Expand compound file(s) Cakel, 5,405,720 ijpg
& LostF Export... » |Cakel 5,210,112 jpg
& LostF T Cake', 4,849,664 jpg
] Lost ashe Cake\ 5,308,416 jpg
& LostF ClamAY scan... Cake', 5,396,544 jpg
& LostF Send to module b |cakel 5,177,344 ipg
&) lower Classify v 5B 52,585 PG
&) lower 1. 57,136 PG
& man Colurmns ¥ jtos) 4,028 PG
& man. Sorting Sort Ascending [Filename]
& McDe o
Men Flags L4 Sort Descending [Filename]
() Men Date Filter Tool Remove Sorts
ml Mes | Col Filter Tool Sort Multi Col
D MID - olumn Filter Too ort Multi Column...
"_'1 milita Explorer Tool Persistent Sort
3.

A multi column sort can also be achieved by right clicking within the column on a filename:

1. Select the “Sorting > Sort Multi Column...” menu item, shown below:

Copyright GetData Forensics Pty Ltd 2010 - 2024, All rights reserved.



Chapter 9 - Working with data 155 | Page

Figure 152: Multi column selection window

Sort Column Selection n
Visible Columns: Sort Columns (Max 5): (in order)
Checked * Filename
Extension & Path
Classification Add - 4 Logical Si
Flags ogical Size
Attributes <- Remove
Initialized Size
Physical Size
Madified
Created
Accessed
Bookmark Fal... Move Up Maove Down
Bates #
Hash (MD5) Column Sort Order
Ascending
Descending
Help oK Cancel

Visible columns are shown in the left-hand window:

1. Select the required sort columns.

2. Add the required sort columns to the right-hand window.

3. Use the “Move Up” and “Move Down” buttons to set the order on which to sort the columns.

4. Choose Column Sort Order of “Ascending” or “Descending”.

5. Click the “OK” button to apply the sort.

Persistent Sort:

e A persistent sort (right-click > Sorting > Persistent Sort) maintains the current sort when switching
between data views.

To remove a multi column sort:
e Release the SHIFT key and double click on a column heading to return to a single column sort.
To remove all sorting,

e Right click and from the drop-down menu select “Sorting > Remove Sorts”.
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9.11 FLAGS

In Forensic Explorer, a flag is a colored box applied in a List view in the “Flag” column to mark a file. Eight colored
flags are available for use. A single item can be flagged one or more times. Flagged files are shown in Figure 153
below:

Figure 153: Flagged items

File List -
Filename & Flags Ext... Ful Path
O O Preview'\FAT32-Photos.EO1\Par
O 0. Preview'\FAT32-Photos.EO1\Par
O [£ canyon.JrG [ | JPG Preview'\FAT32-Photos.E01\Pard
[0 |2 Desert.JrG [ | JPG  Preview\FAT32-Photos.E01\Part
O [ waterfal. PG [ | [ | JPG  Preview\FAT32-Photos.E01\Part
4 1 | 3
5 of 5 items  PreviewhFAT3Z2-Photos. EOL\Partition @ &3 [MO MARK

To apply a flag:
1. Highlight an item in a List view.

2. Double click the opaque flag color in the flag column (if the flag column is not visible add the column
- see paragraph 9.4 - Columns); or,

Right click and use the “Add Flag” menu to place a selection tick next to the required flags, as shown
in Figure 154 below:

Figure 154: Right click "Flags" menu option.

Columns »

Sorting *

<,

Red Flag

Blue Flag

Gold Flag

Orange Flag

v Green Flag
Pink Flag

v AgquaFlag

Brown Flag

Flags 2

<

Clear ALL Flags
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To apply flags simultaneously to multiple items:

1. In the list view, highlight multiple items by holding down the SHIFT or CTRL key and selecting the
required items with the mouse.

2. Right click and use the Flags menu option.
3. Select the required flags.
To clear flags:
1. Double click on the flag; or
2. Highlight the required items, right click, and use the Flags > Clear Flags menu option; or

3. One of the default scripts provided with Forensic Explorer is “/Scripts/File System/Clear All Flags.pas”,
which will programmatically remove all flags.

Scripting Flags

Flags can also be applied by running Forensic Explorer scripts. See the Chapter 19 - Scripts Module, for more
information.

9.12 FILTERING DATA

The Date Range filter tool is applied to the items displayed in a list view and allows filtering by Created, Modified,
and Accessed dates.

To access the Date Range filter tool:
1. Rightclick on a List view window.
2. From the drop-down menu, select “Date Filter Tool”:

The Date Range filter tool then appears above the List view column headings, as shown in Figure 155 below.
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Figure 155: Date filter tool

B File List -

C‘ql;r’n: Aooessed Date N
=
}I 1 1 1 }
2010 2011 2012 2013
al|= A2 Filename 8| Created B | Accessed
Filename Created Accessed Ba...
|:| | GeoTagged P... 22-0ct-12 12:1L01FPM O5-Mowv-12 11:00:52 AM -
] ~| Root 18-May-12 11:50:42PM  06-Mov-12 11:00:52aM | |
] [Z] Root~($50) 18-May-12 11:50:42 PM  06-Mov-12 11:00:52 AM
] | Mirella Samples  20-Jun-12 12:04: 14 PM 0a-Mov-12 10:59:33 AM
|:| =& FOTO 29-May-12 4:59:39 PM Og-Mowv-12 10:59:28 AM -
4 [ ] | 3
1429 Iterms PreviewtLexar 7TGB USE METLEOL\Partition @ 63%

The applied filter column is displayed in red (e.g., “Accessed”).

To change filter criteria, click on the date icon £ in the Modified, Created, or Access columns and select the
“Show Date Range Tool” for that column.

To apply a date filter:

Select and drag the slide bar pointers at either end of the date range to the required position on the date range
bar. As the date range is narrowed, the filter is applied to the list view. In the example below, the filter is set to
show only files with a date between 2011 and 2012:

Figure 156: Application of date range sliders

= 1 Physical Size 6 Modified
y y |
oy &
" W
2012 2013
Physical 5ize Modified
0 0 14-Mar-12 9:37:06 PM

To modify the time scale, when the magnifying glass with plus sign is displayed (see Figure 156 above) double
click to range drill down the scale (e.g. year to day, day to hour, etc.);

=

To clear the date range filter, click on the icon.

To close the date range filter, click the 22 jcon.

9.12.2 COLUMN FILTER TOOL

The column filter tool is applied in a list view and allows instant text filtering on column data.

A lock has been placed on the ‘X’ icon of the Column Filter Tool to stop accidental removal.
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Additional options of Blank and Not Blank have been added to the drop-down menu. This assists where a column
is not fully populated with data, e.g., metadata.

To access the column filter tool:

1. Right click on a List view window.

2. From the drop-down menu, select “Column Filter Tool”:

3. The text filter then appears above the List view column headings, as shown in Figure 157 below.
To apply a column filter:

1. Type into the filter field above the column heading:
i. %% Requires A-Z characters.

ii. ¥ Requires numbers 1 — 9.
Use >, =, or < symbols to list data greater than, equal to or less than the typed number.

iii. 5. Requires a date format (click for auto selection calendar).
2. Astextis typed into the filed the displayed content updates based upon the typed criteria.
When the filter is applied, the outline of the filter box/s turns red in color, as shown in Figure 157 below.

Figure 157: Column filter tool

[F] File List Gallery View Video View | Disk View

-
=] |\_.-. W l:EltSl J

w53

Filename

Cats
[[] Cats~$I30(330)
[[] Cats~$I30(3A0)
[[] Cats~$I30(380)
Black Cats
Orange Cats
Black Cats~$130(590)
CatsAl10_Baby.JPG
CatsA2_Mary.IPG
CatsA3_Choco,JPG
CatsA4_Kristsji, PG

L e L o

|2, |2, |22, |2, [

[y
=

11

I

To apply multiple column text filters: Enter the filter criteria into the field above each column heading. Multiple
text filters are joined with the “and” operator.

To clear a text filter: Remove the text from the filter.

=

To clear all filters: Press the icon.

To close the text filter, click the 220 jcon.
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To change search options, click the ¥ icon.

Note: The Flag Column is a binary search:

Flags Text Filter Value  Flags shown

=1 Shows column 1 (red)

=2 Shows column 2 (blue)
=4 Shows column 3 (yellow)
=8 Shows column 4 (orange)
=16 Shows column 5 (green)
=32 Shows column 6 (pink)
=64 Shows column 7 (aqua)
=128 Shows column 8 (brown)

Note: If the equals sign is not used then the results will show the specified color and above.
A lock has been placed on the ‘X’ icon of the Column Filter Tool to stop accidental removal.

Additional options of Blank and Not Blank have been added to the drop-down menu. This assists where a column
is not fully populated with data, e.g., metadata.

COLUMN FILTER: SIMPLE

Simple returns the exact text entered:

Figure 158: Text filter search options

& Simple
Simple (AMD, OR, NOT)
MNOT
RegEx
DOS Mask
DOS Mask (AMD, OR, NOT)
Elank
MOT Blank

Exact text match finds all items containing the entered text:

Figure 159: Simple search for items containing ‘cat’

[ File List Gallery View Video View | Disk View

IK
(=] AL
X cat

.'.'Q_’g

Filename

1 Cats

2 Black Cats

3 Orange Cats

4 ‘rﬂ Baby_cat_sleeping. PG
5 [] Black Cats~SI30(590)
6 | CatsA10_Baby.JPG

(WS Y[Y[¥[
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In Forensic Explorer version 5.4.8.2036 and above the addition option of Simple (AND, OR, NOT) is added as an
additional search option. This adds Boolean search logic to a Simple search. The Boolean operators are OR, AND,
NOT, (). For example:

The simple search ‘cat AND black’ returns:
e All items that contain the word ‘cat’, AND
e All items that contain the word ‘black’.

Figure 160: Simple with AND

[ File List Gallery View Video View [ Disk View
)
5 [= (A2 cat AND black )
Filename
] 1 Black Cats
] 2 [ Black Cats~5130($50)
| 3 Fi BlackCat 1.JPG
| 4 | Black Cat 2.JPG

The simple search ‘cat OR black’ returns:
e All items that contain the word ‘cat’, OR
e All items that contain the word ‘black’.

Figure 161: Simple with OR

[F] File List Gallery View Video View | Disk View

i [= Lfa-z cat OR black J

Filename

Cats

Black Cats

Orange Cats
Baby_cat_sleeping. PG
[[] Black Cats~8I30(520)
& CatsA10_Baby.JPG
£ CatsAZ Mary.JPG

|
I,
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The simple search ‘cat AND NOT black’ returns:
e All items that contain the word ‘cat’.
e AND NOT items that contain the word ‘black’.

Figure 162: Simple AND NOT

(7] File List Gallery View Video View || Disk View

o (= I:a—z cat AND NOT black J

Filename

Cats

Orange Cats
Baby_cat_sleeping. PG
CatsA10 Baby.JPG
CatsA2_Mary. PG
CatsA3_Choco.JPG
CatsA4_Kristaji. PG

[N Sy %

&, | o, |, |,

For more complex joining of the operators use brackets. For example:

(cat OR dog) AND NOT (black OR orange)

COLUMN FILTER: NOT

Displays any value which does NOT match text entered. When the NOT column filter is active, the A-Z icon turns
black, as shown in Figure 163 below:

Figure 163: NOT column filter active

Ll |: Ename
A

COLUMN FILTER: REGEX

Regular expression search. When the RegEx column filter is active the icon changes to a formula, as shown in xx
below:

Figure 164: RegEx column filter
ﬁdv |: Ename

RegEx quick start guide:

abc... Letters

123.. Digits

\d any Digit

. any Character

\. Period

[abc] Onlya, b, orc
[*abc] Not a, b, norc
[a-z] Charactersatoz
[0-9] Numbers 0to 9
{m} m Repetitions
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{m,n} m to n Repetitions
* Zero or more repetitions
+ One or more repetitions
? Optional
\s any Whitespace
ALS Starts and ends
0] capture Group
(a(bc)) capture Subgroup
(.*) capture Variable content
(alb) Match’saorb
\w any Alphanumeric character
\W any non-alphanumeric character
\d any Digit
\D any non-digit character
\s any Whitespace
\S any non-whitespace character

éCOLUI\/IN FILTER: DOS MASK

File masks consist of any combination of three general symbol types:

e  Fixed characters, such as letters, numbers and other characters allowed in file names.

e ?(Question-mark character) that stands in for any single character.

e  *(asterisk character) that stands in for any number of various characters.

For example, file mask:

?at.jpg

*e.jpg

Refers to all files with three letters in their name ending with at, and .jpg extension,
matching:

cat.jpg
mat.jpg
hat.jpg
rat.jpg

and all other files starting with any character and ending with at.jpg.

Refers to all .jpg files that start with h, end with e, and contain any number (including
zero) in between, matching:

ashe.jpg
hue.jpg
here.jpg
house.jpg, etc.

DOS Mask (AND, OR, NOT) adds Boolean logic OR, AND, NOT, () to DOS Mask statements. See ‘Simple (AND,

OR, NOT)’ above.
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Manage columns (see Custom Columns for more detail):

B9 column Headers >
Available: Current Columns: (in order)
| #2¥  Available Fields | | 2™ fvailable Fields |
Module Fields | Filename

| Attributes o] Extension

ii| Base Bates # | Path

i| Baze Filename E Logical Size

3| Base Path 1] Physical Size

ol o] Modified

is| BIAS Time <-Remove E

51| Bookmarked E Created

2] Byte Start Add > 1] Accessed

E Classification E Bookmark Folder

E Data Level | Bates #

o Data Size

E Deleted

o] Directory Level

| Duplicates

M= - . . -

Format... Move Up Mave Down
Default Custom Ok Cancel

The Explorer Tool is applied in a list view and allows navigation of the file system in a similar fashion to Windows
Explorer.

To access the Explorer tool:

1. Right click on a List view window.

2. From the drop-down menu, select “Explorer Tool”:

3. The Explorer Tool then appears above the List view column headings, as shown in Figure 165: Explorer
Tool below.
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Figure 165: Explorer Tool

| File List

Gallery View Video View || Disk View @ Category Graph

Z3 | Mew Case 37 » DEMO 7.EO1 » Root » Aircraft Photos
DEMO 7.E01

% [~ | DEMOQ 7.E01\Root\Documents and Settings
B CEMO 7.E01\Root\Aircraft Photos

] 1 [ | B24 DEMO 7.E01\RootiAircraft Photos), ]
] 2 || Bomber DEMO 7.E01'\Root\aircraft Photos, ]
] 3 | Commerdal ... DEMO 7.E01\Root\Aircraft Photos), ]
] 4 || Helicopters DEMO 7.E01\Root\Aircraft Photos), ]
] 5 || War Planes DEMO 7.E01\Root\Aircraft Photos), ]
] 6 [[] B24~8I30(5... DEMO 7.E01'\Root\Aircraft Photos), 56
] 7 [C] B24~8I30(5... DEMO 7.E01'\Root\Aircraft Photos), 4,096
] 8 [ B24~8130(5... DEMO 7.E01'\Root\Aircraft Photos), 8

e Click on a folder in the path to jump to that folder in the List view.

e Use the drop-down menu to jump to a recent path.

Folders filters are applied using scripts. See Filters, for more information.

9.13 COPY ROWS TO CLIPBOARD

“Copy Row(s) to Clipboard” is a function specific to a List view. It allows the text in the List view table to be
copied and pasted directly into an external program like Microsoft Excel. To copy rows to clipboard:

1. Highlight the required rows in the List view.

2. Right click and select “Copy Row(s) to Clipboard” from the drop-down menu.

Copyright GetData Forensics Pty Ltd 2010 - 2024, All rights reserved.






Chapter 10 - Evidence Module 167 | Page

Chapter 10 - Evidence Module

In This Chapter

Tt o 1 T PN 169
T = o 1= PPN 170
10.2.1 ManNaging INVESTIZATONS ..cciiiiiiiiiiiiiiiiiieieeeee e e e e e e e e e e e e e e e e e e eeeeeeeeeeseseaanens 172
10.3  OPEN AN EXISTING CASE ..uvriiiiiiiiiiiiiiieee e e ettt e e e e e sttt e e e s s sttt e e e e e s saabataeaeesesasssbaeaeeessessssaeaeesssasnns 173
10.3.1 RECENT CASES ..oiiiiiiiiiiiiiic e 174
O I Yo [o [ g Y- =1V o 1= o Yo PR 174
104.1 AAAING @ DEVICE ..eeueieitieeiiieitteeie ettt sttt sttt et e st e st e e it e e saneesae e e sabeenteesaneennees 175
10.4.2 AddIiNg @ REMOLE DEVICE....cciuiiieeeiiei ettt ettt et e e e tae e e et e e e sab e e e e saba e e s enaaeeessreaeans 176
10.4.3 AddiNg @ FOrENSIC IMAZE ...eiiiiiieeeiee ettt e e et e e e et e e e sabe e e e sateeeeenaaeeessaeaeans 179
10.4.4 Adding a corrupt forensiC iMAaZE ......cocuiieiiiiieeecee et et et aaee e 181
10.4.5 AddiNg @ reGISTrY fil .evieeiii i e e e 182
10.4.6 AT FIl e e e e 182
10.4.7 A FOIART .. e e 182
10.4.8 CrEAENTIANS .ottt st b ettt et s be e b e b b s 182
10.5  EVIHENCE PrOCESSON . ..eiiieiieiiettett ettt ettt e st e bt et ea e satesbeesheesbee bt e bt eateeatesbeesbe e beeabeeabesabesanesaeenees 184
10.5.1 PrOCESSOI TASKS ...uveruiiiiieitieritete ettt sttt st e se ettt ebe e b e bt st e b et saee 184
10.5.2 P 01 A I g L0740 Y =SSN 188
10.6  Adding additional eVIdENCE 10 @ CASE ..ccuuriiiiciiee ettt e e e e e e e e s srre e e e ate e e snnre e e snaeeeens 189
O Y 1V [ o T- - I or- 11 PR PPN 190
10.7.1 AUTO SAVE ...iiiiiiiiiiiiie e s 191
10.7.2 SaVING OF ClOSING @ PrEVIEW ....uuiiiiiiie ittt te e ettt e e e e e st e e e e e e sebbtr e e e e e e sesnartaeseeaeeennns 192

Copyright GetData Forensics Pty Ltd 2010 - 2024, All rights reserved.



168 | Page Chapter 10 - Evidence Module

IR 1o T [ == T o 1Y SR 192

Copyright GetData Forensics Pty Ltd 2010 - 2024, All rights reserved.



Chapter 10 - Evidence Module 169 | Page

10.1 PREVIEW

IMPORTANT: When working with physical devices, accepted forensic procedure dictates the use of a write block.

Refer to Appendix 2 - Write Blocking, for more information.

Forensic Explorer allows the investigator to preview a device, image, or registry file without first creating a case.

To preview a device, image, or registry file:

Click the Preview button in the Evidence module:

NOTE - v2.3.6.3518: From version v2.3.6.3518, the Evidence module Preview button is no longer
displayed by default. To display the preview button, in the Forensic Explorer drop-down menu, select
Options > and check Show Preview button. The option is stored in a registry key and needs only be
set once.

Figure 166: Preview button in the Evidence module

Preview

When the preview button is clicked:

A unique preview working folder is created using a Global Unique Identifier (GUID) in the following
path: C:\Users\Graham\Documents\Forensic Explorer\Previews\{GUID [e.g., 8709A41C-38B6-4F9E-
BA18-633B394721C5]}.

The evidence window in the Evidence module identifies that a preview is in progress with the words
“Case: Preview”. The Add Device, Add Image, Add File, Add Folder, Add Group and Remove buttons
become active in preparation for adding evidence to the preview, as shown in Figure 167 below:
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Figure 167: Evidence Tree in the Evidence module identifying a “Preview.”

Evidence
Previ 1
B Add device g review (1)
. [0 15057702 Dell Laptop.E01 (0)
Add image
[y Add file
Property |'l.|'alue
@ add.cemole Device Type Disk Image
) Bytes Per Secto 512
g Add folder YEES FEr Sector _
Current Filename E:\GH Forensic Images'-— TRAIN
% Add group Device Size 74.53 GB (30,026,361, 344 bytes|
Original Filename E:\GH Forensic}lmages‘l,— TRAIM
% Remave Image Type Encase
IsLogical Mo
Encase Examiner John Zeke Thackray
Encase Case Mumber Op Payback
Encase Evidence Mumber 16051702
Encase Description 16051702 Dell Laptop

For information on adding evidence to a preview, see “10.4 Adding a Device”.

A preview can be saved as a case at any time by selecting the Save button in the Evidence module or using the
“Forensic Explorer > Save Case” drop-down menu item.

When a preview is saved information in the preview GUID folder is transferred to a case folder (see the “New
Case” section below) and the GUID folder is deleted.

10.2 NEW CASE

To create a new case:

1. Click the New button in the Evidence module:

Figure 168: Evidence module, new case button

(+)

MNew Case

The “New Case” window will open, as shown in Figure 169 below:
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Figure 169: New Case window

Mew Case O X
5

Case Name: |Case 123 |

Investigator: | Graham Henley e Mew. .. Edit...

Cases Folder: |C: WsersOwnerDocuments \Forensic Explorer{Cases @.|

Case Motes: | Thiz is 3 test case.|

Case Time Zone Settings

TimeZone: Local Time L

TimeZone Mame: |AL.I5 Eastern Standard Time (-600 mins) |

Daylight Savings: |.ﬁ.L.I5 Eastern Daylight Time {-660 mins) |

STD/DLS Bias: 600 /|60 | minutes

Case Created: |30-DE|:—16 10:40:45 AM |

carcel

Enter the relevant case details:
Case Name requires a unique name is automatically used to create the case folder in the working path.

Investigator can be selected from the drop-down list, or click the New button to create a new investigator.
Forensic Explorer records activity in a case by assigning each investigator a unique investigator ID (GUID).
Investigator details are stored in the case file and will be transferred with the case file if it is moved from one
analysis computer to another. Investigators details are also saved into a local database to ensure that they are
automatically available in the drop-down list for future cases. The default location for this database is:
C:\Users\[profile]\Documents\Forensic Explorer\Databases\Locallnvestigator.rsv. To add, edit or delete an
investigator, see 10.2.1 - Managing Investigators, below.

Cases Folder is the location where files for each case are stored.

Case Notes are used to briefly summarize the case. This information is used in other parts of the program, such
as in the “Recent Case” section of the Evidence module.

Case Time Zone Settings are applied to the entire case. The default is the local time zone. Refer to Chapter 21
for more information about date and time.
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Case Created identified the date and time that the case is created per the local system clock.

Click OK in the New Case window to create the case. Working folders for the case are written (see “Working
Path” page 38) and the new case is saved for the first time. The Processes window will confirm when this process
is complete. Evidence can now be added to the case. See “Add evidence to a case” on page 174.

10.2.1 MANAGING INVESTIGATORS

To add, edit or delete an investigator, select “Investigators” from the Forensic Explorer drop-down menu:

Figure 170: Forensic Explorer drop-down menu.

=

Save
Investigators...

Options

01 8 & I

Layout 4

lcon Editors 3

go
-

Feedback...
License Manager...
About...

Help

@eeE

Exit

Select and edit the investigator as needed:

Figure 171: New Investigator

List of Investigators E

Investigator ID: |{728AA SE7-71CC-4A80-B9DD-6EDF215CB |

Full Name: |\u'era Leung |

Title/Position: |Tesber

|
Organization: |Gei£)ata |
|

Department: |Testing

Contact  Address

Phone: |+61(0)2 82086053
Fax: |+61(0)2958381195

Email: |vara@gebdata.com |

URL: |wu\".i\'.fDrensicexp\orer‘cDm |

Import VCF Export VCF

Save Reset
Add Delete

Import VCF is a fast way to import investigator details using the VCard.vcf format.

Export VCF export the currently selected investigator to a file in VCard.vcf format.
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10.3 OPEN AN EXISTING CASE

To open an existing case,

1. Click the Open button in the Evidence module:

Figure 172: Evidence module, new case button

Open

This will open the “Open Case File” window. When a .case file is highlighted the meta-data for that case is
displayed on the right-hand side of the Open Case File window (shown in Figure 173 below). Click Open to open
the case file.

Figure 173: Open Case File

a Open Case File >
Look in: | New Case 4 ~ | e N )
MName ° Date modified Type Case
* P ’@ Case 4 |
. AttachedEvidence 02-5ep-201912:22...  File folder
GurdErEESe DTSearchindexes 02-5ep-2019 12:22...  File folder %%gﬁ{mmso_gmmmm'
- Exported 02-5ep-201912:22...  File folder
Logs 02-5ep-201912:22...  File folder ’Wiﬁgaw—‘
Desktop Reports 02-5ep-201912:22... Filefolder L=2teund
- D MNew Case 4.FEX 02-Sep-2019 12:22... FEXFile Investigator ID
m 723AASET-71CC-4AB0-B90D-6EDF 219
Libraries Created On

02-5ep-2019 12:22:15PM |

! Case Notes

This PC

MNetwork < 2
File name: Mew Case 4. FEX e Open
Files of type: Case Files (*.FEX) ~ Cancel

2. The Select Investigator window opens so that the person who is about to work on the case can be
identified. Select your name from the drop-down list. Click Edit to preview and change your details if
required. If your name does not appear in the drop-down list, click “New...” to create a new
investigator. Click OK to continue.

Figure 174, Select investigator window.

Select Investigator

Investigator: |Vera Leung w Mew. .. Edit...

The evidence in the case will then populate and display in the “Evidence” window of the Evidence module.
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Recent cases can quickly be opened by selecting the case name from the “Recent Cases” list on the Evidence

module.

When a recent case is highlighted in the Recent Cases list, the “case description” entered when the case was
created will be displayed in the description field, as shown in Figure 175 below:

Figure 175: Evidence module > Case’s tab, Open recent cases

Recent Cases

Case Details ‘ Age |
Marme: New Case 44
Investigator;  Vera Leung Less than
Created: 16-5ep-2019 11:35:01 AM 1 minute
Mame: MNew Case 43
Investigator:  VeralLeung 33 mins
Created: 16-5ep-2019 11:02:17 AM
Property |'|.‘a|ue
Case Mame MNew Case 44
Case Path C:Wsers\Wera\Documents\Forensic., ..
Investigator Vera Leung
Created 16-5ep-2019 11:35:01 AM
Age Less than 1 minute
Case Motes This iz 3 test case

10.4 ADDING EVIDENCE

Evidence in Forensic Explorer can be:
e Adevice (including a remote device).
e Aforensicimage.
e Aregistry file.

e Afile.
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10.4.1 ADDING A DEVICE

IMPORTANT: When working with physical devices or active files, accepted forensic procedure dictates the use
of a write block. Refer to Appendix 2 - Write Blocking, for more information.

To add a device:
1. Create a preview (see 10.1), a new case (see 10.2), or open an existing case (see 10.3);

2. Inthe Evidence module, click the “Add Device” button. (If the Add Device is inactive, click on the case
name in the evidence window to activate the buttons). This will open the Device Selection window
show in Figure 176 below:

Figure 176: Device Selection window

B Device Selection - O X
Select the Device you want to analyse:
Device Label Size FS Type
= }& My Computer
=] a HDO WDE WD 10J31X-00U3VT0 01.0 ATA 931,51 GB SATA (SCST)
BE GH-Data 931.51GB NTFS  SATA (Win)
=] a HD1 WDE WD7500BPKX-00HP] 01.0 ATA 698.64 GB SATA (SCST)
e GH-Data §98.64 GB NTFS  SATA (Win)
= B wp2 SanDisk SDESBIM256G1002 X231 ATA  238.47 GB SATA (SCSI .
a (55D & AddRAID
- = X 0s 216.90 GB NTFS ~ SATA (Win)
B a HD3 WIBU - CodeMeter-Stick v1.0 39.3MB USB {5CSI)
- @ Remote
BF CODEMETER 38.6 MB FAT32 USE (Win)
5l Remove
= Refresh
s G

The Device Selection window includes the following information:

Label: Physical drives are listed with their Windows device number.
Logical drives display the drive label (if no label is present then "{no label}" is used).

Size:  The size column contains the size of the physical or logical device. Note that the actual size of the
drive is usually smaller than what the drive is labeled. Drive manufacturers usually round up the
drive capacity, so a 453.99 GB drive in this screen may be sold as 500GB.

FS: The File System on the drive, e.g., FAT, NTFS or HFS.
Type: Describes the way in which the drive is connected to the computer.
To add a physical or logical device:

1. Highlight the required physical or logical device and click OK, or.
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2. To add a RAID, click the Add RAID button to access the RAID selection window. (Refer to Chapter 25 -
RAID, for more information about examining RAID devices).

Troubleshooting: If the drive is not listed, check for basic connection issues (cables / power etc.). Check
Windows Disk Management to ensure the device is being correctly recognized. Press the refresh button
to refresh the Device Selection window.

Click OK to add the device. The Evidence Processing Options window will open. See 0 - Credentials are
case specific. If credentials are used between cases, the Import and Export buttons can be used to save
and load them for each case.

4. Evidence Processor, below.

10.4.2 ADDING A REMOTE DEVICE

Forensic Explorer has the capability to examine remote devices across a network using the UDP protocol (User
Datagram Protocol is one of the core members of the Internet Protocol Suite).

DEPLOY THE GETDATA UDP NETWORK SERVER AS STAND-ALONE

To examine a network device, it is necessary to deploy and run the GetData UDP Network Server,
GetDataNetworkServer.exe on the remote computer. This file can be found in the Forensic Explorer installation
folder.

When the GetData UDP Network Server is deployed, and run, the following screen appears:

Figure 177: GetData UDP Network Server

GetData UDP Metwork Server n
Server
Server IP: 192.168.64.1
Server port: 443
Server Status:  Waiting

Version: v2.4.0(85)
Ready

Close

Server IP: The IP address of the computer on which the Network Server is running. IMPORTANT: When
troubleshooting, double check the IP address using CMD line “IPCONFIG” command to ensure
the correct machine address.

Server port: The port for communication is 443.

Server Status:  The server enters “waiting” mode for the connection from Forensic Explorer.
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Note: It may be necessary to configure firewall settings on the remote computer to enable remote access to the
GetData UDP Network Server.

NETWORK SERVER COMMAND LINE OPTIONS

The GetData UDP Network Server can be deployed from the CMD line on the remote computer with the
following switches:

/Q Quite Mode (No GUI).
JP:XXXX Specified port number.
IMPORTANT: When deployed in Quite Mode:

e The GetData UDP Network Server will appear as a running process in the Windows Task Manager. The
name of the process is the name of the executable (i.e., rename “GetData UDP Network Server” as
needed).

e The GetData UDP Network Server can only be terminated by ending the process in the Windows Task
Manager.

DEPLOY THE GETDATA UDP NETWORK SERVER AS A WINDOWS SERVICE
The GetDataNetworkServer can be deployed as a Windows Service.
To install as a service, use the following command line switch:
e  GetDataNetworkServer /install /silent
To uninstall the service, use the following switch:
e  GetDataNetworkServer /uninstall /silent.

If a non-default port is required (i.e., a port other than 443) the following key must be added to the registry to
specify the port number:

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\GDStreamService\UDPPort(DWORD) = 443
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éCONNECTING TO THE GETDATA UDP NETWORK SERVER

To connect to the GetData UDP Network Server, follow “Adding a Device” in paragraph 10.4.1 above. In the
Device Selection window, click on the Remote button. The following screen appears:

Figure 178: Forensic Explorer Remote Server Connect Settings

.5} Remote Server Connect Settings — U
Connect | Speed Test | Log
Server IP Address |192.168.100.102 Port |443 =
Mo. of 8k Pages |7 =
[ Use Compression {Only for slow connections)
IUze Checksums
[ |use Enayption -1 =
WAC: GetData Boot 455,76 GB
WAD: GetData Test ... 1.82TB
WL IF: CODEMETER 38.6 MB
\\ \PHYSICALDRIVEQD VW \PHYSICALD. .. 455,75 GB
|\ \PHYSICALDRIVE 1 \\ \PHYSICALD. .. 182 TB
\\ \PHYSICALDRIVES \\ \PHYSICALD. .. 39.3MB
Ok Cancel
Server IP Address: Enter the IP address of the remote computer as displayed in the Server IP field of the
GetData UDP Network Server.
Port: Ensure the Port number uses the same port as the GetData UDP Network Server

(default is port 443).

Click the Connect button to view the available physical and logical devices on the remote computer. Select the
required device and click OK.
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The selected device should now appear under the Networked section of the Device Selection window, as show
in Figure 179 below:

Figure 179: Device Selection window showing a UDP connected network device.

B Device Selection = B
Select the Device you want to analyse:
Device Label Size F5
= ';,,‘,1_ My Computer
+ E HDO WDC WD7500BPKX-00HP] 01.... 698,64 GE
+ E HD1 WDC WD7500BPKX-00HP] 01.... 698,64 GE § Add RAID
+ E HD2 SanDisk SDESE1IM256G 1002 ... 238,47 GB
£ ﬂ HD3 WIEL - CodeMeter-Stick v1.0 39.3ME
_ @ Network
= Ma¥ networked
=,
= E- 192.168.100.102 (443)
" Remove
5 C:  \\.\C:Pages-7 Encrypt-0 Hashed 465,76 GB -
‘ a,‘ Refresh
K Cancel

Click OK to begin processing the drive.

10.4.3 ADDING A FORENSIC IMAGE

To add an image file to a case:
1. Create a preview (see 10.1), a new case (see 10.2), or open an existing case (see 10.3);

2. In the Evidence module, click the Add Image button. (If the Add Image button is inactive, click on the
case name in the evidence window to activate the buttons).

Note: Due to the low-level processing requirements of most forensic investigations (e.g., sector level
keyword searches, indexing, etc.) it is recommended that image files be located on a high-speed device,
such as a local hard drive (minimum USB2 speed).

3. Click OK to add the forensic image. The Evidence Processing Options window will open. See section 0
below.

A manual sector size adjustment in the Evidence module allows users when adding evidence to manually cater
for Advanced Format Drives (512e) with 4096-byte physical sectors which report as 512-byte logical sectors.
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This is achieved by selecting Add with Options in the drop-down menu in Add image:

Evidence
&= New Case 8 (1)
Radidaice [ 18017701 DellLaptop E01 (0)
Addimage ~
B3 Add Image Options L\@ — m] X
[y Agd file
- Options
I Add image |- & sddremote Sector Size:! _
] & Add folder

Add image ’
¢ Add group Cancel

Add with Options... & Remove

. ADD WITH OPTIONS
There are three common hard drive types that a forensic examiner may encounter:
1. "512" with 512-byte physical sectors reporting as 512-byte logical sectors.

2. "Advanced Format Drives (512e)" with 4096-byte physical sectors which report as 512-byte logical
sectors.

3. "4K native" with 4096-byte physical sectors which report as 4096 physical sectors.

How a hard drive is recognized can depend on the third-party device through which it was accessed (e.g., USB
hub, write blocker, forensic image hardware). For example, some third-party devices may recognize 512e drives
as 512:

"Many host computer hardware and software components assume the hard drive is configured around
512-byte sector boundaries. This includes a broad range of items including chipsets, operating systems,
database engines, hard drive partitioning and imaging tools, backup and file system utilities as well as
a small fraction of other software applications. In order to maintain compatibility with legacy computing
components, many hard disk drive suppliers support Advanced Format technologies on the recording
media coupled with 512-byte conversion firmware. Hard drives configured with 4096-byte physical
sectors with 512-byte firmware are referred to as Advanced Format 512e, or 512 emulation drives."
(https.//en.wikipedia.org/wiki/Advanced_Format, accessed 1 August 2019).

"The translation of the 4096-byte physical format to a virtual 512-byte increment is transparent to the
entity accessing the hard disk drive. Read and write commands are issued to Advanced Format drives in
the same format as legacy drives. However, during the reading process, the Advanced Format hard drive
loads the entire 4096-byte sector containing the requested 512-byte data into memory located on the
drive. The emulation firmware extracts and re-formats the specific data into a 512-byte chunk before
sending the data to the host. The entire process typically occurs with little or no degradation in
performance." (https://en.wikipedia.org/wiki/Advanced_Format, accessed 1 August 2019).

In the case where a 512e drive is mis-identified during acquisition, to load the forensic image into FEX it will be
necessary to adjust the sector size to correctly parse the file system.

More reading:

https://en.wikipedia.org/wiki/Advanced Format

https://digital-forensics.sans.org/blog/2010/07/28/windows-7-mbr-advanced-format-drives-e512
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10.4.4 ADDING A CORRUPT FORENSIC IMAGE

1. During the add image process a validity test for .EO1 and .EXO01 files is conducted to determine if:
a. theimage setis complete (i.e., all segments are present); and

b. that the image has a valid structure (IMPORTANT: This is validation test only and does NOT
replace the need to hash verify).

2. Ifan erroris detected a message box will display:

Figure 180: Invalid image (missing segment)

Error pod

e Error reading image:

Ef--- TRAIMING ---\2. Evidence\Op Payback -
Hsl\Mary Thomas Hamilten' 1207707 Dell
Laptoph 12071701 Dell Laptop.EO7

MISSING segment

Do you want to continue?

Clicking the Yes button will continue to add the corrupt image. Any missing or corrupt data is replaced by
zeros. A corrupt image that has been added to Forensic Explorer is identified by a red X on the image icon,
as shown in Figure 181: Icon showing a corrupt image has been added to Forensic below:

Figure 181: Icon showing a corrupt image has been added to Forensic Explorer.

H&-&-e
1T Evidence File System ﬁ Art
a \ ¥ = O

Recover File T  Shadow Signature T Expa
Folders Carve Copy Analysis File]

Folders Categories

Filter: v | =

T[] 2= Mew Case 4 (1) [Local Time]

=2 = 18017701 Dell Laptop.E01 (4) [Local Time]
T[] =g Partition @ 2048 (11) []
C»[] =2 Partition @ 206843 (11) []
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10.4.5 ADDING A REGISTRY FILE

To add a registry file to a new case:
1. Create a preview (see 10.1), a new case (see 10.2), or open an existing case (see 10.3);

2. In the Evidence module, click the Add File button. (If the Add File button is inactive, click on the case
name in the evidence window to activate the buttons). This will open the add file window.

3. Select the registry file and click OK. The Evidence Processing Options window will open. See section
10.5 below.

Note: A registry file can also be added from the File System module. Locate the registry file, right-click and select
Send to > Registry from the drop-down menu. See 16.2 for more information.

10.4.6 ADD FILE

To add a file to a case:
1. Create a preview (see 10.1), a new case (see 10.2), or open an existing case (see 10.3).

2. In the Evidence module, click the Add File button. (If the Add File button is inactive, click on the case
name in the evidence window to activate the buttons).

3. Click OK to add the file. The Evidence Processing Options window will open. See section 10.5 below.
The file will be added to the File System module.

10.4.7 ADD FOLDER

The Add folder button enables the investigator to add a folder full of files to a case (for example, a folder
containing Microsoft Word documents). Add Folder will add all files, including subfolders and their contents.

To add a folder to a case:
1. Create a preview (see 10.1), a new case (see 10.2), or open an existing case (see 10.3).
2. Inthe Evidence module, click the Add Folder button.

3. Inthe Browse to Folder window, navigate to the required folder and click OK. The Evidence Processing
Options window will open. See section 10.5 below. The contents of the selected folder (and subfolders)
will be added to the File System module.

10.4.8 CREDENTIALS

The Credentials button is a repository for case Bitlocker and APFS passwords and/or credential files. If an
encrypted drive is detected Forensic Explorer will cycle through this list to locate the valid password.

Important: This functionality is not intended for password cracking. Windows will force a delay between
password attempts. For speed purposes, it is recommended that no more than 10 passwords be added to this
list.
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Figure 182: Credentials Edit.
B Credential Edit

Text Passwords  Credential files

Password List: {one per line)

Password
password1
Otmary 1234
1234586,
123456789,
gwerty.
password,
12345|
12345678
Otadam1234

Iripart. . Expart..

« [ ome ]

When an encrypted partition has been accessed using a password, the password is displayed in the tree view,

as shown in Figure 183 below .

Figure 183: Encryption Password.

Folders Categories

Filter: [ Mo Filter

Filename

C:[] g Mew Case (4) [Local Time]
=[] [} 20017703 - BITLOCKER - Thumbdrive 2 Smart USB.E01 (2)
-] @ Bitlocker Partition (7) [] [0tadam1234]
= [ 20013704 - TD2SMART G3 USE APFS Encryp
C:[] = EFI Partition @ 40 (5)
BT @ CLEAN (5) [0tadam1234]
=] [ 20013705 - FILEVAULT - ScanDisk Ultra ™
C-C>[] i=g EFI System Partition (EFI 1) (7)
Cr[] 5 orphaned (0)
C:] ) Root (1)
-] @ EFI Partition @ 409640 (10)
T[] [ Apple (14)
C:[[] 5 orphaned (0)
[ = Booter (EFI 3) (10)
=-Cx [N 20081701 - Thumbdrive.E01 (2)
L[ g Bitlocker Partition (0) [ 1

[Dtadam 1234]

Credentials are case specific. If credentials are used between cases, the Import and Export buttons can be used

to save and load them for each case.

Copyright GetData Forensics Pty Ltd 2010 - 2024, All rights reserved.



184 | Page Chapter 10 - Evidence Module

10.5 EVIDENCE PROCESSOR

The Evidence Processor window opens when evidence (a device, image, or file) is added in the Evidence module.
The Evidence Processor window has two functions:

1. To configure the processing options that will automatically take place when the evidence is added;

Note: Evidence processing tasks, such as file carving, do not have to be automatically run. They can be
individually run later in the case.

and:

2. To enable the forensic investigator to modify dates and times in the evidence relative to the time
zone in which the evidence is situated or was acquired.

Note: Time zone settings can be configured or adjusted later in the case from the File System module.
See Chapter 21 - Date and Time, for more information.

Forensic Explorer determines the type of evidence added (e.g., device, forensic image, registry file, or other file)
and displays a default tasks list per the file type.

Copyright GetData Forensics Pty Ltd 2010 - 2024, All rights reserved.



Chapter 10 - Evidence Module 185 | Page

Figure 184: Evidence Processing Options (showing options for a forensic image or device)

Evidence Processor

Evidence Mame: 20011702 - Dell Laptop.E01

(DEFALLT)

Tasks
[ FileSystem
<@ Process in Paralel
5% Verify Device Hash
&% Search for 15O Tracks (CD/DVD)
% Search for MBRs
L% Search for FileSystems
% Signature Analysis
s Compound File Expansion
Process in Parallel

¢
- [T

=
[=1)

o b

OOO000000OREEOOEE m

.7 Hash Files

"2 Entropy Files

"0 Extract Metadata
i File Carve

% Mew Index

-5 Cache Thumbnails

“n Cache Video Thumbnails

EETEETETRETLCERR

- Adjust Time Zone Settings

TimeZone: UTC {(+00:00) i
TimeZone Mame: {0 mins)

Daylight Savings: {0 mins)

STD,/OLS Bias: i} j o minutes

Cancel

The Evidence Processor window enables the investigator to configure specific tasks (such as hashing, signature
analysis and file carving) that will automatically take place when evidence is added. Whilst it is possible to
perform these functions independently later, the processing window enables the investigator to batch these
tasks at the start of the case.

The Evidence Processor window uses the following icons:

Parent / Child: Indicates a parent / child relationship between tasks. A parent tasks must be
completed before a child task can commence.

'@ Process in Parallel: Identifies that the tasks listed in the immediate sub folder will process
concurrently in separate threads.
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iy A task: Indicates a task that can be enabled or disabled.

[ Task options: Identifies those settings for the task must be configured if it is enabled.

CUSTOM PROCESSING PROFILES

At the top of the Evidence Processor is a drop-down menu and save button that enables the investigator to save
and load custom Processing Profiles. Saved profiles are stored as .txml files in the “Documents\Forensic
Explorer\Startup\” folder. Forensic Explorer will default to the last used task (as stored in the registry).

When a different profile is selected from the drop-down menu the following warning message is displayed:

Figure 185: Changing the evidence processing profile.

Warning >

Loading a new set of Tasks with remove all existing tasks
Are you sure you wish to continue?

Yes Cancel

. DEFAULT TASKS

The default settings in the Evidence Processing window when adding a device or an image file is to read and

display existing file systems.
Search for Known MBRs

A Master Boot Record (MBR) is the very first sector on a hard drive. It contains the startup information
for the computer and the partition table, detailing how the computer is organized.
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Search for File Systems

Once an MBR is identified, Forensic Explorer then locates and identifies known file systems (i.e., FAT,
NTFS, and HFS). The file and folder structure can then be read and populated in the File System module.

If these default tasks are not enabled, the device or forensic image file will be loaded as raw data with no file or
folder structure.

. OTHER TASKS
Triage

The triage process runs scripts that extract data from the File System and Registry files. Items identified are
bookmarked and can be seen in the Bookmarks module under the path: My Bookmarks\Triage\Registry\. These
bookmarks are used to generate the Triage report.

Verify Device Hashes

The “verify device hashes” task calculates a hash/s (MD5, SHA1, or SHA256) for the added device or forensic
image.

If the forensic image was created with EnCase®, the calculated hash/s can be compared with the acquisition
hash stored within the forensic image to show that it has not been altered. The result of the hash is written into
the evidence tab of the Evidence module (as shown in Figure 186 below):

Figure 186: Evidence module, Evidence tab, device hash

s P e e T

Description LEXAR LSE

Motes This is an EnCase 7EQ1image of a 7gb lexar usb test disk
Aquiring Programm 7.3.1.203

05 Version Windows 7

Aguired Date 17-May-12 2:25:55 PM ,ﬂncquisitinn Hash

aystem Date 17 May-12 2:25:51PM

Compression Unknown

Password 0 Verification Hash
Encase Hash(MD5) OFS3EBOS4/FF39C 15980 76948 3498 CEE ‘/
Hazh(MD5) OFS3EBOS47FF 39C 15980 76948 344BCEE

Hash(SHA1) 626786505244 CEBEEDEFD1C 52870 A0EC SE10SEAF
Hash(SHAZ256) 928 10E90EB 12D4CFDF SFD3E9F 280 4F0DESS SE 764 38C0E. ..

A device hash can also be calculated at any time using the Verify Devices script. This script can be run either
from the “Analysis Programs” button in the File System module, or directly from the Scripts module. See 22.4
for more information.
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Signature Analysis

Signature analysis is the process of identifying a file by its header rather than by other means. For example,
identifying a file by its signature is a more accurate method of classification than using the file extension (e.g.
.jpg), as the extension can easily be altered.

The signature analysis task can only take place after the identification of a file system. For this reason, it is a sub-
task of “Search for FileSystems” (as shown in Figure 184 above).

Signature analysis can also be independently run in the File System module. Learn more about signature analysis
in Chapter 23.

File Carve
File carving is the identification and extraction of file types from unallocated clusters using file signatures.

File carving can only take place after the identification of a file system. For this reason, it is a sub-task of “Search
for FileSystems” (as shown in Figure 184 above).

File carving can also be independently run in the File System module. Learn more about file carving in section
24.4,

Extract Metadata

Extract Metadata is used to collect internal file data and make the information available in columns. For example,
for a digital photo, metadata can include camera Make and Model, and the GPS coordinates of the photo.

The Extract Metadata option runs a script located in the Scripts module in the path \File System\Metadata to
columns\Extract Metadata.pas. Once the data has been extracted, the metadata columns can be added to a list
view.

PROCESSES LIST

When tasks are run in Forensic Explorer its progress is detailed in the “Processes” list. This list is accessed globally
from any Forensic Explorer Module by clicking on the “Processes” tab in the bottom right-hand corner of the
main program screen.

10.5.2 ADJUST TIME ZONE

File date and times can be adjusted for each piece of evidence as it is added to a case. File date and times are
adjusted per the time zone from which the device or forensic image originates.

The default setting is to process the image per Local Time, that is, the time zone setting on the forensic analysis
computer. If the device or forensic image originates from the same time zone as the forensic analysis computer,
then usually no adjustment is required.

If the device or forensic image is collected from a different time zone, change the Time Zone setting to the source
location to display file date and times per that location.
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Note: Dealing with date and time issues in computer forensics is complex. Additional date and time adjustments
can be made from the File System module once the evidence has been added. Refer to Chapter 21 for further
information.

Figure 187: Adjust time zone information when adding evidence.

[t P e, A, e ey oy Ry ey Y e e ey i, e e Py e, T Ay e e Ay Pl

Adjust Time Zone Settings

TimeZaone: Local Time -

TimeZone Mame: ALIS Eastern Standard Time (-600 mins)
Daylight Savings:  AUS Eastern Daylight Time (-660 mins)

STD/DLS Bias: -500 J 660 minutes

| QK |[ Cancel ]

10.6 ADDING ADDITIONAL EVIDENCE TO A CASE

‘ r

Once added, a device, image, or registry file will appear in the “Evidence” field of the Evidence module, as shown
in Figure 188 below:

Figure 188: Evidence module, Evidence list

Evidence
) ] g Mew Case 43 (4)
haidd deuice { |:N 18013701 Dell Laptop.ED1 (0)
Add image >£| €
J [} pEmMo 7.E01 (D)
“ [ ExportFiles.L01 {0
@Mdﬁle gxpor iles ()]
@ Add remote
Cg Add folder
9 Add group
% Remove

To add an additional device, image, or file:
1. Click on the case name (e.g., “Case: New Case 43” above) to activate the add buttons.

2. Repeat the process described above.
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10.7 SAVING A CASE

To save a preview, or save changes to an open case, click the Save button in the Evidence module:

Figure 189: Evidence module, save button.

Save

Or:

In the Forensic Explorer drop-down menu, select “Save”:

Figure 190: Save Case.

Orens gplore L—J

Save

Investigators...

Opticns

Layout k
lcon Editors k
Feedback...

License Manager...
About..,

Help

@eoeE @08 I

Exit

A case should be saved frequently to ensure that any changes from the last save are not lost.
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10.7.1 AUTO SAVE

A Forensic Explorer case can be set to auto-save at regular timed intervals. To configure auto-save options, in
the Forensic Explorer drop-down menu, select Options > Case, as show in Figure 191 below:

Figure 191: Setting auto-save options.

Options n

£ General | L Case

Backup Settings

Mumber backup saves
Save automatically every minutes

Reset Default

Reset All Options: Defaults Save Cancel

Saves are written to the root of the Case folder. The current case file is fe.rsv.

During the save process a temporary file is written called ~fe.rsv. On completion of a successful save the
temporary file is renamed to fe.rsv. Therefore, if a save is not successful, the current case file with be the last
successfully written fe.rsv.

When a successful auto-save takes place, if the previously saved file was initiated by the user (i.e., by pressing
the save button) the file is named fe.0001.rsv. If the previous saved file was an auto-save the file is backed up
as fe.0001.auto.rsv.

LOADING A PREVIOUS SAVE
There may be a situation where the investigator needs to load a previous save. To do this:

1. If acaseisrunning, save the current case and consider taking a backup of the current case using the
cog icon menu option at the top of the Forensic Explorer window.

2. Close the current case (see 10.8 below).

3. Open the cases folder in Windows Explorer (the default location is ..\Documents\Forensic Explorer
v5\Cases\[Case Name]) and list the fe.rsv files described above. Sort by the Windows date/time
properties to determine the date and time of the previous saves.

4. Drag and drop the selected .rsv file into the top right-hand window of the Forensic Explorer Evidence
module. Follow the prompts and the case will open.
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Figure 192: Drag and drop a .rsv file to load a previous save.

I Evidence |

B ~dd device

Addimage -~

[y Add file

g Add folder

I-ﬁl Add group

ﬁ Add remote

% Remaove

_° Credentials..

Mame

—

AttachedEvidence
DTSearchindexes
Exported

Logs

EF B R

D fe.0002.auto.rsv
D fe.0003.auto.rsv
D fe. 0004, auto.rsv
D fe. 0005, auto.rsv

T « Cases » New Cased

18 )]

31 items 1 item selected 116 KB

e

Each preview is assigned a unique working folder using a Global Unique Identifier (GUID) in the following path:

C:\Users\Graham\Documents\Forensic Explorer\Previews\{GUID - e.g., 8709A41C-38B6-4F9E-BA18-

633B394721C5}

When the investigator has finished the preview, analysis conducted during the preview may be:

1. Saved as a new case (see “saving a case” below). When a preview is saved the contents of the GUID
working folder is transferred into the new case folder and the GUID folder is destroyed.

2. Closed and not saved (see “closing a case” below). When the case is closed and not saved, or when

Forensic Explorer is opened or closed, the preview GUID folder is destroyed.

10.8 CLOSING A CASE

To close a preview or a case use the Close button in the Evidence module:
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Figure 193: Evidence module, Close button

=

Close

Case changes are NOT saved on close. If there are unsaved changes the following confirmation message box will
appear:

Figure 194: Close confirmation message

Confirm ot

o Any changes since the last save will be lost,
Continue?

Cancel

Click OK to close without saving.

To save changes, click the Cancel button, return to the Evidence Module, and use the Save button.
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Chapter 11 - File System module
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11.1 FILE SYSTEM MODULE

The File System module is accessed via the “File System” tab:

Figure 195: File System module tab

| File System

The File System module is the primary Forensic Explorer window where actions such as highlighting, selecting,

sorting, filtering, flagging, exporting, and opening occur.

For more information on these actions, see Chapter 9 - Working With Data.

11.2 TOOLBAR

At the top of the File System module is the ribbon. The ribbon is a toolbar to hold buttons that perform functions
of the program, such as hashing, data recovery or running scripts. It can also be used to create shortcuts to
external programs.

The content of the ribbon in File System view is populated at startup by the startup.pas script. After this,
individual buttons or button groups can be added and removed by running scripts. See Chapter 19 - Scripts
Module, for more information on toolbar scripts.

11.3 FOLDERS VIEW

Folders view is in the top left-hand window of the File System module.

The Folders view is a hierarchical display of items (e.g., devices, partitions, folders, etc.). Like Microsoft’s
Windows Explorer, the Folders view is most used to select a folder, causing the contents of the folder to be
displayed in the adjacent List view (described further below).

At the top of Folders view is the case name which acts as the root container for all other data. The case is the
root of the tree from which all other data in the tree may be explored.
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Figure 196: Folder s View

Folders Categories

Filter: |= Mo Filter v |

C>[] =2 Test case 1 (1) [Local Time] ”
=- T[] 18011101 Dell Laptop.E01 (4) [Local Time]
B L[] =g Partition @ 2048 (11) []
C- Orphaned (8)
= C+[] [ Root (38)
E- T[] [ Extend (16)
C:O [ ¢Deleted (@)
E- O ) $RmMetadata (11)
G 1 smxf (@
C-[ STxfLog (5)
B+ T[] [ $RECYCLE.BIN (8)
C»[0 [ 5-1-5-21-1285875549-1802
C»[0 [ 5-1-5-21-2182880995-4263
C»[0 [ 5-1-5-21-2720337155-3299¢
£+ T[] ) Boot (54)
C:O ) esCZ (1)
CO 1 daDk (1)

Note: The blue number in brackets, e.g., “(2)” counts the number of items inside the folder (but does not count

the contents of sub folders).

11.3.1 FOLDERS ICONS

The following icons are used in Folders view:

g “Preview” (indicating a case has not yet been saved) or Case name
ﬂ A device, e.g., a hard drive or camera card
A forensic image (the purple flag indicates a bookmark)
ﬂ A corrupt forensic image (the purple flag indicates a bookmark)
= Boot partition
== Partition
An expandable branch (folder structure)
An active folder

=] A deleted folder

k Folders containing the results of a file carve. For more information about file

caving see chapter 24.4 - File carving.
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One of the folders displayed in Folders view is ‘Orphaned’. Orphans are deleted folders and files for which the

original parent folder is unknown. For more information on orphaned files see “24.3.2 - NTFS - orphans”.

The drop-down filter at the top of the folder tree has a number of available filters. A search bar enables fast
access via filter name:

‘ Folders Categories

Filter: L Mo Filter w

B[] & =) (az |Fiter

5 B

G g @ [ Bookmarks (11)
o

@
=

2]

- |3 Custom (3)

- [ Date (3)

- [y Deleted (2)

- [y Duplicates (2)

- [y Encrypted (2)

- [y Expanded (3)

- [C File Name (4)

|3 Files (25)

- [y Flagged (11)

|-y Folders (3)

- [-3 Hash Match (5)

“ [y MAC (1)

- [y Phone (8)

- [ Photos (2)

- |y Read From File (4)

- [ Signature Mismatch (3)
- Ly Size (9)

- [y Video Keyframes (2)
- Ly Virus (2)

[ Windows (6)

A Create Drop-down Filter script enables custom filters to be added within File System > Tools > Create Drop-
down Filter:

Add/Remove - Bookmark CETS Categories
Add/Remove - Investigator Motes

4 Add/Remove - RamDisk Tools

E Add/Remove - Reference Library

Clear Column Content

Show/Hide Metadata Columns
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11.4 CATEGORIES VIEW

Categories view is in the in the top left-hand window of the File System module next to the Folders view Tab.
The Category view displays items grouped by criteria. The following category views are available:

Figure 197: Categories view

Folders Categories

£% Rebuild

= Cr[] categories (3)
- [0 %& Evidence (1)
- [0 4 Deleted Items (27)
- D[] & Ccarved Files (0)
- [ ] Bockmarks (1)
- O B Email Files (3)
-~ [[] &% Registry Files {9)
- ] @) Files by Signature (2)
& [ @) Files by Extension (37)
& ] A Flags (8)

Note:

1. A single file may appear in multiple categories. For example, a deleted JPEG will appear under the
categories “Files by Extension > JPEG”, “Deleted”, “Modified Date”, and any other category folder for which
it meets the criteria.

2. Categorization of items takes place when a case is opened. If case meta-data is created by the investigator,
e.g., files are hashed, skin tone analysis is run, flags are added etc. it is necessary to “rebuild categories”
before these items will appear in their respective categories.

To re-categorize:
1. Use the “Rebuild” button or right click inside the category view window.
2. Select “Rebuild” from the drop-down menu.

The new case metadata should now appear in the respective categories.

11.4.1 FILES BY EXTENSION

Files without extension

Files without extensions will not appear in the Files by Extension Category unless a File Signature Analysis has
been run and the categories rebuilt.

Once a Signature Analysis has been run, if it is a recognized signature, files without an extension will be placed
in their relevant category (after a category rebuild) based on the file type identified in the file header.
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11.5 FILE LIST VIEW

File List is in the top right-hand window of the File System module. File List displays content per the selections
make in Folders view (described above). File List view presents the metadata for each item (including file name,
extension, full path, etc.) in a table format. It allows items (such as: devices, partitions, and files) and their
metadata to be sorted, highlighted, checked, flagged, opened and exported. For more information on these
functions, see Chapter 9 - Working With Data.

The following icons are used in File List view to describe items:

Free space on disk
Free space in partition
Unallocated clusters on NTFS volume

An active file

A deleted file

A deleted folder

A system file

A FAT “dot” directory entry

=
=
=]
=
| Anactive folder
=
=)
B
B
B

A FAT “double dot” directory entry

The File List uses the following color to identify specific items (an example is shown in Figure 198 below):
Item: Black

Operating System Compressed: Blue

Encrypted: Green
Expanded: Purple
Alternate: WebOrangeRed
System Files: Maroon

Items displayed by FEX: SteelBlue
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Figure 198: File List colors

[ File List Gallery View Video View [ Disk View
53 (=) 8| (a2~ Flename
Filename
- 1 [® 20013702 - Dell Laptop.ED1
O] 2 =g Partition @ 2043
] 3 . Partition @ 206348
] 4 My Fie Carve PG
Il 5 || Free Space on Disk
l 6 [Z] Master Boot Record
] 7 Root
] 3 Orphaned
|:| 9 || Free space in Partition
] 10 |2 Lost OS Clusters
O] 11 [C) NTFS Volume Boot Record
] 12 [0 Root~$130{$90)
] 13 [0 Root~SI30(5A0)
O 14| [ Root~$I30(380)
] 15 [] Root~$T¥F_DATA($100)
] 16 [O] Root~($50)
] 17 || Unallocated dusters on MTFS volume
] 18 SExtend
] 19 Boot
] 20 System Volume Information
] 71 ERECYCLE.BIM
-l 22 ] sAttrDef
Il 23 [0 sAttrDef~{550)
l 24 [ sBadClus
-l 25 D sBadClus~5Bad

11.5.3 FILE LIST METADATA COLUMNS

File metadata is displayed in columns. These columns include:
File Name: The name of the item (system file, partition etc.) or the name of the file.

Extension: The suffix to the file name, for example .jpg, which indicates the file format. This
column reports the given file extension only and does not validate it as correct.

Flags: A colored flag was added by the investigator to mark a file.

Full Path: Displays the location of the file. The case name examined device name is included
in the path.

Attributes: File attribute settings:

e (-5 are normal DOS attributes.

e 6-15 are NTFS attributes.
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File Signature:

Logical Size:
Physical Size:
Modified:

Created:

Accessed:

Bookmark Folder

Is Deleted:

Additional information is available https://msdn.microsoft.com/en-
us/library/aa365535%28v=VS.85%29.aspx (Other OSs are mapped to these when
available)

Bit 0: r - Read only

Bit 1: h - Hidden

Bit 2: s - System

Bit 3: v - Dos Volume

Bit 4: d - Dos Directory

Bit 5: a - Archive

Bit 6: D - Device

Bit 7: N - Normal

Bit 8: T- Temporary

Bit 9: S -Sparse

Bit10: R - Reparse/Symbolic Link

Bitll: C- Compressed

Bit12: O - Offline

Bit13: | - Not Indexed

Bit14: E - Encrypted

Bit15> 'X' - Other higher flags (not yet determined), but typically are associated
with NTFS system files such as SObjID etc. that are in the reserved SMFT area, but
also can exist on other files.

This column receives data after a file signature analysis (see Chapter 23 - File
Signature Analysis). If the column contains an extension, it means that the file
signature has been identified.

The size of the file in bytes.
The total size of the clusters occupied by the file.
The date and time that a file was opened, edited, and saved.

The date and time a file was created in its current storage location (not necessarily
the original creation date of the file itself).

The date and time a file was last accessed. Note that automated activities, such as
a virus scanner, may cause the last accessed date of a file to be updated.

A folder into which a bookmarked file is placed in the Bookmarks Module.

True or false to indicate whether a file is deleted.

It is possible to add columns using a script. An example of this is where the metadata values from a Microsoft

Word document, e.g., Author, Title etc. are extracted and placed into columns. See 8.13.1 for more information.
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11.6 OTHER DATA VIEWS

Other data views used in the Files System module includes those summarized in the table below. For more
detailed information on each view, see Chapter 8 - Data Views.

Data View Summary of Function

(& Disk View A graphical display of the sectors which make up the examined
device.

Gallery View A thumbnail presentation of the graphics files.

ag

] Hex A hexadecimal view of the currently highlighted data. Hex view
includes a Data Inspector window where a highlighted block of
Hex is dynamically decoded.

= Text A Text view of the currently highlighted file.

|“='_I Display A preview of the currently highlighted file.

Displays information contained in the MFT record or FAT entry

= | Filesystem Record
for the currently highlighted file.

Identifies the location of the highlighted file on the disk. It

= | File Extent
details the start, end, and length of each data run on the disk.
1| Byte Plot A graphical. rep'resenta.tion of byte level data within the
f— currently highlighted file.
= Bookmark View bookmark information for the item.
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11.7 FILE SYSTEM TOOLBAR

The File System module Recover Folders and File Carve buttons are used for data recovery. See Chapter 24 for
more information.

Figure 199: File System module, Recover Folders and File Carve buttons

PR

Recover File
Folders Carve

The File System module Shadow Copy button is used to add shadow copy volumes to the case. See Chapter 26
for more information.

Figure 200: File System module, Shadow Copy button

4

Shadow
Copy

The Cisco Clam Anti-Virus (ClamAV) toolbar button in the File System module enables the forensic investigator
to run a virus scan over the case:

Figure 201: File System module, Cisco Clam Anti-Virus

Cisco Clam
Anti Virus

 ABOUT CLAMAV

In 2013, Cisco System acquired the rights to ClamAV (https://en.wikipedia.org/wiki/Clam_AntiVirus, Accessed

November 2017). “ClamAV” is an open source (GPL) anti-virus engine used in a variety of situations including
email scanning, web scanning, and end point security. It provides a number of utilities including a flexible and
scalable multi-threaded daemon, a command line scanner and an advanced tool for automatic database
updates”. (https://www.clamav.net/about, Accessed November 2017). ClamAV documentation is available at

https://www.clamav.net/documents/clam-antivirus-user-manual.

UPDATING THE CLAMAV VIRUS DATABASE (CVD)

ClamAYV Virus Database updates are released daily. It is recommended that these files are updated frequently.
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CLAMAYV VIRUS DATABASE UPDATE BUTTON

To update the ClamAV Virus Database files using the Update button (an internet connection is required):
1. Click on the Options tab.

2. Select the database path. The default path is C:\Program Files\GetData\Forensic Explorer
v4\ClamAV\database\.

3. Click the Update button.

4. A Command window will open and commence download of the latest ClamAV database files, as shown
in Figure 202: Update of ClamAV database files below:

Figure 202: Update of ClamAV database files

B® Scanning with Cisco's Clam Anti Virus Options — O et

MName:

|5canning with Cisco's Clam Anti Virus

Scan  Options  About

Clamay Database folder: |C: \Program Files\GetData\Forensic Explorer v4\Clamavidatabase =

Update Database: Update

BN CAWINDOWS\system32\cmd. exe — O e

is up to date (version:

(version: 3 igs: 75, evel: 63, buil

Logging: | Mormal " Pricrity: [RERE »

Scan Cancel
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5. Exit the Command window.

CLAMAV VIRUS DATABASE MANUAL UPDATE

To manually update the ClamAV Virus Database files:

1. Using an internet connected computer, visit the web page: https://www.clamav.net/downloads.

2. Inthe Virus Database section, download the main.cvd, daily.cvd and bytecode.cvd files.
3. Copy these files into the C:\Program Files\GetData\Forensic Explorer v4\ClamAV\database\ folder.

4. Follow the instructions below to run a scan.

 RUNNING A SCAN
To run a ClamAYV scan of a case:
1. Click the Cisco ClamAv Anti-Virus button in the File System module toolbar.

2. Follow the instructions above to update the ClamAV Virus Database files if required.
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Figure 203: ClamAV Virus Scan

B scanning with Clam Anti Virus Options = O X
Process Name:

Scanning with Clam Ant Virus

Scan  QOptions About
Source
0 searchable items (1425 items  1.87 GB)

Checked items (0 items 0 bytes)

Scan Oplions
B Quick scan (filetypes: 7Z, CAB, DLL, EXE, JAR, MSI, RAR, SRC, 5Y5, ZIF)
Maximum file size to scan: 5 * MB (0 = No size limit)

() 5can for Potentially Unwanted Applications (PUA). This may produce lots of false positives.
B Indude custom YARA signatures located in the ClamAV Database folder.

[ JHeuristic scan. Detects OLE2 macros, filetype mismatches, encrypted files, 55M and credit card numbers.

Output
B Flag infected files with: | I Red Flag v
B Bockmark infected files

B dd new column showing infection status

Insert new column at position: 3

Ar

Logging: MNormal b Priority: | Normal w

Scan Cancel

3. Select the Source files to scan: Searchable items, Highlighted items, Checked items.

4. Set the Scan Options.

Quick Scan Scans common file types. See:
https://www.clamav.net/documents/on-access-
scanning

Scan for Potentially Unwanted Applications See:
(PUA) https://www.clamav.net/documents/potentially-
unwanted-applications-pua

Include custom YARA signatures located in  See Custom Yara Signatures below.
the ClamAV Database folder.

5. Select the Output options.

Flag infected files with: [Flag Color] A flag is added to the File System module
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Bookmark infected files A bookmark is added to the Bookmarks module
under the Virus Scan bookmark folder

Add new column showing infection status The Virus Name column is added to the File System
and Bookmarks module giving the identified virus
name.

6. Click the Scan button to start the scan.

CUSTOM YARA SIGNATURES

Yara is “a rule-based approach to create descriptions of malware families based on regular expression, textual
or binary patterns. A description is essentially a YARA rule name, where these rules consist of sets of strings and
a boolean expression”. (https://en.wikipedia.org/wiki/YARA - May 2020).

Yara files (either .yar or .yara) are placed in the root of the ClamAV Database folder:
C:\Program Files\GetData\Forensic Explorer v5\ClamAV\Database

To match against yara rules, place a check in the Include custom YARA signatures located in the ClamAV
Database folder checkbox.

The following sample yara file will match against PDF and PNG files in a Forensic Explorer case:

Figure 204: Sample yara file (Source: https://support.phishingtackle.com/hc/en-gb/articles/4410170814609-YARA-Rule-Examples).

|=| pdf_and_pngyar E3 l
1 |rule PDF_and PNG
2 {
% strings:
4 tHex PDF
S $Hex PNG

[ 25 50 44 46 )
[ 89 50 4E 47 0D 0OA 1A 0L }

condition:
any of them

9 1

The Clam Anti Virus log file will detail the matched yara rule(s) and corresponding files:

Figure 205: Yara log file.

[& Log
Scanning with Clam Anti Virus
Scanned: 1392, Infected: 954, Problems: 0 J4 Remove

11.7.3 HASHING

The File System module hash buttons are used to hash case files. See Chapter 22 for more information.
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Chapter 12 — Artifacts Module

In This Chapter

CHAPTER 12 — ARTIFACTS MODULE
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ARTIFACTS

Although widely used in computer forensics, the term Artifact is not well defined. As Vikram et al. discuss, this
can result in a “in a lack of standardized reporting, linguistic understanding between professionals” (10).

A broad-based definition or an Artifact is ‘an item of digital interest’. In practical terms artifacts can include:
e  browsing history.
e call history.
e chat text.
e  Operating System records, etc.

The term artifacts are also used to describe the container of the items of digital interest, such as SMS database,
a browser history, or a chat history file.

The proliferation of ‘Apps’ has meant that there is more artifact data than ever before, often spread over
multiple devices including phones, tablets and computers.

12.1 ARTIFACTS MODULE

The Artifacts module in Forensic Explorer is designed to make artifact records easily accessible by the forensic
examiner. Artifacts are extracted using one or more of the following techniques:

1. Extraction of records from SQLite database files (Forensic Explorer does not currently extract deleted
records within SQLite files).

2. Extracting of records from Plist or XML format.
3. Carving data from files or unallocated clusters.
4. Other custom extraction.

Artifacts in Forensic Explorer are extracted by scripts. This enables the investigator to examine the exact criteria
used to locate the Artifacts. Scripts are located in the path:

C:\Users\user profile\Documents\Forensic Explorer v5\Scripts\Scripts.en\Artifacts

The Process All button will run scripts for: Browsers, Chat, Email, Mobile, MAC OS, Windows OS, and Social
Media, as shown in Figure 207 below.
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Figure 207: Artifacts, Process All button

H&-@-e
1T Evidence File System ﬁ Artifacts

® @ ® _ % [

Process Browsers M Chat V Email v Mahile

All L}

p Keyword Search ,o Inde

“

WAL
o5

= ©

™ Windowis M Sodial

05 Media

A group of artifact scripts can be run by selecting the Process All option for the group, or individual items can

be selected from the drop-down menu for each group:
Figure 208: Grouped Artifacts

&

Browsers

Browsers - Process ALL

& Chrome

& Chromium

tﬁ' Edge

@  Firefox

£ Internet Explorer 4-9
£ Internet Explorer 10-11
() Opem
0 Safari

A stand-alone Artifact Carve script is available to carve URLs etc. from specific files:

Figure 209: Artifact Carve

Artifact
Carve
| () Carve URLs - Process ALL

b Bing Search URLs
n Facebook Search URLs
E GoogleMaps URLs
{5 Google Search URLs
Pornography URLs
B VYouTube Search URLs
™~ GMail Fragments
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When launched, Artifact Carve provides a second selection window where the carve source is selected,
including carving from Hiberfil.sys, Pagefile.sys, Swap file, and unallocated clusters. The Calc. Size button can
be used to identify the volume of these sources. The length of the search will be determined by the size and
the content of the source files.

Figure 210: Artifacts module, Artifact Carve.

B | Carve URLs (Process All) — O >

Options  About

Carve URLs From:

B Free Space on Disk 0.01GB
B Hiberfil. sys 3.12GB
B Fagefile.sys 0.69 GB
B shadow Copy files 3,44 GE
B swapfie 0.25GE
B Unallocated dusters 251,32 GB
Total Selected: lk

264.59 GB

B Deduplicate (Recommended)

Search Cancel

12.1.1 WINDOWS EVENT LOGS (.EVTX)

From Forensic Explorer v5.4.8(2686) onward (April 2022) Windows Event Log files (.evtx) can be processed in
the Artifacts module. Click on the Windows Event Logs button in the Artefacts module toolbar to extract event
log data from the current case.

Once extract it is possible to use filters, keyword searches, etc. to search for significant records. Records found
can be exported using the right-click export options.
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Figure 211: Windows Event Logs (.evtx)
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Chapter 13 - Keyword Search Module
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13.1 KEYWORD SEARCH

The keyword search module is accessed via the “Keyword Search” tab.

Figure 212: Keyword Search tab

p Keyword Search

A keyword is a user created search expression. A keyword can be a simple text, a more complex “Regular
Expression” (RegEx), or hexadecimal. A keyword search is a search for that data.

Advantages of a Keyword Search:

e A keyword search can be performed on all data in a case, including unused disk space, unallocated
clusters and system files;

e Akeyword search can locate byte level fragments of data;
e Text translations allow the investigator to search for keywords in different languages.
Disadvantages of a Keyword Search:

e Akeyword search can be time intensive. The volume of data being searched, the number of keywords,
and the speed of the computer hardware on which the search is run will influence the duration of the
search.

e Each new keyword, or set of keywords, requires a new search. Because a search can be time intensive,
keyword lists needs to be carefully constructed to ensure to locate relevant data and limit false hits.

e When data is not in raw text format, for example a compressed file, keywords will not be located.
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The keyword search module is broken down into the following four sections:
1. Keyword Management: Used to create and manage keywords and keyword groups;
2. Keyword Tree: List the search results for each keyword, including the number keyword hits;

3. Keyword Result List: Lists the files containing the keyword hits and previews the text around the
keyword;

4. Data Views: Displays the file in which the keyword hit/s was found.

As shown in Figure 213 below:

Figure 213: Keyword Search module
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£ Evidence FleSystem  wiwAriacts | O Keyword Search | O ndexsearch (@ Email [ Registry Bookmarks [ Reports S Seripts
R £ B B B > © B

Add Add Add Import  Export Start Keyword  Keywords
Group  Keyword  Multiple  Keywords  Keywords Search Count In Files

Bl Keyword Management

[E] Keyword Result List Gallery View Video View
Keyword Label Search Term Settings No Filter -

0
«

18 Hits 18 HitOffset ¢ |18 HitC

18 Hit Offset

pmn Keyword Label Search Term =
b [ = Keyword Resuits (1) Filename Hits Hit Text HitOffset (Fle)  HitOffset (Parti... Hit Offset (De
clo =)

5

= ! ] LostFie_JPG_643136.5p9
P quaty = [09][0< quality = [09][... Regex | & [J i Keyword Search (3)

01 2 caoon (18) g ] LostFile_JPG_621056.jpg
O£ helo®) hello ] LostFile_JPG_631424.jpg
O £ aquaity = [0-9](09] (36) quality = [0-9]L... £ 9400-0. 6

] img_9410_1280.3°G
0 & >

0 of 5 Checked | 18 of 18 Visible [72.8 MB] 1 Highlighted [10.7 MB] 0 Checked [0 bytes] DEMO 7.E01\Root\EVW - TEST SEQUENCE\CR? - IMG_0018-2.CR2
T

] img_9458_1280.0PG
] img_9459_1280.0PG
£ CRW.aw

[2) NTUSER.DAT

] CR2-IMG_8272.CR2
h] CR2 -IMG_0018-2.CR2
[2) DLL - Explorerview.dl
) sam

[2) old-pc2.xs

B E e EE

Oo0oO0oooooooooc

A B3

o

DEMO 7.E01\Root\EVW - TEST SEQUENCE\CR2 - IMG_0018-2.CR2
[ Hex = Text [ pisplay |[EZ]Bookmark |=|File Metadata = Filesystem Record

<

3 of 3 Checked

[ Case: New Case 45

Copyright GetData Forensics Pty Ltd 2010 - 2024, All rights reserved.



218 | Page Chapter 13 - Keyword Search Module

13.2 KEYWORD MANAGEMENT

13.2.1 CREATING A KEYWORD

To create a keyword:
1. Preview, create, or open an existing case and click on the “Keyword Search” module tab.

2. To open the Add Keyword window (shown in Figure 12-3 below).

Ty
o
Add
e Click on the Add Keyword button L2 jn the module toolbar (if the Keyword icon is inactive,

highlight the “Keywords” folder in the “Keyword Name” window); or,
e  Right-click in the Keyword Management window and select “Add Keyword”; or,

e  Using the keyboard, select the “CTRL” and “N” key.

Figure 214: Add keyword.

B 24d Keyword O 'Y
Search Type: Text ~
Keyword Label: ‘ |
Search Term: | |
Case Sensitive: [ ]
Status: Text I}
Codepages Help
&[] [ Common ~ Select the required codepages.
- o M@ utFas 1200,1201
. [E) ANSI-LatinI 1252
E uF-7 65000
i @ utFs 65001
i [ [E outiook (ANST) 65003
[0 @& outiock (Unicods) 65004
5 O other
- [] [E 1B EBCDIC - U.5. /Canada 37
[ [E) ©EM - United States 437
[0 [@ 1M EBCDIC - International 500
~ [ [E arabic-asmo 708
[ [E Arabic - Transparent ASMO 720
[0 @ oEM - Gresk 4376 737
- [T1 1Al OEM - Baltic 775 v

OK Cancel

The Search Type drop-down menu is used to identify the type of search:
Text:

A text search translates the entered keyword into the character encoding of the selected code-page
formats. The default selection, UTF7, 8, 16 and ANSI will locate English and other non-complex
languages in standard and Unicode format. When searching complex languages, such as Arabic, select
the additional code-pages as required.

Regular Expression (PCRE)

A “Regular Expression” (RegEx, or Perl Compatible Regular Expression) is a “concise and flexible means
for "matching" (specifying and recognizing) strings text, such as particular characters, words, or
patterns of characters” (11). GREP is often misinterpreted as RegEx. GREP is a Linux/Unix program that
is a RegEx search utility.
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Basic RegEx functions include:

\WFFFF Unicode character
\xFF Hex character
. Any character
\d Any number [0-9]

? Repeat zero or one time
+ Repeat at least once

[a-Z] a through z

[A-Z] A through Z

* Repeat zero+ times

[XYZ] Either X, Y, orZ

[*XYZ] Neither X norY norZ

\[ Literal character

(ab) Group ab together for ?, +, *,
{m,n}  Repeat mto ntimes

alb Eitheraorb

Sample RegEx expressions can be loaded from the: “Forensic Explorer\Keywords” folder under the user
profile.

For more RegEx examples, see:

e http://en.wikipedia.org/wiki/Regular expression

e  http://regexlib.com/

e  http://www.regular-expressions.info/reference.html

Hexadecimal

The hexadecimal option allows hexadecimal values to be typed directly into the search window without
formatting. Valid hex characters are 0-9, A-F, and space. For example, the keyword “cow” can be typed
directly into this field as “636F77".

Keyword Name

Keyword Name is used to describe the search term (the Keyword Name is NOT the search term). For
example, when searching for a credit card number with a RegEx expression: 45643#####it#itH#, the
Keyword Name can be “Visa Cards”.

Search Expression
The “Search Expressions” field is where the keyword is entered.
Case Sensitive

If Case Sensitive is checked, the keyword search will match the exact case used in the search expression
field.

The “Status” field provides real time feedback on the validity of the search expression entered. Once the
keyword is entered, press the OK button to add the keyword to the Keyword Management list.
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13.2.2 EDIT OR DELETE A KEYWORD

To edit a keyword:
1. Highlight the keyword with the mouse, then:

a. Double click on the keyword; or

b. Select the Edit Keyword button epwore from the module toolbar; or

c. Right click and select Edit Keyword from the drop-down menu.

2. Inthe Edit Keyword window make the appropriate edit and click OK to save the changes. The adjusted
keyword should now appear in the Keyword Management list.

To delete a keyword:

1. Highlight the keyword with the mouse.

m O
o 2

a. Click the Delete Keyword button [*=°] - or,

b. Right-click on the highlighted keyword and select “delete keyword” from the drop-down
menu).

2. Click OK to confirm the deletion.

See also deleting a keyword group below.

13.2.3 GROUPING KEYWORDS

Keywords can be grouped in the Keyword Management window.

To create a keyword group:

]
Add

1. Click on the Add Group button L°“* | to open the Add Keyword Group window (or right click in
Keyword Management and in the drop-down menu select “Add Group”).

2. Type the keyword group name and click OK.

Figure 215: Add Keyword Group window

Add keywaord group *

Keyword Group: ||

oK Cancel
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To rename a group:

1. Double click on the group name to open the edit window. Edit the group name and click OK to save
changes.

To delete a group:

1. Right click on the group folder icon and from the drop-down menu select “Delete keyword(s)”.

13.2.4 IMPORTING KEYWORDS

A list of keywords can be imported from a text file. To prepare a keyword text file, use the following formatting:

; Indicates a comment and is ignored in the import
[Folder] Creates a folder to group subsequent keywords
Keyword To add a simple list of words, one keyword is placed on each line of the text file.

Blank lines are ignored.
To add additional parameters to the word, use the following format:

Keyword Name, Search Expression,”CaseSensitive,Regex”

In the example below, two folders “Camera Types” and “PDF Header” are created. The Camera Types group
contains a case sensitive keyword. The PDF Header group contains a case sensitive RegEx.

Sample Keywords.txt file:

; This is a list of digital cameras related keywords

[Camera Types]

adobe,adobe,,"1200,1201,1252,65000,65001"
canon,canon,,"1200,1201,1252,65000,65001"
Olympus,Olympus,CaseSensitive,"1200,1201,1252,65000,65001"

[PDF Header]
PDF header,PDF-1.[0-9],"CaseSensitive,RegEx",

A fast way to learn the correct formatting is to add several groups and keywords by hand, then use the export

K/

Export
Keywords

button
instructions below.

to export the list. Then edit the list with additional requirements and import the file using the
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To import a keyword text file:

(3

Import
Keywards

1. Inthe module toolbar, click on the Import Keywords button

2. Browse to the required keyword text file, select the file, and click “Open”.

The keywords in the file will then populate the Keyword Management window. The result of importing the above
“Credit Card.txt file” is shown below:

Figure 216: Keyword Management after the import of the above Credit Card.txt file
L & B B 8 2 & ©0 B B
] L] -] —— i [

Add Add Add Impart Export dit Delete Start Keyword  Keywords
Group Keyward Multiple  Keywords  Keywords Key Keyward Search Count In Files

[=]
=1

Keyward Management

Keyword Label Search Term Settings CodePages
Keywords (1)

=N Credit Cards (&)

O & amex \b3[47] [0-9]413b RegEx N
[] / Dinersclub  'p3(7:0[0-5] |[68] [0-2])[0-9] {11+ RegEx A
[] £ piscover \b&(2:011|5[0-9] {21 [0-9] {12} RegEx M/A
]2 1ce \b{?7:2131]1800]35'd{3)\d 11 RegEx M/A
[] @ Mastercard  b5[1-5][0-2]{144 b RegEx M/A
] # visa \b4[0-9]41247: [0-9] 4307 RegEx MfA

13.2.5 RUNNING A KEYWORD SEARCH

To run a keyword search:

1. Inthe Keyword Management window, select the keyword/s to search by placing a tick in the box next
to the required keyword/s:

©

Start

2. Click the green Start Search button =23 | (or right click in the Keyword Management window and in
the drop-down menu select “Start Keyword Search”). This will open the “New Keyword Search” window
shown in Figure 217 below:
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Figure 217: New Keyword Search window

E Keyweord Search 2 Options

Process Mame:

|KE1,rW|:|r|:I Search

Source

Meodule: | FileSystem

[ ]unallocated space

Additional Options:
File sladk:

Limits

Stop when total search hits reach:

Loaging: | Marmal -

Chedked items (0 items 0 bytes)

Maximum hits per keywaord, per file:

(®) searchable Items (198430 items, 62.01 GB)

Indude Raw Devices, Partitions and Files

[ e

1000000 (Blank = unrestricted)

Pricrity: | Mormal

Ok

Cancel

Keyword search name: This is the name of the search that will be shown in the Keyword Tree window.

The keywords selected for this search and the number of hits per keyword will be displayed under the

keyword search name.

Data: Select the data upon which the search is to be carried out, e.g., data from the File System or the

Registry modules;

Include: Search either all items, or only those which have been checked;

Limits: Limitations can be set for the maximum number of hits per keyword per file (cannot exceed

65536 per file) and the total number of hits.

3. Click OK to commence the search.

Each search runsinits own thread, so multiple keyword searches can be executed at any one time. The processes

window tracks the status of the search.
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13.3 SEARCH RESULTS

The Keyword Tree window contains the search results, as shown in Figure 218 below:

Figure 218: Keyword Tree search results

Filter: [LJ Mo Fiter v |

Keyword Label Search Term Status
[ keyword Results (2)

B [ Keyword Search (3)

i L[ 4@ canon (18) camon Completed
O # hella (3) hello Completed
¢ e[ ## quality = [0-9][0-9] (36) quality = [0-6][... Completed
=0 [ =1 Keyword Search 2 (5)

<[] J® adabe (133) adobe Completed
- [] 4 canon (18) canon Completed
O £ olympus (0) Olympus Completed
- [ & Keyword Search 1 (0) Keyword Search 1 Completed
~[] & POF header (2) PDF-1.[0-9] Completed

0 of 11 Checked

The Keyword Results folder at the root of the tree holds a folder for each search. The default search names are
“Keyword Search 1”7, “...2” etc.:

e Inside the search folder are the keywords for each search;

e Blue brackets, e.g. (10), next to a keyword identify the number of files in the case in which the keyword
has been found;

e The Status column indicates if the search for a keyword is running or if it is completed.

e The Search Term column shows the formatting of the keyword string. It also identifies any search
parameters, such as case sensitivity, or Unicode.

13.3.1 DELETE A KEYWORD SEARCH FOLDER (AND KEYWORDS)

To delete a keyword search folder, right click on the keyword folder and select “Delete” from the drop-down
menu. A confirmation message will appear:

Figure 219: Delete a keyword search folder

Confirm =

o Are you sure you want to rempve 'PDF Header'?
This will remove any associatd.sbockmarks,

Yes Mo

Upon confirmation, all search results within that keyword search folder will be deleted.
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13.3.2 TO DELETE A KEY WORD

To delete a keyword:
1. Right click on the keyword;
2. Select Deleted keyword(s) from the drop-down menu.

The same procedure is used to delete a keyword group (a folder containing multiple keywords).

13.3.3 NOTE: WHY KEYWORD HITS DIFFER WHEN COMPARED TO ENCASE®

A difference in the number of keyword hits can occur between Forensic Explorer and EnCase® (v7). This is due
to the way each program deals with deleted files. For Example:

On a Fat32 system, EnCase® treats a deleted file as having 1 allocated cluster (the starting cluster is in the
directory entry of the file). If a keyword is in this first cluster, the ‘hit’ is attributed to that file. Subsequent hits
in the remaining clusters are identified as belonging to unallocated space.

On the same Fat32 system, Forensic Explorer identifies any search hit within the group of clusters attributed to
a deleted file to belong to that file, and the file name appears in the Keyword Result List. In addition to this, as
the space occupied by a deleted file is treated by the Windows Operating System as unallocated clusters,
Forensic Explorer also attributes the same search hits to unallocated clusters.
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13.4 KEYWORD RESULT LIST

When a keyword is highlighted, or a group of keywords is branch plated in the Keyword Tree any files which
contain the keyword/s are displayed in the Keyword Result List window.

Figure 220: Keyword Result List

Keyword Result List Gallery View Video View

A2® Filename 18 Hits 18 Hit Of

i
0

Filename Hits Hit Text Hit Offset
% LostFile_IPG_580416.jpg
& LostFile_JPG_590343.ipg
% LostFile_IPG_601408.jpg
& LostFile_JPG_611584.ipg
% LostFile_IPG_621056.jpg
& LostFile_IPG_643136.ipg
| LostFile_JPG_631424.jpg
& 9400-W.IPG

& img_9410_1280.JPG

& img_9458_1280.1PG

& img_9459_1280.JPG

IEEEEEEEEEEDE
-~ 000000000000

P T ¥ o N T o B Y ST I U ST R ST P ST PR ST TU R 01

Cm| CRW.aw
1 5 i0Q. .~ .. .. Canon _.Canon Pot

----- 2] - e....Canon.Canon PowerShol
=] [Z) WTUSER.DAT

12 ... MSé&.. . 100CENON. . (.. ... i

----- 27 p....1.0.0.C.AN.ON._ .. .._.
& [ & CR2-IMG_8272.CR2
- & CR2-IMG_0018-2.CR2
=[] [Z) DLL - Explorerview.dl
w1 ™ cana
<

18 of 18 Visible [7T2.8 MB] 1 Highlighted [2.4 MB] 0 Checked [0 bytes] DEMO 7.E01\Root\EVW - TEST SEQUEMCE\CRW.crw

The Keyword Result List includes the “Hits” column which identifies the number of times the keyword/s has
been found within a file.

Each file listed in the Keyword Result List has an expansion cross . Click on the expansion cross to preview the
“Hit Text” of each keyword in the file. The Hit Text consists of 20 characters before and after the keyword hit.
It is designed as a quick reference guide to identify hits that require further investigation.

A keyword search hit has three columns which describe the location of the hit in the evidence, Hit Offset (File),
Hit Offset (Partition) and Hit Offset (Device), as shown in Figure 221 below:
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Figure 221: Keyword Search Hit Offset

[F7] Keywerd Result List | [35] Gallery View video View
%ﬁ = AZ/¥ Filename 1-8 18 Hit Offset (F ||1:8/ Hit Offset (Partiion |[1:8 Hit Offset (Dev || A2Y Ext
Filename Hits  Hit Text Hit Offset (File) Hit Offset (Partition) Hit Offset (Device)  Extension
=0 ] LostFile_IPG_580415.jpg 3 ipg
d$ . .Canon.Ca 158 281435470 281485470
non.Canon EC 164 281435478 281485476
---.-Canon EC 1566 281486873 281486878
=S| ] LostFile_JPG_590843.jpg 3 ipg
d# . .Canon .Ca 158 2868260054 286826654
non.Canon EC 164 286826000 286826600
....Canon EC 1566 286828062 2868280602
O | LostFile_JPG_601408.jpg 3 ipg
O ] LostFile_JPG_611584.jpg 3 ipg
=0 | LostFile_IPG_621056.jpg 3 ipg
Important

When working with hit offset in Forensic Explorer it is important to remember that that Hex view is file based,
that is, Hex view is driven by the selection in the Folder tree, the List View, or the Disk View. For example, to view
the entire disk in Hex view from physical 0, the evidence file (i.e., the raw device) must be selected in either the
Folder tree, or the File list. If any other file is selected, only the content of those files will be shown in HEX view.

Hit Offset (File)

For the file in which the hit was found, Hit Offset (File) is the number of bytes from the beginning of the file to
the location of the hit. In the example in Figure 221 above the file offset to the first search hit ‘Canon’ in
LostFile_JPG_580416.jpg is 158.

When the first hit in Figure 221 above is selected, Hex view displays the content of the file with the hit
highlighted. If the cursor is manually placed at the beginning of the first hit, the Hex view information bar
shows:

e Sector: 549776 (x86390): The sector of the current hit.

e  Device Offset: 281485470 (x10C7209E): The number of bytes from the beginning of the device (DEMO
7.E01) to the start of the hit.

e  File Offset: 158 (x9E): The number of bytes from the beginning of LostFile_JPG_580416.jpg to the start
of the hit.

Figure 222: Example of Hit Offset (Device) and Hit Offset (File)
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Hit Offset (Partition)

For the partition in which the hit was found, Hit Offset (Partition) is the number of bytes from the beginning of
the partition to the location of the hit. In the example in Figure 221 above the partition offset to the first search
hit ‘Canon’ in LostFile_JPG_580416.jpg is 281485470.

In order to view the partition Hex view, it is necessary to change to the File System module and select the
partition in either the Folder tree or the List view.

Figure 223: In this example...

NOTE: In this example:

The forensic image is an acquisition of a partition (e.g., the ‘D:\’ drive was acquired), so evidence file is the
entire partition. This is why the Hit Offset (Partition) and Hit Offset (Device) numbers are identical in Figure
221 Figure 221: Keyword Search Hit Offset.

When the evidence file is selected in the File System tree (shown in Figure 224 below), the entire device is shown
in the Hex view:

Figure 224: Selection of the device in the File System tree view

H&-@-e
£} Evidence File System ﬁ A
a Q@ 3 |

Recover File Name File T Shadow  Sign|
Folders Search Carve Caopy Ang

Folders Categories

Filter: |= Mo Filter i |

C:[] Orphaned (18)
][] Root (91)

To go to the Hit Offset (Partition):
1. Inthe File System module Hex view, right click, select GOTO from the drop-down menu;

2. Enter the partition offset taken from the Hit Offset (Partition) column in the Keyword Search module
(use right-click Copy Cell to copy the partition offset number from the keyword hit), as shown Figure
225 below:
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Figure 225: Hex view Goto

NOTE: You must have the correct file selected:
e  Click the Device to Goto from the beginning of the device;
e  Click the Partition to Goto from the beginning of the partition;
e  Click the File to Goto from the beginning of the file.

Goto prd
From
(®) Beginning of Data Offset: |ﬂ
() Current position @Dec  OHex
(_JEnd of data (back from)

Goto takes the Hex view to the entered offset.
Manually click at the offset to ensure the Hex view information bar refreshes to show:

e Offset: 281485470 (x10C7209E): The number of bytes from the beginning of the partition to the Goto
location.

Figure 226: Example of Hit Offset (Partition)
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Sector: 549776 (x85390) Device Offset: 281485470 (x10C7209E)  File Offset: 281485470 (x10C7209E) = | DEMO 7.£01
B Hex | =l Text [=]Info Bookmark | .. BytePlot =i Display |=|FilesystemRecord | = File Metadata =] File Extent

Note: In this example the select partition is also the device and the selected file (see Figure 223 above for more
information).

Hit Offset (Device)

For the device in which the hit was found, Hit Offset (Device) is the number of bytes from the beginning of the
device to the location of the hit. In the example in Figure 221 above the disk offset to the first search hit ‘Canon’
in LostFile_JPG_580416.jpg is 281485470.

13.5 KEYWORD SEARCH DATA VIEWS

When a file is highlighted in the Keyword Results list, the content of the file is displayed in data views at the
bottom of the screen. The data views available to the Keyword Search Module are Hex, Text and Display. Learn

more in Chapter 8 - Data Views.
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Chapter 14 - Index Search Module
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14.1 INDEX SEARCH

The Index Search module is accessed via the “Index Search” tab.

Figure 227: Index Search module tab

‘p Index Search ‘

An Index Search creates and then uses a database that stores the location of words in the evidence. Forensic

Explorer uses inbuilt dtSearch® technology for this purpose (for more information see http://dtsearch.com/).

Once an index is built for a group of files, fast keyword searches can be performed on those files.

IMPORTANT - Sharing a DTSearch Index:

A DTSearch index requires each file in a case to be uniquely identified. In Forensic Explorer this is
achieved using an items Bates ID. This means that the index alone is NOT transferable to another user, as
evidence and processes maybe be conducted in a different sequence by that user, resulting in a different
bates number sequence.

To share a DTSearch index, the entire case must be provided to the third party.

For a list of the file formats supported by dtSearch® see "What file formats does dtSearch support" at
http://support.dtsearch.com. http://support.dtsearch.com/dts0103.htm#Formats

A keyword index is stored as part of a Forensic Explorer case. The default path is:
C:\Users\user profile\Documents\Forensic Explorer v5\Cases\case name\DTSearchindexes\index name\

A keyword index is usually about one fourth the size of the original documents, although this may vary depending
on the number and kinds of documents in the index. The forensic investigator should make sure there is ample
disk space available when creating an index.

A noise word is a word such as “the” or “if” that is so common that it is not useful in searches. To save time,
noise words are not indexed and are ignored in index searches.

To modify the list of words defined as noise words, edit the file:

C:\Program Files\GetData\Forensic Explorer v5\noise.dat
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The noise word list does not have an order and can include wildcard characters such as * and ?. However, noise
words may not begin with wildcard characters.

When an index is created, the index will store its own copy of the noise word list. Changes made to the noise
word list will be reflected in future indexes but will not affect existing indexes.

14.2 CONSIDERATIONS PRIOR TO CREATING AN INDEX

Prior to creating an index, it may be advantageous to recover any available data from the case and expose the
data as files to the index process. For this reason, the forensic investigator should consider first running:

e A Recover Folders search;
o A “file carve” for specific file types (see 24.4 - File carving).

e Decompress or decrypt any compound files not supported by dtSearch®.

14.3 CREATING AN INDEX

To create an index:
Open a case, or preview or start a new case and add evidence.
To index checked files

Switch to the required module tab; File System, Email or Registry, and select the required files, then
switch to the Index Search module;

Or;

to index the entire case go directly to the Index Search module.

In the Index Search module, click on the “New Index” button. The New Index window will display, as shown in
Figure 228 below:
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Figure 228: New Index

2

Process Mame:

Mew Index

Source L\}

Module: | FileSystem -

(®) Searchable items (324 items 934.9 ME)
[ Junallocated space
Chedked items (0 items 0 bytes)

Include Raw Devices, Partitions and Files

Logging: | Mormal e Priority: | Mormal ~

Ik Cancel

Process Name: The name given to the index. Each index must be given a unique name.

Items to Index: The module, e.g. File System, Email or Registry, from which the index will be generated (each
module must be indexed separately).

Searchable items (x items): This selection will index all items in the selected module.
Checked items: The items which have been checked in the selected module.

Include: Unallocated Space: Determines whether unallocated space will be included in the index.
File slack: Determines whether the file slack of each file will be excluded from the index.

Click OK to start the index process.
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An index in progress will show “Running” in the Indexes window, as shown in Figure 229 below:

Figure 229: Index creation in progress

Indexes

- El} Mew Index

Indexes
] =) Mew Index 2
L] (=) Mew Index 3 Running

| B Export Words

The progress is also tracked in the program process list, as shown in Figure 230 below:

Figure 230: Forensic Explorer process window showing a completed index

Creating Indexc Index 2 (FileSystem)
E PPT - GetData Presentation.ppt
———

R T e W T iy

W‘xmvw”\.l

Running Processes: 1
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Important: Deleting and index is a permanent operation. A deleted index cannot be recovered.

To delete an index, check the required index, then right click on the index name, and select Delete Index from
the drop-down menu:

Figure 231: Delete Index

e ovie |EERCRR

£ Evidence File System ,ﬂu‘- Artifacts ﬁ Keyw|
o

Indexes B Index Result List
- [l Newindex | 22l = A2 Displ
Indexes Display Na

MR | Mew Index

||E Export Waords

rrrrrrrrr

Search for:
| [ @ |

A warning message will appear. Clicking Yes will permanently delete the index.

Figure 232: Delete Index confirmation

Warning >

| Are you sure you want to delete this index?

Mote: This is a permanent operation.

Yes Mo
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14.4 SEARCHING AN INDEX

When the indexing process is complete, the index will appear in the “Available Indexes” window, as shown in
Figure 233 below:

Figure 233: Index search
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Select the required index by placing a tick in the box next to the index name.

Type the search term into the “Search for” window. As the search term is typed, a list of index words is
dynamically displayed showing:

1. The words in the index which match the typed criteria;
2. The number of times the word appears in the index (“Word Count”); and,
3. The number of documents in the index in which the word appears.

An alternate word can be selected from the displayed list by double clicking the required word.
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14.4.1 SELECT THE SEARCH FEATURES TO USE IN YOUR SEARCH.

The following options can be included in the search, by selecting the relevant check box:
Stemming

Search for other grammatical forms of the words in your search request. For example, with stemming
enabled a search for “apply” would also find “applies”.

Phonic searching
Find words that sound like words in your request, like Smith and Smythe.
Fuzzy

Fuzzy searching sifts through scanning and typographical errors.

14.4.2 BOOLEAN SEARCH

A group of words or phrases linked by connectors such as AND, OR, that indicate a relationship between them.

For example:
Search Request Meaning
apple and pear both words must be present
apple or pear either word can be present
apple w/5 pear apple must occur within 5 words of pear
apple not w/12 pear pear apple must occur, but not within 12 words of pear
apple and not pear only apple must be present
apple w/5 xfirstword apple must occur in the first five words
apple w/5 xlastword apple must occur in the last five words

If you use more than one connector (and, or, contains, etc.), you should use parentheses to indicate precisely
what you want to search for. For example:

(apple and pear) or (name contains smith)
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For a more complex search which uses a phrase, use quotation marks around it, like this:

apple w/5 "my fruit salad"

If a phrase contains a noise word, dtSearch will skip over the noise word when searching for it. For example, a
search for statue of liberty would retrieve any document containing the word statue, any intervening word, and
the word liberty.

A search word can contain the wildcard characters:

? Matches any character

Matches any single digit
* Matches any number of characters

The wildcard characters can be in any position in a word. For example:

appl* Would match apple, application, etc.

*cipl* Would match principle, participle, etc.

appl? Would match apply and apple but not apples.
ap*ed Would match applied, approved, etc.

Note: Use of the * wildcard character near the beginning of a word will slow searching.

14.5 SEARCH RESULTS

Search results display in the Index Results List view window, as shown in Figure 235 below. Select the relevant
file in the Index Result List and the indexed content will display the Search Hits preview window.

Use the marker arrows to jump between highlighted hits:

Figure 234: Navigate index search hits

€€ £ > B> Hit 1 of 22

Use the “Auto Scroll to First Hit” check box to automatically scroll to the first keyword hit in the Search Hits
window.
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Search hits are highlighted in yellow, as shown below:

Figure 235: Index search results

(plorer H @ 'tﬁ = @rensic Explorer 5. 1.2(3926) (64bit) Case: New Case 45 —-0x
ﬁ Evid... F|Ie- -’l*.qu p Key... p Inde... @ Emai... & Regi... E Eook D Rep... g Scri..
Bl Indexes [ 1ndex Result List
ElJ mew Index B = A2 Filename AZ[* Display Name 18 Hits
Indexes Filename Display Name Hits
1 =) New Index 2 O 1 Q DLL - Explorerview.dl DLL - Explorerview.dll -~
1 £ New Index 3 =] 2 & img_9459_1230.1PG img_9459_1280.1PG
() New Index 4 O 3 [ 150 - test-bmf3.iso IS0 - test-bmf3.iso
O 4[] NTUSER.DAT NTUSER.DAT
(4 Export Words ] 5[] NTUSER.DAT i NTUSER.DAT
] 6 [ 5AM SAM
P i 7 2 software software
dEEane =] 8 [C) SOFTWARE SOFTWARE
evi @ ] 9 [0 system system
i ] 10 [) SYSTEM SYSTEM
Ear ] 11 [J] Test Outiook.pst Shriveled in direct. [203aa4].msag
Options ] 12 ) Test Outlook.pst [SPaM] Over 1,500,000 bottles sold...
Stemming Fuzzy O 13 [J) Test Outlook.pst Fast weight loss, Boosts Energy, Ce... v
[ Phanic < >

22 of 22 Visible [433.4 MB] 1 Highlighted [768 KB] 0 Checked [0 bytes] DEMO 7.E01\Root\MIST Registn|

Word Count  Est. Count ™ “BH search Hits
1 1 —
2 1 Hit 1 of 44 Auto Scroll to First Hit
3 - nd Settings\ Mr. Evil\ntuser dat
2 2 $SSPROTO.HIV "
i i AppEvents
5 5 EventLabels v
s 4 . Default
DEMO 7.E01\Root\MIST Registry Files\NTUSER.DAT = NTUSER.DAT\NTUSER.DAT
| Case:New Caseds e R Brocessiesi 0o |

14.6 INDEX SEARCH COMPOUND FILES

DTSearch will index compound files, including PST and ZIP and display individual keyword hits within the
messages and files.

It is also possible to add a compound file directly as evidence (use the Add File button in the Evidence module)
and index its content.

14.7 EXPORT WORD LIST

The Export Words button (implemented in v2.3.6.3531 and above) is used to export the list of indexed words
to a .csv file on the investigator’s computer. The list can then be used for password breaking or other
purposes.

To export the indexed word list:
1. Inthe Index Search Module, Indexes window, check the required index;
2. Click on the Export Words button;

3. Select the name and location of the exported .csv file.
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14.8 INDEX SEARCH LOGGING

In some instances, a forensic examiner may wish to log the index searches conducted.

To export the indexed word list:

1. Click on the Orange Forensic Explorer button and select Options.

Forensic Explorer WSEY
@ Save

@ Investigators...
[ Options h

i | Layout r
&8 lcon Editors r
[@ Feedback...

License Manager...

G‘ﬁ
& About...
) Help

@ Exit

2. Tick the Log Searches in Index Module checkbox (note that this setting is remembered for future
cases).

Figure 236: Log Searches in Index Module

Log File Viewer:

Show Preview button
Log Searches in Index Module

Reset All Options: Defaults

3. Index Search history is written to the file:
...\Documents\Forensic Explorer v5\Cases\[CaseName]\Logs\Index Search Results.csv

4. andis recorded in the following format:
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Figure 237: Sample Search Log

A B = D E F G H I J

1 |Date lTime Index Name Search Term Stemming Fuzzy Phonic Files Hits Investigator

2 | 30-Mar-21 14:13:13 New Index cat FALSE FALSE FALSE 21 163 Graham Henley
3 | 30-Mar-21 14:13:17 New Index dog FALSE FALSE FALSE & 161 Graham Henley
4 |30-Mar-21 14:13:23 New Index kangaroo FALSE FALSE FALSE 1 1 Graham Henley
5 | 30-Mar-21 14:13:37 New Index donket FALSE FALSE FALSE 0 0 Graham Henley
6 | 30-Mar-21 14:13:43 New Index donkey FALSE FALSE FALSE 0 0 Graham Henley
T

Copyright GetData Forensics Pty Ltd 2010 - 2024, All rights reserved.




Chapter 15 - Email Module 243 | Page
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15.1 EMAIL

Email analysis is a key component of computer forensics. The Forensic Explorer Email module supports a variety
of email formats, including::

e _EDB Microsoft Exchange

e EML Email Message format

e .MBOX Mailbox format

o .MSG Microsoft Message file

e .OST Microsoft Offline Storage Table

e PST Microsoft Personal Storage Table

Note: It is possible to independently index and keyword search email in the Index Search module. Refer to
Chapter 14 - Index Search Module, for more information.

15.2 EMAIL MODULE

The Email module is accessed via the “Email” tab.

Figure 238: Email module tab

‘@ Email ‘
The Email module is broken down into three panes:
1. Email Tree
Holds the folder structure of the email file.
2. Email List
Lists individual messages and their metadata. Available columns include.
o I (importance).
o Subject.
o Sent From, etc.
3. Data Views

Displays message content and additional properties. The Property Viewer contains Outlook MAPI
(Microsoft Application Programming Interface) properties associated with each message.

15.3 MICROSOFT OUTLOOK .PST EMAIL

The Microsoft Outlook email client is available as part of the Microsoft Office suite. Microsoft refers to it as a
“personal information manager” as it has additional functions to email, including calendar, contacts, and notes.
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When running on a typical home computer Outlook stores mail on the local hard disk in an Outlook Data File
(.PST) file. In a business environment, Outlook can be configured to interact with a mail server (usually Microsoft
Exchange). In this case a local copy of the data may be held in an Offline Data File (.OST).

To add a stand-alone Microsoft Outlook .PST file to the Email module:
1. Inthe Evidence module, start a new case or preview.

2. Inthe Evidence module click the “Add File” button.

3. Select the .PST file to add. Click “Open”. The .PST file will then be added to the case. Forensic Explorer
will detect that it is a .PST file and add the content to the Email module.

Add a .PST file from within an existing case to the Email module:
1. Locate the relevant .PST file in a module.

2. Right click on the .PST file and select “Send to module > Email” in the drop-down menu. The content
of the .PST file will then be populated in the Email module.

15.4 INDEX SEARCH THE EMAIL MODULE

Data that has been added to the Email module can be independently indexed or keyword searched.
To index the content of the Email module:
1. Inthe Index Search module, create a new index.

2. Inthe New Index window, select Email as the target module.
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Figure 239: Index Search module, New Index window

B New Index 5 Options — O x

Process Mame:

|Index of email in the Email Module]

Source

Module: |Email o -

(@) Searchable items (12064 items 40,5 ME)
[Junalocated space
Checked items (0 items 0 bytes)

Indude Raw Devices, Partitions and Files

Logging: | Mormal “ Priarity: | Mormal ~

Important:

Creating an index of the content of the Email module is NOT the same as indexing a PST file that is in the file
system. DTSearch will already index a PST file that is in the file system.

15.5 KEYWORD SEARCH THE EMAIL MODULE

To keyword search the content of the Email module:
1. Inthe Keyword Search module, start a keyword search.

2. Inthe Run Keyword Search window, select Email as the target module.

Figure 240: Keyword Search module, Run Keyword Search window

B8 Keyword Search 3 Options — O x
Process Mame:
|Keywcrd Search 3

Source

Module: | Email <= w

(®) Searchable Items (12064 items, 40.5 ME)
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16.1 REGISTRY MODULE

The Registry module is accessed via the “Registry” tab:

Figure 241: Registry module tab

ﬁ Registry

The Registry module is used to expand and examine Windows registry files. A Windows registry contains a great
deal of information that can be of value to the forensic investigator.

“The Registry contains information that Windows continually references during operation, such as
profiles for each user, the applications installed on the computer and the types of documents that each
can create, property sheet settings for folders and application icons, what hardware exists on the
system, and the ports that are being used.” Windows registry information for advanced users (12)

Unlike the Microsoft Windows registry editor, which is restricted to the current systems registry, Forensic

Explorer allows the forensic investigator to examine registry files from any computer.

16.1.1 WINDOWS LOCATION OF REGISTRY FILES

The Windows Registry is physically stored in several files. The number of files, their name and location, will vary
depending on the version of Windows in use. See http://support.microsoft.com/kb/256986 “Windows registry
information for advanced users (12)” for detailed information.

In most cases the forensic investigator will target the following Windows registry files:

Windows 95, 98, and ME operating systems have two registry files, located in the C:\Windows folder and
or Windows\profiles\user profile\ folder:

e system.dat, and
e user.dat.

Windows NT based operating systems separate system registry data into four files, located in the
C:\Windows\system32\config\ folder:

e security.
e software.
e SAM; and
e System.

User settings are stored in a separate file called ntuser.dat inside the user path.
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16.2 ADDING A REGISTRY FILE TO THE REGISTRY MODULE

There are two methods to add a Windows registry file to the Forensic Explorer Registry module.

To add a stand-alone registry file to a case:
4. Inthe Evidence module, start a new case or preview.
5. Inthe Evidence module click the “Add File” button.

6. Select the registry file to add. Click “Open”. The registry file will then be added to the case. Forensic
Explorer will detect that it is a registry file and add the content to the Registry module.

Add a registry file from within an existing case to the registry module:

3. Locate the relevant registry file in the File System module (use the locations described in 16.1.1 -
Windows location of registry files, above).

4. Right click on the registry file and select “Send to module > Registry” in the drop-down menu. The
content of the registry file will then be populated in the registry module.

Registry files will be grouped by the originating device. Groups are identified by the “Sent From
[device name]” folder, as shown in Figure 242 below:

Figure 242: Registry module showing "Sent from"

W"’“ﬁ
= O [ 2= MIST Hacking Case (1) []
= ] ﬁ Sent from NIST - 4Dell Latitude CPi.E01 (11) []
i [ [] -] NTUSER.DAT (12) [Local Time]
- [ [ [ NTUSER.DAT (12) [Local Time]
- [ [ NTUSER.DAT (14) [Local Time]
- [ ) NTUSER.DAT (12) [Local Time]
- [ [ ntuser.dat (12) [Local Time]

H- [ (] ) SAM (4) [Local Time] .

;

L T ETF L TR TN TP I | ¥ LT}
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16.3 REGISTRY DATA VIEWS
The Registry Tree in the top left window of the Registry module lists the folders that contain registry keys, as

shown in Figure 243 below:

Figure 243: Registry Tree, showing folders in NTUSER.DAT

Registry Tree o

Filter: |£_." No Filter v | -

= T[] [ | NTUSER.DAT (ettings\default userintus
& L[] [ AppEvents (3)

- [ [ Console (32)

& L[ [ Control Panel (25)

- [ [ Environment (3)

B ] [ Identities (8)

- T[] [ Keyboard Layout (3)

= [ [ Network (1)

B T[] [ Printers (3)

B ] [0 Software (19)

- [ UNICODE Program Groups (1) w

0 of 767901 Checked [0 bytes]

Case: New Case 45

The blue number in brackets, e.g., “(2)” shows the number of items inside the folder (but does not count the
contents of sub folders).

For information, see 8.2.1 Navigating Tree views, including branch plating.
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When a folder is highlighted in the Registry Tree, the contents of that folder are displayed in the Registry List,
as shown in Figure 244 below:

Figure 244: Registry List view

Registry List =
Filename Type Data Timestamp

[1 [ camtasia Studio REG_MOME {value not set) 13-Jun-10

- !: UseHaspActivation REG_DWORD 0x00000000 (1)

] [ TSCC REG_MOME (value not set) 23-Dec-114

] [~| Snaglt REG_MOME (value not set) 17-Jul-10 1

] || Filters REG_MOME (value not set) 17-Jul-10 1

] [ ~sedesc REG_BIMARY 50 FF FFFF 736800 ...

4 m " 3

2 of & itemms NTUSER.DAT\Software\TechSmith' UseHaspActi

The following default columns are displayed in Registry List view:
Filename: Gives the name of the registry item.

Type: Describes the type of data held. See “List of standard registry value types” (13) for
more information.

Data The value stored.
Timestamp The date attributed to the registry folder.
Physical Size The physical storage size of the entry.

The Registry List view makes the standard analysis tools available from the right click menu. This includes
Bookmarks (See Chapter 14 - Bookmarks) and sort and filter (See Chapter 9 - Working with data).

Hex and Text data views are provided in the Registry module to give access to the raw data of the registry entry.

The Filesystem Records view decodes the entry and maps the decoded parts to the raw entry data.
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16.4 DELETED REGISTRY KEYS

When a registry file is read by Forensic Explorer, the unallocated space within the registry file is parsed for
deleted registry keys. These keys are placed into the “Deleted Keys” Folder, marked with the following icons:

B Deleted key

g Deleted folder

16.5 EXAMINING REGISTRY FILES USING SCRIPTS

A default installation of Forensic Explorer includes a “Parse Registry Keys” button group in the Registry Module

toolbar:

Figure 245: Registry Module, Parse Registry Keys

]
d
a4
]

B3|

a '

A H""' [ﬂj

MT User _  SYSTEM . SOFTWARE SAM -
Hive Hive Hive Hive

Parse Reqgistry Keys

Each of the drop-down links in the button group passes a variable to the Scripts/Registry/Registry Key
Processor.pas script to scan (and in some cases interpret) data of interest from specific keys. For example,
selecting the “SOFTWARE > Registered Owner\Organization” button returns:

Figure 246: Registry Key Processor

B Registry Key Processor - m} *
Search for: SOFITWARE\Microsoft \Windows NT“CurrentVersion'% RegisteredOwner and RegisteredOrganization
Description: Cwner and organization details entered at installation. Can be modified.
Reference: Hone .
Eey Found: Sent from DEMO 7.E0l\software\Microsoft'\Windows NT\CurrentVersionm’

Value Data

RegisteredOrganization

Registerediwner Ed
Fey Found: Sent from DEMO 7.E0L\SOFTWARE\Microsoft'Windows NT\CurrentVersion®
Value Data

RegisteredOrganization N/R
Registerediwner Greg Schardt

Begistry Eey Processor finished.
< I >

| Copy to Clipboard | | Bookmark and Close | | Close |

The Registry Key Processor.pas uses a RegEx search to locate the relevant key. The script then processes and
displays the result per its type (and any unique processing that the specific key requires).
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IMPORTANT

It is important to note that automated registry key analysis is a developing field based largely on individual
forensic practitioner research. Limited registry documentation relevant to pertinent keys is made available by
Microsoft.

Also, note that registry content is largely the result of user behaviour, and that registry structure will change
between Windows versions. The Registry Key Processor.pas script has been developed on sample registry hives
and there is no guarantee that other hives will be parsed accurately.

As with the analysis of any Windows artifact, results from the Registry Key Processor.pas should be validated

before being relied upon.

16.5.1 QUICK REGISTRY

A Quick Registry button in the File System module toolbar gives users fast access to important registry
Artifacts. This natively reads registry files without the need to add data to the Registry module.

File M Hash Hash
Info Files Match

=

Windows NTFSDisablelastAccessUpdate
Windows RecentDocs

Windows SystemRoot

Windows TimeZone

Windows Uninstall Programs

Windows USB Devices

Windows User Accounts

Windows Wireless Metworks (Win7)

eEEEBEES
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17.1 ADDING BOOKMARKS

Bookmarks are used to annotate items of interest. Forensic Explorer enables almost any item (e.g. file, folder,
keyword, search hit, etc.), or a selection from an item (e.g. a fragment of text from a file or unallocated clusters),
to be bookmarked and listed in the Bookmarks module.

Atoolbar has been added to the Bookmarks module. This enables faster access to scripts specific to that module.

IMPORTANT: Forensic Explorer Reports are generated from Bookmarked items.

17.1.1 MANUALLY ADD A BOOKMARK

To manually add a bookmark:

e InaTree, List, or Gallery view, right click on the required file/s and select “Add Bookmark” from the
drop-down menu; or,

e In a Hex or Text view, highlight the required data with the mouse, right click and select “Add
Bookmark” from the drop-down menu.

This will open the “Add Bookmarks” window, shown below:

Figure 247: Add Bookmarks window

B9 4dd Bookmark... O ¥

Source Files [é
() Chedked files (D files, 0 folders, 0 bytes)
(®) Highlighted files (1 files, 0 folders, 67. 1 KB (68,752 |

Select Folder: File(s) Comment:

E Mew Case 45 (1) [Local Time] "~ |
=8 ? My Bookmarks (12)

- 3 Audio (0)
3 Documents (0]

- 23 Email (0)
5 Evidence (2)

E Files (0)
- 2 Tlicit Images (0)

E Index Search (0)
3 Internet (0)

3 Keyword Search (0)

3 Pictures (0)
G- 5 Reqistry (1) h

Folder Comment:

| g Mew Folder

carel
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Source Files: A bookmark action can be performed on a highlighted file/s or checked files.

Select Folder: Folders are used by the investigator to group together bookmarked files of like interest.
Folders can be moved using the mouse drag and drop.

The right click drop-down menu or the New Folder button enables the investigator to add
or delete a folder.

Folder Comment: A comment about the folder holding the bookmarked files.

File/s Comment: A comment about the file/s being bookmarked.

When evidence is added to a case the option exists in the Evidence Processor (See 0) to “Triage” data.

Many of the scripts supplied with Forensic Explorer have the option to bookmark search results, (for example,
Discover PDF Files by Author, located under the Analysis Programs button in the File System module). The
default folder for script bookmarks is: My Bookmarks\Script Output\. A user who writes or modifies a script can
select or create a bookmark folder of their choice.

A script has been added to create custom bookmark folders. Templates can be created and loaded to quickly
create bookmark folders for each case:

Figure 248: Bookmarks toolbar

e
£ Evidence [ File system ,f* Artifacts ﬁ Keyword Search S Indg

Bookmark T
by Device

Lo Add Custom BookmerkFolders [\ [ L

4 Add Folders lllicit Images EI EI
E =

Gallery View Widg

"4 Add Folders lllicit Videos

| A2 Filename
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17.2 BOOKMARKS MODULE

The Bookmarks module is accessed via the “Bookmarks” tab:

Figure 249: Bookmarks module tab

‘ Bookmarks ‘

The bookmarks module provides a single location where items of interest are gathered together. The bookmarks
module is divided into three areas;

1. Bookmarks tree;
2. Bookmark List;
3. Bookmark data views,

which are described in more details below.

The Bookmark tree displays:

|§ Bookmark folders: used by the investigator to group together bookmarked files of a similar
nature.

An example is shown in Figure 250 below:

Figure 250: Bookmark folder tree

Bookmarks

Filter: |£_.” Mo Filter v

Bookmark Mame Folder Comment
C:] Mew Case 45 (1) [Local Time]
= [ 3 My Bookmarks (12)
- O Audio (0)
- ] |E Documents {0)
- DO 5 email ©
- [ |E Evidence (1)
~ [ Files (0)
- C O 1licit Images (0)
- [ index search (0)
- O 1nternet (0)
- O P keywaord Search (0)
[ = L] Pictures (10) | important pictures
-~ [0 Classification 01 (4)
- O Classification 02 (1)
- L[ Classification 03 (1)
- O registry (0)
~ [ videos (0)
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MANAGE BOOKMARK FOLDERS

To add a bookmark folder:
Right click and select Add Folder from the drop-down menu.
To delete a bookmark folder and its contents:

Right click and select Delete folder from the drop-down menu:

Figure 251: Manage Bookmark folders

o Add Folder...

& Edit folder comment...
Rename

E}) Export.. r
Delete folder...

"f% Refresh

%5 Contract all

%5 Expand all
Clear All Checks

[+ Branch plating »

To move a bookmark folder:

Drag and drop an existing folder to its required location.

17.2.2 BOOKMARKS LIST

The Bookmarks List is a list view of the bookmarked items (files or data). Bookmarked files are identified by a
bookmark icon that overlays the file icon, as shown in Figure 252: Bookmark list below:

Figure 252: Bookmark list

[7] Bookmarked Items List Gallery View Video View

g = A2¥ Filename 18| Classificatior ||1:8/ Flags AZ¥ Path 18 Data Size
Filename Classification Flags Path Data Size

1 1 [N 90min 2.docx DEMO 7.E01\Root) 28,672

i 2 [ poc.doc DEMO 7.E01\Root\EVW - TEST SEQ... 2,333,584

D 3 |] DOCY - Office 2007 Word Document.docx DEMO 7.E01\Root\EVW - TEST SEQ... 65,536

O 4 |] old-pci.doc DEMO 7.E01'\Root\Signature Testh 12 288
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MANAGE BOOKMARK LIST
To add a bookmark:
See 17.1 Adding Bookmarks, above.
To delete a bookmark:

1. Inthe Bookmarked Items List, highlight the required file/s, right click, and select Delete Bookmark/s
from the drop-down menu. The following confirmation window will appear:

Figure 253: Delete bookmark/s confirmation

Confirm =

o Are your sure you want to delete the Bookmark(s)?

Cancel

2. Click OK to proceed. The file/s is deleted from the Bookmarks module.
To copy a bookmark to another bookmark folder:

1. Left click on the bookmarked item;

2. Drag and drop the bookmark to the required folder.
To move a bookmark from one bookmark folder to another:

1. Left click on the bookmarked item;

2. Hold down the SHIFT key;

3. Drag and drop the bookmarked item to the required folder.
To edit a bookmark comment:

1. Right click on the bookmark or a file in the Bookmarks List and from the drop-down menu select Edit
Bookmark comment.

2. The Edit Bookmark window will open where the comment text can be updated.
To edit multiple bookmark comments:

1. Highlight multiple bookmarked files using the mouse and the SHIFT or CTRL key;

2. Right click and select Edit Bookmark Comment from the drop-down menu;

3. The Edit Bookmark window will open. Edit the first bookmark and click OK. The comments will be
updated for each of the bookmarks.
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17.2.3 BOOKMARK DATA VIEWS

Data views enable the investigator to examine the item (device, folder, file, email message or registry key) that
has been bookmarked. The data views available in the Bookmarks module are Bookmark, Hex, Text, Info, Display,
File Metadata, Filesystem Record, and File Extent.

The Bookmark data view, shown in Figure 254 below, is visible in all modules. It enables the investigator to
determine the Bookmark folder/s into which a file has been placed.

Right click on the view and select “Edit bookmark comment...” from the drop-down menu to edit a comment.

Figure 254: Bookmark data view
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17.3 IDENTIFYING BOOKMARKED FILES OTHER MODULES

Bookmarked files can be identified in the File System module by:

1. A purple bookmark that overlays the file icon, as shown in Figure 255 below:

Figure 255: Bookmarked files in the File System module
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2. The bookmark folder name is shown in the Bookmark Folder column (if a file has been bookmarked in
multiple folders the column contains each folder name separated by a comma).
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18.1 MS WORD - QUICK REPORTS

Forensic Explorer Quick Reports is a methodology to quickly generate a Microsoft Word report on
bookmarked items.

The requirement for Quick Reports is:
e  Microsoft Word 2016 or above.
e Microsoft Word must be fully licensed.

Quick Reports is launched from the toolbar icon of Forensic Explorer modules. If the Quick Reports button is
not visible in a module toolbar, add it to the module using the File System > Tools > Add/Remove — Quick
MSWord Report menu item.

Figure 256: File System > Tools > Add/Remove — Quick MSWord Report.

& O
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Add/Remove - Bookmark CETS Categories

Add/Remove - Bookmark Interpol Categories
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Add/Remove - Quick M5Word Report Ib

BN EE e

The advantage of using Quick Reports is that enables bookmarked items to be quickly imported into a
Microsoft Word format. This gives the investigator flexibility to use Microsoft features such as:

e  Report Sections.
e Table of Contents.
e  Styles.
To launch Quick Reports:
1. Click on the Quick Reports toolbar icon.

2. The Quick Reports script will open in the Report Options tab (on first run).
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Figure 257: Quick Reports > Report Options.
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The Report Options tab is used to configure the various document options, including header and footer, title
page. Customization is possible by saving graphics and text files to the Settings Folder. The additional tabs,
Triage, Gallery, File List, Artifacts, Email, Registry, and Other, source report data from specific bookmark
folders. Use the SHIFT or CTRL key to select the bookmark folders to include in the report:

Figure 258: Triage, selected bookmark folders to include.
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Where additional settings or columns are available, make the applicable selection:

Figure 259: Selecting Quick Report settings and columns.
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When the required selections have been made, press the Run button to launch Microsoft Word. Once Word

has launched, the investigator can customize and save the document as needed.

Figure 260: Quick Reports, Microsoft Word.
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18.2 THE REPORTS MODULE

The purpose of the Reports Module is to assist in the generation of a report that documents forensic analysis.
The Reports module is based on the use of templates that can be re-used across multiple investigations. A report
template can be automatically populated with bookmarked items.

Figure 261: Modules > Bookmarks > Reports

File System

ﬁ Keyword Search \

p Index Search — Bookmarks

g Scripts /
@ Email D Reports

Bookmarks are either added manually or as the result of running a script (e.g., Triage scripts). For more
information about adding bookmarks see Chapter 17 above.

Care should be taken to arrange the bookmark structure effectively to fully maximize the use of report templates
discussed in this chapter.

The Reports module is accessed via the “Reports” tab:

Figure 262: Reports module tab

D Reports

The Reports module is divided into three main sections (as shown in Figure 263 below):
1. Reports tree
2. Preview window

3. Report Editor window
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Figure 263: Reports Module showing the Triage Report
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The sections are described in more detail below.
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18.3 REPORTS TREE

The Reports tree is the location where reports are managed. This includes:

e Loading a new report from a template;

e  Printing or exporting a report as PDF, DOC or RTF;
e Deleting a report;

e  Renaming reports;

e Rearranging sections of a report

e Exporting an edited report (or section of a report) as a new template.

 RUNNING A TRIAGE

When evidence is added to Forensic Explorer the option exists in the Evidence Processor window to Triage (see
“10.5 Credentials are case specific. If credentials are used between cases, the Import and Export buttons can be
used to save and load them for each case.

Evidence Processor” for more information). The triage process runs scripts that bookmark data in the My
Bookmarks\Triage\ folder. The dynamic content of the Triage report is populated from this bookmark. (Note: If
the triage option was not selected, or there were no files found, the Triage report will contain blank fields).

A triage can also be run at any time from the Triage icon in the File System module:
Figure 264: Triage from File System module
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éTRIAGE REPORT REPEATING OVER MULTIPLE DEVICES

The Triage report is designed to work for multiple devices in a case by repeating on the “Triage — Bookmark
Folder” report section as represented by the green icon in Figure 265 below:

Figure 265: Reports Tree showing the Triage Report
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The repeat function is set by right clicking on the required folder > Properties... and applying the * symbol, as
shown in Figure 266:

Figure 266: Iterating a report over multiple devices
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éTRIAGE REPORT AND UNIQUE DEVICE NAMES

The Triage report is also an example where bookmarks are created under unique device names. This is handled
in the report by replacing the unique folder name with * in the bookmark path, as shown in Figure 267:

Figure 267: Triage report, handling unique device names
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Learn more about creating reports in 18.5 Creating Reports.

18.3.2 CHANGING THE DEFAULT REPORT

To use a different report as default:
1. Inthe Reports tree, click the New button and select Set Default from the drop-down menu;
2. Choose the desired report from the list. Any new case will now show the selected report as the

default.

18.3.3 OPEN A NEW REPORT

All new reports are created from a template. Templates are in the ...[profile]/My Documents/Forensic
Explorer/Reports Templates folder. These templates are accessible for any case.

To open a new report;
1. Click on the New button in toolbar;
2. Select the desired report from the drop-down menu.

The report is loaded from a template and added to the Report tree (click on the report name to preview its
content). Once a report has been added to a case it becomes part of that case. It will remain with the case until
the report is deleted.
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18.3.4 REPORT NAME, GROUPS AND SECTIONS

A report consists of the following components:
J Report Name:
Click on the report name to preview the entire contents of the report in the preview window.

Note that it is possible to have more than one report open and visible in the Report tree.

|:|

Report Section:

A report section is used to compartmentalize the content of the report. Click on a section to
display its contents in the preview window (see 0 below). By using multiple sections additional
control can be gained over how the final report is displayed (see Enabled checkbox below).

= A group of sections:

A group is used to arrange sections. Grouping also gives additional control on how the final
report will be displayed. Click on the group to display the entire group content in the preview

window.
Enabled checkbox:

The enabled checkbox determines if the sections or group will appear in a preview, print, or
export.

The Reports tree for the Triage report is shown in Figure 265 above.

18.3.5 RENAME OR MOVE A GROUP OR SECTION

To rename a report, group, or a section:
e Using the mouse, click then hover on the name. Then type the new name in the edit window.
To move a group or section:

e  Click on the group or section with the mouse and drag and drop the group or section to the desired

location.

All rename or move options are automatically saved to the case.

18.3.6 PRINT A REPORT

To print a report:

e  (Click on the report name, or a section in the report, and click the print button. The Windows print

dialogue will open.
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18.3.7 EXPORT A REPORT AS DOC, RTF, OR PDF

To export a report as a .doc, .rtf or .pdf:

e  (Click on the Export button and select the desired format;

Figure 268: Export a Report
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e Save the file to the desired location.

Note: .docx and .rtf do not currently support the saving of page headers and footers.

EXPORTING A REPORT WITH HYPERLINKS

When a report has been created and a field in the report has the option to Hyperlink to Exported File checked
(see Step 8 — Adding Hyperlinks for the exported report), a folder called ReportData is created to hold the
relevant exported files. An example is shown in Figure 269 below where the report and report data has been
exported to the Windows Desktop:

Figure 269: A report with hyperlinks exported to the Windows Desktop
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18.3.8 SAVE A REPORT AS A TEMPLATE

If a report has been changed, or a new report has been created, it may be beneficial to save it as a template so
that it can be re-used in future investigations.

To save a report as a template:
1. Inthe Report tree, click on the name of the report;
2. Rightclick and in the drop-down menu select Save As Report Template.

3. Browse to the required folder, or use the Make New Folder button to create a new destination:

Figure 270: Save a Report Template
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4. Click OK to save the components of the report into the folder.
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Once saved as a template, the report will now be available under the New button in the Reports tree:

Figure 271: Load a report template

= Mew ~ | o= Print HE:{pﬂrtv| A Edit

Sl Triage (Default) me

Blank Report

Broken Template

Sample - CEM Hash Set Match
Samples

Triage - MAC

€F Set Default »
— )

IE Pictures
i[5 References
- E Report Layout
E Skin Tone
= TriageTest
" E Title Page
- l_@ Triage - Bookmark Folder

-3

CEEEEE EEEEE EE EE O

Copyright GetData Forensics Pty Ltd 2010 - 2024, All rights reserved.



Chapter 18 — Reports 277 | Page

18.4 REPORT EDITOR

The Report Editor window has two functions:

1. To preview a current report;
2. Tocreate \ Edit a report.

To switch between preview and edit, click on the report section in the tree and;
e Click the Edit or Preview button in the toolbar, or,

e Rightclick in the tree and select Edit or Preview from the drop-down menu.

The Report Editor Preview (shown in Figure 272 below) displays the content of the currently selected report in
the Report tree.

To preview the report:
e Inthe Repot tree, click on the report name;
To preview a group or a section:
e Inthe Report tree, click on a group or a section.

(If in edit mode, click the preview button at the top of the tree to change to preview.)

Figure 272: Report Editor Preview
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IMPORTANT: For speed purpose a report Preview is limited by default to 100 records. This default can be
changed by setting the following Registry key:
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HKEY_CURRENT_USER\SOFTWARE\GetData\ForensicExplorer v4\Configuration\ DWORD
ReportPreviewlLimit = 100.

If the report contains more than limit a message will appear in the Preview information bar with the option to
generate a Preview for the entire report, as shown in Figure 273 below:

Figure 273: Limited Preview - Generate Full Report
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To cancel the generation of a full report in progress click on the cancel button for this task in the progress bar.

The Repot Editor Edit window gives access to edit an existing report, or to design a new report.

To open the report, Edit window;
e Inthe Report tree, click on a report section and click the Edit button at the top of the tree; or
e Right click and select the Edit option from the drop-down menu.

When in Edit mode the Report Editor will show the toolbar with the various edit functions:

Figure 274: Report Editor in Edit Mode
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18.5 CREATING REPORTS

Whilst the Forensic Explorer Reports module can be effectively used to create one off reports on a case-by-case
basis, the power of the module comes from the ability to design, use, and then re-use automated report
templates in future cases.

As described in the sections above, Forensic Explorer reports are created from bookmarked items. A methodical
approach to bookmark structure will ensure that report templates can be used repeatedly.

Forensic Explorer can report on a single bookmarked item and its attributes or iterate through a list of
bookmarked files and their attributes. The following exercises provide examples of how to design basic report
templates.

18.5.1 PREPARATION FOR REPORT EXERCISES

The following exercises are created using the image file Animals.LO1 available for download from:

http://download.getdata.com/support/forensic-image-files/AnimalsL01.zip

Unzip the download file and use the Animals.LO1 file.

STEP 1 — START A CASE AND BOOKMARK FILES

Start a case and add bookmarks:
a. Inthe Evidence module, create a new case, and add the forensic image Animals.LO1.

b. In the Bookmarks module, right click on the Pictures bookmark folder and add two additional sub folders,
Cats and Dogs (as shown below).

Figure 275: Bookmarks module
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c. Inthe File System module;

e Branch plate the Cats folder;
e Highlight the 21 JPG files in the Cats folder;

e Rightclick in the File List view and Add Bookmark. Bookmark the files to the Cats bookmark folder.

Figure 276: Preparation for report exercises, bookmarking files

Folders Categories [ File List Gallery View Video View (| Disk View &Y Category Graph
Filter: L] No Filter v| B = AZ" Ficrame azv Ext |18 Classificatior (18 Flags
DD% , Filename Extension Classification Flags
= &[0 Time, & 1 [ Black Cats
=2 O ] 2 Orange Cats
= &0 ] 3 ol Baby_cat_sleeping. PG PG
B0 ] 4 [O) Black Cats~$130{590)
= &0 1 5 ofl CatsA10_Baby.JPG PG
XN - 7 6 #l CatsAZ Mary. PG PG
=R - 7] 7 # catsA3_Choco.PG PG
-O ] 8 #l catsA4 Kristaji. PG PG
O ] a il catsAS_Starbuck.JPG PG
B B[ cats (29) 7l 10 =0 CatsA7 TomTom.JPG
B[] [ Black Cats (2) 7] 11 ¥ CatsAB_Gadget. PG
@[] [ Crange Cats (4) 7l 12 &M CatsAg_Minikin.IPG RS bRl
=0 3 7 13 #M catsB1_Corduroy.PG PG Open
[ (& ] 14 tq CatsB3_CharlieTuna. PG IPG .
O 4 F 15 # catsss_Choco. PG PG TP
O 11 ] 16l catsBs_Grendel. PG PG Determine file signature

d. Repeat the step above to bookmark the 10 dog pictures to the Dogs bookmark folder.

e. Switch to the Bookmarks module. Review the Pictures bookmark folder to ensure that it contains the
bookmarked files, as shown in Figure 277 below:

Figure 277: Bookmarked files from Animals.L01

Bookmark Mame

C:[] g Mew Case (1) [Local Time]

= 0 " My Bookmarks (11)
C:[] 7 Documents (0)
T+ -5 Email (0)
C+[] 7 Evidence (1)
T @ Files ()
T 7 it Images (0)
T+ 7 Index Search (0)
C:[] 7 Internet {0)
T[] 79 keyword Search {0)

= L[] 7 Pictures (2)

T[] 7 Dogs (10)
T[] 7 Registry (0)
T[] 7 videos (@)

GO Cats (21) eumm—
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18.5.2 EXERCISE 1: REPORT ON A SINGLE FILE

OBJECTIVE

The objective of this exercise is to create a report for a single file bookmarked in the My
Bookmarks\Pictures\Cats folder. The bookmarked file used in this example is Orange Cat 4.JPG. The finished
report will look as follows:

Figure 278: Reporting on a Single Bookmarked File (finished report output)

Filename: Orange Cat 4.JPG

Accessed: 14-Mar-129:37:12 AV

Created: 17-May-12 2:01:22 P

Modified:  14-Mar-12 9:37:12 PM

Path: Exercise - Creating Report Tenplatesi\Lexar 7G

T T L T Ay ey e e T

e L P I il SR TP P

STEP 1 — PREPARE BOOKMARKS

Follow STEP 1 in 18.5.1 above to prepare a case with bookmarks.

STEP 2 — CREATE A BLANK REPORT

Create a blank report:
a. Switch to the Reports module.

b. Inthe Reports tree, select New > Blank Report.

Figure 279: Creating a blank report

H&-#%-e
£ Evidence File System ﬁ A
T | Reports a
Enew - mPrint | by Export - # Edit
B Triage (Default) Enabled
Blank Report

FERO

Broken Teffiplate
Sample - CEM Hash Set Match
Samples

Triage - MAC

) Set Default L4
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STEP 3 — RENAME THE BLANK REPORT

Rename the blank report:
a. Inthe Reports module, click then hover over the report name to rename the report to Single Item Report.
b. Repeat this step to rename the section. The Reports folder tree should now look like this:

Figure 280: Rename the Report and Section

Forensic Explorer = W dhdk - 20d’

£ Evidence File System i p Index Search
Reparts
New =~ cmaPrint | b Export «
Section Name

S Exercise - Creating Report Templates
" Triage
=- Single Item Report

----- I;.] Single Ttem Report

STEP 4 — EDIT THE REPORT

Edit the report:
a. Highlight the Single Item Report and click the Edit button to open the report in the Report Editor window.

Note that the Edit button changes from Edit to Preview depending on whether the Report Editor window
is in Preview or Edit mode:

Figure 281: Edit/Preview button

[ [ ] Reports a
New = c=aPrint | | Export + 4 Edit
U

b. In the Reportable Items column (shown in Figure 282 below), click on the folder containing the desired
bookmark, i.e., Cats. Then at the bottom of this column, locate and click on the required file, i.e., Orange
Cat4.JPG.

c. The fields available for the highlighted file are now shown in the Available Fields column to the left (as
shown in Figure 282 below).
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Figure 282: Selecting a Bookmarked File and its Fields

Available Fields

A2 Available Fields

Module Fields
Accessed

Attachments

Attributes
Bates #
BCC

BIAS Time

Bookmark Comment
Bookmark Folder
Bookmarked

Byte Start
cc
Classification
Created
Data Size
Directory Level
Extension
File Categary
File Signature
Filename
Flags

Fram
Hash5et

HashSet Category

Reportable Ttems

Qe Report Section: Single Item Report

%= Investigator: Vera Leung

g Exercise - Creating Report Templates (1) [Local Time]

=
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P

T
m

4
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[

3
o

'_ﬁ My Bookmarks (12)
5 audio (0)
'_ﬁ Documents (0]
5 Email (0)
'_ﬁ Evidence (1)
3 Files (0)
T 1icit Images (0)
3 Index Search (0)
'_ﬁ Internet ()
'_ﬁ Keyword Search (1)
= '_ﬁ Pictures (2]
9 cats (21)
? Dogs (10)
'_ﬁ Registry (1)
'_ﬁ Videos (1)

3
o

=
o
|
m

LCatsd3_Charhe luna, i
CatsB5_Choco.JPG
CatsBe_Grendel. JPG
CatsB7_Maebh.IPG
CatsBa_TC. PG

Black Cat 1.JPG

Black Cat 2.JPG

Orange Cat 1.IPG
QOrange Cat 2.IPG
Orange Cat 3.0PG

Orange Cat 4.1PG

{Anim v

o e e e e e e e

Path
A

Anirr
Anirr
Anir
Anir
Anir
Anir
Anirr
Arirr
Anirr

d. Select the required fields with the mouse (use the CTRL key to select a group) and drag and drop the fields

for the file onto the Report Editor window. In this example, we are using the fields: Filename; Created;

Modified; Accessed; and Path. Organize the fields into a vertical list, as shown in Figure 283 below:
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Figure 283: Report Editor Showing Fields

*2) Repart Editor
Section Edit Font Paragraph Format Insert T,

H OB i @ 0 3o

Save .
Fast:
Section Find b By
Report Search Clipboard
N A R R

| £ Orange Cat 4.IPG:File]
|ij'| Orange Cat 4.JF‘G:CrE{
|1j'| Orange Cat 4.]F‘G:Mnd
|1j Orange Cat 4.JPG:.ﬁ.|:I:|I
|1j'| Qrange Cat 4.]F‘G:Pat"

e. Preview the report by clicking on the Preview button at the top of the folder tree. This will show the
contents of the field, as shown in Figure 284 below:

Figure 284: Report Editor - Preview

p Index Search @ Email ﬁ Registry Bookmarks D Reports $ Scripts

Orange Cat 4. JPG

17-May-2012 2:01:22 PM

14-Mar-2012 9:37:12 PM

14-Mar-2012 9:37:12 PM

Animals L01\New Casel\Lexar TGB USB EO01.E01\Partition @ 63\RootlAnimals\Cats\Orange Catsh

f.  Toinsert the picture:
e  Click on the Edit button to edit the page in the Script Editor;

e (Click on the file name Orange Cat 4.JPG in the Reportable Items column (shown in Figure 282 above).
The picture will display at the bottom of the Available Fields Column;

e Drag and drop the picture to the required position onto the report, as shown in Figure 285 below:
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Figure 285: Drag and drop picture onto report

Ao 200 e 200 ailable Fields
Orange Cat 4. JPG:File] AZY Available F
Orange Cat 4.JPG:Crd] odle Feld
odule Fields
Orange Cat 4.JPG:Mof e
| Orange Cat4.JPG:Aca
Accessed

Attachments

Attributes

BIAS Time
Bates #

Bookmarked

elds

Bookmark Comment
¢ || Bookmark Folder

Reportable Items

Report Section: Single Item Report
Report Section: Single Item Report
Investigator: Graham Henley

Filter: |No Filter v [

g Mew Case (1) [Local Time]
=] F My Bookmarks (11)

'_ﬁ Documents ()
3 Email (0)
'_ﬁ Evidence (1)
T Files ()
I licit Images (1)
'_ﬁ Index Search (0)
'_ﬁ Internet (0)
'_ﬁ Keyword Search {(0)
=] '_ﬁ Pictures (2)
S cats (21)
'_ﬁ Diogs {(10)
'_ﬁ Registry (0)
'_ﬁ Videos (0)

Running Processes: 0 .:

g. Toinsert field labels, click on a field then right click and select Insert Label from the drop-down menu:

Figure 286: Insert default label for report field

Set Field...
Set Format...
Insert Label

Hyperlink to Exported File
Copy C

h. Use the format toolbar to add formatting (font, text size, color, etc.). The formatted output is shown in

Figure 278 at the start of the exercise.

SAVE REPORT

Save the report:

a. Use the save button at the top of the Report Editor window to save the current report. The report is saved

with the case.

SAVE REPORT AS A TEMPLATE

To make this report available for future cases, the report must be saved as a Report Template:

a. Follow the instructions in 18.3.8 above to save the report as a template.
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18.5.3 EXERCISE 2: LISTING BOOKMARKED FILES IN A TABLE

OBJECTIVE

The object of this exercise is to show the contents of a bookmark folder as a list in a table. The finished report is

shown in Figure 287 below:

Figure 287: Exercise 2 — Listing bookmarked files in a table

i

Filename

Created

Momﬁeé

CatsB7_Maebh.JPG

17-May-12 2:01:22 PM

14-Mar-125

CatsB6_Grendel JPG

17-May-12 2:01:22 PM

14-Mar-12¢

CatsB5 Choco JPG

17-May-12 2:01:22 P

14-Mar-12}

CatsB3 CharlieTuna. JPG

17-May-12 2:01:21 PM

14-Mar-12¢

CatsB1_Corduroy JPG

17-May-12 2:01:21 PM

14-Mar-12}

CatsA9_Minikin. JPG

17-May-12 2:01:21 P

14-Mar-127

CatsA8_(adget JHS

17-May-12 2:01:21 PM

14-Mar-12{

CatsA7_TomlTomJPG

17-May-12 2:01:21 P

14-Mar-12}

CatsAS5_ Starbuck JPG

17-May-12 2:01:21 PM

14-Mar-123

CatsA4_Kristaj.JPG

17-May-12 2:01:21 PM

14-Mar-123,

DogsA9_Kodie JPG

17-May-12 2:01:23 P

14-Mar-12}

DogsA8 Jack-Jack JPG

17-May-12 2:01:23 PM

14-Mar-12}

e e o B o i T

e Ton e B T il ]

STEP 1 — PREPARE BOOKMARKS

-‘WJ-’HHF‘:,

If not already done, follow STEP 1 in 18.5.1 above to prepare a case with bookmarks.

STEP 2 — CREATE A BLANK REPORT

To create a blank report:

a. Switch to the Reports module.

b. Inthe Reports tree, select New > Blank Report (as shown in Figure 279 above).
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STEP 3 — RENAME THE BLANK REPORT

Rename the report:
a. Click and hover on the report name to rename it to List of Pictures Bookmarks.

b. Repeat this step to rename the section, as shown in Figure 288 below:

Figure 288: Renaming the report

[ | Reports o
ElNew - mPrint | bdExport - Edit

Section Mame Enabled
g Exercise - Creating Report Templates
];' Single Ttem Report
= ];' List of Pictures Bookmarks
' [=] List of Pictures Bookmarks

EEEO

STEP 4 — ADD A REPEATING TABLE TO THE REPORT

Edit and add a repeating table to the report:

a. Inthe Reports tree, highlight the report and click on the Edit button to open the report in the Report Editor
window.

b. In the Reportable Items column, select the Pictures bookmark folder and drag and drop it onto the blank
page, as shown in Figure 289 below:

Figure 289: Drag and drop folder

Bates # LS
? Bookmark Comment Filter: |M':I oL il
Bookmark Created g Mew Case (1) [Local Time]
Bookmark Modified = j My Bookmarks (11)
Bookmark Hame '_ﬁ Documents (0]
e rresteatgr Name 5 Email (0)
Fath '_ﬁ Evidence (1)
Global Fields = Fies (0)
Acquired Date {U... T Tlicit Images (0)
. S Index Search (@
Acqguiring QS Ver... _ﬁ
¢ |2 Acquiring Program _ﬁ Internet (0)
: - ) Keyword Search (0]
: Acquiring ?ystem... ._ﬁ Bictures (2)
Compression Cats (21)
Device Serial Nu... = | Dogs (10)
Device Size (bytes) 5 Eegisty )
Device Volume M., T videos )
m Encase Case Mu... —

c. Select to Insert Item as Table for the table to iterate through each bookmarked file:
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Insert As Field...
Insert As Scriptable Field
Inzert [tems As Table..,

d. Select the Multiple columns per item column table:

Figure 290: Selecting a List View Table Style

Column Table

* Multiple columns per Item

e. The Insert as Table window opens showing the available fields for the Pictures bookmark folder. In this
example we will not use fields associated with this bookmark folder. Leave the Selected Fields blank and
click OK:

Figure 291: Insert Table Window

Insert as Table >

P Selected Fields
AZ™ Available Fields

Module Fields

Bates # ~
Bookmark Comment
Bookmark Created
Bookmark Modified |>3
Bookmark Name
Investigator Name
Path

Global Fields
Acquired Date (UTC)
Acquiring OS5 Version
Acquiring Program
Acquiring System Date (UTC)
Compression

Device Serial Mumber

| - . - n

[Jindude Column Header Back | | Ok Cancel

A blank Pictures table will be added to the report, as shown in Figure 292 below:
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Figure 292: Pictures bookmarks table

H -89
£ Evidence File System ﬁ Artifacts p Keyword Search p Index Search @ Email
I Bl Reports 2 B report Editor
@ Mew = | c=aPrint || |y Export - ﬂ Preview WM Section Edit Font Paragraph Format Insert Table
i = = a— a]
Section Name Enabled = g it ﬁi.%' Fy By o?g . 1 =g
g Exerdise - Creating Report Templates D Save Show Find b Paste
ge Single Item Report Section Header " fac Falg
1= L i v
= ; ILISt of Pictures Bookmarks Report Search Clipboard Paragraph Style
|| List of Pictures Bookmarks
LTRSS OO PR, AUOOL: OO Nt SO POY PP SOt SRR G SO
| Hpictures |

Note that hovering over the Pictures folder with the mouse will show the source bookmark folder for the table
(My Bookmarks\Pictures) in the bottom information bar of the Report Editor window.

STEP 5 - POPULATE THE REPEATING TABLE WITH THE REQUIRED FIELDS

To populate the table with the required fields:

a. Inthe Reportable Items column, select the sub bookmark folder containing the files, e.g., Cats;

b. Inthe bottom window, click on a file name within the Cats bookmark folder. The Available Files column will

now populate. Drag and drop the required files into the table, as shown in Figure 293 below:

Figure 293: Adding fields to a table

rﬁpictwes | (ﬁ_: v modified J IRapor; SE;ﬁOI:;: I'v:«' Ga:lieryi' Report - P
= " nvestigator: Graham Henley
File Name Created |Mod|fied _ Module Fields = >
| Baby cat‘.‘.JPG:Filand i Baby_cat s\eaging.JPﬂ | | Baby_cat_sleepin . ~
Directory Level
Q irectory Leve Fiter: [NoFiter o ||3%
E Extension
1] File Category g MNew Case (1) [Local Time] A
E File Signature = ? Ig Ennkmark;[lul)
E Filename -_ﬁ E;::“E;; @
5| Flags 5
I : From j Evidence (1)
i Hashset 3 Fies (1)
ashse =
= j Tlicit Images (0)
ji| HashSet Category S Index Search (0)
¢ [1] HashSet Identif. .. ._j Internet (0)
£ [ia] Hit Text '_ﬁ Keyword Search (0)
io| Hits =] j Pictures (2)
| 1 T cats 21)
5] Intact Size S Dogs (10)
21| Investigator Na. .. '_j Registry (0)
o] Is Key 3 Videos {0) L
s Yle >
AZ¥ Filename
Filename
tﬂ Baby_cat_sleeping. JPG ~
ol Catsa10_Baby. PG
ol CatsA2 Mary.JPG o
Feiein e e
a > < >
Running Processes: 0 ;2

f.  Format the table as needed and switch to the Preview window to view the result. The table list should look

like Figure 287 at the start of this exercise.
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STEP 6 - SET THE PROPERTIES OF THE REPEATING TABLE

The properties of the repeating table determine what content will be displayed. To set the properties of the
repeating table:

a. Hover the mouse over the table folder, i.e., Pictures. Right click and select Right click and select
Properties:

Figure 294: Table Properties

coe e 00 e fD 2000 ¢
|T‘F‘i-:t|.|res |

Properties... I}

Copy C

This will open the Report Table Properties window:

Figure 295: Repeating table properties

Parent Bookmark Folder:
|I'~'1y' Bookmarks\Pictures | =
Children Filter:
(O ' single Folder Orly
] Direct Children Only [Jinclude Folders
- Indude Items
(@ [=a Fully Recursive
Fully Recursive: The table includes all sub-folders under the Parent Bookmark

Folder (i.e., Pictures);

Include Items Only: The table will report on items (files) only.

STEP 7 - PREVIEW THE FINAL REPORT

a. Click on the Preview button to display the report. The report should appear like Figure 287 at the beginning
of this exercise.

b. Update formatting as needed.

STEP 8 — ADDING HYPERLINKS FOR THE EXPORTED REPORT

In the Report Editor select the field where the link is required, right click and check Hyperlink to Exported File,
as shown in Figure 296 below:
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Figure 296, inserting a hyperlink for an exported report

| S Fictures | 4
Filename Modified Crea)
'-I_I #:Filename | (=] ?:Modified | ?g
Set Field... | ]

Set Format... g

Insert Label i

~  Hyperlink to Exported File ;
Copy C {

4

When the report Preview tab is selected, a blue hyperlink will appear in the relevant column, as shown in

Figure 297 below:

Figure 297: a report with a hyperlink

]

Filename

Mod ified

C reated ¢

CatsA10 Baby IPG

14-Mar-12 9:37:11 PM

11-Aug-14 11:09: 2

CatsA2 Mary JPG

14-Mar-12 9:37:11 PM

11-Aug-14 11:09:2(

Catss3d Choco PG

14-Mar-12 9:37:12 PM

11-Aug-14 11:09:2¢

CatsAd Kristaji. /PG

14-Mar-12 9:37:12 PM

11-Aug-14 11:09:2¢

CatsAh_Starbuck PG

14-Mar-12 9:37:12 PM

11-Aug-14 11:09:2¢

Catssy TomTom.) PG

14-Mar-12 9:37:12 PM

11-Aug-14 11:09:22

CatsA8 Gadget IPG

14-Mar-12 9:37:12 PM

11-Aug-14 11:09:2¢

CatsA9 Minikin JPG

14-Mar-12 9:37:12 PM

11-Aug-14 11:09:28

CatsB1 Corduroy. JPG

14-Mar-12 9:37:12 PM

11-Aug-14 11:09:2¢

CatsB3_CharlieTuna. JPG

14-Mar-12 9:37:12 PM

11-Aug-14 11:09:25

CatsB5 Choco PG

14-Mar-12 9:37:12 PM

11-Aug-14 11:09:2¢

CatsBE Grendel PG

14-Mar-12 9:37:12 PM

11-Aug-14 11:09:2§

CatsBY Maebh JPG

14-Mar-12 9:37:12 PM

11-Aug-14 11:09: 28

CatsBS TC.JPG

14-Mar-12 9:37:12 PM

11-Aug-14 11:08:2F

DogsA10 Maddie JPG

14-Mar-12 9:37:12 PM

11-Aug-14 11:09:2§

DogsAl GretaGarbo PG

14-Mar-12 9:37:12 PM

11-Aug-14 11:09:2¢

DogsAd4 Brady JPG

14-Mar-12 9:37:13 PM

11-Aug-14 11:09:2%

14-Mar-12 9:37:13 PM

11-Aug-14 11:09: 2}

Poﬂsﬁ.a Shay. PG
DogsA7 _Moka. . PG

14-Mar-12 9:37:13 PM

11-Aug-14 11:00:2¢

DogsA9 Kodie JPG

14-Mar-12 9:37:13 PM

11-Aug-14 11:09:2f

When the report is exported, a ReportData folder will also be created containing the relevant images which are

hyperlinked from the report. See section 18.3.7 above.

SAVE REPORT

Save the report:

a. Use the save button at the top of the Report Editor window to save the current report. The report is saved

with the case.
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SAVE REPORT AS A TEMPLATE

To make this report available for future cases, the report must be saved as a Report Template:

a. Follow the instructions in 18.3.8 above to save the report as a template for future use.
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18.5.4 EXERCISE 3: CREATING A GALLERY VIEW REPORT

OBJECTIVE

The objective of this exercise is to produce a gallery view of bookmarked items in the My Bookmarks\Pictures

folder, as shown in Figure 298 below:

Figure 298: creating a Gallery View Report (finished report shown)

Bookmarked Plctues

CatsB8 TC.JPG
C:17-May12201:22 PM

Cats#9_Minikin.JPG
C:17-May12201:21 PM

Cats’8 Gadget JPG
C:17-May12 201:21 PM

e IO

Ly

Catsié_Kristad
C:17-May1220

Orange Cat 1.JPG
C:17-May12Z201:2 PM

Orange Cat 3JPG
C:17-Mayx12 1:46:2 PM

- "

Orange Cat4.JPG
C:17-May12201: 2 PM

.

DogsA7_M

VN e N

VOV e VT

STEP 1 — PREPARE BOOKMARKS

C:17-May1220®
w—'J

If not already done, follow STEP 1 in 18.5.1 above to prepare a case with bookmarks.

STEP 2 — CREATE A BLANK REPORT

To create a blank report:

a.

b.

Switch to the Reports

module.

In the Reports tree, select New > Blank Report (as shown in Figure 279 above).

STEP 3 — RENAME THE BLANK REPORT

Rename the report:

a.

b.

Click and hover on the report name to rename the section to My Gallery Report - Pictures.

Repeat this step to rename the report section.
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STEP 4 — ADD A REPEATING TABLE TO THE REPORT

Edit and add a repeating table to the report:

a. Inthe Reports tree, highlight the report and click on the Edit button to open the report in the Report Editor

window.

b. In the Reportable Items column, select the Pictures bookmark folder and drag and drop it onto the blank

page, as shown in Figure 289 above:

Figure 299: Drag and drop folder

- Bates #

Bookmark Comment
Bookmark Created
Bookmark Modified
Bookmark Name

Path
Global Fields
Acquired Date (U...
Acguiring O3 Ver.,..
¢ 3] Acquiring Program
Acquiring System...
i Compression
Device Serial Mu...
Device Size (bytes)
Device Volume M...
m Encase Case Mu...

akor Mame

Filter: |No Filter

il |

g Mew Case (1) [Local Time]
= ? My Bookmarks (11)
? Documents (0]
3 Email (0)
? Evidence (1)
9 Files (0)
9 Tllicit Images (0)
? Index Search (0]
3 Internet {0}
? Keyword Search (1)
3 Pictures (2)

1_/\\} Cats (21)

? Dogs (10)
3 Registry {0}
;ﬁ Videos (0)

c. Select to Insert Item as Table for the table to iterate through each bookmarked file:

Insert As Field...
Insert As Scriptable Field
Inzert [tems As Table..,

d. Inthe table selection window, use the Grid Table so that pictures are entered horizontally across the

screen in the gallery view format:
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Figure 300: Selecting a Gallery View Table Style

Grid Table

" One grid cell per Item

e. TheInsert as Table window opens showing the available fields for the Pictures bookmark folder:

Figure 301: Insert as Table

Insert as Table ot

Available Fields Selected Fields
AZ¥ Available Fields
Madule Fields
Bates # (s
Bookmark Comment
Bookmark Created
Bookmark Modified
Bookmark Name
Fath
Global Fields
Acquired Date (UTC)
Acquiring OS5 Version
Acquiring Program
Acquiring System Date {UTC)
Acquisition Hash (MD5)
Acquisition Hash (SHA1)
Compression W
M . = e

= carcel

In this example we will not use fields associated with the folder. Leave the Selected Fields blank and click OK.
The pictures table will be added to the report:
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Figure 302: Pictures table

1T Evidence File System ﬁ Artifacts ﬁ Keyword Search p Index Sez
| Bl r " | Report Editor
@ Mew ~|| ¢=s Print b Export - t-t] Preview [ Section Edit Font Paragraph Format Insert Table
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g Exercise - Creating Report Templates O Save Show Finde  ah Paste
ge Single Ttem Report Section Header " A sl
= L i v
; ia :stgfl:i‘lcb_lr;s E-?kaarks Report Search Clipboard
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[Z] My Gallery - Pictures ORI ST PR SO, S OSSP SO O

| S pictures |

Note that hovering over the Pictures folder with the mouse will show the source bookmark folder for the table
(My Bookmarks\Pictures) in the bottom information bar of the Report Editor window.

STEP 5 - POPULATE THE REPEATING TABLE WITH THE REQUIRED FIELDS

To populate the table with the required fields:
a. Inthe Reportable Items column, select the sub bookmark folder containing the files, e.g., Cats;

b. Inthe bottom window, click on a file name within the Cats bookmark folder. The Available Files column will
now populate. Drag and drop the required files into the table, as shown in Figure 293 above:

Figure 303: Adding fields to a table

[Fpictures | (2" modfed Y] Report Secton: My Galery Repart A
- Report Section: My Gallery Repori ,
Module Fields
< >
E Accessed ~ -
[i2] Attachments Filter: (NoFilter o | 3
E Attributes g New Case (1) [Local Time] -~
[i£] B1AS Time =] 3 My Bookmarks (11)
[if] Bates # “J Documents (0)
1 = Email ()]
s m—— e — E Bookmark Com... ="
/ [ soby_cot sespra bl e | I 3 e ()
¢ [ElBeby_cat sleeping. J7] i —J Files
= (e cot deeor ‘ % F Tlicit Images (0)

3 Index Search (0)
'_ﬁ Internet (0)
F Keyword Search (0)
= 3 Pictures (2)
T cats (21)
F Dogs {10)
3 Registry (0)
'_ﬁ Videos (0) w

AZ|IAZ™ Filename

Filename

k! Baby_cat_sleeping.JPG  ~
ol catsa10_Baby. PG

o catsa2_Mary. PG

B mian s s

< >

]

Running Processes: 0 ;|

c. Format the table as needed and switch to the Preview window to view the result. The table list should
look like Figure 287 at the start of this exercise.
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STEP 6 - SET THE PROPERTIES OF THE REPEATING TABLE

The properties of the repeating table determine what content will be displayed. To set the properties of the
repeating table:

a. Hover the mouse over the table folder, i.e., Pictures. Right click and select Right click and select
Properties:

Figure 304: Table Properties

coe e 00 e fD 2000 ¢
|T‘F‘i-:t|.|res |

Properties... I}

Copy C

This will open the Report Table Properties window:

Figure 305: Repeating table properties

Parent Bookmark Folder:
|I'~'1y' Bookmarks\Pictures | =

Children Filter:

(O ' single Folder Orly

] Direct Children Only [Jinclude Folders
= Indude Items
(® 2= Fully Recursive

Fully Recursive: The table includes all sub-folders under the Parent Bookmark
Folder (i.e., Pictures);

Include Items Only: The table will report on items (files) only.

STEP 7 - PREVIEW THE FINAL REPORT

Preview the final report:

a. Click on the Preview button to display the report. The report should appear like Figure 287 at the beginning
of this exercise.

b. Update formatting as needed.
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STEP 8 — ADDING HYPERLINKS FOR THE EXPORTED REPORT

If hyperlinks are required for an exported report, refer to the instructions in the previous exercise.

SAVE REPORT

Save the report:

a. Use the save button at the top of the Report Editor window to save the current report. The report is saved
with the case.

SAVE REPORT AS A TEMPLATE

To make this report available for future cases, the report must be saved as a Report Template:

a. Follow the instructions in 18.3.8 above to save the report as a template for future use.
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18.5.5 EXERCISE 4 - NESTED TABLES

OBJECTIVE

In this exercise, we will create a list of bookmarked pictures grouped by a subcategory, i.e., Cats and Dogs. The

finished report looks as follows:

Figure 306: Finished nested table report

:
Outer Table 3
Cats !
]
Filename Created Modifie
Baby cat_sleeping.JPG 17-May-12 2:01:20 PM 14-Mar-1
Black Cat 1.JPG 17-May-12 2:01:21 PM 14-Mar-
Black Cat 2.JPG 17-May-12 2:01:21 PM 14-Mar-1
CatsA10_Baby.JPG 17-May-12 2:01:21 PM 14-Mar-13
CatsA2_Mary.JPG 17-May-12 2:01:21 PM 14-Mar-{
CatsA3_Choco.JPG 17-May-12 2:01:21 PM 14-Mar-3
CatsA4_Kristaji.JPG 17-May-12 2:01:21 PM 14-Mar-1
CatsA5_Starbuck.JPG 17-May-12 2:01:21 PM 14-Mar-'j'.’
CatsA7_TomTom.JPG 17-May-12 2:01:21 PM 14-Mar-%
CatsA8_Gadget.JPG 17-May-12 2:01:21 PM 14-Mar-3
CatsA9_Minikin.JPG 17-May-12 2:01:21 PM 14-Mar-%
CatsB1_Corduroy.JPG 17-May-12 2:01:21 PM 14-Mar-}
CatsB3_CharlieTuna.JPG 17-May-12 2:01:21 PM 14-Mar-7
CatsB5_Choco.JPG 17-May-12 2:01:22 PM 14-Mar-1
CatsB6_Grendel.JPG 17-May-12 2:01:22 PM 14-Mar-?
CatsB7_Maebh.JPG 17-May-12 2:01:22 PM 14-Mar-t
CatsB8_TC.JPG 17-May-12 2:01:22 PM 14-Mar-#
Orange Cat 1.JPG 17-May-12 2:01:22 PM 14-Mar-3
Orange Cat 2.JPG 17-May-12 2:01:22 PM 14-Mar-

Orange Cat 3.JPG

17-May-12 2:01:22 PM

Orange Cat 4.JPG

17-May-12 2:01:22 PM

—
B
=
0
D
T ekt I 2.

Dogs
Filename Created Modifie¢
DogsA10_Maddie.JPG 17-May-12 2:01:22 PM 14-Mar-%
DogsA1_GretaGarbo.JPG 17-May-12 2:01:23 PM 14-Mar-%
vaﬂmﬁmmmewmAw
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The report is created using nested tables. The structure of the tables is described below:
Figure 307: Layout of a Nested Table
Pictures (bookmark folder)

This is the Outer table

Cats

This is the Inner table
File Name Created Date
CAT1.JPG (Folder 1, Record 1) Created Date
CAT2.JPG (Folder 1, Record 2) Created Date
CAT3.JPG (Folder 1, Record 3) Created Date

Dogs
File Name Created Date
DOG1.JPG (Folder 2, Record 1) Created Date
DOG2.JPG (Folder 2, Record 1) Created Date
DOG3.JPG (Folder 2, Record 1) Created Date

STEP 1 — PREPARE BOOKMARKS

If not already done, follow STEP 1 in 18.5.1 above to prepare a case with bookmarks.

STEP 2 — CREATE A BLANK REPORT

To create a blank report:
a. Switch to the Reports module.

b. Inthe Reports tree, select New > Blank Report.
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STEP 3 — RENAME THE BLANK REPORT

Rename the report:
a. Click and hover on the report name to rename the section to Nested Table Report.

b. Repeat this step to rename the report section.

STEP 4 — ADD A REPEATING OUTER TABLE TO THE REPORT

The purpose of the outer table is to group report results. In this example we wish to group report results by the
sub-folders of the Pictures bookmark folder, i.e., Cats and Dogs.

To add the outer table to the report:

a. Inthe Reports tree, highlight the report and click on the Edit button to open the report in the Report Editor
window.

b. In the Reportable Items column, select the Pictures bookmark folder and drag and drop it onto the blank
page, as shown in Figure 289 above:

Figure 308: Drag and drop folder

> Bates # ~ . _

Bookmark Comment Filter: |M':I Filter e |
Bookmark Created g Mew Case (1) [Local Time]
Bookmark Modified = ? My Bookmarks (11)
Bookmark Name ? Documents {0)
L Name ? Email (0)
Path 5 Evidence (1)

Global Fields 7 Fies (0)
Acquired Date (U... 9 Tlicit Images (0)

? Index Search (0)
? Internet (0)
= Keyword Search (0)

Acquiring 05 Ver...
Acquiring Program
Acquiring System...

= _ _ﬁ %cmres (2)
ompression
Cats (21)
Device Serial Mu... T‘ﬁ Dogs (10)
Device Size (bytes) 5 Eegish'y' )]
Device Volume M, .. _ﬁ Videos {0)

Ir?ﬂ Encase Case Mu...

c. Select to Insert Item as Table:

Insert As Field...
Insert As Scriptable Field
Inzert [tems As Table...

Copyright GetData Forensics Pty Ltd 2010 - 2024, All rights reserved.



302 | Page Chapter 18 — Reports

d. Use the table type Multiple columns per Item;

Column Table

* Multiple columns per Item

e. Add the Bookmark Name field to the report:

Insert as Table b

Available Fields Selected Fields
A-Z¥ Available Fields Bookmark Name

Module Fields
Bates # "
Bookmark Comment
Bookmark Created
| Bookmark Modified
|| Bookmark Name
E Investigator Name

Path

Global Fields
80211D Ie
Account Type Description
Acquired Date (UTC)
Acguiring O5 Version m
Acquiring Program
Acquiring System Date (UTC)
| T B P

nciude Lolumn Reader fal anCe|
[#] Indude Column Head Back OK Cancel

f.  Click OK to add the Outer Table.

g. Tovisually assist in the creation process, rename the Column Header from Bookmark Name to Outer Table
and add space to the table. The table should look as follows:
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Table 1: Outer table

S 00 s 2000 ¢+ et e e 300

| A pictures |
Outer Tabl e|
| A pictures:Bookmark Narl

STEP 6 - SET THE PROPERTIES OF THE OUTER TABLE

The properties of the repeating table determine what content will be displayed. To set the properties of the
repeating table:

a. Hover the mouse over the table folder, i.e., Pictures. Right click and select Right click and select
Properties:

Figure 309: Table Properties

W00 e e 200 st e e e 300

|  Pictures |

Properties...
Copy I"x’ C

This will open the Bookmark Enumerator Properties window:

Figure 310: Repeating table properties

Report Table Properties *

Parent Bookmark Folder:
|I'~"Iy Bookmarks\Pictures | 9

Children Filter:

O 5 Single Folder Only
. Direct Children Only
O E:-n Fully Recursive

Indude Folders
[ ]indude Items
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Direct Children: The table will report Parents direct children, i.e., the Cats and Dogs sub-
folders.

Include Items Only: The table will report only folders (any files in the parent folder will be
ignored).

b. Click the Preview button to display the content of the report. It should look like this:

Table 2: Outer table

Outer Table
Cats

Dogs

STEP 5 — ADDING THE NESTED INNER TABLE

The purpose of the inner table is to display records by group (i.e., a list of all Cats, followed by a list of all Dogs).
To add the inner table:

a. Drag and drop one of the folders required for the inner table, e.g. Cats, to the Report Editor and insert it
inside the outer table, as shown in Figure 311 below:

Figure 311: Nested table. Insert a sub-table.

[~ Sic | | Forensic Bxplorer v3.46(5015) Case: Excercise - Createing Report Templates — [u] X
']
%ﬁ Evidence ... File Syste... pKayword p Index Sea... @ Email % Registry ... Bookmark... D Reports ... g Scripts
El Reports 1 Report Editor -
B New ~ Print.. |kl Exportas - || [ preview (4 edit
Fie Edit Font Paragraph Format Insert Table
Section Name & Enabled I
(= Excercise - Createing Repc ] " - ,_E va
- |2] Nested Table Report Save P'r”e‘«"?; Hi’;‘;";r Fm’j .4 PL'jt = ﬁ
[) Nested Table e ek ]| e ey
[ Repot | Search ] Clipboard
""""" 100- - e e pe e 200 et 300 00 iable Fields Repartable Items
Module Fields Report Section: Nested Tabl
Bates # A Investigator: Graham Henle:
< > Bookma... < >
Page Header | Even Pages Bookma. .. Sookmark Name 4
=5 I Bookma... 5 & Excercise - Createin
[rictures Bookma... B 53 My Bookmarks
[Outer Table Tnvesti... “J Documents {
T pictures:Filename Path 3 email (0)
Global .. 9 Evidence (1)
il : 3 Files (0)
S 1lict Images
= T Index Seard
S Internet (0)
S Keyword Se:
- es (2)
ats (10
Dogs (1€
a > T Registry (0)
......... S videos (0)
< > | Page Footer  Even Pages -7 Triace 1(2)
Processes &
Excercise - Createing Report Tem Running Processes 0 ;:]
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c. Select to Insert Item as Table and use the table type Multiple columns per Item;

Column Table

* Multiple columns per Item

d. Select the fields to use in the table. In this exercise use Filename, Created and modified, as shown in Table
field selection Figure 312 below:

Figure 312: Table field selection

Insert as Table I} X

Available Fields Selected Fields

AZY Avaiable Fields Filename
Created

Module Fields )
Modified
Module Fields A oome

Accessed
Attachments
Attributes
BIAS Time
Bates =

Bookmark Comment
Bookmark Folder
Bookmarked

Byte Start

Created

Data Size

Directory Level

Extension o

m o, - .

nauae Lolumn Reader =] dncel
[ indude Column Head Back oK Cancel

e. Click OK to drop the table into the report.

f.  The Inner Table will display a “\*”, indicating that is operating on the first sub folder, as shown in Figure
313 below (a refresh of the view may be required to see the *).

g. Right click on the Pictures\* folder and display the contents of each sub folder (i.e., Cats & Dogs) by
selecting:
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Table 3: Open the Propertied of the inner table

Doeo e 00 e 200 e e 300

| pictures |
QOuter Table
| S pictures:Filename |

[T rictures\* |
Properties... l/\\s Created
Copy C Black Cat 1.JP

h. Set the properties of the of the inner table:

Figure 313: Setting the attributes of the inner table

Report Table Properties x
Parent Bookmark Folder:
|My Bookmarks\Pictures\Cats | 5
Children Filter:
O 9 Single Folder Qnly
O Direct Children Only [ indude Folders
- Indude Items
(O] {%= Fully Recursive
Full Recursive: The table will report all items in all subfolders of the

parent.

Include Items Only: The table will report only folders (any files in the parent
folder will be ignored).

STEP 7 - PREVIEW THE FINAL REPORT

Preview the final report:

a. Click on the Preview button to display the report. The report should appear like Figure 306Figure 287 at
the beginning of this exercise.

b. Update formatting as needed.

STEP 8 — ADDING HYPERLINKS FOR THE EXPORTED REPORT

If hyperlinks are required for an exported report, refer to the instructions in the previous exercise.
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SAVE REPORT

Save the report:

a. Use the save button at the top of the Report Editor window to save the current report. The report is saved
with the case.

SAVE REPORT AS A TEMPLATE

To make this report available for future cases, the report must be saved as a Report Template:
Follow the instructions in 18.3.8 above to save the report as a template for future use.

18.5.6 APPLY A FILTER TO A REPORT TABLE

It is possible to limit the items shown in a report by applying a filter. The filter can be applied to a wide-ranging
criterion including filename, path, file size, maximum number of records to display, etc.

In the examples below, the Nested Table report from the previous exercise is used.

FILTER 1 — FILTER BY BOOKMARK FOLDER (OUTER TABLE)

To display only contents of the Cats folder only, a filter is applied to the outer table;
a. Right click on the Outer Table folder and in the drop-down menu select Properties;

b. Set the Custom Children Filter using the code:

Result := uppercase(Entry.EntryName) = 'CATS' as shown in Figure 314 below:

Figure 314: Filter a bookmark folder

Report Table Properties X

Parent Bookmark Folder:
|My Bookmarks\Pictures | 9

Children Filter:

(@) ) Single Folder Only

- ]
® Direct Children Only £ Indlude Folders

- [Jindude Items
(O 2aFully Recursive

Sort: ";.5:-; v‘ @ =

Custom Children Filter:

function IsEntryInduded {Entry : TEntry; Index: integer; Continue: boolean) : boolean
begin

Result := uppercase(Entry.EntryName) = 'CATS|

end;

| oK Cancel
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FILTER 2 — FILTER TABLES USING A FILE NAME

To filter a table report by filename;

a. Remove any prior filters;

b. Right click on the Pictures\* folder (inner table) and in the drop-down menu select Properties;
c. Inthe Table Iteration Filter enter the filter:

Result := (pos('CHARLIE', Uppercase(Entry.EntryName) ) > 0)

as shown below:

Figure 315: Filter a file name

Report Table Properties >

Parent Bookmark Folder:
|My Bookmarks\Pictures\Cats | =9

Children Filter:

(@) =5 Single Folder Only

® Direct Children Only [include Folders
- Indude Items
(@) {a Fully Recursive
Sort: ":.s:.-; v| e

Custom Children Filter:

function IsEntryInduded (Entry : TEntry; Index: integer; Continue: boolean) : boolean
begin

Result : = (pos{CHARLIE', Uppercase{Entry.EntryName) } = 0)

end;

cance
which gives the following result:
Figure 316: Results of filtering on the inner table
Y
Outer Table :
Cats ]
{
File Name Created |
CatsB3_CharlieTuna JPG 17-May-12 2.015
:
L
Dogs i
[File Name Created !
[ | j
R :
{
T T e L R e e e A L ey
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The following RegEx commands could also be used:

//Include filenames names that end with .doc:
Result := (RegExMatch(Entry.EntryName,'\.doc$', false))

//Include filenames that end with .doc, .xls, or .pdf:
Result := (RegExMatch(Entry.EntryName,'(\.doc|\.xIs|\.pdf)S', false))

//Include filenames that start with 2 and end with .doc:
Result := (RegExMatch(Entry.EntryName,'*2.*\.doc$', false))

//Include filenames that contain only text and not numbers:
Result := (RegExMatch(Entry.EntryName,'([*0-9]*)$', false))

FILTER 3 — LIMIT THE NUMBER OF RECORDS SHOWN IN A TABLE

It is possible to limit the maximum number of items displayed in a repeating table:

a. Remove any prior filters;

b. Right click on the Pictures\* folder (inner table) and in the drop-down menu select Properties;
c. Inthe Table Iteration Filter enter the filter:

Result := (index < 5) as shown below. This will list the first 5 records in the bookmark folder:

Figure 317: Limit reporting on a bookmark folder to X records

Report T{}Ie Properties *

Parent Bookmark Folder:
|My Bookmarks \PicturesCats | =

Children Filter:

) 9 Single Folder Only

® Direct Children Only [Jinclude Folders
- Include Items
(O F2a Fully Recursive
Sort: Mo Sort “ | @ =

Custom Children Filter:

function IsEntryInduded (Entry : TEntry; Index: integer; Continue: boolean) : boolean
begin

Result := (index < 5) |

end;

anc
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Chapter 19 - Scripts Module

In This Chapter
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19.1 SCRIPTS MODULE

Forensic Explorer utilizes Pascal as its scripting language. Scripts are written and run in the scripts module or

launched in other modules via toolbar buttons or by other scripts. The Scripts module is accessed via the scripts
tab:

Figure 318: Scripts module tab

‘$ Scripts

The scripts module is arranged into three windows: Scripts; Script Editor; and Messages, as shown in Figure 319

below:

Figure 319: Scripts module

5] @ © @ -9 Forensic Explorer w5, 1,2(8940) (64bit) -ox
£ Evidence [ File System .. s artitocts J2 Keyword Sea.. O TndexSearch... (@ Email [ Registry Bookmarks ... [7) Reports S scripts

BE & &2 B O~ 4«

Backup Delphi FEX T Remove windows 7 Forensics
Scripts Basics Basics Button Group Programs Programs
Bl soipts Saript Editor
Za"; ‘ waed I (@@t REBAFE BEQOQO | parameters:
Filters -~
DisplayMessages
24 Saripts spleyMessag
‘4 Artifacts 1 [{ INAME: DisplayMessage.pas) T o
E Backup 2 {IDESC: Shows the difference between DisplayMessage and DisplayMessages in |the progress bar)
[ Bookmarks 2 {AUTHOR: GetData)
- 24 Common 4
E Evidence § program FrogressBar;
[
- ] Excel 7 uses
124 File_System

B Classes, Common, DataEntry, DataStorage, SysUtils;
[ﬁ Keyword_Search

24 Live_Boot Scnpts J.Z var Edltqr

4 Quick_Reference 11 i: integer;

[ Applications 12 Total: integer:
1= Bockmark 13
E Columns 14 begin
- Common + 15 Total := 10000007
[ﬁ Files + 1& progress.max := Totals
=4 Fiters + 17 progress.currentposition := 0f
1= Forms + 18
- Hash + 15 for i := 1 to Total do
=4 Lists ¢+ 20 begin
ﬁ Modules + 21 if not Progress.isRunning then break; v
E Navigation < L4
- 2% Open C:\Users\Vera\ Documents\Farensic Explorer vS\Scripts\Scripts.en\Quick Reference)\Progress\DisplayMessages.pas
4 Paramaters —_— =
- i progess T Sep TS O~ TE T Aoy R R
* LT DisplayMessages.pas 16-1ul 23-Sep-201% 10:15:05 &M Logging: Nozrmal
E Randomize 23-Sep-201% 10:15:05 AM Date Run: 23-Sep-201% 10:15:05 AM
lﬁ Regex 23-Sep-2019 10:15:05 BM FE Version: v5.1.2{8940)
Run 23-Sep-201% 10:15:05 AM
4 Signatures 23-Sep-2015 10:15:12 AM I‘V‘Iessages ———————————
- (# Testing 23-Sep-201% 10:15:12 M Time Taken: 00:00:0€
24 Toolbar ¥ W 23-Sep-2015 10:15:12 M Command Task FINISHED
i 24 23-Sep-201% 10:15:12 BM  Time Taken: 00:00:08
23-Sep-2015 10:15:12 2M v

, Funning? ™

Forensic Explorer is installed with a number of default scripts in the paths:

e ..\Documents\Forensic Explorer v5\Scripts\Scripts.en\
e ..\Documents\Forensic Explorer v5\Filters\Filters.en\

Scripts are separated into sub-folders based on their function.
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When editing scripts, it can be useful to take a periodic backup of an individual script, or the entire scripts
folder. This is achieved with the Backup Scripts button in the Scripts module toolbar.

Figure 320: Scripts module, Backup Scripts.

Backup
Scripts

Figure 321: Backup Scripts.

7 Backup Scripts = O >

About Options

Backup Scripts

0 2l Scripts

Highlighted

Destination Folder

C:\Forensic Explorer Backup\Scripts Backup

Reset | Run Cancel

..................................
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19.1.3 SCRIPTS WINDOW

The script window lists available .pas (Pascal) scripts and their attributes.

Figure 322: Scripts Windows showing .pas file attributes

L] seripts
Mame Madified Description
- % Filters
= 4 Seripts
= j Comman

#- (4 Toolbar

=} [ File System
#- [ Disk View
[ [ Backup Settings.pas 16-Feb-13 1:13:40 PM Backup Forensic

L e i e W e

[ Chart File Types - Excel.pas 04-Mar-13 2:52:496 PM Counts file type by
L[ Chart Fragmentation - Excel.pas 22-Feb-13 3:25:34 FM Analyzes file frag-r

T Clear all Flags.pas 16-Feb-13 1:158:40 FM Clears all flags fr
L[ Entropy Analysis.pas 04-Mar-13 7:47:22 AM Calculates byte
L[ Export File Types.pas 16-Feb-13 1:158:40 PM Export file types

- File List - Ward, pas 22Feb-13 3:25:34 PM Expart FiIeSyste?
Script Attributes
The Scripts window lists the attributes of each script:
Name: The script name is auto generated from the “script.pas” file name.

Description and Author: These attributes are auto generated from the comments at the start of the
script.

Modified and Created: Script dates are auto generated from the Windows date and time stamps of the
.pas file.

Hash (SHA256): A SHA256 hash is calculated for each script. The hash is updated each time the Scripts
window is refreshed. To manually refresh the Scripts window, right click in the Scripts window and
select Refresh option from the drop-down menu.

The purpose of the SHA256 has is so that the investigator can validate the authenticity of a GetData
script, or a script from a trusted third party.

The scripts window is where scripts are created, copied, renamed, and deleted.
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 FILTERS

Filters are scripts which perform the specific task of filtering displayed results to show only files specified in the
filter criteria. The filter scripts are listed in the drop-down bar of a Folders view, as shown in Figure 323 below
for the File System modaule (filters can be applied in Folders view of other modules, including Email and Registry):

Figure 323: Tree view filter (File System Folders view)

Ly H&-%-e
€T Evidence File System ﬁﬂr‘tifacts p Keyword Se
a A N v [ O M

Recover File Mame File T  Shadow Signature T Expand Extract
Folders Search Carve Copy Analysis Files IMetadata
Folders Categories [ File List Gallery View
Filter: |Lf Mo Filter | ~] ) = A2% Filename
CO& (=) (v Fiter Filename
[ 1 [ pEmo 7.E01
+ Bookmarks (11) A (=]
+ Checked (2)
+ Classified (13)
+ Custom (3)
4 Date (3)
« Deleted (2)

+ Duplicates (2)
+ Encrypted (2)
+ Expanded (3)
« File Name (4)
+ Files (24)

0 7

[=] Archives

2] poc, bocx

D Documents

[Z) Email

[Z] Free Space

2 Graphics

= re

2] Lhg

(2 Multimedia

D Music

[Z) POF

[Z) pLIST

[Z] PsT, OST

£ RAR 1 of 1 Visible [5.85 GB] 0 Hig

D Registry Files - All

[Z) Registry Files - Current

- - - - - G B B - -

<

The filter can easily be modified to add additional file types.

 SCRIPTS

Default scripts are separated into subfolders depending on the module in which they are used or their
function.

SCRIPTS\COMMON\

The Scripts\Common\ folder is used to hold scripts that are frequently called by other scripts.

The Scripts\Common\Toolbar folder contains the scripts used to manage the default toolbar button navigation
system provided with Forensic Explorer:

e The default Startup.pas file (described above) initiates the creation of toolbars and buttons by calling
scripts in the Common\Toolbar\ folder.
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SCRIPTS\FILE SYSTEM\

The Scripts\File System\ folder contains default scripts which used in the File System module. This includes
Hashing, Exporting and Skin Tone Analysis.

Sub-folders include:
Scripts\File System\Disk view

The “..\FileSystem\Disk View\” sub-folder contains scripts used to change block color in the Disk View
window of the File System module. Colors are assigned using the color reference chart:
http://en.wikipedia.org/wiki/Web colors

SCRIPTS\REGISTRY\

The Scripts\Registry\ folder contains default scripts used to extract information from registry keys. The
processing script is “Registry_Key_Processor.pas”.

SCRIPTS\SCRIPTS\

Scripts\Scripts\ contains default scripts used in the Scripts module.

| STARTUP

The Startup folder contains the script startup.pas (..\[User Profile]\Documents\Forensic
ExplorerVx\Startup\startup.pas”).

The purpose of startup.pas script is to automatically run when Forensic Explorer is launched and configure the
interface. It can be individually configured by the investigator. For more information, see 19.4 below.
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19.1.4 SCRIPT EDITOR WINDOW

A .pas file selected in the Script window will display its content in the Script Editor. A script can be opened directly
from the editor, or a new script created in the editor. The functions of the editor are primarily controlled by the
toolbar at the top of the Script Editor window. The button functions are as follows:

kA

Save an existing script (a script is also saved when it is run). This button is only active when a script has
been modified but not saved.

@ Undo last.
@ Redo last.
% Cut text.

L‘El Copy text.

Paste from clipboard.

|y

Change font.
q:'?
& Search for text.
=3
AE

Replace text.

€L

Compile and save binary format.

I
A
ar

Compile current script.

Break point a script.

(Save and) Run script as a single thread.

@ © e

Run a threaded script.

(%)

Cancel the execution of the script.

Add/Remove comment lines (Ctrl + Q)

Parameters:

” ” o«

Enter script parameters, e.g., “Parameter One” “Two” “Three” “Four”.
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19.1.5 MESSAGES WINDOW (CONSOLE)

The Messages window (also referred to as the “console”), is used to display compiler error messages or script
output.

A console message is written with the “Process.log(‘Text”) command. In the default scripts provided with
Forensic Explorer the log output is often formatted with a “procedure” (see below) to include a date and time
reference using a using the command “ConsoleLog('Text’)”. See Appendix 7 - Sample Script, for an example.

If a script is run in the Scripts module, the output will appear in the Messages window. However, if a script is
executed in another module (run from a toolbar button or a link) the output is written to the log file for that
module. Access the log for a module via the “Processes” log (see 7.4 - Task Processes List, for more information).
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19.2 MANAGING SCRIPTS IN THE SCRIPTS WINDOW

To open a script:

Double click on the script name in the Scripts window. This will display the script in its own tab in the
Script Editor window.

To create a script:
1. Right Click in the Scripts window and select Scripts > New (.pas)
2. Enter the name of the new script in the popup New (Scripts) window.

3. The script will then appear in alphabetical order in the Scripts window. Double click to display the
content of the new script in a tab in the Script Editor.

To copy a script:
1. Right click on the script in the Scripts window.
2. Select Scripts > Copy from the drop-down menu.

The highlighted script will be copied. A new script of the same name will appear in the Scripts window with the
added file name text “_0001.pas”. Then use the re-name function to rename this file.

To rename a script:
1. Highlight the script in the Scripts window.

2. Right click and select Scripts > Rename from the drop-down menu. Edit the file name in the Rename
File window:

Rename File -

Mew flename:

Note: If the renamed file does not appear, right click in the Scripts window, and use the Refresh option to
refresh the display. If the renamed file still does not appear, check to see that it has been renamed with the .pas
extension.

To delete a script:
1. Highlight the script in the Scripts window.
2. Right click and select Scripts > Delete from the drop-down menu.

A confirmation window will appear to confirm that the delete is required.
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19.3 INTRODUCTION TO SCRIPTING

Forensic Explorer is installed with “Delphi Basics”© reference documentation. It is installed in the path:
“C:\Program Files\GetData\Forensic Explorer v5\Delphi Basics\” and accessible by the “Delphi Basics” help
button in the Script module toolbar (shown below):

Figure 324: Scripts Module toolbar, Delphi Basics, FEX Basics scripting documentation

is | a%

Delphi FEX
Basics Basics

-

The Delphi language is a set of object-oriented extensions to standard Pascal and has become the most popular
commercial Pascal implementation (see http://en.wikipedia.org/wiki/Comparison of Pascal and Delphi for

more information). Delphi Basics© is provided as a reference guide only. Not all commands/features in the
documentation are available in Forensic Explorer. Delphi Basics© is licensed for use from
http://www.delphibasics.co.uk/ and may only be used with Forensic Explorer.

FEX Basics can be used to quickly create a working example of FEX specific code. Includes additional templates
to quickly create a working GUI script template.

A typical Forensic Explorer script contains the elements described in the paragraphs below.

19.3.1 PROGRAMMING COMMENTS

It is good programming practice to include comments within a script. Comments help anyone reading the script
understand the authors intention. Comments are shown in the Script Editor window in red. To insert a comment:

e //The forward slash marks are used for a single line comment

e {Theright and left brackets are used for a comment that can be written over multiple lines}

19.3.2 RESERVED WORDS

A Forensic Explorer script starts with the word 'Program' (although it is not explicitly required) and ends with
'End.’ (A period after an “End” identifies the end of the program). These are examples of “Reserved Words”, set
aside for special use and which cannot be used for any other purpose. Reserved words are shown in blue in the

Script Editor window. Following is a list of reserved words in Forensic Explorer.

|and ||array Hbegin Hcase Hconst Hdiv |
|do ||downto ||e|se ||end ||fi|e ||for |
|function ”goto ||if ||in |||abe| ||mod |
|ni| ”not ||of ||or ||packed ||procedure |
|program ||record ||repeat ||set ||then ||to |
|type ||unti| ||var ||whi|e ||With ||uses |
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‘Uses’ enables a script to call on a library of additional code. For example, the “GUI” library in the example above

enables the scripter to use “MessageBox”, which constructs a displayed window without the need to write
extensive code. Forensic Explorer has the following code libraries:

ByteStream
Classes
Common
DataEntry
DataStorage
DataStreams
Graphics
GUI

Math
MetaData
RawRegistry
System

SysUtils

A constant declares a value that cannot be changed during script execution. It is often used so that the constant
can be easily edited (outside of program execution) and thus updated at multiple reference points in the script.
An example is provided in Appendix 7 - Sample Script, where “starting age” is declared as a constant and
referenced multiple times.

The variable block starts after the "var" reserved word and continues until the next reserved word is reached. A
variable stores a value that can be changed during the execution of a script. Each variable must be a unique,
non-reserved name, followed by a declaration of its type, for example:

e Integer = a whole number, positive or negative.
e Real =adecimal number (e.g., 12.987)

e Boolean = true / false

e  String = Character

Once a variable is declared, it can be assigned a value in the script “:=", for example, X := 27.
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A procedure is a set of instructions to be executed, with no return value. A function is a procedure with a return
value.

A commonly used procedure, “ConsolelLog”, is used in Appendix 7 - Sample Script. The procedure formats the
Progress.log command (writing a message to the messages window) to include the date and time:

Figure 325: Procedure "ConsoleLog"

procedure ConsoleLog(AString: string);
begin

Progress.Log('[' + DateTimeToStr(now) + '] : ' + AString);
end;

The procedure is called with the line:
ConsolelLog ('Here is the message’);
And the resulting output is:

[17-Jan-13 1:47:22 PM] : Here is the message

The main part of the script appears between the two reserved words, “begin", marking the start of the code,
and "end." (with a period) marking the end.

A script is broken down into a series of commands. A general rule is that a command must end with a semi-
colon. If a command extends over several lines, for example an “If Then Else” statement, generally the semi
colon won’t appear until the end of the entire statement.

Errors in a script are reported in the Messages (console) window. Usually, the message will provide the line
number of the code where the error appears. Double click on the line number to go directly to the problem
line.
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19.4 STARTUP.PAS

The startup.pas script, “...\[User Profile]\Documents\Forensic Explorer\Startup\startup.pas” runs when
Forensic Explorer is launched.

To view the startup.pas script:
e Go to the Scripts module.

e At the bottom of the Scripts window (top left-hand window) click on the "Startup" folder to
show "startup.pas";

Scripts

Mame 4

&% Filters
= 4 saipts
[ﬁ Comman
-- [ﬁ File System
[ﬁ Phaone
-- i Quick Reference
[E Registry
& 4 Scripts
= 24 startup

g startup.pas

e Double click on "startup.pas" to open and display its content in the Script Editor (right hand
window).

Startup.pas can be used to:
e Manage displayed modules (turn modules on/off at startup using the 'Startup Modules.pas' script.
e  Startup with custom modules (see "Phone Module").
e Add button groups and buttons to module toolbars.

These features in the startup.pas file can be activated by removing the // slash marks are used to comment out
the code.
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Module

19.4.1 MANAGE STARTUP MODULES

In certain situations, a computer forensics investigator may choose not to start Forensic Explorer with all
modules visible. For example, when a case is to be reviewed by a third party, the forensic investigator may
choose only to display relevant modules, such as Keyword Search and Bookmarks.

Figure 326: Startup.pas

S

Name Modified
% Fiters
=4 saipts

4 Artifacts

(4 Backup

(24 Bookmarks

startup

Configures startup modules, custom modules

124 Evidence
1 Exeel
(4 File_system

1
2
K]
(=4 common g
H
=
7
8

program Startup;

uses
Common, Modules, DataStorage, SysUtils:

HOO+DEASRE WHEQOQO W pramees [ ]

and module toolbars. )}

124 Keyword_Search
(24 Live_Boot 10 procedure Consolelog (A5tring: string):
124 Quick_Reference 11 begin
124 Rambisk 12 Progress.Log('[' + DateTimeToStr{now()) + '] :
[ Reference_Library 13 end;
(24 Registry
124 scripts
14 Triage
- startup
LT startup.pas

//add time and date to the console log messages.

"+ AString);

cedure InitDisplay():

235ep-2) 18 begin
Consolelog ('The star

1. MANAGE STARTUP

NAME ARTIFACTS)

The method which can be used is to hard code the modules provided in the default startup.pas script.
Example code to hide the Registry Module is shown below:

tempModule := ModuleManager.ModuleByName('Registry');
if assigned(tempmodule) then
tempModule.WillShow(false);

Note: If the Scripts module is hidden with this technique, it will be necessary to edit the script using
Windows Notepad (or other such program to re-enable the Scripts module).
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Chapter 20 — Encryption
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20.1 ENCRYPTION

There are many different types of encryptions which vary in complexity and effectiveness. Some are easily
identified and broken. Some are difficult to identify and impossible to break.

Forensic Explorer currently supports the following types of encryptions:
e Windows NTFS encryption.
e  BitLocker.

e File Vault 2.

Forensic Explorer displayed Windows NTFS encrypted (green) and compressed (blue) files using color, the same
way as Windows:

Figure 327: Windows 10 file: Compressed (blue), Encrypted (green), Password Protected, and Normal

N s Test Folder

B Decktop " Name
& Onelrive % Windows 10 Compressed File.docx
& User @Windnwsm Encrypted File.docx
I3 Thic PC Windows 10 Microsoft Word Password Protected File.docx
; Desktop Windows 10 Mormal File.docx
S I i P

Figure 328: Windows 10 file: Compressed (blue), Encrypted (green), Password Protected, and Normal

3l [=] AZY Filename 1:8| Entropy
Filename Extension  Entropy
1 [o) windows 10 Compressed File.docx docx 0.7226
2{].| Windows 10 Normal File.docx docx 0.7422
3 2] windows 10 Microsoft Word Password Protected File.docx  docx 0.8722
4 [2) windows 10 Encrypted File.docx docx 0.9983

Windows Encrypted files can be easily filtered in Forensic Explorer by adding the IsEncrypted column to the File
List view. IsEncrypted is a Boolean field of Yes or No.

Windows encrypted files can be decrypted in Live Boot by logging into the computer as an authorized user. See
Chapter 28 for more detail.

Support has been added for MAC APFS encryption. A prompt will show for credentials when an image is added.
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APFS encryption prompt on add image:

E APFS Volume Credentials XM\APFS Test Images\Encrypted\APF5S Enc 2GB with files.E0 - O >

Farensic Explorer is trying to access an Encrypted APFS Valume

Please supply a valid credential (password, recovery key or file) to allow access.
— il Volume: Getdata APFS
s UUID: {CFDATARS-0D52-AC4E-AD32-0CAFSDD1ATS 3}
l[ Credential: ||
]

Browse... L\x’ Cancel

20.1.3 BITLOCKER ENCRYPTION

BitLocker is a full disk encryption feature included with Windows Vista and later. It is designed to protect data
by providing encryption for entire volumes. By default, it uses the AES encryption algorithm in cipher block
chaining (CBC) or XTS mode with a 128-bit or 256-bit key. (https://en.wikipedia.org/wiki/BitLocker, July 2017).
For more information see:

BitLocker frequently asked questions (FAQ) (https://docs.microsoft.com/en-us/windows/device-
security/bitlocker/bitlocker-frequently-asked-questions, July 2017).

During setup of a BitLocker partition a user is provided a recovery key which can be used to access the encrypted
partition even if the main key is lost. Microsoft recommend that the recovery key is:

e Saved to a file.
e  Printed.
e Stored on a USB flash drive; or

e Saved to a Microsoft account on Windows 8 and 8.1. If you back up the recovery key to your Microsoft
account.

A BitLocker Recovery Key file has a default filename in the format:
BitLocker Recovery Key 0C29BEFD-E244-4ADC-B8A0-A6D1DD6588B5.TXT

where the number used in the filename is the identifier (not the actual key). Inside this file is the Bitlocker key:
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Figure 329: Content of a Bitlocker Recovery Key file

BitLocker Drive Encryption recovery key
To verify that this is the correct recovery key, compare the start of the following
identifier with the identifier value displayed on your PC.
Identifier:

0C29BEFD-E244-4ADC-B8A0-A6D1DD6588B5
If the above identifier matches the one displayed by your PC, then use the following
key to unlock your drive.
Recovery Key:

672573-169873-647867-465509-462253-505483-475772-203071
If the above identifier doesn't match the one displayed by your PC, then this isn't
the right key to unlock your drive.
Try another recovery key or refer to
http://go.microsoft.com/fwlink/?LinkID=260589 for additional assistance.

20.1.4 FILE VAULT 2

File Vault 2 is a full disk encryption feature included with MAC OS X Lion (released July 2011) or later. See
https://support.apple.com/en-au/HT204837 for more information.

20.2 DECRYPTING SUPPORTED ENCRYPTION FORMATS

To decrypt Bitlocker and File Vault 2 drives:

DECRYPTION WHEN ADDING EVIDENCE
IMPORTANT: Bitlocker decryption requires the forensic workstation to be running Windows 10 (or above).

When a forensic image containing a supported encryption, format is added to Forensic Explorer the investigator
will be prompted with the following Bitlocker Credentials window:

Figure 330: Encryption Credentials window (BitLocker shown)

E BitLocker Credentials D\2, Test imageshTesting files\Encrypted files\Thumbdrive Encry... — O x

Forensic Explorer is frying to access an Encrypted Bitlocker Partition
Please supply a valid credential (password, recovery key or file) to allow access.

Partition @ 0 (123.3 MB)
Recovery ID: {E69B3CES-4259-40 1C-0A3F-0C6A2AFC 3FDE}

Credential: ||

Browse... Cancel

This window will accept either the password (or in the case of Bitlocker, the recovery key or Bitlocker recovery
file). Without one of these credentials, the partition cannot be decrypted (click Cancel to bypass the decryption
process).
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Examples of an encrypted and decrypted partition are shown in the screen shots below:

Figure 331: Encrypted Partition (closed padlock)

Folders Categories

Filter: [ Mo Filter w

Filename E
C: g Mew Case 1 (1) [Local Time]
=[] [ 20011703 - BITLOCKER - Thumbdrive 2 Smart USB.ED1 (2)

L[] g Bitlocker Partition (0) [ [

Figure 332: Decrypted Partition (open padlock)

Folders Categories

Filter: [ Mo Filter w

Filename i
E[] g Mew Case 1 (1) [Local Time]
=[] [} 20011703 - BITLOCKER - Thumbdrive 2 Smart USB.E01 (2)
=H®[] g Bitlocker Partition (7) [Otadam1234]
®:[ ] =5 Orphaned (0)
B[] | Root(s)
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DECRYPTION DURING A CASE
To decryped a partition during a case:

1. Right click on the encrypted partition and select Encryption Password, as shown in Figure 333:
Decryption during a case:

Figure 333: Decryption during a case

Folders Categories

Filter: [ Mo Filter v

Filename i
C+[] 2= Mew Case 1 (1) [Local Time]
-] [ 20013703 - BITLOCKER - Thumbdrive 2 Smart USB.EO1 (2)

I—DD g Bitlocker Partition (0) [] [] E, IO
ocokmark...

[&L Export... »

Encryption Password

2. Enter the Bitlocker credentials:
Figure 334: Encryption password prompt.
E BitLocker Credentials DATRAINING - 202002, Evidence\Other\Adam Thomas Hamilto... — O >

Forensic Explorer is trying to access an Encrypted Bitlocker Partition
Please supply a valid credential (password, recovery key or file) to allow access.

Partition @ 0 (123.3 MB)
Recovery ID: JE69B3CES-4259-40 1C-9A3F-0C5A 2AFC3FDE}

Credential: Otadamiz34|

Browse. .. Cancel

3. If the Bitlocker password has been accepted, the password will appear next to the encrypted partition
in the Folders view and the Evidence Processor window will open:
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Figure 335: Process the decrypted Bitlocker partition.

Folders Categories

Filter: [ Mo Filter v

Filename
O g Mew Case 1 (1) [Local Time]
=T [ 20013703 - BITLOCKER - Thumbdrive 2 Smart USB.E01 (2) [Locs

L[ & Bitlocker Partition (0) [] [0tadam1234] _
Evidence Processor

[FH] File List Gallery View Video View [
P @

-

AZ¥ Filename

Filename

Evidence Mame: Bitlocker Partition

(DEFALLT)

Tasks
FileSystem

—l@ Process in Parallel
£ Werify Device Hash
5™ Search for IS0 Tracks (CD/DVD)
£ Search for MBRs
L™ search for FileSystems
£ Signature Analysis
£ Compound File Expansion

Note that if a Bitlocker partition has been added but not processed (i.e., the Cancel option was selected in the
Evidence Processor window above), it is possible to right-click and process the partition during the case:

Figure 336: Process a decrypted Bitlocker partition during a case.

Folders Categories

Filter: [ Mo Filter

Filename

= g Mew Case 1 (1) [Local Time]

L[] 5 Bitlocker Partition (0) [| [0tadam1234]
[ AddBookmark...

@ Export..
EF Modify time setting...

@
& Process..,

=] [ 20017703 - BITLOCKER - Thumbdrive 2 Smart USB.E01 (2)
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20.3 IDENTIFYING OTHER ENCRYPTED FILES

20.3.1 IDENTIFYING ENCRYPTED FILES USING ENTROPY

The entropy score of a file is an expression of randomness where the more random the data, the higher the
score. Encrypted files have a high entropy score.

To calculate file Entropy scores in a case:

1. In the File System module click the Analysis Programs button and select Entropy Analysis from the
drop-down menu.

2. Add the Entropy column to the display.

3. Double click on the column name to sort by Entropy.
It is expected that an encrypted file will have an entropy score of .995 or higher, as shown in Figure 328 above.
The limitations of using entropy to identify encrypted files include:

e Many files, e.g., ZIP, have a naturally high entropy score and false positives may occur.

o Depending on the type of encryption used, a protected file may not have an entropy score above .995,

as shown in Figure 328 above with the Microsoft Word Password Protected File.docx.

20.3.2 IDENTIFYING ENCRYPTED FILES USING A THIRD-PARTY TOOL

The most well know tool to identify encrypted/password protected files is Passware’s free Encryption Analyzer,
available at: https://www.passware.com/encryption-analyzer/.

To identify encrypted files using Passware Encryption Analyzer and Mount Image Pro (provided with Forensic
Explorer):

1. Install the latest version of Mount Image Pro from www.mountimage.com (requires a reboot after

install to load the mount drivers).
2.  Run Mount Image Pro from the desktop icon.
3. Click the Mount button in the GUI toolbar.

4. Click Add Image and add the required image to the Device Selection window:
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Figure 337: Mount Image Pro Device Selection window

Select the image file, or other device to Mount:
Device Label

= _.t'J Image Files

= k My Computer

= a Hard Disk 0 W \PHYSICALDRIVED
i E: GH-Data

= a Hard Disk 1 W PHYSICALDRIVEL
; D: GH-Data

= ﬁ Hard Disk 2 W PHYSICALDRIVEZ

_.t" 16051T02 Dell Laptop.E01  E:\GH Forensic Images'-— TRAIMIM. ..

[l Mount. ..

d Add Image
= Add RAID

@ Remote

(%) Remaove

&4 pefresh

Cancel

5. Click the Mount button.
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6. Mount the image as File System with the following settings (File System ensures access to all files,
including deleted, system and hidden):

Figure 338: Mount Settings

W Mount: E\..\1605JT02 Dell Laptop.EO01 >
b ount A

O Disk
(®) File System

b aunt Points:

Location or ;
Dirive Letter[z): Automatic i
Digk Ophions:
Fead Only
B12
Cache Folder:  |/[Ciefault Cument Image Folder] =
File Syster Options:
Label | MIP Filesystem Disk
Include Unallocated Space:
Include Deleted Files:
Include System Files:

Remaove Hidden Attibuites:
Remowve Spstem Attibuites:

[

F, Cancel
7. If additional images are added, it is possible to add to the same drive letter under the Mount Points
option.
8. Click OK to mount the drive.

Figure 339: Mount Image Pro GUI showing mounted File System drive

M Mount Image Pro v6.42 (1853) - Activated — O *
File Options Help
@_ Mount... - B_ Unmount - @\ View... m Options @ Update a Help
Filename Capacity ~ Mounted As Partiton  Mount Paint Location (Bytes) Propertty  Walue
= 18014707 Dell Laptop.EO1 T453GE  Disk [PMNP) WAPHYSICALDRIVEZ
Spstem Reserved (E:] 100.0 MB 1 [Active] E: 1048576
Local Disk (F:] 7443 GE 2 F: 105906176
£ >
sk x64 v6.5.0(56), Service Started FileSystem x64 v6.5.0(36), Service Started
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9. Launch Passware Encryption Analyzer and scan the mounted drive:

Figure 340: Passware Encryption Analyzer

|5 Passware Encryption Analyzer
File View Help

@Back @ Formard ‘ ﬂ?Search ‘ & Upgrade % Support @ Help

Scan Options

Quick Start [] Scan system folders
B 5can My Computer [] Scan slow file types
[ Scan Documents Where to Scan
i () My Computer
Scan Local Drives 0 My Documents
() All Local Drives
@ Heo (®) Selected Drives and Folders

Select Drives and Folders
(i 05 (C)
[ lsH-Data (D3

Scan Options Details *

Enable all the Scan Options for a
full scan. [ GH-Data (E:)

Disabling some of the Scan
Optiens will make the scan
faster. For example, system files
and the following database files
that are slow to analyze can be
skipped:

5 [ s CODEMETER (F5)
— MIP Filesystem Disk (G:)

MS SOL

ACT! 3.0

ACT! 2007 and higher
MYOB

Encrypted files can now be detected by the File System > Analysis Programs > Encrypted Files script:

|87 Find Encrypted Files — O b

About  Options

Find Encrypted Files:

[l Blackberry .rem files

[AiTunes Backup (Manifiest.plist)
[£IMs Office ¥ML (DOCX, XLSX, PPTX)
FANTFS Encrypted

EIrar

Mzip

M 7zip

[Ireport Other Archive Types With High Entropy

[ add Entropy column: Add at column 3 w
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20.4 DECRYPTED PASSWORD PROTECTED ARCHIVES (ZIP, 7Z)

To decrypt a password protected archive file (e.g., ZIP, 7z) in the File System module:
1. Locate the encrypted file using the method described above.

2. Right-click on the file and select Set Password from the menu:

Figure 341: Setting a password for a file in the File System module

[F7] File List Gallery View video View [, Disk View &8 Category Gra

&%= b A2Z¥ Filename 18 Flags
Filename Flags
] 1 @] country-flags. zip
Add Bookmark...
Classify r
Flags r
Set Password...
&  Open

3. Enter the password and click OK. This password is attached to the file and saved with the case:

Figure 342: Enter file password

Set Password X

Set Entry Password  password

Cancel

4. Right-click and Expand compound files(s). If a password is stored with the file, it will be used in the
expand process to decrypt the content.
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Chapter 21 — Date and Time
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21.1 DATE AND TIME IN COMPUTER FORENSICS

Timestamps are often important in a computer forensics examination. The investigator should have a clear
understanding of the subject before making critical conclusions.

When date and time is an issue, the following verified information should be at hand:
e The time zone where the computer or device was operating when it was acquired.

e Thetime of the computer BIOS clock compared with a verified time source (e.g., a recorded time service)
for that location.

It is the file system in use which determines whether Modified, Accessed and Created (MAC) times are stored in
local time or Coordinated Universal Time (UTC). Appendix 4 - Summary of Date and Time, is a summary table of
file system date and time, including the location of the source data interpreted by Forensic Explorer.

Date and time attributes of individual files can be examined using the Filesystem Record view of the File System
module (see 8.12 - Filesystem Record view, for more information).

21.2 FAT, HFS, CDFS FILE SYSTEM DATE AND TIME

FAT, HFS and CDFS store local date and time as per on the BIOS clock. There is no time zone adjustment. For
example:

o Afile stored at 11am is stored in the file system as 11am.

When Forensic Explorer opens this file, the default file time will display as 11am.

21.3 NTFS, HFS+ FILE SYSTEM DATE AND TIME

NTFS and HFS+ file systems store date and time in Coordinated Universal Time (UTC), which in practical terms,
when fractions of a second are not important, can be considered equivalent to Greenwich Mean Time (GMT).
To display date and time information in a format relevant to the end user’s location, the UTC time is translated
into local time using the computer’s time zone setting.
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21.4 DATE AND TIME INFORMATION IN THE WINDOWS REGISTRY

Windows time zone settings are held in the Windows registry. They are set during install and can be modified at
any time via the Time Zone Setting options of the control panel (shown below):

Figure 343: Windows 7 time zone settings

(s ™y
#5 Time Zone Settings — - ﬂ
Set the time zone:
Tirme zone:
[(UTC-U?:UO] Mountain Time (US & Canada) -

[V] Automatically adjust clock for Daylight Saving Time

Current date and time: Wednesday, 26 January 2011, 3:42 PM

[ oK J ’ Cancel ]

“ "y

For Windows 10, time zone settings can be found in Settings > Time & Language > Date & Time > Time zone
drop-down menu.

As the time zone may be incorrectly configured or deliberately altered, it is necessary for the investigator to
determine these settings so that the correct time zone offset for the case can be made.

21.4.1 MANUALLY EXAMINE REGISTRY FOR TIME ZONE INFORMATION

Registry files are in the following path:

e Windows NT/2000: C:\Winnt\System32\config\

e  Windows XP/Vista, 7 and 10: C:\Windows\System32\config\
This path contains the five hive files:

e SAM (Security Accounts Manager).

SECURITY (Security information).

SOFTWARE (Software information).

SYSTEM (Hardware information); and,

DEFAULT (Default user settings).

(Note that each file has a corresponding repair file in case of corruption. Be sure to examine the active registry
files.)

To examine a registry file in Forensic Explorer the file must be first added to the Registry module.
To add a stand-alone registry file:

1. Inthe Evidence module, commence a case or a preview.
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2. Click on the Add File button and select the file. Forensic Explorer identifies a registry file by its file
signature. The Evidence Options window displays with the option to add the hive to the Registry
modaule. Click OK to proceed.

To add a registry file from within an existing case or preview.
1. Locate the registry file in the file list view of the File System module.

2. Right-click on the registry file and select the Send to module > Registry option from the drop-down
menu.

REGISTRY - CURRENT CONTROL SET

To locate relevant date and time information in the registry it is first necessary to determine the “current control
set”. This identifies the last system configuration booted by the computer.

CurrentControlSet is identified using registry file:

e  Registry file: C:\Windows\System32\config\SYSTEM
And registry key:

e \Select\Current\

The key Current is a pointer to the current control set. A Dword hex value of “01 00 00 00” identifies the current
control set to be:

e \ControlSet001

(Note: A typical Windows installation contains at least two control sets.)

REGISTRY - TIME ZONE INFORMATION

Once the current control set is identified, Time Zone information can then be identified in the SYSTEM registry
file under key:

e \CurrentControlSet\Control\TimeZonelnformation

As shown in the Forensic Explorer Registry module in Figure 344 below:
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Figure 344: Windows registry: HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\TimeZonelnformation
Image file: NIST Hacking Case (14)

B Registry List

%_-’:‘ = AZ¥ Key Mame 1-8 Flags || &-Z¥ Key Typ
Key Mame “  Flags Key Type key Data
] 1 D raSecDiEsc {value not set)
] 2 4] ActiveTimeBias REG_DWORD  0x0000012C (300)
] 3 4] Bias REG_DWORD  0x00000158 (350)
] 4 %) DaylightBias REG_DWORD  OxFFFFFFC4 (4294967236)
] 5 gl_ﬂ Davylightiame REG_57 Central Daylight Time
|:| = _?_-'-_nﬂ DaylightStart REG_BIMARY 000004000100 0200000000470...
| 7 §4) standardBias REG_DWORD  0x00000000 (0)
] ] 3'_1] StandardMame REG_SZ Central Standard Time
|:| 9 _ﬁ'-_n'] StandardStart REG_EBIMARY 00 000AQDQS0002000000004a,.,

9 of 9 Visible [136 bytes] 0 Highlighted [0 bytes] 0 Checked [0 bytes]

The information in the registry includes:

ActiveTimeBias: The number of minutes offset from UTC for the current system time.
Bias: The number of minutes offset from UTC for the current time zone setting.
DaylightBias: The number of minutes offset from UTC for the current time zone when daylight

saving is in effect.

DaylightName: The name of the time zone (daylight saving).

DaylightStart: The date and time daylight saving starts.

StandardBias: The number of minutes offset from GMT when standard time is in effect.
StandardName: The name of the time zone (standard time).

StandardStart: The date and time when Standard time starts.
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21.4.2 EXTRACT TIME ZONE INFORMATION

Registry information, including Windows date and time settings, is also available in Forensic Explorer by using
the toolbar shortcut Quick Registry > Windows TimeZone located in the File System module.

The Windows TimeZone script decodes the registry keys and provides output in the following format:

Figure 345: NIST Hacking Case (14) output.

1 Triage - Registry — [m| X
Parse: Registry

¥*% TimeZone Information **%

Source: NIST - 4Dell Latitude CPi.E0l1\Partition @ &3‘\Root\WINDOWS\repair‘\system

Bias: 2€0

DaylightBias: -€0

RetiveTimeBias: 300

Source: NIST - 4Dell Latitude CPi_E01\Partition @ €3%Root\WINDOWS\system32\confighsystem
Bias: 2€0

DaylightBias: -€0

RetiveTimeBias: 300

End of results.

21.5 DAYLIGHT SAVING TIME (DST)

Daylight saving time (DST), involves the advancing of clocks (usually by 1 hour) to add more daylight in the
evenings at the expense of less daylight in the mornings. Depending on where you are in the world, it can be
implemented on a country, region or state by state basis. Generally, DST is a practice that is undertaken in
summer months (when there is more daylight is available), meaning that it is implemented at different times in
the Northern and Southern hemispheres.

Forensic Explorer automatically adjusts the times for DST based upon when the date occurred. The investigator
does not need to make additional changes.

DST - UNITED STATES OF AMERICA

In the United States, the days of the year when DST time changes were made (i.e., clocks put forward and the
put back) were first regulated in 1986. In 2007, the Energy Policy Act extended these dates by and additional
four weeks:

United States DST

Clocks forward 1 hour Clocks back 1 hour
1986 - 2006 First Sunday of April Last Sunday of October
2007 onward Second Sunday of March First Sunday of November

Microsoft released a patch for the NTFS file system to compensate for the 2007 change (See
https://support.microsoft.com/en-gb/help/932955/how-to-handle-dates-and-times-that-include-dst for

further information). If the examiners forensic workstation is patched, Forensic Explorer will convert the dates
in the additional four-week period to have the new daylight savings time applied. Caution: This will apply to all
date and times in this four-week period, even those in 2006 and prior.
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21.6 ADJUSTING DATE IN FORENSIC EXPLORER

In Forensic Explorer, date and time can be adjusted for a:
1. The Entire Case: Date and time settings are applied to all evidence items within the case.

2. Individual Evidence Items: When case time is Not Set, evidence items can be individually set.

IMPORTANT: A case time setting has precedence over evidence time settings. If case time is set all settings
will be disabled (i.e. greyed out).

Case time zone settings are applied when the case is created in the Evidence module, as shown in Figure 346
below:

Figure 346: Setting a Case Time Zone (Local Time shown)

Mew Case hod

Case Name: |NIST Hacking Case| |

Investigator: |Graham Henley V| | Mew... || Edit... |

Cases Folder: |C:‘l.leers‘l,Dwner‘anmments‘anrensic Explorer\Cases

Case Summary:

Case Time Zone Settings

TimeZone: | Local Time ot |

TimeZone Mame: |AUS Eastern Standard Time (-600 mins) |

Daylight Savings: |nu5 Eastern Daylight Time (-660 mins) |

STD/DLSBias:  |-600 |/[-680 | minutes

Case Created: |15—Dec—15 8:32:16 PM |

TO CHANGE CASE TIME ZONE SETTINGS DURING A CASE
To change case time zone settings during a case:

1. Inthe File System module, right click on the case folder.
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2.  From the drop-down menu select the Modify time settings option.
As shown in Figure 347 below:

Figure 347: Adjusting Case Time Zone Settings

4

>

1T Evidence File System ﬁ Keyword Search g
" i T 1 i

a N v @ 4O i

- o] [2¥1] L

Recover File Shadow Signature Expand Extract Anaf
Folders Carve Mount Analysis Files IMetadata Progh
T

'l

[F7] File List ]E

Folders Categories
Falders - 0

Filter: | No Filter |38 =

22 =] | &2* Filen

Filamama

=2 O MIST - 40ell Latitude CPi.EOL (3] Add Bookmark...
C» [ =g Partition @ 63 (5) ]

B e g e Dt

Edit folder cormment...

[&  Export To r
& Modify time setting...
Remove...

WWW“MWH—MWVWV

5

21.6.2 SETTING THE TIME ZONE FOR INDIVIDUAL EVIDENCE ITEMS

When examining NTFS or HFS+ file system, to view date and times zones per the location of the subject
computer, it is necessary to set date and time settings to that location (given that time settings were confirmed
to be accurate at the time of acquisition).

To cope with evidence items from multiple time zones, it can be necessary to adjust date and time settings for
individual evidence items. For example, your forensics lab and computer are in Texas USA:

e Evidencel.EO1 is from New York. Adjust the Time Zone to USA EST to show New York time.
e Evidence2.EO01 comes from Los Angeles. Adjust the Time Zone to USA PST to show Los Angeles time.

File date and times can be adjusted for each piece of evidence as it is added to a case (for information on adding
evidence to a case, see section 10.4 - Adding evidence). If the device or forensic image is collected from a
different time zone, change the time zone setting to the source location to display file date and times per that
location using the TimeZone drop-down menu shown in Figure 348 below:
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Figure 348: Adjust time zone information when adding evidence.

i Bl i A ek T mm e B R T L i o W T, AR I

Adjust Time Zone Settings

TimeZone: Local Time -

TimeZone Mame: ALIS Eastern Standard Time (-600 mins)
Daylight Savings:  AUS Eastern Daylight Time (-660 mins)

STD/DLS Bias: -600 J 660 minutes

QK ] [ Cancel

IMPORTANT: A case time setting has precedence over evidence time settings so the case time setting must be
Not Set before evidence time settings will take effect.

TO CHANGE EVIDENCE TIME ZONE SETTINGS DURING A CASE

Date and time settings can be adjusted whilst a case is in progress. Settings can be applied to a device as well as
volumes on a device (for example if a drive has an NTFS and FAT partition, date and time adjustments can be
made for each).

To adjust date and time settings on a device.

1. In File System, Folders view, right click on the device or a partition and select “Modify Time Setting...”
from the drop-down menu, which opens the Times Settings window, as shown below:

Figure 349: Adjust time zone settings for an evidence item.

C [ [ Documents and Settings (5) | ) Modify time setting...
> O [ My Documents (3) L\\,

Forensi CXplorel E}
£ Evidence File System éj Keyword Search p Index sel
< — 2
/ | E
a N ¥ [« O

Recover File Shadow Signature Expand Extract T  Analysis }
Folders Carve Mount Analysis Files Metadata Programs :

. omnayss |
=
Folders Categories [ File List Gallery View I

Folders -1

Filter: |No Filter ~| 15|12 == A2 Filename 7
5 D [] 3§ NIST Haddng Case (1) [None] Fikname 4
= Ce [ B0 imisT - 40ell Latitude CPi.E01 (3) [Local Tim=1: B ™1 4 \ Darkitinn @ £ i
B L [ =g Partition @ 63 (5) ] Add Bookmark... rd E
C> [0 [ Crphaned (4) Edit folder comment... ko
2+ [ [ = Root (45) 3
T sextend (4) [& ExportTo » ;
¢
{
?

Remove...
C» [ = Program Files (34)
L B BECYCIER L1} - Process... -

Copyright GetData Forensics Pty Ltd 2010 - 2024, All rights reserved.



346 | Page Chapter 21 — Date and Time

Figure 350: Time settings

Tirne Settings X

Selection

TimeZone: {UTC-06:00) Central Time (US & Canada) ~

TimeZone Mame: |Cen1ra| Standard Time (350 mins) |

Daylight Savings: |Central Davlight Time (300 mins) |

STD Bias: |3en | minutes
DLS Bias: |300 | minutes
Additional bias: |12IZI| | seconds

2. Select the Time Zone relevant to the evidence. The Additional Bias field is used to make minor
adjustments in seconds (for example when the system bios clock is not correctly synced with a known
time source).

3. Click OK to save these settings. New time zone information will be displayed next to the device, as
shown in Figure 351 below:

Figure 351: adjusted time zone information

| O MIST - 4Dell Latitude CPi.E01 (3) [(UTC-06:00) Central Time (US & Canada) + 120] |

4. Date and time information in the File System > File List will now be adjusted (Note: It may be necessary
to refresh the File List display to show this adjustment).

21.6.3 SYNCHRONIZING TIME ZONES

In a case involving multiple computers from different geographic locations, it may be advantageous for the
investigator to synchronize time zones.

To synchronize time zones:
1. Inthe File System module, right click on the case icon.
2. Select modify time setting from the drop-down menu and apply the time to the case.

IMPORTANT: A case time setting has precedence over evidence time settings. The case time will be applied to
all evidence items irrespective of their individual settings.
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EXAMPLE
A new case is created with two evidence files:
e The case time zone setting is set at Not Set.

e Evidencel.EO1 is from New York. The evidence time zone setting has been adjusted to USA EST to
show New York time.

e Evidence2.E01 is from Los Angeles. The evidence Time Zone setting has been adjusted to USA PST to
show Los Angeles time.

The suspect in New York created a file at 11 AM and immediately sent it to the suspect in Los Angeles.

With evidence time adjusted:
e The New York computer has a file creation time of 11AM.

e The Los Angeles computer has a file creation time of 8AM (three hours earlier).

A Case time setting of New York is then applied to the entire case:
e The New York computer has a file creation time of 11AM.

e The Los Angeles computer has a file creation time of 11AM.

Copyright GetData Forensics Pty Ltd 2010 - 2024, All rights reserved.



348 | Page Chapter 21 — Date and Time

21.6.4 WHAT TIME ZONE IS BEING APPLIED?

In Forensic Explorer v5.4.8.2930 and above, the time-zone/s currently being applied is identified by the blue
highlight color. In the example below:

1. Case [Local Time] is applied to all evidence items in the case (note that time-zones for individual
evidence items are greyed out):

Figure 352: Case time settings are applied to all (shown in blue)

Folders Categories

Filter: L[ Mo Filter v

Filename £
C>[] &5 TEST_CASE (2) [Local Time]

C> [A 20013701 - 5D Card.DD (7)

C>] [B 20011702 - Dell Laptop.E01 (4)

2.  When case time is set to [Not Set] (greyed out), individual evidence items settings are applied (i.e.,
Pacific Time (US & Canada) and Hawaii, as identified by the blue highlight color:

Figure 353: Individual evidence time settings are applied (shown in blue)

Folders Categories

Filter: [ Mo Filter w

Filename i
C:[] = TesT_CAsE (2)
C:[] 20011701 - 5D Card.DD (7) [(UTC-08:00) Padfic Time (US & Canada)]
et ] 20011702 - Dell Laptop . EO1L (4) [{UTC-10:00) Havaii]
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Chapter 22 - Hash Sets
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22.1 HASH VALUES

A hash value is the numeric result of a mathematical calculation to uniquely identify a file or stream of data. A
hash is often referred to as a “digital fingerprint”, as a strong hash algorithm essentially rules out different data
from having the same hash value.

22.2 HASH ALGORITHMS

MD5 (Message-Digest algorithm 5) is a publicly available and widely used cryptographic algorithm designed in
1991 by RSA (Ron Rivest, Adi Shamir, and Len Alderman). MD5 is the most well-known hash algorithm in
computer forensics largely through its implementation by Guidance Software in its EnCase® .EO1 forensic
acquisition file format:

“The MD5 algorithm uses a 128-bit value. This raises the possibility of two files having the same value
to one in 3.40282 x 1038”. (EnCase Forensic Version 6.10 User Manual. s.l. : Guidance Software, 2008
(15 p. 12)).

In 1996 cryptanalytic research identified a weakness in the MD5 algorithm. In 2008 the United States Computer
Emergency Readiness Team (USCERT) released vulnerability Note VU#836068 stating that the MD5 hash:

“..should be considered cryptographically broken and unsuitable for further use”. (5)

SHA-2 is expected to become the new hash verification standard in computer forensics. SHA-2 is a set of
cryptographic hash functions (SHA-224, SHA-256, SHA-384, and SHA-512) designed by the National Security
Agency (NSA) and published by the USA National Institute of Standards and Technology.

22.3 ACQUISITION HASH

In computer forensics, an acquisition hash is calculated by forensic imaging software during the acquisition of a
physical or logical device. It represents the digital fingerprint at the time the image was taken. It is
recommended, in line with accepted best forensic practice, that an acquisition hash is always included when
acquiring data of potential evidentiary value.

In EnCase® .E01 and Ex01 image file formats, the acquisition hash is written into the image header. In other
formats, such as with a DD image, a hash value is usually written into an associated text file.

To display an acquisition hash in Forensic Explorer:
1. Inthe Evidence module, create or open a case.

2. In the Evidence module, in the Evidence tab, click on the image file to display the file properties,
including the Acquisition hash value, as shown in Figure 356: Acquisition and Verification hashes.

22.4 VERIFICATION HASH

A verification hash is a recalculation of the hash for a forensic image file. It enables the investigator to compare
the acquisition hash with the verification hash to confirm the validity of the image file, i.e., if the hashes are
identical; the image has not changed since acquisition.

There are two methods to calculate verification hash in Forensic Explorer:
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1. Calculate the verification hash when adding evidence to the case:
a. Inthe Evidence Module, start a case or preview or open an existing case.
b. Click the Add Device, Add Image or Add File button to add evidence to the case.

c. In the Evidence Processor window, place a check in the “Verify Device Hash” box and select the
hash you would like to process. Click OK > Start to proceed with the evidence processing.

Figure 354: Evidence Processor

Evidence Processor [Image: DEMO 7.E01 1]

Evidence Name: [DEMO 7.E01 1 |

(DEFALLT) ~ b
Tasks Enabled
=] FileSystem
() <@ Process in Parallel I_E_I
[T Verify Device Hash EL 1]
o4 Search for 10 Tracks -
b Search for MERs
[Z}- 5.h Search for FileSystems
b Signature Analysis = Nl
54 Expand Compound Files o O
i+, Process in Parallel
i.p Triage @& 0O
% Hash Files - Ml
% Extract Metadata @ 0O
'} File Carve = 0O
b Cache Thumbnails @S 0O
Adjust Time Zone Settings
TimeZone: Local Time ~
TimeZone Name: ‘AUS Eastern Standard Time {(-500 mins) |
Daylight Savings: ‘AUS Eastern Daylight Time (-660 mins) |

sopsss [0 e me

caes

2. Calculate the verification hash during a case:

a. Inthe Evidence module, run the Verify Device Hash script accessed from the Verify Hash toolbar
button which allows for multiple image verification in a single pass:

Figure 355: Verify device hash from the Evidence module toolbar.

B Verify Devices - O X

About Options

Select a Device:
18017701 Dell Laptop.E01 ( 74.53 GB) v

Or:
[ verify Al Devices (2) h

Hash:
MD5
[JsHa 1
[JsHaA 256

Verify
Hash

Cancel
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The verification hash is written to the evidence module with the acquisition hash and is possible to know the
last date and time the image was verified, as shown below:

Figure 356: Acquisition and Verification hashes, last validation date/time

Evidence

g New Case 60 (1)
|: 18017T01 Dell Laptop.E01 (0)

Addimagg ~» — 7 o0— 00—

B Add device

Property Value
ﬁj Add file Device Type Disk Image
Eytes Per Sector 512
& Addremote Total Sectors 156301488
add folder Current Filename D:\2. Test images}18017701 Dell Laptop!18013T01 Dell Laptop.E01
—a Acquisition Hash (MD5) 1d8321c372 b3td818a2e320 2079
i Addgroup verification Hash (MD5)
Acquisition Hash (SHA1)
x Remove Verification Hash (SHA1)
Device Size 74.53 GE (80,026,361,856 bytes)

Verification of Logical Image Files (.LO1, .LX01, .AD1)

A logical forensic image is a collection of individual files written to a logical forensic container such as a .L01 or
.LX01 (EnCase format by Guidance Software) or .AD1 (FTK format by Access Data).

When a logical image is created, individual file hashes can be created on acquisition. This means that at a
future time, individual file hashes can be recalculated and compared their acquisition hash to determine that
file data is unchanged.

Forensic Explorer will calculate an overall verification hash for the entire logical evidence file and display this
value in the Evidence module. However, this calculation is unique to Forensic Explorer. If the logical image is
provided to a third party, Forensic Explorer must be used to recalculate the verification hash.

To provide a simple mechanism whereby a logical image file can be verified by a third party who does not have
access to Forensic Explorer, a hash of the logical image segments can be used.

In the example shown in Figure 358 below, a logical image file called ExportFiles.LO1 has been created. The
image is made up of three segments, ExportFiles.L01, ExportFiles.L02, ExportFiles.L03. When verified in
Forensic Explorer using the Evidence module Verify Hash button:

Figure 357: Evidence module, Verify Hash

Verify
Hash

a MD5, SHA1, or SHA256 hash value will be created for each image segment. Any third-party hashing tool can
be used to verify the hash of the image files.
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Figure 358: Hash of logical image segments.

7 Verify Devices = a >
Devicelist Count: 1
Hash Types: MD5
1. Device WName: ExportFiles  LOL1
MD5 Beoguisition Hash: Boguisition Hash is not stored within this image.
MD5 Verification Hash: febefleda747f2c0del Be38d2e307d488 FLugical - Unigue to FEX)I
MDS Status: W/
Logical Image: ExportFiles . LO1
- Segment 1 MD5: 1247£79c13ale00b4923b00252%befal
- Segment 2 MD5: dfe0843£32030c44€23014055a521774E
— Segment 3 MD5: 75faef38£f5cbo3855€98a735ab53ecel
Verification time: ad:00:1e
Total Verification time: a0:00:1¢
Verify Devices finished.
4 3
Copy to Clipboard Save and Close

22.5 HASHING FILES IN A CASE

To calculate hash values for individual files in a case:
1. Inthe File System module, click the required Hash button:
Figure 359: File System module Hash Files button
[ [
3

Hash Hash T Hash
Files Match Set Create

-

Or alternatively, right click on a file in the File List and select “Hash...” from the drop-down menu.
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[] File List Gallery View Video View [ Disk View @ Category Graph

o5 = AZ¥ Filename (azw ipg ] 1-8/ Hash (MD5) |
Filename Extension Hash (MD5)

= 1 [‘;ﬁﬁ Bears.jpg ipg

I~ 2 |z Blue_Gradient.jpg :
[ = Add Book o

= 3 |gd Garden.jpg ookmar

e - [@ GreenBubbles.jpg Open

D 5 [l_ﬁ HandPr!nts.Jpg Open with..

= 6 [ Monet.jpg

i 7 [ Notebook.jpg Determine file signature

O 8 [z OrangeCirdes.jpg Expand compound file(s)

™ 9 [g) Peacock.jpg Export... b

i 10 [z Pine_Lumber.jpg

el 11 l\% Pretty_Peacock.jpg Hash...

O 12 [z Psychedelic.jpg ClamAV scan...

2. These opens the Hash Files Options window:

Figure 360: Hash Files Options window

B3 Hash Files Options - O d

Source
(® Searchable items (0 items 0 bytes)
[Junallocated space
() Checked items (0 items 0 bytes)
[Jindude Raw Devices, Partitions and Files

Crypto Hash Methods Similarity Hash Methods
MDS5 Hash [JFuzzy Hash
[JsHA1Hash [Coifferential Hash (graphics only)
[]sHA258 Hash PhotoDF—ll,\\}lasl'l (graphics only)
[[JcrC32 Hash (Signature analysis required for graphics)
Options

[JForce recalculation of hash

[JFind duplicate files {requires a Crypto Hash)

-
-

Insert new columns at position: |3

File Size Range

Maximurm: | 1024 1| Mb (0 = no limit)

Logging: | Mormal A Priority: | Mormal ~

s [ ]

Source A hash of files will take place in the module that the hash is run. For example, if the
button is pressed in the Email module, a hash is calculated for the messages and
attachments in that module.
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The hash can be calculated or all searchable items or checked items. Include Raw
Devices and Partitions will additionally search those items as stand-alone files
(Warning: This will increase the time required).

Hash Methods: Select the type/s of hash to be used.

Force Recalculation: When checked, all hashes will be recalculated. (When unchecked a hash will be
calculated for only those items that do not have a hash.

Duplicates: See below.
File Size Range: Ignore files that do not fall within the range (0,0 = hash all files).
Logging & Priority:  See 7.5 — Logging and Priority.

The results of a file hash are written in the Hash column of the File System module.

If the Hash column is not visible, learn how to add columns to the File System module in chapter 9.4 - Columns.

22.5.1 HASH METHODS

éCRYPTO HASH METHODS

A crypto hash is used to determine if two files contain identical data. A cryptographic hash function takes an
input (file data) and calculates and returns a fixed-size alphanumeric string called the Hash Value. The common
and well documented formats used in computer forensics are CRC32, MD5, SHA1 and SHA256.

Historically MD5 has been the mainstay of computer forensics. More recently, due to the possibility of MD5 hash
collisions (see: https://en.wikipedia.org/wiki/MD5) the stronger SHA1 is increasingly used.

SIMILARITY HASH METHODS

DIFFERENTIAL HASH (FIND VISUALLY SIMILAR GRAPHICS)

A differential hash is a 64-bit number. The hash is created by:
e  Grey-scaling a graphic.
e  Shrinking the graphic to 9 x 8 in size.

e Setting each bit for the hash to a +/- according to whether the previous pixel is greater or less than
the current pixel (hence the differential).

More detailed information on the differential hash process is available here:
http://www.hackerfactor.com/blog/?/archives/432-Looks-Like-It.html

A differential hash can be used to locate similar graphics in a case, as shown in the following examples.

Example 1:

Copyright GetData Forensics Pty Ltd 2010 - 2024, All rights reserved.


https://en.wikipedia.org/wiki/MD5
http://www.hackerfactor.com/blog/?/archives/432-Looks-Like-It.html

356 | Page Chapter 22 - Hash Sets

In the following example 1.JPG is checked as the source file. Other variations of this file exist in the case (e.g.,
1-blur.bmp, 1-gamma.bmp, etc.), as well as an identical file in a sub-folder also called 1.JPG.

Figure 361: Example of locating similar graphics using differential hash.

[l meust |[§7] Gakery view [T widea view (i Discviow @8 Category Graph

& O O Oassficasonkeys (0-9): [] SrBeokmark: (3, 5 Llarger

il 1ranbmp

) ol 122008 berp #r 1.bro

9 of 9 Visible [3.5 MB] 0 Highlighted [0 bytes]

To locate graphics visually like 1.JPG.
1. Differential Hash the files

In the File System module click on the Hash Files button and check the Differential Hash (graphics only).
Click OK to run the hash and a Hash (Differential) column is created containing the differential hash value.

2.  Run Match Visually Similar Graphics (Differential Hash)

A comparison between differential hashes is determined by calculating the Hamming Distance (see:
https://en.wikipedia.org/wiki/Hamming_distance). In the File System module click the Hash Match button

drop-down menu and select Match Visually Similar Graphics (Differential Hash):
Figure 362: Hash Match drop-down menu

g @

Hash T Virtual 7 | Cisco Clam Wi
atch Set Create Live Boot Aniti Wirus Pro

Hash Match
Bookrark Files by Hash Set Match

[ +J !

CEM - Bookmark Files by Hash Set Match

Match Almost [dentical Files (Fuzzy Hash)
Match Visually Sirmilar Graphics (Differential Hash)
Match Visually Similar Graphics (PhotoDMA]

=)

3. The following option window will open:
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Figure 363: Find Similar Graphics (Differential Hash)

B Find Visually Similar Graphics (Differential Hash) = O x

About  Options
Find Similar Graphics To:
(®) Chedked items (1items) - of 1318 Differential Hashed items

(C)Highlighted items (1 items) - of 1318 Differential Hashed items

Options

Minimum File Size to Match (Mb)

Maximum Difference Score:
0 = The Same
3 = Similar
5 = May Be Similar
= 15 = Mot Similar

tched source files in log

Run Cancel

In this example 1.JPG is checked as the source file. The maximum difference score is set at 10 (no files with a
greater score will be included in the result). Clicking Run produces the following output:

Figure 364: Results of Find Similar Graphics (Differential Hash)

8 7 Find Visually Similar Graphics (Differential Hash) - O K
Use: Find similar loocking graphics by calculating the Differential Hash H
Working with Checked Items: True (1 items)
Haximum match score: 10
Bookmark Hesults: True
Include unmatched files in log: False
SOURCE FILE === BATES: 31 FhotoDlNA Test.LOl\FPreview\M\Reot\Photol¥A\Ll.JRPG
Score = 00 =-=-> Bates: 23 FhotoDWA Tesc.LOl\Preview\W\Root'\ PhovoDMAR\Variaticons'\l.JBG
Score = 05 --> Bates: 23 PhotoDNA Tesc LOl%Preview'\M'\Root'PhotoDHA\Variations'l-gamma.bmp
Score = 0& --> Bates: 22 PhotoDHA Testc LOLlYPreview'\WyRoot' PhotoDHAV\Variations'\l-blur bmp
Score = 0& --> Bates: Z4 PhotoDNA Test.L0l\Preview\M\Root\PhotoDHA\Variationsyl-oil . bmp
Score = 0& --= Bates: I7 FhotoDHA Test.LOlWPreview'\l\Root\PhotoDlA\Variations'\l-sepia.bmp
Score = (7 == Bates: I¢& FhotoDlA Test.LOl\FPrewview\ I\ Root\ PhotoDlA\Variationsil-rain.bmp
Score = 07 --> Bates: 28 PhotoDNA Test.LOLl\Preview\M\Root\ PhovoDHA\Variations'\l.bop
Score = 05 --> Bates: 25 PhotoDlA Testc.LOl\Preview'\M\Root\PhotoDHR\Variations\l-pixelise.bmp
Finished.
£ >

Save and Close

We can see that each of the 8 files like 1.JPG have been identified. The scores range from 0 (the identical file
1.JPG in the sub-folder) to 9 (the pixilated version of the of the picture).

As the Bookmark Results option was selected the matching files were bookmarked and grouped in folders
according to their difference score, as shown in Figure 365:
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Figure 365: Bookmark results of Find Similar Graphics (Differential Hash)

e e g, Pre. Pn. @ce.. B re. BB

[E5] Bookmarked Items List Gallery View

Fiter: [No Filter v!| |9¢

J[;,- & 2 . -
Bookmark Name Bl - o G Vclassnﬁcabon Kew [0'*91{7[1.

D2 New Case 11 (1) [Local Time]
= D[ =5 My Bookmarks (12)
D[ %3 bocuments (0)
DO emai (0)
O evidence (1)
D= Files (0)
D 1lict Images (0)
D[ 1ndex Search (0)
[ internet (0)
0 Keyword Search (0)
O pictures (0)
D7 Registry (0) ;
D053 videos (0) Clal recpiabew
= DO saipt output (1)
& D[ simiar Graphics (1)
= D@ 1.6 -Bates: 31(5)
DO oto1(1)
DO 4to5()
DO sto7(5) O =8 1.6mp
DO st ()

[ 58 1-0i.bmp

] =# 1-rain.bmp

Example 2

The following digital photo is retouched to blue the outline of the hair:

Figure 366: First edit of digital photograph.

Tolerance:
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The original file is used as the source. Running a Match Visually Similar Graphics (Differential Hash) identifies
the touched file (Blur_Hair.png) with a 0 score (the highest possible match), as shown below:

Figure 367: FEX search results

B " Find Visually Similar Graphics (Differential Hash) — O >

Use: Find wisually similar graphics by calculating the D:

Working with Checked Items: True (1 items)

HMHinimum £file match size: 104857 Fb

Maximum match score: 1a

Bookmark Results: True

Include unmatched files in log: True

SOURCE FILE === BATES: 200358 C:ZUsershOwnerhDesktop\Test \Original .png

Score = 00 --> Bates: Z003&4 C:\UsershOwner\DesktopiTesthOriginal Blur Hair png

Finished.

< >
Save and Close ! Close

The Blur_Hair.png file is edited a second time to add a yellow circle, thus increasing the visual difference between
the original and the new file Yellow.png:

Figure 368: Second edit of digital photograph

Offset: (0,0)

Zoom: 35%

Tolerance: 94

The original file is used as the source. Running a Match Visually Similar Graphics (Differential Hash) identifies
the Yellow.png with a score of 7.
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Figure 369: FEX search results

B " Find Visually Similar Graphics (Differential Hash) — O x
Use: Find wisually similar graphics by calculat:
Working with Checked Items: True (1 items)

Minimim file match size: 104857 bytes

Maximim match score: 1ad

Bookmark Besults: True

Include unmatched £files in log: True

SOURCE FILE == BATES: 200448 C:\Users\Owner\Desktop\Test \Original .png
Score = 00 —-—>= Bates: 200447 C:\Users'Cwneri\Desktop'\Test Blur Hair.png
Score = 07 ——> Bates: 200445 C:\Users\Owner\Desktop\Test\Yellow.png

Finished. %
< >

Save and Close

PHOTO DNA

PhotoDNA is a technology developed by Microsoft and improved by Hany Farid of Dartmouth College that
computes hash values of images, video and audio files to identify alike images.[1] PhotoDNA is primarily used in
the prevention of child pornography and works by computing a unique hash that represents the image. This hash
is computed such that it is resistant to alterations in the image, including resizing and minor color alterations.[1]
It works by converting the image to black and white, re-sizing it, breaking it into a grid, and looking at intensity
gradients or edges. (https://en.wikipedia.org/wiki/PhotoDNA, October 2017).

GetData Forensics is licensed to distribute Photo DNA to law enforcement agencies solely for the purpose
preventing the spread, or investigation targeted to stop the distribution and possession, of child sexual abuse
content. Photo DNA files are not shipped with Forensic Explorer, which is why this option may appear to be
disabled in the File System module Hash Files menu. To request the Photo DNA files, please contact
support@getdata.com from a law-enforcement email address identifying your status to meet these
requirements. Further information will then be provided.

FUZZY HASH (FIND SIMILAR FILES)

A fuzzy hash uses context triggered piecewise hashing to identify almost identical files. (See: Identifying almost
identical files using context triggered piecewise hashing, Jesse Kornblum, Digital Investigation, September 2006,
Pages 91-97, Elsevier, September 2006). The implementation used in Forensic Explorer is detailed at:
https://ssdeep-project.github.io/ssdeep/index.html

IMPORTANT: Fuzzy hash works on digital content. Many programs encode data when a file is written to disk.
For example, a small edit and save of the digital photograph in Figure 366 above produces two files with almost
entirely different content (shown as red below):
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Figure 370: Binary comparison of Original.png and Blur_Hair.png shown in Figure 366 above

C:\..A\Desktop\Test\Original.bet ~ | E‘* - | C:\A\Desktoph Test\Blur_Hairbd v | E‘* -

26-Oct-17 1:40:46 PM 189,915 bytes  Everything Else  26-Oct-17 1:42:11 PM 186,456 bytes Everything Else
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@ARA2E@8 B3 18 (D B4 @9 44 DA BF F.1°.D0
PPOR2B0E 45 1@ 99 8@ 43 DE 7B A9 E.™€CP{

14 BD 97 EE ED 8D .8.X-1i

B
8 FC 56 41 B EBE 85 i.-’-:-.u[.i‘-.flé

@@ee2561@ CE DE D@ 4E CC BF 11 64 fPBNi{. @ Al 57 13 AC @3 68 2F 64 jW.-.hs

@@e82618 DB 5E 58 F7 6A 6A EB @@ U"X+jjé 8 E9 @2 6F @E 9 ED @B 2C &.0.Edi.
®

@eEB2E20 DA @9 59 DA @ 1B 43 72 U.YUA.C B1® AD A4 @ 9E 21 71 -H--AZ!
PBEE2B28 BB ©2 4B 23 29 3@ 57 B8 ».K#)oW B16 5F 25 3C 3F FD ey
@@@a2E30 DF 57 A9 9F 1F EE B7 B2 RWEV.i-

=

5 & & o
=R & ®
0 R & 0

o ® & o
[T S T L )
m

BREE2E38 BA 63 16 12 75 @1 DE AB  %c..u.P BEBE2E1E DE DA F
PEEE2B1D E9 BE 39 48 D4 87 F8 A8 &79HO.¢
BBEB2E40 20 C8 €@ 81 9E 5D 42 EA.3] |P@@@2B25 82 20 8B ,
PABA2B47 E3 FD A2 C9 7D DA C9 66 &y¢EIUE v v
< > < >
1 # Binary differences |nseQ‘> Load time: .52 seconds

Similarly, a Microsoft Word.docx file that is edited with the addition of a single word, when saved will have an
almost entirely different digital footprint.

For this reason, a Fuzzy Hash match is useful only for file formats where file encoding does not take place (e.g.,
the edit of a plain text document).

22.5.2 DUPLICATES

The “Find duplicate files” checkbox (shown in Figure 360 above) is used to identify files that have identical hash
values. In addition to this benefit, a principal reason for identifying duplicates is that it enables the investigator
the opportunity to de-duplicate a case. This potentially improves case processing time in that it allows the
forensic investigator to work with unique files only.

When the “Find duplicate files” option is checked, a new columns titled Duplicates Index and Duplicates Count
is created in the File System > File List view (to learn how to add this column to the File System > File List, see
9.4).

The Duplicate Count column has the following meaning:

e A count of 2 means that two files with identical MD5 hashes have been located (one of which is that
file). A count of 3 means that three files with identical MD5 hashes have been located (one of which is
that file). Etc.

IMPORTANT CONSIDERATIONS:

e Duplicates are matched by MD5 hash value. To identify all duplicates a MD5 hash of all files must have
been run.

e Be aware of adding new files to the File System module from a process like a file carve, recover folders,
or expand compound files. These new files will need to be hashed.
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22.5.3 FILTERING A UNIQUE DATA SET

A common objective of the investigator is to operate on a unique data set that contains no duplicates. This is
usually done for speed purposes, as it can reduce the time needed for a keyword, index, or similar search. The
Duplicate Index column is used for this purpose.

The Duplicate Index column assigns a count to each duplicate. In below, there are four files with the same MD5
hash. The Duplicate Count column shows 4. The Duplicate Index column assigns 1, 2, 3 and 4 to each file.

IMPORTANT: The Duplicate Count number is assigned per the sequence of the files as they were processed. The
number is NOT an indication that one file has any greater relevance than the next.

To locate only unique files a case:

A unique data set consists of all files that have a Duplicate Index that is blank and all files that have a
Duplicate Index of 1.

e Inthe Text Typing filter, this is achieved by <=1

Figure 371: Identifying duplicate count and duplicate index.

(] File List Gallery View Video View () Disk View &3 Category Graph

i = AZ¥ Filename A2 Ext |18 DuplicatesIr ||1:8 Duplicates Cou [l
Filename Extension Duplicates Index  Duplicates Count [

L1 o I:I WUPLY = W Le WP LTI SO TLE LT VU Lk = a <

] a47 H] P1010011.IPG PG 1 4

] ] H] P1010011.IPG PG 2 4

] 349 H] P1010011.IPG PG 3 4

] 850 ﬁ] P1010011. PG PG 4 4

22.6 HASH SETS

A Hash Set is a store of hash values for a specific group of files. The hash values are a “digital fingerprint” which
can then be used to identify a file and either include or exclude the file from future analysis.

Hash Sets are often grouped in the forensic community into:

Good Hash Sets: Operating System files, program installation files, etc. (these are also often referred
to as “Known” files); and

Bad Hash Sets: virus files, malware, Trojans, child pornography, steganography tools, hacking tools etc.
(these are often referred to as “Notable” files).

Hash Sets have two essential uses:

1. To reduce the size of a data set and speed up an investigation: A Hash Set that eliminates known
operating system and program installation files, allows the examiner to quickly focus on electronic files

created by the user and which are likely to be the subject of the investigation.
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2. To quickly identify specific files relevant to a case: If the investigator is attempting to locate the
presence of a group of known files, applying their hash value to the case will quickly and positively

identify them in the data set.

Forensic Explorer supports the following types of Hash Sets:

.db3 or.edb3  The Forensic Explorer Hash Set (SQLite database format. The .edb3 is the extension is
for an encrypted file from a third-party supplier, e.g., www.hashsets.com);

.hash EnCase 6 format (no conversion is necessary).

Flat Hash Set A list of hash values in a text file (a Flat Hash Set must have a file extension of .txt,
md5, .shal or .sha256. See 22.8.2 below).

The default hash set location is: [profile]\Documents\Forensic Explorer\HashSets\

22.7 DOWNLOAD HASH SETS

Hash Sets for use with Forensic Explorer are listed at https://getdataforensics.com/hash-sets/ and are

available for download by contacting support@getdata.com. Hash sets from other trusted locations can also

be used.

22.8 CREATING HASH SETS

Before creating a custom hash set, files in a case must be hashed. Follow the instructions in 22.5 above.

To create a new Forensic Explorer Hash Set:

1. Click the “Hash Set Create” button in the File System module toolbar and select FEX Hash Set:

Figure 372: Create Hash Set

FEX Hash Set (.db3)

MD3 Flat Hash Set (.bat)
SHA Flat Hash Set (.bd)
SHA256 Flat Hash Set (.bet)
Manual Flat Hash Set (txt)

L ) ] = s )

Project Vic Export (JS0N)

The following window will display:
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Source
(®) Hashed Ttems (1704 items, 1.83 GE)
Checked Hashed items {0 items, 0 bytes)
HashSets
Location: |C:\Users\Vera\Documents\Forensic Explorer v5\HashSete| |5 Refresh
Name Identified As
New Set
Indude:

MD5
[JsHa1
[JsHazss

Logaing: | Normal ~ Priority: |Mormal ~

2. Click the New Set button. Check the type of hash/s to be used in the set (MD5, SHA1, and SHA256). A
new hash set will be added to the list.

3. Rename the new hash set and right click to rename the “Identified As” text. Click Save to save the
Hash Set. The new hash set is created and saved to disk in the current hash set location (default
location is: [User]\Documents\Forensic Explorer\HashSets\.

Files with the extension .db3 are hash sets created by Forensic Explorer. Files with the extension
.edb3 are encrypted files that have been acquired from a third-party source and provided for use with
Forensic Explorer.

4. The new hash set is now available when the Hash Match button is pressed (refer to 22.9- Hash Match,
below).

22.8.2 FLAT FILE HASH SETS

A Flat File Hash set must:
e Be a plain text file in ANSI format.

e Have an extension of .txt, md5, .shal or .sha256 (If the .txt extension is used Forensic Explorer will
determine the type).

e NO blank lines. A blank line identifies the end of the list.

The following file format can be used to give meaning to Forensic Explorer column data:
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Figure 373: Flat Hash Set format

# This is a Flat MD5 Hash Set file This is a comment

# Hash Set Name = My MDS5 List 1 'HashSet' column text

# Identified As = Significant 'HashSet Identified As' column text
83e05311eab2c2d50c2bc6fa219e6905 The list of hash values

a526a95fc34e049360755d9f0450d662
b8bca7ac76f0ade815c5¢c743866293e0

A blank line = end.

TO MANUALLY CREATE AND USE A FLAT HASH SET
To manually add the Flat Hash Set file to Forensic Explorer:

1. Place the correctly formatted Flat Hash Set in the Forensic Explorer hash set folder:
[profile]\Documents\Forensic Explorer\HashSets\.

2. Click on the Hash Match button in the File System module toolbar to open the Match Hash Files
Options window.

3. The Flat Hash Set should appear in the list of available sets, as shown in Figure 374 below.

Copyright GetData Forensics Pty Ltd 2010 - 2024, All rights reserved.



366 | Page Chapter 22 - Hash Sets

Figure 374: Flat Hash Set

E Hash Match Options

— O *
Compare HashSets to
(®) Hashed Items (1704 items, 1.83 GEB)
Ched:ed Hashed items (0 items, 0 bytes)
Compare Using
(®) MD5 Hash (") SHA1 Hash () SHA256 Hash
[Iclear any existing hash matches
|:| Insert new columns at position:
Select HashSets
Location: |C:‘!,LIsers‘\l-'era\DocumentsForensic Explorer vSiHashSets | =) Refresh
Include subdirectories
Filename Hash Set Mame Identified As  MD5S SHA1 SHAZ256
[ 1dentified As.db3 Identified As Bad ¥
[] Malware_known_248528.hash  Malware_Known_248528.hash Motable ¥
I [] ™y Flat Hash Set 1.txt My Flat Hash Set 1 Significant ¥ I
=] NSRLFile. txt MSRLFile Known T A
Logging: | Mormal w Priority: | Normal -

Download hash sets:

forensicexplorer. com/hashsets OK
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TO CREATE AND USE A FLAT HASH SET FROM A CASE

To create a Flat Hash Set, select the required format, MD5, SHA1 or SHA256 from the Create Hash Set button
drop-down menu as shown in Figure 372 above (This executes a script which can be viewed and edited in the
Scripts module). The following window appears:

Figure 375: Create Flat File Hash Set from Case

B MDS5 - Create Flat Hash Set from Case — Od >

About Options

Source

(®) all File System items {1559 items)

() Chedked File System items {0 items)

Destination File

Hash Set Folder: | Ci\JsersiVera\Documents\Forensic Explorer w5'HashSets) |

File Name: | Flat Hash Set |

Include Comment in Header

File Comment: | Flat Hash Set created by Forensic Explorer 27-52p-2019 2:09:54 PM |

Case Mame: | New Case 52 |

Specify Column Text in Header

HashSet: | Flat Hash Set |

Identified As: | Known w |

Cancel

The Flat File Hash set is then created with the specified options and written to the
[profile]\Documents\Forensic Explorer\HashSets\ folder. The hash set appears and is available for use in the
Hash Set window shown in Figure 374 above.

22.9 HASH MATCH

A Hash Match is the process whereby hash values contained in a Hash Set are matched to hash values in a
case.

To run a Hash Match:

1. Hash individual files in your case as described in 22.5 above.
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2. Inthe File System module, click the Hash Match icon > Hash Match.

Figure 376: File System module, Hash Match icon

Hash M
Match

3. The Match Hash window will open:

Figure 377: Match Hash window

E Hash Match Opticns
Compare HashSets to
(®) Hashed Items (1704 items, 1,83 GB)

Checdked Hashed items (0 items, 0 bytes)

Compare Using

(®) MD5 Hash (_)SHA1Hash (_) SHA258 Hash

@:Iear any existing hash matches

[Cinsert new columns at position: |3 -

Select HashSets

Location: |C: \Wsers\Vera\Documents\Forensic Explorer v5\HashSets

=

Indude subdirectories

[] 1dentified As.db3 Identified As Bad
Malware_Known_248528.hash  Malware_Known_248528 . hash Notable
] ™y Flat Hash Set 1.txt My Flat Hash Set 1 Significant
I:‘ MNSRLFile, txt NSRLFile Known

Logging: | Mormal ~ Priority: | Normal

Download hash sets:
forensicexplorer.com/hashsets

Filename Hash Set Mame Identified As

MD5 SHA1

- = = =

Refresh

SHAZ5E

Cancel

4. Select the hash set to use by placing a tick in its box:

File Name: The name of the hash file.

Hash Set Name: The name given to the hash set read from the header of the file. If the Hash Set

Name is blank, the File Name is used.

Identified as: Describes the classification given to the hash set when it was created.

Hash Type: The types of hashes contained in the file are marked in the remaining columns using

uYn .
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5. Clear any existing hash matches:

a. When “Clear any existing hash matches” is checked:
Existing has values in the “Hash Set” and “Hash Set Identified As” columns will be cleared

before then new values are written into the columns.

b. When “Clear any existing hash matches” is not checked:
The new values of the hash comparison will populate the “Hash Set” and “Hash Set Identified
As” columns. They will overwrite any existing values. However, existing values in those

columns which are not overwritten will remain.

6. Click OK to proceed with the hash match.

Once a Hash Match has been run, two columns will be created in the Forensic Explorer File System module,

“Hash Set” and “Hash Set Identified As”:

Figure 378: Running a Hash Match in a case.

Hash (MD5) HashSet » HashsSet Indentified As
bada 1b360a5672d80c2 7430391532 2c GetData [Windows] good
f1c9645dbc 14efddc7d8a32 2685 26eh GetData [Windows] good
bdf3bf1da3405725be 763540d6601144 GetData [Windows] good
fafasefeaf3che3b23b2748d 1326291 GetData [Windows] good
076e3caed753a 101809 1a0e9cae 3368 GetData [Windows] good
Saebebact 2ecbf3b4009f79be 3549052 GetData [Windows] good
cdf80f35aba322d5d0ecbafafe0b 2995 GetData [Windows] good
ba45cafal456a672e003a875e469d0eb GetData [Windows] good
Sad4c7baSbbedec8a7233d67e4506348 GetData [Windows] good
9d377b10ce77804938b3cTe 2c63a22% GetData [Windows] good
1598834753 ba4fbadcedof1931db7hf GetData [Windows] good

2b04df3ecc1d94afddffila2d 139caf15 GetData [Windows] good
Shilafacf7447e4b7c 1093702 26 1be 2e GetData [Windows] good
b445533383b3123a747d13%bd0e7 1d2df GetData [Windows] good

An entry in the Hash Set column identifies that the file hash matches a hash in the set.
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22.9.1 HASH MATCH WITH MULTIPLE HASH SETS

In the following example two has sets were created:

e Cats.db3, Identified as Bad, containing a hash for all 19 files in the Cats folder and its sub folders

(including the Orange Cats folder).

e OrangeCats.db3, identified as Bad, contains a hash for 4 files in the Orange Cats folder.

As shown in Figure 379 below:

Figure 379: Hash Match with multiple hash sets

Folders Categories

I [F] File List Gallery View Video View [\ Disk View @3 Category Grapl

Filter: |_.:_." No Filter B Hash Match Options — O x B
Compare HashSets to -
COS - e (®) Hashed Items (1704 items, 1.83 GB) 2
ENa| 11) focal Tme &
EE Checked Hashed items (0 items, 0 bytes)
=0 C
C: g Compare Using
CO 7 (®) MD5 Hash (_)5HA1Hash () sHA256 Hash
= O 1
=E » [ clear any existing hash matches
CO 51 [Dinsert new columns at position: |3 =
O
CO 22 Select HashSets
cO 4 _ _
EN SN : Location: |C:'lJ_Isers'l,h'era'lpov:uments'lforensm Explorer v5\HashSets | = Refresh
C ii Indude subdirectories
O
= B[] Cats (19) Filename Hash SetName  Identified As  MDS SHAL 2
B[] Black Cats (2) Cats.db3 Cats Bad ¥
B[] Orange Cats (4) OrangeCats.db3 OrangeCats Bad
O :
C 1
CO 11
cO -
C:[ < >
C[ Logging: | Mormal v Priority: | Mormal « =
O 5
O i Download hash sets:
O o| forensicexplorer. com/hashsets Cancel
C: 15
¥ | O = l‘

When a Hash Match is run using multiple hash sets (either one at a time or simultaneously) :

e The name of each matching hash set is appended to any existing text in the Hash Set column and

separated by a comma. For example, in Figure 380 below;

o the text “Cats” identifies a Hash Match for the Cats.db3 file only.

o Thetext “Cats,OrangeCats” identifies a Hash Match in both Cats.db3 and OrangeCats.db3.

e The HashSet Identified As name for each hash set is appended to existing text in the HashSet Identified
As column, separated by a comma. For example, in Figure 380 below;

o the text “bad” identifies a Hash Match for one of the hash sets; and
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o thetest “bad,bad” identifies a match in both hash sets.

Figure 380: Hash Match using multiple hash sets.

[F] FleLst [37] Gallery View [I2] Video View (| Disk View & Category Graph

ALY Filename Lo AZY HashSet AZY HashSet Identified 1.8 Hash (MDS)

Fiename Ex... HashSet HashSet Identified As w Hash (MD5S)
[0 1 = OrangeCat1.JPG PG Cats,OrangeCats  Bad,Bad df55058a18c271¢
| % t}] Orange Cat 2.JPG PG Cats,OrangeCats Bad,Bad 93d1492cc8 1debc
i3 tj Orange Cat 3.JPG PG Cats,OrangeCats  Bad,Bad 6da41b620b54¢cct
[0 4 =] orangecCat4.3PG PG  Cats,OrangeCats  Bad,Bad 4fa22addaf20fc7.
[0 s =i saby_cat_sleeping.... PG Cats Bad 36f49dbcb43efes
[0 6 [0) slack Cats~$130($90 Cats Bad 2366437ad4bd06:
[0 7 = catsa10_Baby.)PG ®»G Cats Bad 01bfof0a41df45a:
[0 8 x) catsa2_Mary.)PG PG Cats Bad 4f3e99434df20e0
[0 s =i catsA3_Choco.)PG »G Cats Bad bfdfec997fd 14dfc
[0 10 =) catsa4 Kristaji. PG »G Cats Bad 524adf4a69aafic
[0 11 =) catsAS Starbuck.JPG PG Cats Bad 4094599 1b63ad9

It can be seen from this example that providing a descriptive name for both the Hash Set Name and the
Identified As text can be beneficial.

Important: The contents of the HashSet and HashSet Identified As columns are not saved with a case. Each
time the case is opened, a new Hash Match must be run to re-populate this data. This is done so that if additional
data is added to a case, or hashes are added to or removed from a Hash Set, the changes will be included in the
next Hash Match.

22.9.2 NSRL HASH SETS

Forensic Explorer v5 now works directly with NSRL hash sets. Place NSRL hash sets into the Hash Sets
folder and they will be directly available under the Hash Match button. It is recommended that SHA1
be used to match against NSRL hash sets as they are pre-sorted by SHA1, and it significantly improves
the RAM load speed of large sets.
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22.10 PROJECT VIC™

“Project VIC is a global partnership that uses advanced technology to fight child sexual exploitation and
trafficking. Using new forensic and data analytics tools, Project VIC identifies new victims of abuse and locates
perpetrators around the globe. More than 2,500 law enforcement agencies in 40 countries use the technology
developed by Project VIC’s partners to rescue child victims, apprehend offenders and secure crime scenes.”
(www.projectvic.org, 25 October 17).

Project VIC™ files use a JavaScript Object Notation (JSON) format (see https://en.wikipedia.org/wiki/JSON).

In some situations, an investigator may wish to export Project VIC™ JSON data to be used by a third-party
application.

To Export a Project VIC™ JSON file:

1. Files within the case must have an existing hash value (an MD5 hash is mandatory). To hash files, follow
the instructions in 22.5 above.

2. Inthe File System module, click on Hash Set Create > Project Vic Export (JSON):

Figure 381: Project Vic Export as JSON

Virtual 7 | Cisco Clam
Live Boot Anti Virus

FEX Hash Set (.db3])

MD5 Flat Hash Set (txt)
SHA1 Flat Hash Set (.td)
SHAZ256 Flat Hash Set (.td) E
Manual Flat Hash Set ()

Project Vic Export (JSON)

fied

U GO0 E B
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3. The Export JSON VIC File Options window will open:

Figure 382: Export Project VIC™ JSON file

B¥ Export JSON VIC File Options - O >

Process Mame:

|Ex|:|nrt 150N VIC File

Source
Module: |FileSystem >

() Hashed Items (1704 items, 1.82 GE)
{®) Checked Hashed items {4items, 3.0 MB)

Destination
Filz type:  |Project VIC model 1.3 ~
Export:  |Do Mot Export
Sort: |Export with unigue FileMame
Export with hash FileMame
.. |Export with hash FileMame and Extension
Destination Foners
|C:‘n,l_Jsers‘n,'l.u'era‘n,Dm:uments‘nFDrensic Explorer v5\Cases\Mew Case 52\Exported), E|
Destination File:
|ExportPrDj'l.-'ic.jsnn ||E'J‘
Logging: | Mormal o Friority: | Mormal e
Ok Cancel

a) Select to export Hashed or Check Hashed items.
b) Select the Project VIC model supported by the location where the file will be used.

c) In certain situations, in addition to the JSON file, it is beneficial to export the hashed files (for example
the JSON file and data files may be imported into a third-party application for classification). Choose an
option for the export.

d) Enter the destination path and JSON file name. Note: If the Export files and link option is checked,
ensure there is sufficient space in the destination folder to export the files.

The export to Project Vic will result in the following in a ExportProjVic.json file and an accompanying
Attachments folder. The json file holds the metadata and links to the actual exported files in the attachments
folder (json file and the folder need to stay together as they are linked).
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Figure 383 - Export to Project Vic - Output

Mame

Attachments
@' ExportProjVic.json

22.10.2 IMPORT PROJECT VIC .JSON WITH ATTACHMENTS (FROM 3%° PARTY TOOL)

To import Project Vic evidence into Forensics Explorer from a third-party product (e.g., Griffeye):
1. Inthe Evidence module, start a new case.

2. Click the Add Image button and select the .JSON file (e.g., as shown in Figure 383 above). Note that
the JSON file must be accompanied by the Attachments folder (containing the files) in the same
directory.

The contents of the Attachments folder will then be visible within Forensic Explorer.

22.10.3 PROJECT VIC .JSON — HASH MATCH

To hash match using Project Vic json:
1. Add the .JSON file to the Hash Sets folder: ..\Documents\Forensic Explorer v5\HashSets\

2. Inthe File System module, click on the Hash Match button. The JSON files will appear in the list of
available hash sets in the Hash Match Options window.

3. Check the required file and click OK to run the Hash Match.
IMPORTANT: Files in the case must already be hashed with the relevant type of hash (e.g., MD5) in order for a

match to take place.

22.10.4 IMPORT C4ALL

Similar to Project Vic (described above) some programs like Cellebrite export data in to a C4All format. The
C4All format uses an XML file to store the metadata which points to files contained in a Files folder:

Figure 384 - C4ALL Data from Cellebrite

Marne

Files
@' Case Reportaxml
[ PA C4P Index.xml
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To import C4All data into Forensics Explorer:
1. Inthe Evidence module, start a new case.

2. Click the Add Image button and select the ...index.xml file (this file must be accompanied by the Files
folder containing the data).

Note that in the example shown in Figure 384 above the structure of the filename is:
PA = Cellebrite Physical Analyzer
C4 = Short for C4All

P = Photos (this may be replaced by M for a movie specific export).
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23.1 FILE SIGNATURE ANALYSIS

Signature analysis is the process of identifying a file by its header rather than by other means (such as the file
extension). The International Organization for Standardization (ISO) has published standards for the structure of
many file types. The standards include a “file signature”, a recognizable header which usually precedes the file
data and assigns a file to a specific type, e.g., a jpeg.

For example, shown Figure 385: JPEG file signature below, is the beginning of a photo taken with a digital camera.
It is identified as a JPEG by the file header y@ya- (or in Hex: FF D8 FF EO 00).

Figure 385: JPEG file signature

V@va..JFIF..... L LWAI4ExIEL LMM.AL L.
........... E e e e e,
....... T o
R T Bl et E 3
A¥..... B.LEe¥ED. .. .. B..'...'NPanasonic.DM
C-TZ15..... . ‘....Microsoft Window
2 Photo Gallery 6€.0.6001.18000..2009:07:
19 15:39:02..%,3......... e e Lo

.......... i e aeaeeae.0221.....

Identifying a file by its signature is a more accurate method of classification than using the file extension (e.g.
.jpg), as the extension can easily be altered.

23.2 WHY RUN FILE SIGNATURE ANALYSIS?

File signatures are an important part of the examination process because it gives the investigator confidence
that they are seeing files for what they are. It is recommended that a File Signature analysis is one of the first
steps performed by the investigator in each new case.

A file signature analysis with Forensic Explorer will:

e Identify files for which the file extension does not match the file signature. These files may have been

deliberately manipulated to hide data.

e Empower other components of Forensics Explorer, such as the Categories view, to see files based on

file signature, rather than extension.
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23.3 RUNNING A FILE SIGNATURE ANALYSIS

To run a file signature analysis in Forensic Explorer:

1. Click on the Signature Analysis button in the File System toolbar (shown below) to open the Signature
Analysis Options window shown in Figure 387: Selecting file types for signature , below:

Figure 386: Signature Analysis button in the File System module toolbar

4

Signature
Analysis

2. Or right click on a file in the File System module and select Determine File Signature from the drop-
down menu. This method will determine the File Signature of the currently highlighted file/s and add
the result to the File Signature column. If more than 1000 files are highlighted the Signature Analysis
Options window shown below will open:

Figure 387: Selecting file types for signature analysis.

B9 signature Analysis Options - O *

Process Mame:

|5ignathe Analysis

Source
(T) Searchable items (1348 items 1.83 GB)
Unallocated space
(® Chedked items (4 items 3.0 ME)
[Jindude Raw Devices, Partitions and Files

Filetypes to determine:

=[] ED) Archives A
- [ 6D 72IP (.72 .72ip . 720)

Android Backup {.ab)

~ [¥] #)] BzZip2 (.bz2 .bzip2)

E Cabinet compression file (.cab)

- [#]£3) GzIP compression file (.gz .gzip .tgz)
- [#1ET) LzH compression file (.lzh)

E Miliki Super Compression (.qcf)

- [] | M Backup File (.bkf)

; RAR compression file (.rar)

~[¥] @] Retrospect Backup (.rfb .rdb)

@ TAR archive file (tar)

‘ ¥AR (eXtensible ARchiver) (.xar .pka)

- W
Find: | |
Options
[C)Farce determination
Insert new columns at position: |3 -
Logging: | Marmal e Priority: | Normal w~

carel
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Find: Use this filter to find a specific file type.

Force Determination: If the File Signature is already determined this setting will force a re-
determination of the signature rather than using the existing value.

Insert new columns at... File Signature results are added to the File Signature column of the File
System module. The default columns position is 3.

3. Select the file types for which a signature analysis is to be conducted. Note that the speed of the analysis
is affected by the number of file types selected. File signatures are inbuilt into Forensic Explorer and
cannot be added (A custom file signature can be created using a script. See Chapter 19 - Scripts Module,
for more information on writing scripts).

23.4 EXAMINE THE RESULTS OF A FILE SIGNATURE ANALYSIS

There are three columns which relate to file signatures:

1. Extension

The Extension column lists the files’ given extension (i.e., the extension given with the file name).

2. File Signature

The File Signature column is the result of the analysis of the file header. After a File Signature Analysis,
has been conducted for a file, the column either:

a. shows an extension: This means that it has been successfully identified as a file type
contained within the Forensic Explorer signature list, shown in Figure 387 above; or,

b. No Size: The file does not have a logical or physical size, or the file does not have a run list in
the Master File Table.

c. Folder: A folder.

d. Unknown: The file signature could not be matched against the file types contained in the
Forensic Explorer signature list.

e. is blank: A signature analysis has not been conducted for this file.

3. Extension Mismatch

The Extension Mismatch column alerts the forensic investigator to any files where the identified
signature does not match the current extension. These files are worthy of closer examination to
determine the underlying reason.
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Results of a file signature analysis are shown in Figure 388 below:

Figure 388: File System module columns relating to file extension.

[F7] File List Gallery View Video View || Disk View @ Category Graph
5= AZ¥ Filename AZ¥ Ext ||IAZ™ File Signature AZ¥ Extension Mismatch
Filename Extension  File Signature Extension Mismatch
L 915 i IMG_1179.1PG JFG JPG Mo
O 916 &| IMG_1180.1PG IPG IPG Mo
O 917 & IMG_1131.JFG PG PG Mo
i 918 ®| IMG_1182.1PG PG PG Mo
e 919 1‘11 IMG 1183.1PG JPG JPG Mo
|:| 920 lﬂ DWG - M1200, 20 20 AutoCAD DWG Yes
|:| 921 E| PFS - Mewcastle Storm June 07.pps pps PowerPoint Yes
1 922 |;| WPD - w7 WPTTest-memo, wpd wpd WordPerfect File Yes
] 923 | F13.JPE JFE PG Yes
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24.1 DATA RECOVERY - OVERVIEW

An essential part of computer forensics is the ability to recover evidence from deleted data. Forensic Explorer
automates the following data recovery procedures:

1. Recovery of deleted files within the existing file system;
2. Recovery of orphaned folders in the existing file system;
3. Recovery of folders from unallocated clusters;

4. File carving from unallocated clusters.

Itis important for the forensic investigator to understand the methodology behind the recovery automation and
to be able to validate recovery results manually. This chapter sets out to provide a description of the tools for
automation and the methodology to validate search results.

It should be noted that the success of data recovery will depend on many factors, including such things as:
e Subsequent disk activity which may have overwritten and corrupted data.
e The level of file fragmentation and the extent to which it can be tracked.

An investigator should always critically examine data recovery results before drawing conclusions.
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24.2 FAT DATA RECOVERY

When a file is from a FAT file system, the content of the file remains available for recovery from those newly
unallocated clusters. The original data will remain in each cluster up until it is used to store new data and the
previous content overwritten. If only a percentage of clusters are reused, then partial recovery, or the recovery
of a data fragment, may still be possible. If all clusters are re-used, all original content is overwritten and
destroyed.

24.2.1 FAT - DELETED FILES

Forensic Explorer automatically displays deleted files and folders in Folders view and File List view. They are
marked with the following icons:

B Deleted file
g Deleted folder

An example is shown in Figure 389 below:

Figure 389: Deleted folders and files in File System module Folder view and File List view

Folders -
= D[] &8 FAT Photos 32 (1) ] S | (—
= D[ [i]) FAT32-Photos.E01 (3) [Local Tim :
& O[] == Partition @ 63 [NO NAME] (7 Filename a
D [ =) orphaned (0) O ~| Aquatic
& [ - Root (4) O . Birds
Rl Animals | B B
O O Aquatic (13) a Q -
e O[O sirds (49) O |-=J African Elephant.jpg
O [ [ Cranes (3) O [2) Buffalo.jpg
O _g Flamingos (3) | @ Koala.JPG
D [ g Flowers (9) O [£) PIGS.JPG
D [ Landscape (5) O [Z) REDPANDA.JPG
O [L3 _unny. PG

FAT - IDENTIFYING DELETED FILES

In a FAT file system, Forensic Explorer identifies deleted files by locating the OXE5 marker in the first byte a files
directory entry.

When a file is deleted on a FAT system its entries in the FAT table are reset. At this point, as far as the FAT is
concerned, a deleted file no longer occupies physical space on the disk.

Importantly, the directory entry for a deleted FAT file retains the attributes for the starting cluster and the logical
file size. Forensic Explorer uses the logical file size to calculate the total clusters used by the file.
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FAT - FILENAMES OF DELETED FILES

Some deleted files will display in File List view of Forensic Explorer with an underscore as the first character,
whilst other deleted files retain their original name. An example is shown in Figure 389 above with the deleted
file “_UNNY.JPG” (originally called “BUNNY.JPG) has it first character replaced, but Koala.JPG in the same folder
retains its original file name.

The starting character of a Short File Name (SFN) is overwritten when a file is deleted by the OxE5 marker. For
display purposes, Forensic Explorer replaces the first character with an underscore.

Where a file having both a SFN and a Long File Name (LFN) directory entry, the missing first character of the file
name is in the LFN and is used by Forensic Explorer to display the full original file name.

FAT - LOCATING DATA FOR A DELETED FILE ON DISK

The following example details the methodology used by Forensic Explorer to identify and locate deleted files on
a FAT formatted disk.

In Figure 390 below, the parent folder of the file Koala.JPG is highlighted in Folders view:

Figure 390: Animals folder selected in Folders view.

[ Folders =
= D [ 2R FAT Photos 32 (1) ST | (e—
= D[ [5) FAT32-Photos.E01 (3) [Local Tir '
& O [ = Partition @ 63 [NO NAME] (7 Fiename a
D [ ) Orphaned (0) ~| Aquatic
& D [ Root (4) | Birds
=B lI] Animals B .
O Aquatic (13) D

)

= DO Birds @) i ‘Afiican Slephantjpg

0000000000

O[O cranes (3) [2) Buffalo.jpg
D [ 1.4 Flamingos (3) ]__3 Koala.JPG
[ [=g Flowers (9) [2) p1GS.PG
D [ - Landscape (5) [2) REDPANDA.IPG
23 _unny.ore

The directory entries for the parent are displayed in Hex view:

Figure 391: Animals directory showing 32-byte directory entries.

16 17 18 1% 1a 1B 1C 1D 1E 1F

B 63 73 3E 03 00 00 00 00 00 | . L ..*isvay. _tisv. .. ...
ZB 63 73 3E 00 00 00 00 00 00 | .. LLo*isvay . tismo. ...
FF FF FF FF 00 00 FF FF ¥FF FF | Ba.n.t...j...ip.q... §099i9.. 99¢
§C 00 &5 00 00 00 70 00 &8 00 | .B.£.r.i.c...iz.n. .E.l.e...p.h.
FD 96 ZZ 3R 04 00 EC EZ 05 00 | RFRICA~1JEG .. *isws>. _§.i:..i&..
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The directory entries show:
e That file “40ALA .JPG” starts with the OxE5 deleted file marker.
e It has both a short file name and long file name directory entry.

Koala.JPG is then highlighted and its directory entries are decoded in Filesystem Record view, as show below in
Figure 392:

Figure 392: Decoded directory entry of "Koala.JPG"

E Filesystem Record

Property Value Raw Value Type
= FAT Record (4,111,138)

= ﬂ Short Filename 1 —.r _OALA PG _OALA LIPG Astring
o Deleted True True Boolean

123 Atttributes A 32 Byte
12§ Reserved 0 0 Byte

128 Created (10ms) 156 156 Byte
_Ef] Created Time 1:09: 20 PM 26522 Word
E}] Created Date 19-Mar-11 15987 Word
E}] Accessed Date 19-Mar-11 15987 Word
125 EAIndex (FAT12/16) 0 0 Word
E}] Written Time 1:52:26 AM 3725 Word
Ef] Written Date 15-Jul-09 15087 Word
1] Start Cluster (FAT12/16) 492 492 Word
2§ Start Cluster (FAT32) 2 —fp 432 492 LongWord
125 Filesize 3 —P 730,531 730831 LongWord

= Longfile Record 1

El LFM String Koala, PG Koala. PG LI5tring

125 LFN Sig. byte 279 279 Byte

Eﬂ LFM Attribute 15 15 Byte

125 LFN Flag 0 0 Byte

128 LFN Checksum 215 215 Byte

128 LFN FirstCluster 0 0 Word

d)| Long filename 4 —Pp Koala.JPG Koala.JPG UString

The following information is observed:
1. The short filenameis “_OALA.JPG”
2. The starting cluster is 492;
3. Thefile size is “780831” bytes;
4. The long file name is “Koala.JPG”

To manually calculate the number of clusters used by Koala.JPG, the following additional disk information is
needed:

1. Bytes per sector; and

2. Sectors per cluster.
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This information is available by decoding the Volume Boot Record (VBR) with Filesystem Record view:

= Filesystem Record

Property Value Raw Value Type

[ FAT32 VER Record (32,256)
Lis| IMP Instructions EBE 58 90 Binary
ﬂ QOEM name M5DOS55.0 M5DOS55.0 AString
Eﬂ Bytes per sector 512 512 Word
) Sectors per duster 3 3 Byte
128 Reserved sectors 34 34 Word
Eﬂ Number of FAT's 2 2 Byte
Eﬁ] Mumber of root entries ... 0 0 Word
Eﬂ Mumber of sectors (16 hit) 0 0 Ward
12 Media 248 248 Byte
Eﬂ Sectors per FAT 0 0 Waord
Eﬂ Sectors per track 63 63 Word
12 Heads 255 255 Word
Eﬂ Hidden sectors 63 63 LongWard
Eﬁ] MNumber of sectors (32 bit) 4,064,382 4064382 LongWard

To determine the number of clusters used by Koala.JPG, the calculation is:
e  File size: 780,832 bytes / 512 bytes per sector = 1525.06 sectors
e 1525 sectors / 8 sectors per cluster = 190.63 clusters

The number of clusters that can be attributed to Koala.JPG is 191. The file therefore starts at cluster 492 and
finishes at the end of cluster 682.

To see this information in Forensic Explorer, switch to the “File Extent” view which details the byte, sector, and
cluster positions of the file:

Cluster Start: 492
Cluster End: 682
Cluster Length: 191
Sector Start 11941
Sector End 13468
Sector Length 1528
Highlighting the sectors in disk view reveals the following picture:

Figure 393: Display view of Koala.JPG

Display v
;[\ Image (Raster) ~ | (§1 | s B & |4t & 2 D -@‘ ]
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24.2.2 FAT - RECOVER FOLDERS

“Recover Folders” is a method of searching unallocated clusters to find deleted or missing folders and their
content. Recover Folders will often locate multilevel folder and sub folder structures and make them visible to
the investigator within the File System module. For this reason, it is recommended that a Recover Folders search
be one of the first tasks undertaken by an investigator in a new case.

To run a Recover Folders search, click the Recover Folders toolbar icon in the File System module:

Figure 394: Recover Folders File System module toolbar icon.

&

Recover
Folders

This opens the Recover Folders options window:

Figure 395: Recover Folders options

B9 Recovered Folders 1 Options - O X

Process Mame:

|Reco\rered Folders 1
Source
(®) Unallocated Spaces
Device: FAT32-Photos.E01 (125.0 ME) e
Partition: | Partition @ 47 (using Unallocated dusters on FAT 16 volume (120.5 MB)) ~

Checked itemz (0 items 0 bytes)

Filesystems
FaT ] exFAT[]

NTFS [] HFs [

Options
Keep Filesystem fragments

Logging: | Narmal ~ Priority: | Normal ~

OK Cancel

Name: Enter the folder name which will hold the recovered folders in the Folders view
of the File System module.

Source: A Recover Folders search must be run on an existing partition. Select the
partition from the drop-down menu.

File Systems: Select the type of File System records for which to search.

Keep Filesystem fragments: Fragments are the carved MFT, FAT, etc records that are used to rebuild the
folder and file structure. Once the file structure is rebuilt and displayed, the
fragments are no longer required. If this option is checked the carved items are
displayed in a sub-folder called FS Fragments (as shown in Figure 396). If the
option is not checked the fragments are not added.

Logging & Priority: See 7.5 — Logging and Priority.
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When the “Recover Folders” command is executed on a FAT partition in Forensic Explorer, the program searches
unallocated clusters for the “dot, double dot” directory entry signature Ox2E and Ox2E2E as well as LFN and SFN
directory entry structures.

The “Double Dot” is used to locate the parent folder and traverse up the directory tree. Eventually, because
located folders are not part of the existing file system, a parent folder will not be found. Forensic Explorer
appends the results in a folder in File System module Folders view using the generic name “Recover Folders X”,
as shown below:

Figure 396: Recover Folders results

H&-&-e
1T Evidence File System ﬁﬂr’cifacts é
& QA | 2 (& =

Recover File Mame File T Shadow  Signature T Expang
Falders Search Carve Copy Analysis Files
Folders Categories [ File List
Filter: |=." Mo Filter v | 5 (= A
inimf 4 Mew Case 53 (1) [Local Time] i F
= 13013701 Dell Laptop.E0L (4) [Local Time] ] i [

L[] =g Partition @ 2048 (12) ]
= L[] =) Partition @ 206848 (12) []
= [0 My Recovered Folders 2 (11)
C E FS Fragments HFS Catalog Rec |
C>[1 %y, Fs Fragments NTFS Table (1)
C:[] Orphaned (00
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24.3 NTFS DATA RECOVERY

When a file is deleted in a NTFS file system, the data content of the file remains available for recovery from the
newly unallocated clusters. The original data will remain in each cluster up until it is used to store new data and
the previous content overwritten.

If only a percentage of clusters are reused, then partial recovery, or the recovery of a “data fragment”, may still

be possible. If all clusters are re-used, all original content is overwritten and destroyed.

24.3.1 NTFS - DELETED FILES

Each file and folder on an NTFS drive has an “allocation status” set by a flag in the Master File Table (MFT) record
header. The flag identifies whether it is an “allocated” (active) file, or “unallocated” (deleted). To display deleted
files, Forensic Explorer reads the MFT to find “unallocated entries”.

Allocation status flag values are shown in Table 1 and Table 2 below:

Table 1: Allocation status for a file

Flag Value for a file
Hex Binary Status
00 00000000 Unallocated
01 00000001 Allocated
Table 2: Allocation status for a folder
Flag value for a folder

Hex Binary Status
02 00000010 Unallocated
03 00000011 Allocated
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In Forensic Explorer, the allocation status of a file is shown in Filesystem Record view when the file is highlighted:

Figure 397: Forensic Explorer Record view showing decoded MFT allocation status (an allocated file)

Filesystem Record

Property Value
=~ MFT Record
=+ Header
= Flags
o Deleted False
o Directory False
125 Offset to fixup 43
128 Size of fixup 3
Eﬂ Logfile sequence # 33747168
Fj] Segquence # 1
128 HardLinks 1

o Lhﬂ Am.‘ ikhh_—.‘.-ﬁﬁn&-\.!-ﬂ.—.ll-l .

When the MFT record is marked as unallocated, both the MFT record, and clusters used to store the data (for
non-resident files) become available to store new data. However, importantly:

e the file attributes within the unallocated MFT record remain intact;
e the data for the file remains untouched.
When new data is written to the MFT record or the clusters holding the data, the possibility for successful

recovery of the deleted file is diminished.

24.3.2 NTFS - ORPHANS

In Folders view a folder is created by Forensic Explorer called “Orphans”. Orphans are deleted folders and files
for which the original parent folder is unknown.

From the investigators perspective, an orphaned file can be treated in an investigation the same way as any
other deleted file. The only difference is that it is longer possible to determine the location of the file or folder
within the directory structure prior to deletion.

An example of how NTFS folders and file can become orphaned is as follows:

1. Afolder onan NTFS drive, “PARENT-1" is deleted by the user. At this point, PARENT-1, and its content,
“CHILD-FOLDER-1”, are deleted files.

2. The user then saves a new file. The MFT record for PARENT-1 is re-used to store information for the
new file. The MFT information for PARENT-1 is now overwritten and destroyed.

3. The computer is then forensically imaged and examined.

4. Forensic Explorer reads the file system and CHILD-FOLDER-1 is located. Forensic Explorer then tries to
trace the parent folder but determines that the MFT record for the parent folder has been re-used by
another file and the original information for the parent is no longer available.
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5. CHILD-FOLDER-1 and its content are available, but Forensic Explorer cannot determine where in the
tree structure it belongs. The Orphans folder is created by Forensic Explorer to hold CHILD-FOLDER-1
and its content.

24.3.3 NTFS - RECOVER FOLDERS

“Recover Folders” is a method of searching unallocated clusters to find deleted or missing folders and their
content. Recover Folders will often locate multilevel folder and sub folder structures and make them visible to
the investigator within the Forensic Explorer module. For this reason, it is recommended that a Recover Folders
search be one of the first tasks undertaken by an investigator in a new case.

To run a Recover Folders search, click the Recover Folders toolbar icon in the File System module:

Figure 398: Recover Folders File System module toolbar icon.

&

Recover
Folders

This opens the Recover Folders options window:

Figure 399: Recover Folders options.

E Recovered Folders 3 Options - O *

Process Mame:

|Rec0vered Folders 3

Source
(®) Unallocated Spaces
Device: 18011701 Dell Laptop.E01 (74.53 GE) v
Partition: |Partition @ 206848 (using Unallocated dusters on NTFS volume (23.51 GB)) e

Checked items (0 items 0 bytes)

Filesystems

FaT ] exFAT [
NTFS HFs []

Options
Keep Filesystem fragments

Logging: | Marmal ~ Pricrity: | Mormal v

When the “Recover Folders” command is executed on a NTFS partition in Forensic Explorer, the program
searches unallocated clusters for MFT records.

The process is identical to that described in “NTFS Orphans” above. The only difference is that instead of working
with files in existing MFT records, the MFT records themselves are recovered from unallocated space.
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24.4 FILE CARVING

File carving is a well-known computer forensics term used to describe the identification and extraction of file
types from unallocated clusters using file signatures. A file signature, also commonly referred to as a magic
number, is “a constant numerical or text value used to identify a file format or protocol” (16).

An example of a file signature is shown in Figure 400, which is the beginning of a .jpg file in Hex view:

Figure 400: View of .jpg file header

y@ya..JFIF..... L uardExRif. MMLEL L. L.,
........... Ei it nean e maear e e
....... T e AR
- S = 3 T
A¥..... B..&>ED..... B..'...'HPanasonic.DM
C-TZ1l5..... i e e .. Microsoft Window
& Photo Gallery 6.0.6001.18000..2009:07:
19 15:39:02. .8, 8.....004 e e Lom

.......... B v s A

The object of the carving exercise is to identify and extract (carve) the file based on this signature information
alone. Carrier (2005) describes File carving as:

“..a process where a chunk of data is searched for signatures that correspond to the start and end of
known file types. The result of this analysis process is a collection of files that contain one of the
signatures. This is commonly performed on the unallocated space of a file system and allows the
investigator to recover files that have no metadata structures pointing to them”. (2)

24.4.1 CARVING ADVANTAGES AND LIMITATIONS

File carving has both advantages and limitations. These include:
File system independent

File carving is essentially file system independent. A file type will exhibit the same file signature and
structure under FAT, NTFS, HFT, EXT2 or other file systems and can be data carved accordingly. File
carving is also an effective method of recovery when the file system is corrupt or destroyed.

Time Required:

A drawback of file carving is that it can take a considerable amount of time to process a large drive. The
lower the level of search (i.e., cluster v’s sector v’s byte), and the greater the number of file signatures
searched for simultaneously, the longer the search.

False Positives:

File carving always brings with it the risk of false positives, where identified file signatures are not true
identifiers for the start of a file. Searching at the lower levels of sector and byte may increase the
number of false positives because it removes the validation requirement that the signatures must start
near cluster boundaries.
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Data Fragmentation:

Without file system records, it is difficult to track fragmented files. File carving relies on the information
contained in the file structure and to a lesser extent it’s on disk layout.

No Original File Names

As file names are stored only as part of the file system, data carved files cannot be recovered with their
original name.
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24.4.2 FORENSIC EXPLORER FILE CARVING ENGINE

Forensic Explorer has an inbuilt file carving engine capable of carving more than 300 file types.

To run a file carve using the Forensic Explorer file carving engine:

1.

2.

Switch to the File System module;

Click the File Carve button on the ribbon;

Figure 401: File System module, File Carve button

N\

File
Carve

The “File Carving” selection window, shown in Figure 402 will open:

Figure 402: File carving file signature selection window

E File Carve Options
F

Process Mame:

|Fi|e Carve

Source

(®) Unallocated space (7 items 23,59 GB)

Checked items (0 items 0 bytes)

Include Raw Devices, Partitions and Files

Search Mode: | Sector w Byte Offset: 0

File types to carve:

] = ) OO Oy O O O A

F

I @ Archives

[0 © artifacts

[ & camera

[J || Databases and Finandals
= Documents

= L”‘;] Email

(1% Graphics

(] &] Internet

O @ Microsoft Office
(] »ei] Multimedia
O[] Music

[ & Text (WARNING: Slows Search)
| P T

Find: |

Logging: | Mormal w Priority:

MNormal w
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. CARVE NAME

The carve name is the name of the folder which holds the carve results. This folder is displayed in Folders view
of the File System module. The default name, “File Carve” can be edited during setup of the search.

Figure 403: File Carve results.

He-#&-0
1T Evidence File System ﬁ Artifacts p Keyword Sej
‘ T
a @ N v v O o
Recover File Mame File Shadow  Signature T Expand Extract
Folders Search Carve Copy Analysis Files Metadata
Folders Cateqgories [ File List Gallery View
Filter: |_.=_." Mo Filter v| 3= &2 Filename
O g Mew Case 53 (1) [Local Time] A Filename
B ?é.' 18011701 Dell Laptop.E01 (5) [Local Time] | i & Carved_IPG_1
E=] k File Carve (742) sh— : ] > & Carved _JPG_1
C:[ =g Partition @ 2048 (12) [ N 3 W, Carved_1PG_{

 SOURCE

A File Carve is usually run-on unallocated space. However, it is possible to carve on a specific file, such as the
Windows page file, or a backup file, by first checking the file in the File System module and then selecting to

carve the checked items.

. CARVE SEARCH MODE:

Cluster based file carving

In a cluster-based file system like FAT or NTFS a new file must start in a new cluster. It follows then that

the file signature appears near a cluster boundary. Carving speed is therefore achieved by searching for

file signatures only near cluster boundaries.

Sector based file carving (recommended)

It is recommended to perform a lower-level search for sector-aligned file signatures. This search may

recover additional files, for example files from a previous volume which had a different cluster layout

and is no longer aligned to current cluster boundaries.

NOTE: Carving in sector mode will increase the length of the search.

File Carve > Byte based file carving

In certain situations, it is necessary

to data carve at a byte-by-byte level. This will locate additional

files where the file signature is neither aligned with a cluster or sector boundary.

Sector carving is used to recover files from mobile/cell phone image files.

NOTE: Carving in byte mode will greatly increase the length of the search.
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CUSTOM BYTE CARVE

Custom Byte Carve is an alternative method to file carve at a byte level. Custom Byte Carve is a script, and uses
RegEx as its means of traversing data.

Launch Custom Byte Carve from the drop down menu of the File System module > File Carve > button:

Figure 404: Custom Byte Carve.

File System

BN

File
Carve

'”th File Carve
'“th Custom Byte Carve

Custom Byte Carve is useful for searching sequential data file such as:
e Hiberfil,
e  Pagefile,
e Swap file.

The primary advantage is that users can enter custom header, footer and size information, as show in Figure
405 below.
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Figure 405: Custom Byte Carve.

B ' Custom Byte Carve = O X

About Options
Source
Chedked Items (0 items)

[ Devices: All Devices w
[ | Hiberfil. sys

[ shadow Copy

[ swapFileX, (MAC)

E] Temporary Internet Files
[ unallocated Clusters

Carve Settings
JPEG o
Header: PP D8 weFF [WED\WE 1\wFE]
Footer: YwFF D3
Trim Footer:
Min Size: U] ME
‘ Max Size; 25 ME ‘
‘ Ext: Jpa ‘
Results

Folder Mame: 2023-11-18 122044

Max Hits: 10000

Run Cancel

SELECTING FILE TYPES TO CARVE
Select the required file signatures by placing a tick in the selection box and click OK to begin the search.

NOTE: It is recommended that to maintain search speed, no more than 10 file signatures be selected at one
time.
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_CARVE PROGRESS

The progress of the data carve is shown in the processes window. To stop a data carve click the stop button in
this window.

DEFAULT SIZE ALLOCATION

When a file signature of a selected file is located, Forensic Explorer will analyze the file structure to locate the
end of the file. If the file end is not found, but sufficient information is found within the file to suggest it will at
minimum be partially recovered, it is assigned a pre-determined default file size per that file type.

LOGGING AND PRIORITY

See 7.5 - Process Logging and Priority.

The second file carving method available in Forensic Explorer is to use a custom file carving script. An investigator
may use, modify, or write a script to suit their data recovery needs.

For more information on scripts, please refer to Chapter 19 - Scripts Module.

In some circumstances, e.g., carving a fragmented file, it may be necessary to join individual fragments of
carved data to make a single file.

To merge or join files:
1. Select the carved files.

2. Right-click and select Merge Files from the drop-down menu.
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Figure 406: Merge files

Filename
- 1% 11111
ol 2 % 202
] 3 E REE]
Add Bookmark...
Open
Open with...

Determine file signature
Expand compound file(s)
Export...

Hash...

ClamAV scan...

Merge Files

Send to module

In the Merge Files window:

1. Adjust the sequence of fragments as needed using the Move Up and Move Down buttons.

2. Enter a New Name to describe the new created file.

3. Click OK to add the file to the File System module.
Figure 407: Merge files
B Merge Files - O -
Mew Name: (Merged Data
Available Folders:  File Carve W New...
Items:
Filename Data Sive Bates ID
11111 1024 20
22222 1024 21
33333 1024 2
Mawe Up Mave Down
[oc ] conce
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25.1 RAID - INTRODUCTION

Forensic Explorer supports the analysis of the following types of RAID:
JBOD

JBOD (Just a Bunch of Disks) is a term to describe the grouping of odd-sized drives into one larger useful drive.
For example, a JBOD could combine 3 GB, 15 GB, 5.5 GB, and 12 GB drives into a logical drive at 35.5 GB, which
is often more useful than the individual drives separately.

RAID O

A RAID 0 (also known as a stripe set or striped volume) splits data evenly across two or more disks (striped) with
no parity information for redundancy. It is important to note that RAID 0 was not one of the original RAID levels
and provides no data redundancy. RAID 0 is normally used to increase performance, although it can also be used
to create a small number of large virtual disks out of many small physical ones.

A RAID 0 can be created with disks of differing sizes, but the storage space added to the array by each disk is
limited to the size of the smallest disk. For example, if a 120 GB disk is stripped together with a 100 GB disk, the
size of the array will be 200 GB.

RAID 1

RAID 1 is a mirrored set with parity. Typically, it consists of two physical drives, one being an exact copy of the
other. The RAID Array continues to operate so long as at least one drive is functioning. Using RAID 1 with a
separate controller for each disk is sometimes called duplexing.

A RAID 1 drive is added to Forensic Explorer using the Add Device (or Add Image) button in the Evidence module
(itis not necessary to use the Add RAID button).

RAID 5

RAID 5 uses block - level striping with parity data distributed across all member disks. Distributed parity means
that if a single drive fails the array is not destroyed. Upon a drive failure, any subsequent drive reads can be
calculated from the distributed parity of the functioning drives. A single drive failure in the set will result in
reduced performance of the entire set until the failed drive has been replaced and rebuilt.

RAID 6

RAID 6 is like RAID 5 but parity data is written to two drives. That means it requires at least 4 drives and can
withstand 2 drives failing simultaneously.

25.2 PREPARATION

When dealing with RAID drives, care should be taken in the forensic acquisition phase to document as much
information as possible as to the RAID configuration.

Successful RAID setup in Forensic Explorer will be assisted by knowledge of the following:

e [sitahardware or software RAID? (A hardware RAID usually has a separate RAID controller card);
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e What is the RAID format, JBOD, RAID O, 1, 5, other? (Are the drives in the raid identical in size and

capacity? This information may be obtained from the system administrator or setup documentation).
e What is the RAID stripe size? (This information may be determined from the RAID controller)
e  How many physical disks make up the RAID?

e What is the sequence of the physical disks in the RAID? (Noting or photographing the RAID controller

port numbers may assist to determine drive sequence).
e Isthe RAID complete and functioning? Are there missing drives?

25.3 ADDING A RAID TO A CASE

A RAID can be constructed and added to Forensic Explorer using:

1. Physical disks (Note: When using physical disks, a hardware write blocking device is recommended to

preserve forensic integrity);
2. Forensic Image Files; or,
3. A combination of both physical disks and forensic image files.

To add a RAID drive to a case:

1. Click the button to add a device to the current case.

£ Add RAID

2. Inthe Device Selection window, click on the

button. This opens the RAID configuration

window.

25.3.1 HARDWARE RAID, KNOWN CONFIGURATION:

Enter the RAID configuration information:

RAID 4
RAID Configuration Raid 5 Options
RAID Mame: |User RAID | First Checksum Device: 2 5
Type: Hardware e Checksum rotation direction: Lleft W
Format: RAID 5 (Striping with Redundancy) ~ [Juses asynchronous checksum rotation
Stripe size: | &4 w | kB

and follow the instructions to add and test the RAID.
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If it is a software RAID:

1. Setthe "Type" of RAID to "software".

2. Avalid software RAID will show with green ticks on the added drives (or image files):

Raid Segments | Probable Solutions | Event Lu:ug|

Marme # Size
ﬁ- SAe CAUzers\Graham \DeskiophBAIDWS W 0 b 0 7453 GA
ﬁ- SAe CAlzers\Graham\DesktophBAIDASW 0 a.. 1 7453 GE

Once the correct RAID layout has been identified, click SAVE and OK to add the configured RAID drive to the

Device Selection window.

{rio label}

{nao label}

L. _: zer BalD

et oot g Bt B

Select the RAID drive and click OK to add the drive to the case.

Once the RAID drive is added, select, and preview individual files to ensure that the RAID drive is correctly
configured and access to all files in the RAID has been achieved.
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26.1 SHADOW COPY INTRODUCTION

The ability of Forensic Explorer to easily access and explorer Volume Shadow Copies (VSCs) offers the forensics
investigator the ability to examine data at different time snapshots in a forensic examination. A Shadow Copy is
essentially a differential backup of the contents of a drive. By examining a Shadow Copy it can be possible to
view previous versions of a file, a directory, or a volume.

Prior to Windows Vista, “Restore Points” were a relatively simple snapshot of critical Windows system files. In
Windows Vista and beyond, the Volume Shadow Copy Service (VSS) takes a snapshot of all files on the volume
that has changed, including user files.

VSS is present on:
e  Windows Server 2003
e  Windows Vista (all versions)
e  Windows Server 2008

e Windows 7 (all versions)

26.1.1 SHADOW COPY CONFIGURATION BY WINDOWS USERS

Windows VSC controls are access via:
“Control Panel\All Control Panel Items\System\System Protection”.

VSC is activated on an NTFS drive by turning on the Protections Settings in the System Properties windows.
Shadow Copies can be created on local or removable media. The System Properties window (Win 7) is shown in
Figure 408 below:

Figure 408: System Properties, Protection Settings

& ™y
System Properties M

| Computer Name I Hardware Ad\rancedl System Protection | Remote

Wl Use system protection to undo unwarted system changes and
45 restore previous versions of files. What is system protection

System Restore

“You can undo system changes by reverting
your computer to a previous restore point. [ System Restore...
Protection Settings
Available Drives Protection g
=aDATAZ(E) Off K
N TOSHIBA EXT (G2) On 3
&L, Win7x64 (T (System) On AL
Configure restore settings, manage disk space,
and delete restore points. Eoplioses
Create a restore point right now for the drives that e

have system protection tumed on.

OK [ Cancel || feply
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The configure button gives access to further settings. The lowest setting is to “Only restore previous versions
of files”, with the option to “Restore system settings and previous version of files”. This is shown in Figure 409
below:

Figure 409: System Protection Settings

., System Protection for DATA 1 (D) e

Restore Settings

System Protection can keep copies of system settings and previous
versions of files, Select what you would like to be able to restore:

@ Restore system settings and previous versions of files
i) Only restore previous versions of files

() Turn off system protection

Disk Space Usage
¥ou can adjust the maximum disk space used for system protection. As
space fills up, older restore points will be deleted to make room for new

ones.

Current Usage: 0 bytes

Max Usage: r}i

Delete all restore points (this indudes system settings
and previous versions of files),

[ OK ][ Cancel ] Apply
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When VSC is active on a volume, a Windows user can right click on any file in Windows, select the Properties
options for that file, and then access the Previous Versions tab, shown in Figure 410 below:

Figure 410: Windows file properties, Previous Versions

W4 12 Days of Christmas.docx Properties I&
| General | Security | Details | Previous Versions
"J:_ Previous versions come from restore points or from
e Windows Backup. How do | use previous versions?
File wersions:
Mame Date modified Location
4 Yesterday (11)
W] 12 Days ... 19-Jul-13 5:57 PM Restore poit
Eﬂ 12 Days .. 19-Jul-13 5:47 PM Restore poir
@] 12 Days... 19-Jul-13 5:45 PM Restore poir| 5
Eﬂ 12 Days ... 19-Jul-13 5:42 PM Restore poir
@12 Days.. 19-Jul-135:39 PM Restore poir
W] 12 Days... 19-Jul-13 5:36 PM Restare poit
E_"ll?. Days ... 19-Jul-13 5:33 PM Restore poirll 2
@] 12 Days... 19-Jul-135:29 PM Restore poit
W] 12 Days ... 19-Jul-13 5:26 PM Restore poit =
1| 1] [ 3
Cpen Copy... Restore...
0K || Ccancel Apply

It is the ability to extract previous file versions which is of clear value to the investigator. It is possible, for
example, that even though a file has been deleted and erased from the current file system (with no trace of the
file in unallocated clusters), that a version of the file prior to its deletion could be contained within a VSC on the
system.

26.1.2 WHEN ARE SHADOW COPIES CREATED?

The frequency of VSC creation will depend on the Operating System installed. Typically, they are automatically
created daily in Vista, and weekly in Windows 7. VSCs can also be automatically created prior to significant
Windows Operating System events, such as the installation of new software, including Windows updates.

In addition to this, many commercial applications such as registry optimization software offer the ability to
create a system restore point (for backup purposes) prior to making disk changes. An end user can also manually
create a VSC from the Windows System Properties > System Protection > “Create” button, shown in Figure 408
above.
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26.1.3 WHERE ARE SHADOW COPIES STORED?

Shadow Copies are stored in the hidden folder “Partition\Root\System Volume Information” on the volume
on which the “Protection Settings” are enabled.

The “System Volume Information” folder contains:

e aVSS Catalog file called {3808876b-c176-4e48-b7ae-04046e6cc752}, a unique identifier specific to
VSS;

e VSS Store files (the files which contain the actual shadow copy data) which have names like:

{c678aeab-f000-11e2-93bf-005056c00008} {3808876b-c176-4e48-b7ae-04046e6cc752}.

(Note that the VSS identifier is attached to the Store name in the second set of braces).
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26.2 EXAMINING SHADOW COPIES WITH FORENSIC EXPLORER

To mount a Volume Shadow Copy (VSC) in Forensic Explorer;
1. Inthe Forensic Explorer Evidence module, start a preview, a new case, or load an existing case;
2. Switch to the File System module to view the files in the case;

3. Click on the Shadow Copy button in the File System module toolbar:
Figure 411: Shadow Copy button in the File System Toolbar

4

Shadow
Copy

4. The Forensic Explorer Volume Snapshot Mount window will open and list the available VSCs for the
selected volume, as show in Figure 412 below:

Figure 412: Volume Snapshot Mount Window

Q Shadow Copy Options = O *

Process Name:

|5hadow Copy

Logging: | Normal

Available Volumes: |Partition @ 206848 ~
List of Snapshots | = Date (UTC) MName )
17 21-Jan-2018 9:15: 17 PM Windows Update {763E75D8-FEEF-11E7-AF.
16 22-Dec-2017 10:43:01PM Microsoft Visual C++ 2015 Redistributable (..
15 20-Dec-2017 12:30:17 AM Windows Update {9831C063-E51B-11E7-B6..
14 20-Dec-2017 12:29:25 AM Microsoft Visual C++ 2015 Redistributable (..
13 19-Dec-2017 11:43:34PM Windows Update {8AD19C11-E515-11E7-E7.
12 03-Jan-2017 1:02:44 AM Windows Update {9E2D6732-D14F-11E6-9B.
4 20-Dec-2015 3:28:52 AM Restore Operation {1031BB15-A6C3-11E5-8.
2 19-Dec-2015 8:02: 18 PM Windows Update {34F75F97-A685-11E5-99..
1 19-Dec-2015 7:14:00 PM Windows Update {97AEB76D-A63F-11E5-A..
11 19-Dec-2015 4:25:10 PM Windows Update {37AEBEFB-AG3F-11E5-AC.
10 14-Jun-2015 2:40:58 AM 13th of Jun and we are almost there big we.. »
< >
Options
Mount method: | Only files that are different ~
Color: B Green ~

Priority: | Mormal bl

e [ ]

Available Volumes:

Enables another volume and it shadow copies to be accessed.

Mount Method:

Only files that are different displays only those files in the VSC which are different from that
listed in the current file system. This saves the investigator cluttering with File System module
with duplicate identical files from the VSC.
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Each Shadow Copy catalog contains a list of cluster changes. The 'difference' is a comparison
between the cluster changes in the Shadow Copy catalog versus the information supplied by
the current MFT. A 'difference' does not necessarily mean that a file shown in the Shadow
Copy has different content. It may just mean that a file is now located in different clusters in
the current MFT, even though both files have the same MD5 hash.

All Files mounts the entire Shadow Copy.
Color:

Assigns a color to the mounted VSS. If a color is selected, a new column is created in the File
System module called “VSS”. The columns contains the selected color to identify the origin of
the file.

5. Inthe Volume Snapshot Mount window, click on the required snapshot (identified by the date
created) and click OK. The Shadow Copy is then processed (the process status is shown in the process
window in the bottom right hand corner of Forensic Explorer) and the VSC files added to the File
System module.

3 Added VSC volumes are identified by the shadow copy icon in the Folders window of the File
System module.

The VSC volume name includes the date and time of the snapshot, as shown in Figure 413 below:

Figure 413: File System module showing a mounted shadow copy

| Folders | [ | categories

Filter: | Mo Filter o

C:O g Mew Case 54 (1) [Local Time]
=2- 0O 153013701 Dell Laptop.E01 (5) [Local Time]

C>[] =g Partition @ 2048 (11) [] partitiﬂl"l
] = Partition @ 206848 (11) [ - .

.............................................................................................................................................................................................

-~ Shadow

When a VSS has been added to the File System module, four new columns become available:

e VSS Color— Contains the color assigned to the shadow copy volume during the mount process (if a color
has been assigned, this column is automatically added to the File System module at position 2);

The following columns can be manually added (Right Click > Columns > Edit Columns);
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e VSS Date — The date of creation of the VSS;
e VSS GUID — The Windows GUID assigned to the VSS, e.g. {C678AE98-F000-11E2-93BF-005056C00008}
e VSSID —The VSS snapshot ID.

To best examine different version of a single file a combination of the Folders Filter (see 9.12.5), the Branch Plate
(see 8.2.3), and the column filter tool (see 9.12.2) can be used, as shown below:

Figure 414: Filtering Different Versions of the same file — shows original and two VSS versions (green and red)

Folders Categories [EE] File List Gallery View Video View () Disk View (8 Category Graph
. T - i !
Filter: |=. Mo Filter ~ | %_?- = L-‘t!' home.doc J 1-8l V55 Color
B[] g Mew Case 54 (1) [Local Time] Filename VS5 Color
= B[] 18017701 Dell Laptop.E01 (6) [Local Time] i 1 D Home.doc
B[] =g Partition @ 2048 (11) [] = 2 [C] Home.doc .
B[] = Partition @ 206848 (11) [] = 3 [2] Home.doc [ |

B[] #2 Partition @ 206848 (03-Jan-2017 1:02:44 AM) () [
B[] §2 Partition @ 206848 (20-Dec-2015 3:28:52 AM) {2) [

E- - -

Once a VSC is mounted in the File System module, it is possible to operate on it like as you would a normal
volume, including keyword search, indexing etc.
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Chapter 27 - Mount Image Pro
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27.1 MOUNT IMAGE PRO

Your Wibu dongle purchased with Forensic Explorer also contains a license key for Mount Image Pro.

Mount Image Pro is software used to 'mount' forensic image files as a drive letter or physical drive on your
forensic workstation. This allows users to:

e  Browse the contents of an image file in programs such as Windows Explorer;

e  Run third party applications, such as virus scanners, spyware scanners, cache analyzers etc. over the
mounted evidence files;

e Run third party programs on the physical drive, such as Virtual Forensic Computing
(www.virtualforensiccomputing.com), used to boot an image of a Windows file system in a virtual

environment.

Once an image is mounted, these actions are ready only and "forensically secure", as the contents of the image
file will not be changed.

27.1.1 INSTALL AND RUN MOUNT IMAGE PRO

Mount Image Pro is a stand-alone application available for download from www.mountimage.com or

http://download.getdata.com/eMIP-Setup.exe (Note: To use Live Boot within Forensic Explorer you must have

Mount Image Pro v6 or above installed).
Download and run the setup file and follow the onscreen installation instructions.

Run Mount Image Pro from the desktop icon. Ensure that the dongle is inserted to activate the product (when
activated the red “buy online” button will not show in the program tool bar).

To mount an image file;
1. Click the mount button in the program toolbar;

2. In the “Drive Selection” window, select the image file or physical device to mount (If the image file is
not listed, click the “Add Image” button, and select and add the image to the available devices list). Then
click the Mount Disk, or Mount File System button.

Mount Disk:

The Mount Disk option is used to Mount an image file and display the physical disk and / or partitions
as if the physical drive were connected to the local computer. Windows is responsible for reading the
file system and displaying the files.

Mount File System:

The Mount Filesystem button mounts the selected image or disk and uses the Mount Image Pro Version
6 Filesystem Driver (not Microsoft windows) to display the file system. This allows additional
information to be displayed within the mounted image, including deleted files and Windows system
files.
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The Mount Image Pro GUI displays the image details and the assigned drive letter, as show in Figure 415

below:

Figure 415: Mount Image Pro GUI

|] Mount Image Pro v6.42 (1839) - Activated

File Options

a_mounl... - Q_ Unmount - @\ﬂew E‘Options @gpdate a Help

Help

Mounted As
Diisk [PMF]

Filename Capadity Partition Mount Point

= E 18074701 Del Laptop.EOT T4BIGE WAPHYSICALDRIMEZ
) 100.0 MB 1 [Active) E

A >

; B 2

Location (Byte | Property

Capacity

1048576 Total Sectors

System Reserved [E
]

36 Cylinders
TracksPerCylinder
SectorsPerTrack
BytesPerSector
Acquiing Date
System Date

.| Examiner

¢ Acquiing 05

f| Acquiing Program
Case Mo
Evidence Mo
Compression
Password
Deszciiption

Mote

< >

Value

7463 GE

156301485

155061

18

=<}

812

26nlan-2018 8:46: 08 PM
26n] ane 2018 5:46:06 PM
John Zeke Thackiay
Wwin 2014

ADI3433

Op Payback

18014701

Fast

0

18014701 Dell Laptop
The laptop was found in the tiunk /b,

Disk x64 v6.5.0(56), Service Started FileSystem x64 v6.5.0(56), Service Started

D:\2. Test imagesh1801JT01 Dell Laptop\1801JT01 Dell Laptop.EO1

Mount Image Pro has numerous other features, including:
e Mount as read only or simulate disk writes
e Mount the physical drives into Windows disk management
e  Mount from the command line

e  Mount logical image files from created by EnCase® and FTK.

These features are more fully described at www.mountimage.com and in the support documentation for the

product.
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28.1 LIVE BOOT

Forensic Explorer Live Boot enables an investigator to boot a forensic image or write-protected physical hard
drive containing a Windows Operating System. The investigator can then operate the computer in a forensically
sound virtual environment.

Utilizing Live Boot as part of a forensic examination can give insight into computer use that may not be as readily
evident when examining file system records alone. For example, viewing the desktop, icon layout, menus, and
running installed software, is a fast and effective way to quickly profile computer use.

Live Boot also offers a compelling means of presenting digital evidence to a client, prosecutor, or court. To
demonstrate a live running computer can be an effective means of conveying complex evidence in a way that is
easily understood.

28.2 REQUIREMENTS

Live Boot has the following requirements:

Live Boot requires a full dongle version of Forensic Explorer. Live Boot will not run in the Forensic Explorer
evaluation edition.

GetData’s Mount Image Pro is used to mount a forensic image to make it accessible to Live Boot. A purchase of
Forensic Explorer includes a license for Mount Image Pro on the same dongle.

The latest version of Mount Image Pro is available at:

e www.mountimage.com; or,

e http://download.getdata.com/eMIP-Setup.exe

NOTE: When installing Mount Image Pro v6 for the first time, a reboot is required. Ensure that when Mount
Image Pro starts, both the Disk and FileSystem drivers show a ‘Service Started’ status, as shown Figure 416
below;
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Figure 416: MIP driver status

|] Mount lmage Pro v6.42 (1859) - Activated

File Options Help

a_ﬂount... - B_ Unmount - @.Vw 7’| Options @deate a Help

Filename Capacty  Mounted As Partiion  Mount Point

Dhisk x84 +6.5.0(36), Service Started FileSystern x64 +v.3.0(56), Service Started

28.2.3 VIRTUALIZATION SOFTWARE

At least one of the following virtualization tools must be installed:

VIRTUAL BOX (RECCOMENDED)

Forensic Explorer 3.5.7.5214 and above supports Live Boot using Oracle Virtual Box. This is Open-Source
visualization software available for download at www.virtualbox.org.

 VMWARE
The following VMWare applications are supported:

e VMWare workstation (commercial)
http://www.vmware.com/products/workstation/; or,

e VMWare Player (free for non-commercial use)
https://my.vmware.com/web/vmware/freeidesktop end user computing/vmware player/7 0%7CP
LAYER-714%7Cproduct downloads

IMPORTANT: Adding additional drives requires VMWare Workstation and will not work with
VMWare Player. See Figure 417 below. VMWare does NOT support booting of MAC system,
VirtualBox must be used.

NOTE: If you are installing VMWare Player you must run VMWare Player and agree to the terms and
conditions, shown in Figure 417 below, before running Live Boot:

Copyright GetData Forensics Pty Ltd 2010 - 2024, All rights reserved.


http://www.virtualbox.org/
http://www.vmware.com/products/workstation/
https://my.vmware.com/web/vmware/free#desktop_end_user_computing/vmware_player/7_0%7CPLAYER-714%7Cproduct_downloads
https://my.vmware.com/web/vmware/free#desktop_end_user_computing/vmware_player/7_0%7CPLAYER-714%7Cproduct_downloads

Chapter 28 — Live Boot

423 | Page

Figure 417: VMWare Player Terms

-

Welcome to ViMware Player 7

2]

‘?-ljl VMware Player 7

@ Use YMware Player 7 for free for non-commerdial use

Enter a valid email address. You agree to receive
promotional emails from YMware related to VMware

Flayer.

View our privacy policy

or to allow commerdial use

Learn more about YMware Player 7 Pro

(71 Enter a license key to enable YMware Player 7 Pro features

e VMWare Player Plus (Commercial)
http://www.vmware.com/products/player/.

INSTALLING VMWARE TOOLS (AFTER BOOTING)

VMware Tools is a suite of utilities that enhances the performance of the virtual machine's guest operating

system. It also improves management of the virtual machine by allowing such options as the transfer of data

into or out of the virtual machine.

To install VMware Tools, click on the Install Tools button. If you receive the following VMware error message:

Figure 418: VMWare Tools virtual CD/DVD error

VMware Player

device to install VMware Toals.

The virtual machine needs to have a virtual CO/OVD

To enable the virtual CD/DVD:

1. Shut down Windows virtual machine inside the VMWare window;

2. In VMWare window, select the required VMWare session, right click, and select settings. The
Virtual Machine Settings window will open.

3. Click Add to add a virtual device and select CD/DVD Drive from the Hardware Type menu:
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Figure 419: Virtual Machine Settings

Virtual Machine Settings
Hardware | Options
Device Summary Memory
Spedify the amount of memory allocated to this virtual
0 Memory 2GB " ﬁr - . VE [P "
[ processors 1 Add Hardware Wizard
i Hard Disk (5CSI) 74.5GB
USE Controller Present Hardware Type _
,G,:, sound Card Auto detect What type of hardware do you want to install?
E.] Display Auto detect
Hardware types: Explanation

2 Hard Disk Add a DVD/CD-ROM drive,

) CD/DVD Drive

[ Floppy Crive

@ Network Adapter

USB Controller

'G'I' Sound Card

E Parallel Port

m Serial Port

@ Printer

Generic SCSI Device

< Back Mext = Cancel
Add... Remave
Concsl | [

4. Restart the virtual machine and click on the Install button to install VMWare Tools.

USING SHARED FOLDERS IN VMWARE (AFTER BOOTING)

With shared folders, you can easily share files among virtual machines and the host computer. To use shared
folders, you must have the current version of VMware Tools installed in the guest operating system and you
must use the Virtual Machine Control Panel to specify which directories are to be shared.

To set up one or more shared folders for a virtual machine, be sure the virtual machine is open in Workstation
and click its tab to make it the active virtual machine. Go to Edit > Virtual Machine Settings > Options and click
Shared folders (See https://www.vmware.com/support/ws4/doc/running _sharefold ws.htm| &
https://docs.vmware.com/en/VMware-Workstation-Pro/15.0/com.vmware.ws.using.doc/GUID-AACE0935-
4B43-43BA-A935-FC71ABA17803.html for additional documentation).

28.3 COMPATIBILITY

Forensic Image Files

Live Boot requires a forensic image of a physical device that contains a bootable file system (Live boot does
not currently support the booting of logically acquired partitions).

Supported Target Operating Systems
Live Boot will boot the following Operating Systems:

e Windows 95, 98, XP, Vista,7, 8, 10, 11 (including GPT partitioned drives);
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e Windows Server 2012;
e Linux.

e Macintosh HFS (VirtualBox must be used as the virtualization software).

28.4 LIVE BOOT WORKING FOLDER

IMPORTANT: Live Boot requires a working folder to store the Mount Image Pro disk cache and working files.
Each time a Live Boot session is started a working folder is created in the Live Boot folder of the current case
path, in the format:

[user]\Documents\Forensic Explorer\Cases\[Case Name]\Live Boot\[Boot Image Name + Date Time
stamp]

As shown below:

Figure 420: Current Case folder showing Live Boot working folder.

Documents » Forensic Explorer » Cases » MNIST Hacking Case » Live Boot »

oy
Mame

MIST - 40ell Latitude CPi 16-09-13 145638

The data for each Live Boot session is retained to enable the re-open in the virtualization software of a Live Boot
session at a specific point in time. If individual sessions are no longer required, they can be deleted.
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28.5 LIVE BOOT ON WINDOWS 11 FORENSIC WORKSTATIONS

Changes by Microsoft between Windows 10 and 11 means that there are additional configuration steps
required to optimize Live Boot when running a Windows 11 forensic workstation. The following configuration
steps are suggested, particularly when attempting to Live Boot to boot MAC devices.

1. Turn off Windows Features:

e  Virtual Machine Platform.
e  Windows Hypervisor Platform.

Figure 421: Windows Features.

Turn Windows features on or off

Settings

Figure 422: Windows Features.

Windows Features — 0 w0
Turn Windows features on or off (7]

To turn a feature on, select its check box, To turn a feature off, clear its
check box. A filled box means that only part of the feature is turned on.

[I7 Internet Information Services

Internet Information Services Hostable Web Core
Legacy Components

Media Features

Microsoft Defender Application Guard

Microsoft Message Cueue (MSMO) Server
Microsoft Print to PDF

Microsoft XP5 Document Writer

MultiPoint Connector

Print and Document Services

B ®

=

®H &®

Remote Differential Compression APl Support
Services for NF5

Simple TCPIP services (i.e. echo, daytime etc)
5ME 1.0/CIFS File Sharing Support

S5MBE Direct

_ Telnet Client

~ TFTP Client

_ Virtual Machine Platform

~ Windows Hypervisor Platform

~ Windows ldentity Foundation 3.5

3]

[+
gouoaodsosddsedesdasdd]
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2. Turn off Core isolation.

Figure 423: Windows Core isolation.

am Core isolation
w System settings

Figure 424: Core Isolation.

rz,

i Core isolation

Security features available on your device that use virtualisation-based
security.

Memory integrity

Prevents attacks from inserting malicious code into high-security
processes.

® ) off

Learn more

3. Disable Hyper-V in boot configuration using the BCDEdit tool. From an elevated command prompt type:

. Bcdedit /set hypervisorlaunchtype off

An optimized Windows 11 forensic workstation will have the following settings in the System Information

window:

Figure 425: Windows 11 Live Boot optimization.

B System Information
File Edit WView Help

System Summary [tem

[#-Hardware Resources Tirmne Zone

Components Installed Physical Memaory (RAM])
- Software Environment

Total Physical Memary
Available Physical Memory
Total Virtual Memory
Available virtual Memory
Page File Space

Page File

Kernel DMA Protection

Value

AUS Eastern Daylight Time
64.0 GB

63.9 GE

50.4 GE

73.4 GB

58.5 GE

9.50 GE

Ch\pagefile.sys

off

Virtualization-based security

Mot enabled |

Windows Defender Application Control policy
Windows Defender Application Control user mode policy
Device Encryption Support

Enforced
Off
Elevation Required to View

Hyper-V - VM Monitor Made Extensions Yes

Hyper-V - Second Level Address Translation Extensions Yes

Hyper-V - Virtualization Enabled in Firmware Yes

Hyper-V - Data Execution Protection Yes
Find what: Find Close Find
[ search selected category only [J search category names only
b
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28.6 HOW TO LIVE BOOT A FORENSIC IMAGE

The following steps describe how to use Live Boot to boot a forensic image. In this example an EO1 file from the
‘NIST Hacking Case’ is used (http://www.cfreds.nist.gov/Hacking Case.html). The image is booted using Virtual

Box as the virtualization software.
1. Check installed software: Ensure that all required software is installed (as detailed in section 28.2 above).

2. Start a Forensic Explorer case: Run Forensic Explorer and start a Preview or Case. Add a forensic image
file of a Windows disk to the preview or case. If the original computer had additional data disks, also add
the forensic image files of these disks.

3. Run Live Boot

a. Torun Live Boot, In the Forensic Explorer File System module click on the Virtual Live Boot button in
the toolbar:

Yirtual
Live Boot

The Live Boot Options window will display:

Figure 426: Live Boot Options

E Virtual Live Boot Options = O *
Process Name:

Virtual Live Boot

Boot ExtraHODDs VM Settings Advanced
Hard Disk

Hard Disk 1 (Boot): |200]_'IT02 -Dell Laptop.EDL -~

Detected 05: |Windows 7 v

Options
Boot to IS0: [
150 image file:

BIOS boot delay (secs): 0

Boot date/time (UTC): |29—Dec—2019 E- | | 9:59:26 PM =

Use datetime: |29-Dec—2019 09:59:26 PM Last ACCESSED v|

Host system memory (MB): 65408
WM memory (MB): 4096 =

VM CPU count: 1 =

-

B start virtual Machine
[ Attempt to minimize pending Windows Updates
B Bypass Windows user passwards (Up to Windows 7)

Logging: Maormal ~ Priority:  Mormal w
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Hard Disk 1: Select the device to boot from the drop-down menu;
Detected OS: The OS found on the Device to Boot;

Boot to ISO: Boot the device using an ISO image (used primarily for password cracking
(see belowy);

Boot Date/Time: Defaults to Last Shutdown Time (or if not found the current date time).
Edit these settings to adjust to a custom date time or use the drop-down
menu below.

Use Date/Time: Select the:

e MAC (scans the partition on the physical drive to locate the latest
date which is a non-future date);

e Last Shutdown (from the registry);
e Current (system clock of the forensic workstation);
From the drop-down menu to change the Boot Date/Time;
Host system memory (MB):
The amount of RAM on the VM host.
VM Memory (MB):

Default RAM size has been preselected depending on the Operating
System detected. Additional memory can be allocated as required (for
more information see:
http://support.theenterprisecloud.com/kb/default.asp?id=344&Lang=1).

VM CPU count: The CPUs per virtual machine.
Windows 11 computers require a minimum of 2.

Start Virtual Machine:
Launches the virtual machine automatically.

Bypass Windows user Passwords:

This option will blank Windows user passwords. See password cracking
below. To bypass Windows 10 passwords, see 28.7 below.

Attempt to minimize Pending Windows Updates:

This option will limit Windows updates to only those that have started
but are not yet complete. No new updates will be started.

b. Ensure that ‘Hard Disk 1 (Boot)’ contains the required image.

c. To add additional Hard Drives to the virtual machine, click on the Extra HDDs tab:
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Figure 427: Add additional hard drives to a Live Boot

B virtual Live Boot Options — O >
Process Mame:
\Virtual Live Boot
Boot ExtraHDDs yM Settings Advanced
Add additional hard disks (not available in YMware Flayer):
Hard Disk 2: | 18011701 Dell Laptop.ED1 e
Hard Disk 3: | None ~
Hard Disk 4: | None ~
Hard Disk 5: | None ~
Hard Disk & | None ~
Hard Disk 7: | None g
Hard Disk 8: | None ~
Logging: | Mormil w Priarity: | Mormal v
Cancel
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Add additional hard disks:

If the suspects computer had additional disks, then these disks can be added to the
virtual machine.

IMPORTANT: Adding additional drives requires VirtualBox, or VMWare Workstation (will
not work with VMWare Player).

First, add the forensic images of the disks to the case, then add the additional disks to
Live Boot. It is important that the disks are in the original order. For example, if Disk 1
contained the Windows installation, Disk 2 contained the My Documents folder, Disk 3
was an additional storage disk, and then it is important to keep this disk order so that
the My Documents disk functions correctly when running in the virtualization software.

d. Switch from the Boot Options tab to the VM Settings tab:

Figure 428: Live Boot Options

B9 virtual Live Boot Options — O X

Process Mame:

|virtual Live Boot

Boot ExtraHDDs VM Settings  Advanced

Program Installation Folders:

VirtualBox: |C: \Program Files\Crade WirtualBox), = |

WMware: | :\Program Files (x86) WMware \WMware Workstation' @|

Mount Image Pro: |C: \Program Files\GetData\Mount Image Pro vaY B|

Boot Virtual Machine Using:

(® virtual Box
VMware Workstation

VMware Player

Logging: | Mormal ~ Priority: | Normal -

e. Ensure that the paths to the installed virtualization software and Mount Image Pro v6 are correct.
f.  Click Launch to proceed with the boot.

g. Information about the boot process is displayed in the process window. The virtualization software
will then launch, and the forensic image will boot, as shown in Figure 429 below:
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Figure 429, Live Boot using Virtual Box

Xl NIST - 4Dell Latitude CPi-liveboot [Running] - Oracle VM VirtualBox - O X

File Machine View Input Devices Help

Todls

i/ start 22, 1:50.aM

=] = (2] right ctrl

HINT: In Virtual Box, to switch the mouse between the virtual machine and the desktop, use the RIGHT CTRL
Key (in VMWare it is the CTRL — ALT keys).

Copyright GetData Forensics Pty Ltd 2010 - 2024, All rights reserved.



Chapter 28 — Live Boot 433 | Page

28.7 LIVE BOOT AND USER LOGIN PASSWORD BYPASS

In many cases when Live Boot is used to launch a virtual machine access to the virtual computer will be blocked
by a user account login screen. If passwords for the user accounts are unknown, there may be options to either
recover or bypass the password.

28.7.1 WINDOWS USER PASSWORD RECOVERY

The advantages of password recovery are:

1. A known password may be of evidentiary value to a case. For example, a unique password may tie an
individual to a computer.

2. A known password may assist in other avenues of investigation. For example, the password may be
used in the decryption user files.

The disadvantages of password recovery are:
1. Password recovery requires the use of third-party software.
2. Password recovery can be resource and time intensive.

3. Strong passwords may not be recovered.

éWINDOWS NTLM HASHES

An NTLM hash is the cryptographic format in which user passwords are stored on Windows systems. To break
an NTLM hash, various programs can be used, such as Ophcrack, John the Ripper, and Hashcat. These
programs are capable of performing dictionary attacks, brute-force attacks, and other techniques to crack the
hashes and reveal passwords.

NTLM hashes can be extracted in Forensic Explorer using: File System > Tools > 3rd Party Tools > GetData
NTLM Hash Extract.

Figure 430: GetData NTLM Hash Extract.

&

3rd Party
Tools

a Beyond Compare
E Elcornsoft Encrypted Disk Hunter

T4t ExifTool
GetData NTLM Hash Extract

Al
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Figure 431: Figure 425: GetData NTLM Hash Extract output.

E]?.OOUTO?_ - Dell Laptop.E01 - Windows_NTLM_Hash (config).tet B
1 FetData Forensics NILM Hash Decrypter v1.0

5AM H:\MTH\2001JT02Z - Dell Laptop.E01\Partition @ 206848\Root\Windows\Sy=stem32\config\SAM
SYSTEM = H:\MTH\2Z001JT0Z2Z - Dell Laptop.E0l\Partition @ 206848\Rooct‘\Windowsz\System32\config\SYSTEM

& SamFey = 82bT730dlelS554dc9dad497295ecakbacdl
SysFey = cafece030ce985bdo3cTdezadb0ad4s84

o User: Administrator
10 RID: £000001F4 (500)
11 NTLM hash: 3ldeécfeldleas®31b73c59d7e0c089%c0 (Empry)

13 User: Guest

14 RID: £000001F5 (501)

15 NTLM hash:

17 User: John Thomas Hamilton
18 RID: S000003EE (1000)

19 NTLM hash: 413b3fc95%bacTeébébSdebeacfSezfsl

21 Usexr: HomeGrouplUsers
22 RID: S000003ER (1002)
2 NTLM hash: 906d0%b40e562186283d106e62eT729f1

User: UpdatusUser
RID: $000003EE (1003)
NTLM hash: 7556l624f545ea366b6lebedScS5821fE

User: Bdam Thomas
RID: $000003EC (1004)
NTLM hash: batfl3lffelsbcTdcc0286ca3ds21739

Usex: Mary Thomas
RID: SO00003ED (1005)
NTLM hash: 174ad277fb%ac309fe59%b86ecci96e4d

fTHIRD PARTY PASSWORD RECOVERY TOOLS - OPHCRACK

Ophcrack is a free open-source program that recovers Windows passwords by processing NTLM hashes through
rainbow tables (see http://en.wikipedia.org/wiki/Ophcrack). Ophcrack can be used to recover passwords from
Win XP, Vista, Win7 and Win8 operating systems.

Ophcrack I1SO image files are available for download from http://Ophcrack.sourceforge.net/download.php.

These include:
e  Ophcrack-xp-livecd-3.6.0.iso (for LM hashes of Windows XP and earlier);
e Ophcrack-vista-livecd-3.6.0.iso (for NT hashes of Windows Vista and 7).
To recover a password with Ophcrack:
a. Follow the instructions provided above to mount the image file and run Live Boot.

b. Inthe Boot Options tab, check ‘Boot to ISO’ and select the relevant Ophcrack ISO image, as shown in
Figure 432 below:
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Figure 432: Live Boot ISO

B8 virtual Live Boot Options — O >

Process Mame:

|uirma| Live Boot

Boot ExtraHDDs WM Settings Advanced
Hard Disk

Hard Disk 1 (Boot): | 18013701 Dell Laptop.E01 w

Detected O5: | Windows 7 w

Options

Boot to I50:

150 image file: |E: \GH Forensic Images\Password Bypass\ophorack-vista-win7divecd-3.

BIOS boot delay (secs): IE'

Boot date/time (UTC): |26-Jan 2018 B~ | | :34:40 PM =

Use dateftime: | 26-Jan-2018 09:34:40 PM Last ACCESSED e

Host system memory (MB): 16040

VM memary (MB): 4096 =

Start Virtual Machine
] Attempt to minimize pending Windows Updates
Bypass Windows user passwords (up to Windows 7)

Logging: | Normal ~ Priority: | Mormal ~

c. Click OK to launch Ophcrack in the virtual machine.

d. Follow the on-screen Ophcrack prompts to commence the password breaking process, as shown in
Figure 433 below:
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Figure 433: Ophcrack Password Breaking

ophcrack -0X

Load = Delete | Save : Tables Stop Help Exit About
Progress | Statistics | Preferences |

user | LMHash | NTHash | Lmpwd1 LM Pwd 2 NT Pwl
Administrator 31décfe0dl... empty
Guest 31d6cfendl... empty
HelpAssistant 2111829216... bd8c73557¢... KWONGPY
*disabled* s... c23faddsve..
mr, Ewil 31d6cfendl... empty

Table Directory Status | Progress
- @ XP fre... [//media/hdc... 100% in RAM | ]

Preload: Brute force: Pwd found: Time elapsed: | 0Oh 1m 5s l

Additional rainbow tables are available online. Click the Ophcrack Tables button to add additional tables (if using
the Ophcrack vista/7 LiveCD additional Win7 tables are in the /media/hdc/tables folder). Refer to
http://sourceforge.net/p/ophcrack/wiki/ophcrack%20Howto/ for additional information.

Once the required password is recovered, close the virtual machine and re-launch Live Boot without the ISO

boot option checked. When presented with the Windows login screen, enter the recovered password to
proceed.
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FORENSIC EXPLORER PASSWORD BY-PASS

Check the Bypass Windows user passwords checkbox in the Live Boot Options window. Forensic Explorer will
attempt to blank Windows user passwords. At the Windows login screen, login with a blank password.

éTHIRD PARTY PASSWORD BY-PASS TOOL — PCUNLOCKER

PCUnlocker from http://www.top-password.com/reset-windows-password.html is a recommended third party
application for Windows user account by-pass (Learn more about PCUnlocker here: http://www.top-
password.com/guide/reset-windows-password.html)

GetData has partnered with top-password.com to provide licensing solutions. Please contact
support@getdata.com for more information.

PCUNLOCKER - MBR (TRADITIONAL BIOS MODE) USING VIRTUALBOX

1. In Forensic Explorer click the Live Boot button in the File System module to launch the Live Boot window.

2. Inthe Forensic Explorer Live Boot window check Boot to ISO and enter the path to the pcunlocker.iso file
(31,370kb, MD5 6DDFO65CF9B65F265E4654025FBO0CSS).

3. Click OK to boot and the Virtual Machine will launch PCUnlocker:

Figure 434: PCUnlocker Windows’s password bypass

Enterprise Edition v4.2

a4 PCUnlocker

http:/fwww.top-password.com

r 1. Select a recovery mode

¥ Reset Local Admin/User Password " Reset Active Directory Password

r 2. Select the Windows SAM registry file

| F: WINDOWS\system32\config\SAM ~|

3. Select a user account from the list, then dick "Reset Password” button to continue,

User Name | Password | Locked Qut | Disabled | Mever Expire | Description
charl <blank> Mo Mo Yes

DefaultAccount <blank > Mo Mo Yes A user account r
Eddie <hlank= Mo Mo Yes

Guest <blank > Mo Yes Yes Built-in account 1
HomeGroupUsers <hlank = Mo Mo fes Built-n account 1
Punisher <hlank> Mo Mo Yes

W

£

Reset Passward Restart
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4. Highlight the required user accounts to bypass and select the Reset Password button. When the password
has been successfully reset the password column will show <blank>.

5. Once the required passwords have been bypassed, it is necessary to eject the virtual CD (the booting ISO
image) from the virtual machine. In Virtual Box this is done by selecting Devices > Optical Drives > Remove
disk from virtual drive, as shown in Figure 435 below (Hint: To unlock the mouse from the VirtualBox
window, press the right CTRL key).

Figure 435: Ejecting a virtual CD (ISO image) in VirtualBox.

ﬁ;ﬁ SPI_2016 Final-liveboet [Running] - Cracle VM VirtualBox

File Machine View Input Devices Help

() Optical Drives ' [A Choose disk image...

[ Shared Folders
@ Rernowe disk from virtual drive

Shared Clipboard

O
By Drag and Drop
&

Insert Guest Additions CD image...

Enterprise Edition v4.2

{ﬂ PCUnlocker

1, Select a recovery mode

6. Oncethe CD is ejected, press the Restart button in the PCUnlocker window. The virtual machine will then
restart and boot into Windows. Bypassed Windows User Account passwords will be blank.

Important: The error message “FATAL: No bootable medium found! System halted.” Indicates the disk contains
an EFI partition. Follow the instructions below:

Figure 436: PC Unlocker — “Non-bootable medium found! System halted.”

&l 1tb_hp_laptop-liveboot [Running] - Oracle VM VirtualBox = O x

File Machine View Input Devices Help
FATAL: Mo bootable medium found?! System halted.

>
B © ] =@ {3 (2 (8] rightcrl

PCUNLOCKER - EFI SYSTEM PARTITION USING VIRTUALBOX

“UEFI is short for "Unified Extensible Firmware Interface". It's an advanced interface standard of firmware for
operating system compared to legacy BIOS, such as it supports fast PC startup, bootable GPT hard drive, larger
capacity more than 2T etc. Almost all recent PCs are EFI/UEFI”.
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To bypass Windows user password on an EFI partition using VirtualBox and PCUnlocker it is necessary to disable
EFI during the password bypass process. Follow these instructions:

1. Run Forensic Explorer and Live Boot the forensic image with VirtualBox using the default Live Boot settings

(do not boot with pcunlocker.iso).

2. At the Windows login screen, shutdown the machine using the standard Windows shutdown procedure as
shown in Figure 437 below (Windows must be shutdown correctly to obtain access to system boot settings
in VirtualBox):

Figure 437: Windows Shutdown in VirtualBox

ER 1tb_hp_laptop-liveboct [Running] - Gracle VM VirtualBox b

File Machine View Input Devices Help

Password

B EW @ © @ rgtc

Forensic Explorer can now be closed as the remaining procedure is done using VirtualBox and PCUnlocker

only.

3. Run Oracle VM VirtualBox from the desktop icon. In the left column, select the required virtual machine
from the list. From the VirtualBox menu, select Machine > Settings > System to display the window shown
in Figure 438 below. Uncheck the Enable EFI (special OSes only) box:
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Figure 438: VirtualBox System Settings - Disable EFI

¥
7 ] 1tb_hp_laptop-liveboot - Settings ? X
shots
New  Setting
1@1 General System L\\)
ET] A
hﬂ @ &
b System Motherboard ~ Processor  Acceleration
Display Base Memory: . 4096 MB ¥
@ Storage 4MB 16384 MB
{p Audi Boot Order: Floppy
udio @ Optical
] & Hard Disk
@ Netwark
O @ Metwaork
‘@ Serial Ports Chipset: PINZ =
p USBE Pointing Device: |PS/2 Mouse 7
Extended Features: ] Enable /0 APIC
Ij Shared Folders 4 /
| [] Enable EFI {spedial 0Ses only) |
E User Interface [] Hardware Clock in UTC Time
e
[T oo
Hast Driver:  Windows DirectSound v

Important: If the Enable EFI (special OSes only) is greyed out, it means that the Virtual Machine is running,
or Windows has not shutdown correctly (i.e., the running state of the virtual machine has been saved).
Restart the virtual machine and power down using the Windows shutdown procedure.

4. With the virtual machine shutdown, in the virtual machine settings window, select Settings > Storage > click
on the Optical Drive and select the pcunlocker.iso file, as shown in Figure 439 below:

Figure 439: Select the PCUnlocker ISO from the VirtualBox settings window.

A Oracle VM VirtualBox M

I e Qe & O 9.

Mew  Add Settings Discard  Start

LoneWolf-liveboot g_ [ General =] preview
'-r;ITEI' @ Powered Off _— Name: LoneWolfiveboot
Operating System:  Windows 10 (54-bit) J
| [l Casctan

) LoneWalf-liveboat - Settings

E General Storage
System Storage Devices Attributes
ISJ I @ Controller: IDE Optical Drive:  IDE Secondary Device 1 e @ |
Display -
© panlocker.iso |_J Live CDjOVD [a Choose/Create a Virtual Optical Disk. ..
Storage & Controller: SATA Information [ Choose a disk file... L\\)
= " Type: Image
Audio (2] LoneWolfHiveboot.vmdk :
GD] Size: 209.31MB T EEETES
@ MNetwork Location:  C:\GetDataMotes\PCUnlocker \peunlod @ Remove Disk from Virtual Drive
s Attached to: LoneWolf-iveboot

5. Click Start to launch the virtual machine and boot with PCUnlocker. Follow the PCUnlocker instructions to
reset the required Windows user account passwords. Once the passwords have been reset, eject the virtual

CD containing the pcunlocker.iso by selecting Devices > Optical Drives > Remove disk from virtual drive (as
shown in Figure 435 above).
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6. Power off the machine by selecting the X button in the top right corner of VirtualBox and select Power off
the machine.

Figure 440: Power off virtual machine in VirtualBox

1tb_hp_laptop-liveboot [Paused] - Oracle VM ‘u‘irtualBolk - O >

You want to:
() Save the machine state
@ O send the shutdown signal

? (®) Power off the machine

ccel | [ rio

W

>
B ) ] = @ {3 (9 (3] right Ctr

7. Once the machine is powered down go back to the Machine > Settings > System settings and re-check
Enable EFI (special OSes only).

8. Ensure that in the virtual machine settings window that the optical drive is empty (eject the pcunlocker.iso
if it is still present).

9. Click Start to launch the virtual machine. The machine should now boot to the Windows Desktop with
passwords bypassed.

éWINDOWS DOMAIN USER ACCOUNT BYPASS

A Windows domain password cannot be recovered or bypassed because it relies on data stored on a remote
computer (no longer accessible) for authentication. In this situation the forensic examiner should attempt to
gain access to a local administrator account that can be then used to log into the system and change the required
user account authentication method (i.e., remove domain authentication and set the user account to a known
or blank local password).

Forensic Explorer users have also reported success with Forensit's User Profile Wizard 3.16
https://www.forensit.com/downloads.html in converting a domain account to a local account.
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28.7.3 MAC PASSWORD BYPASS

SINGLE USER MODE — CREATE ADMINISTRATOR ACCOUNT

A Google search for ‘reset MAC user account’ will return many articles relating to the use of MAC Single-User

mode. This is the MAC equivalent of accessing a Windows DOS shell where UNIX commands can be issued prior
to startup.

Variations of Single-User password reset instructions exist, which can also vary between versions of the MAC
OS. In this example we use the following commands:

mount -uv /

rm /var/db/.AppleSetupDone

By deleting the .AppleSetupDone file the next boot will mimic the first install and prompt for the setup of an
Administrator account. All system files, apps, personal data, etc., for any existing user accounts remain intact.

To by-pass a MAC user login using Single-User mode:

1. This procedure works only with Forensic Explorer Version 4 and above. Ensure that Forensic Explorer
v4 or above is installed.

2. Startanew case, add the forensic image (ensure that it is a bootable image that contains a Master Boot
Record).

3. Click on the Live Boot button in the Forensic Explorer File System module toolbar to open the Live Boot
Options window. The Detect OS should identify the type of MAC OS:

Figure 441: Live Boot Options window showing detected MAC OS

] virtual Live Boot Options - O x

Process Name:

|Virtual Live Boot

Boot ExtraHDDs WM Settings Advanced
Hard Disk

Hard Disk 1 (Boot): | 18011T01 Dell Laptop.E01 w

I Detected OS: |Mac OS5 X 10. 15 Catalina x64 ~

User selected
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4. Click on the Advanced tab. Place a tick in the checkbox for Start MAC OS X in Single User mode (Virtual
Box Only):

Figure 442: Live Boot Options window Advanced tab

B8 virtual Live Boot Options - O >

Process MName:

|Virtual Live Boot

Boot ExtraHDDs VM Settings Advanced

Advanced Options

Show logging during MAC OS X boot (Virtual Box Only): []
Start MAC OS X in Single User mode (Virtual Box Only

Mount Image Pro Timeout (secs):

5. Click Launch to launch the virtual machine. The virtual machine will boot the Single-User mode
command interface:

Figure 443: Launch of VirtualBox virtual machine in MAC Single-User mode.

B aaron-mac- 128 vebast [Running] - Oracke VM Vil - o x
or Time Machine (THSafetyMet)

FHE1)

andbox policy
e

199,
the University of Ca

. IBOBOIREN

o ICHARHC 1 /PRTO0N/ T0ANC 10w co@0,/fipp | oAHC 101 skDr i ver / T0ANC 101 ockSLorageDev i ce/

dl/RELEASE_XB6_64

FEFSL I IEICLTE
6. Atthe command prompt, issue the command: mount -uv /

IMPORTANT: Manually type the above command (there may be invalid characters if copy and paste is used).
There is a SPACE between the v and the forward slash.

Figure 444: Entering UNIX commands in MAC Single-User mode

pash-3.2# nmount -uv /
hfs: Removed 10 orphaned / unlinked files and O directories

Wfs: created HFBT on Macintosh HD

dev/diskl on / (hfs, local., journaled)
rash-3.2# ||

Copyright GetData Forensics Pty Ltd 2010 - 2024, All rights reserved.



444 | Page Chapter 28 — Live Boot

7. At the command prompt, issue the command: rm /var/db/.AppleSetupDone

IMPORTANT: Manually type the above command (there may be invalid characters if copy and paste is used).
There is NO SPACE between the forward slash and the period.

Figure 445: Entering UNIX commands in MAC Single-User mode.

hash-3.2# ra fvar/db/ .AppleSetupDone

rash-3.24 ||

8. At the command prompt, type exit (to boot the virtual machine). During the startup process you will
be prompted by several setup screens:

Figure 446: MAC setup

|
Choose s keybowrd lyout.
|
|

FEFECT RO

9. Atthe Create a Computer Account screen, enter your details for a new administrator account:

Figure 447: Create MAC administrator user account.

Create a Computer Account

Fill out the following information to create your computer account.

Full name: ||
Account name:
This will be the name of your home folder.
Password:

Hint:

Require password to unlock screen

Options: Set time zone based on current location
Send diagnostics & usage data to Apple

Help Apple improve its products and services by
automatically sending diagnostics and usage data.
Diagnostic data may include locations.

Share with app developers

Help app developers improve their apps by allowing
Apple to share crash data with them.

About Diagnostics and Privacy.

© ©

Back Continue
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10. Click through the setup screens to reach the MAC desktop. Once at the desktop click on the settings
button and then Users & Groups:

Figure 448: MAC Settings button

11. In the Users & Groups window, click on the lock icon in the bottom right-hand corner and enter your
new user account administrator credentials. This will unlock the ability to change passwords for other
user accounts. Once the target account is unlocked, use the Change Password button.

Figure 449: Edit user accounts in MAC Users & Groups

[ ] Show All Users & Groups Q
illiel Login ltems
M GetData Change Password...
Other Users
i
M
Guest User
Sharing only
Contacts Card: Open...
Login Opti
m ogin Upflons L\\’ Open Parental Controls...
L3
Click the lock to make changes. ?

12. Log out of your administrator account and log back in via the target account.

éTHIRD PARTY SOFTWARE — KON-BOOT

It is possible to bypass MAC user passwords with a third-party commercial tool called Kon-Boot for Mac OSX
(http://www.piotrbania.com/all/kon-boot/). This version includes the ISO image: Konboot.iso (MD5 Hash:
6D148A57181429F42F161387FD7A31B8). The most successful methodology is to use this tool to create a new
administrator account through which other account passwords can be changed.

To by-pass a MAC user login with Kon-Boot:

1. Start a new case, add the forensic image (ensure that it is a bootable image that contains a Master Boot
Record) and Live Boot the image using the instructions described above using VirtualBox as the virtualization
software.

2. Once the MAC has booted to the MAC user login window, close the VirtualBox virtual machine and select
Power off the Machine.
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3. Close Forensic Explorer, it is no longer required.

Figure 450: MAC user login window

L IO
4. Launch VirtualBox from the desktop icon.
5. The last Live Boot session will show at the bottom of the list in the left-hand column:

Figure 451: VirtualBox GUI

N9 Oracle VM VirtualBox Manager — O s
File Machine Help
{:} ﬁ} g 3 v | petais | (@ Srapshots
New Settings Discard Start
f @ ral \ Q P o 1A
Mame: aaron-mac-128gb-iveboot
| Operating System: Mac O35 ¥ 10. 10 Yosemite (64-bit)
| System < |
Base Memory: 2043 MB
Boot Order: Floppy, Optical, Hard Disk
Acceleration:  VT-x/AMD-V, Mel*ed Paging, PAEMX,
Minimal Paravirtu#ization
( Display \
Video Memory: 255 MB
Remote Desktop Server:  Disabled
| Video Capture: Disabled
| Storage
Controller: SATA
SATA Port O: aaron-mac-128gbiveboot,vmdk (Mormal, 113,00 GB)
. SATAPort8: [Optical Drive] Empty
| B Audio
Host Driver:  Windows DirectSound
| Contraller:  Intel HD Audio
| @ Network
 Disabled )
5 use
| Shared folders
| Mone )
( @ - \
Created By: Forensic Explorer v3.9.8.6558
Created Date: 22-Jun-2017 01:04 PM
. Device: aaron-mac-128gb-liveboot v
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6. Inthe VirtualBox Manger information window on the right-hand side, under Storage, look for [Optical Drive]
Empty. Right click and select “Choose disk image...”:

Figure 452: VirtualBox Optical Drive

Storage
Controller: SATA

SATA Port 0: aaron-mac-123gb-iveboot. vmdk (Mormal, 113.00 GB)
SATA Port 8: [Optical Drive] Empt
Iﬁ Choose disk image...
{7 Audio = .
konb ) Choose dis
Host Driver:  Windows DirectSound TIIIT T
Controller:  Intel HD Audio pcunlocker.iso
Bl Network PCUnlocker_UEF|_x64.iso
|

Disabled M fTa e T el A

¥ usB

7. Select the konboot.iso downloaded earlier.

8. Launch the virtual machine (by pressing on the green start arrow in the VirtualBox manager toolbar) whilst
pressing the ESC key to enter the virtual machine BIOS. TIP: When the virtual machine boot window first
appears, click on it to ensure that it has focus and rapidly press the ESC key on your keyboard).

9. Successful access to the virtual machine BIOS will provide the following menu:

Figure 453: MAC BIOS

x aaron-mac-128gb-liveboot [Running] - Oracle VM VirtualBox - m] X

File Machine VYiew Input Devices Help

Select Language
» Boot Manager
» Device Manager

<English>

This selection will
direct the system to
continue to hooting
process

» Boot Maintenance Manager

t1=Move Highlight

<{Enter>=Select Entry

B ® @ = @ 3 9 € rihtcyl

10. Select the Boot Manager menu option and then select to boot using EFI DVD/CDROM:
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Figure 454: MAC Boot Manager

Boot Manager

Device Path :
Boot Option Menu PciRoot (0x0) /Pci (Ox1F,
0x2) /Sata (0xB,0x0, 0x0)
Mac Boot
Hac Boot

EF1 DUD/CDROM

EFI Hard Drive

EFI Internal Shell

T and | to change option. ENTER to select an
option, ESC to exit

Tl=Move Highlight <Enter>=Select Entry Esc=Exit

® &)= @@ [F 9 3] rightcul

11. The Kon-Boot menu will appear. Use option [1] Use new-account feature (login: kon-boot password: kon-
boot):

Figure 455: MAC Kon-Boot user menu

LS

» Scaming all disk drives
» Found handles=b (SelfHande=7F64A918)
» Found our drive at index=1 {out of 6)

» MacBootEfi device found. id = 3 (F628018)
» MHacBootEfi device found. id = 4 (YFO1SE1B)
» Found 2 mac devices!
b Installing our driver...
» Please pick your option (0-1):
+ [01 Use bypass feature (no new account)
+ [11 Use new-account feature (login: kon-boot password: kom-boot)
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12. The MAC computer will then boot with a Kon-Boot user account displayed.

Figure 456: MAC Kon-Boot 'Other' user account

FISF L EICET

13. Login via the Other user account, using username kon-boot, password kon-boot. Once logged in, click on
the MAC System Preference icon:

Figure 457: MAC System Preferences icon

14. In the System Preferences select the Users & Groups icon. Select on the required user account, and click
the Change Password button to enter new password details:

Figure 458: MAC System Preferences, Users & Groups

o0 Show All Users & Groups Q Search
Current User Password R GEIEGES
Other Users
Guest User

'! Sharing only

Contacts Card: Open...

Allow user to administer this computer
fa}
Login Options I}
[+]— [ 4] |

|| Enable parental controls Open Parental Controls...

dﬁ Click the lock to prevent further changes. 2

15. Log out of the kon-boot user account and then into the target user account using the new password
details.
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Since Mac OS 8.6, the Mac has managed passwords with Keychain, Apple’s password-management system.
Learn more about keychain management here: http://www.macworld.com/article/2013756/how-to-manage-

passwords-with-keychain-access.html

Once logged into the target account the password will not match the password of the original login keychain. To
create a new key chain, follow these instructions: https://support.apple.com/en-au/HT202860#keychain.

28.8 TROUBLESHOOTING LIVE BOOT

Following the checks below to troubleshoot Live Boot:

Does the forensic image have a valid Master Boot Record (MBR)?

To boot a forensic image, it must be an image of a physical drive which contains a valid MBR. Check this in the
File System module by selecting the image in the Folders view and viewing its child entries in the File List, as
shown in Figure 459 below:

Figure 459: Checking for a valid MBR.

Forensic Bxplorer = e iRk 2 ?)
€ Bvidence Fle System  |wf\wArtifacts 2 Keyword Search K
@ Q& N ¥ 9 O i

Recover File Name File T  Shadow Signature T Expand Extract 7 Analysis
Folders Search Carve Copy Analysis Files Metadata Programs
Folders Categories File List Gallery View Video View
Filter: |J:,_f No Filter W | =g = AZ¥ Filename

g Mew Case 55 (1) [Local Time] Filename

[ ] |s} 18013701 Dell Laptop.ED1 (4) [Local Time] 1 (=g Partition @ 2048

2 = Partiton @ 206843
3 |Z Free Space on Disk

4 [C) Master Boot Record h

Can the Live Boot NIST control image be booted successfully?

[ o o

e Download and boot the NIST “Hacking Case” EnCase image available at:
http://www.cfreds.nist.gov/Hacking_Case.html. This image boots to Windows XP. A successful boot
will assist you to determine if the error relates to the configuration of Live Boot or the image that

you attempting to boot.
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28.8.3 LIVE BOOT CONFIGURATION

Is VMWare Player or VMWare Workstation or Virtual Box installed?

e  Check Live Boot Options (shown in Figure 428: Live Boot Options above) to confirm the correct path to
the virtualization software executable file is visible, i.e.:

o VMPlayer: C:\Program Files x86)\VMware\VMware Player\vmplayer.exe. (If you are using
VMPlayer ensure that you have entered your user details into the VMPlayer splash screen);

o VMWorkstation: C:\Program Files (x86)\VMware\VMware Workstation
o Virtual Box: C:\Program Files\Oracle\VirtualBox\...
Is Mount Image Pro v6 installed? (Live Boot is NOT compatible with earlier versions);
e  Check Live Boot Options (shown in Figure 428 above) to confirm the correct path to MIP:

o C:\Program Files\GetData\Mount Image Pro vX\MIP.exe.

28.8.4 MOUNT IMAGE PRO CHECKS

Mount Image Pro Cache and Virtualization Files

e Locate and delete the Live Boot working folder and then try again. The Live Boot working folder is in
the following path:

[user]\Documents\Forensic Explorer\Cases\[Case Name]\[Boot Image Name + Date Time stamp].
Does the Image mount independently in Mount Image Pro v6?
e  Run Mount Image Pro v6 as a stand-alone program;
o Ensure that Mount Image Pro is activated;

o Ensure that Mount image Pro drivers are correctly installed, as shown in Figure 460 below:

Figure 460: Mount Image Pro drivers

nr'_wﬂnw—u—'mu——'\mﬂm/\_.d——ul

£
Disk x64 v6.3.0(32), Service Started FileSystern x84 v6.1.0(22), Service Started

LA i,

e Manually mount the required image in Mount Image Pro using: Mount Disk; PNP; Write to Cache.
Confirm that the image mounts successfully.
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Does the image that you are trying to boot contain a valid Windows File System?

e In the Forensic Explorer File System module, examine the file and folder structure to confirm that the
image has a valid bootable Windows file system. Check that this folder is also accessible in the mounted
image.

Is it possible that Mount Image Pro is timing out before the image is mounted?
e In the Forensic Explorer Live Boot window change to the Advanced tab and in the Mount Image

Timeout (secs) increase the default setting to 360 seconds.

28.8.5 BIOS — INTEL VIRTUALIZATION TECHNOLOGY

The live boot of a 64-bit virtual machine can require Intel Virtualization Technology to be enabled in the forensic
workstation bios.

Additional information can be found at:

e  http://kb.vmware.com/selfservice/microsites/search.do?language=en US&cmd=displayKC&externall
d=1003944

e  https://www.hardwaresecrets.com/everything-you-need-to-know-about-the-intel-virtualization-

technology/

28.8.6 VMWARE CHECKS

If you are using VMWare as the virtualization software, check the following:

éVMWARE PROCESSOR CHECK UTILITY FOR 64-BIT COMPATIBILITY

Ensure that your forensic workstation can run a 64-bit virtual machine. Download the test utility VMware-
guest64check|[ver].exe using via the link below:

“When you power on a virtual machine with a 64-bit guest operating system, Workstation performs an
internal check: if the host CPU is not a supported 64-bit processor, you cannot power on the virtual
machine. VMware also provides this standalone processor check utility, which you can use without
Workstation to perform the same check and determine whether your CPU is supported for virtual
machines with 64-bit guest operating systems” (http://www.vmware.com/pdf/processor_check.pdf,
accessed 18 March 2015).

 KEYBOARD ISSUES
VMWare keyboard communication issues can include:
e Slow or unresponsive keyboard;
e Unable to issue commands like CTRL/ALT/DEL

Most keyboard communication issues can be solved by installing VMware Workstation and using the custom
setup option to add the Enhanced Keyboard Utility (if VMWare Workstation is already installed, re-run the
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setup, and use the modify/change option). Forensic Explorer Live Boot will use the Enhanced Keyboard Utility if
available.

Figure 461: VMWare Workstation Enhanced Keyboard Utility

ViMware Workstation Setup

VMware Workstation Features
Select the features you wish to install,

Click on an icon in the list below to select features for installation.

— Feature Description
Core Components Core Components
VIX Application Programming Interface

I Enhanced Keyboard Utiity I This feature requires 3200 MB

on your hard drive,
|| visual Studio PlugIn L

Install to:

C:'Program Files (x36)\WMware\WMware Player,

28.8.7 INCOMPATIBLE SECURITY SOFTWARE

Live Boot can conflict with specific security programs. Known programs are:
e Bitdefender Total Security 2015 (BSOD relating to trufos.sys);

Live Boot has been tested and is compatible with the following security products:

e ESET NOD;
e  McAfee;
e Norton.

28.8.8 CONTACT TECHNICAL SUPPORT

Contact technical support (see Appendix 1 - Technical Support) with the supporting information from the above
checks.
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28.9 CREATING A DEPLOYABLE LIVE BOOT

A standalone Live Boot session can be created and provided to a third party to boot and review a suspect’s
computer without Forensic Explorer. Two different methods are detailed below. In these instructions, the
following terminology is used:

e Forensic Workstation (the computer used by the forensic examiner);

e Examination Computer (the computer used by the investigator running the Live Boot and reviewing the
evidence);

e  Suspects Computer (the computer displayed in the Live Boot session).

In the example below, Virtual Box is used to create a deployable Live Boot of the NIST Hacking Case
(http://www.cfreds.nist.gov/Hacking Case.html).

28.9.1 METHOD 1 (AUTOMATED USING A SCRIPT)

Method 1 requires Mount Image Pro to be installed on the Examination Computer.

ON THE FORENSIC WORKSTATION
On the Forensic Workstation:

1. Follow the instructions in Chapter 28 to Live Boot the forensic image. Ensure to bypass Windows login
information and make any other changes needed to the running virtual machine.

2. Once booted, power off the virtual machine and close Virtual Box.

3. Open the Mount Image Pro GUI, click on the Unmount button and Unmount All images:

Figure 462: Mount Image Pro - Unmount All

M Mount Image Pro v6.42 (1839) - Activated - O X

File Options Help

&M{)unt.. - 8_ Unmount - @'Vw 'E()pﬁons @gp-date () Help

Filename Explore... Mounted As Partiton  Mount Point Property  Value
= B 180JT01 O Dizk [PHP) W APHYSICALLD
Unmount .
1 [&ctive)  E:
E Laocal Di Unmount All 2 F
< >

Disk x64 v6.5.0(56), Service Started FileSystem x64 v6.5.0(36), Service Started

The Mount Image Pro GUI should now be empty of image files.
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4. In the File System module, from the Live Boot button drop-down menu run the Virtual Box — Create Live
Boot Deploy Folder script (this runs Scripts\Live_Boot\Deploy_VirtualBox_Live_Boot.pas):

4]
[} m'! <
Cisco Clam Windows 7 Forensics
Anti Virus Programs Programs

B Virtual Live Boot
n¢  VirtualBox - Create Virtual Live Boot Deploy Folder

5. The following input form will open:

Figure 463: Deployable Live Boot Folder for VirtualBox - Selecting the Live Boot Session folder.

B Deployable Live Boot Folder for VirtualBox - O *

About  Options

Select the Case Live Boot Session Folder:

C:\Users\Vera\Documents\Forensic Explorer v5\Cases\New Case 55\Virtual Live Boot},

|| SelectLive Boot Session Folder:

DTSearchindexes ~
Exported
Logs
Reports
v Virtual Live Boot
v 1801JT01 Dell Laptop
v 1801701 Dell Lapt
Logs
Reporting Exercise
Test case 1

DataBases

< >

Make Mew Folder oK Cancel

Run Cancel

.......

6. Select the Case Live Boot Session folder by clicking on the [

folder search button, navigating to the
\Documents\Forensic Explorer vX\Cases[CaseName]\Live Boot\ folder and select the required Live Boot
Session (the folder name identifies the date and time that the Live Boot session was created in Forensic
Explorer).

7. The export path is automatically filled with the path to the case export folder. This can be modified, and
the folder written directly to another location.

8. Boot Image path is automatically filled with the current path to the booting forensic image.

Additional Disks paths are automatically filled with the current path to the image files for any additional
disks that were added when the Live Boot was created in Forensic Explorer.

IMPORTANT: When the Live Boot Session folder is deployed to an Examination Computer the folder must
have access to the required forensic images in these paths.
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Network Forensic Image store: If you access forensic images from a central server (i.e., the same path from
both the Forensic Workstation and the Examination computer) then this path can be used in the above
fields.

Stand Alone Examination computer: If the examination computer is stand alone, then it is necessary to
copy the required images to a folder on the computer that matches the paths used above.

9. Click the Run button and the configured Live Boot Session folder is exported to the specified location. The
exported folder has the name: Live Boot Deploy — [Forensic Image Name] [YY-MM-DD HHMMSS] and
includes the following files:

Figure 464: Configured Live Boot Session folder

» Live Boot Deploy - MIST - 4Dell Latitude CPi 16-10-05 160224 »

Mame Date modifie

MIPDisks 16-10-05 160224 053-0ct-16 40

MIST - 40ell Latitude CPi-liveboot 05-0ct-18 &0
[%] Live Boot Session Launch.bat 053-0ct-16 4:3
| | MIST - 4Dell Latitude CPi.gdcache 053-Oct-16 40
'@. MIST - 4Dell Latitude CPi-liveboot.wmdk 05-0ct-18 40
[ READ ME.bt 05-Oct-16 4:3

READ ME.txt contains information about the Live Boot session, including the path to the required forensic
image files.

Live Boot Session Launch.bat is the Windows batch file that is used to launch the Live Boot session.
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ON THE EXAMINATION COMPUTER

1. Copy the Live Boot Session folder created above to the Examination Computer. Ensure that the path to the
required image files detailed in READ ME.txt are valid (if not, re-create a new Live Boot Session folder using
valid image paths).

2. Launch by running the Live Boot Session Launch.bat file. A CMD window will open to configure and launch
VirtualBox:

Figure 465: Launching a VirtualBox Live Boot deploy.

t Folder for VirtualBo:
PM

VirtualBox will then launch the session:

Figure 466: Deployed VirtualBox Live Boot Session Launch

EX MIST - 4Dell Latitude CPi-liveboot [Running] - Oracle VM VirtualBox - m] X

File  Machine View Input Devices Help

2113 AM
@ = & {3 (9 (2] rightcarl
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28.9.2 METHOD 1 (MANUAL METHOD)

Method 1 (Manual) describes how to manually perform the process that is undertaken by the script in the
description above.

METHOD 1 (MANUAL): ON THE FORENSIC WORKSTATION
On the Forensic Workstation:

1. Follow the instructions in Chapter 28 to Live Boot the forensic image. Ensure to bypass Windows login
information and make any other changes needed to the running virtual machine.

2. Once booted, power off the virtual machine and close Virtual Box.

3. Open the Mount Image Pro GUI, click on the Unmount button and Unmount All images:

Figure 467: Mount Image Pro - Unmount All

|] Mount Image Pro v8.42 (1859) - Activated - O
File Options Help
[;. Mount... - B. Unmount - @\ View... m Options @ Update () Help
Filename Explore... Mounted As Partiion  Mount Paint Property  Value
= B8 1301JT01 D Dizk [PMP) W APHYSICALLD
o Unmount i
Systerm | 1 [Active] E:
B Local Di Ut AL 2 F.
< >
Disk x64 v6.5.0(56), Service Started FileSystem x84 v6.5.0(36), Service Started

The Mount Image Pro GUI should now be empty of image files.

4. Using Windows Explorer open the Live Boot working folder (there is a shortcut to this folder from the
Forensic Explorer Folder icon at the very top of the GUI). The working files for the Live Boot session will be
contained in a folder that is named after the booted image with a date time stamp, as shown in Figure 468
below:

Figure 468: Live Boot working folder.

Documents » Forensic Explorer » Cases » MNIST Hacking Case » Live Boot »

Mame

MIST - 40ell Latitude CPi 16-09-13 145638

Copy this folder to the Examination Computer (see Step 1 below).
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METHOD 1 (MANUAL): ON THE EXAMINATION COMPUTER

On the Examination computer:

1. Copy the Forensic Explorer Live Boot working folder (described above) from the Forensic Workstation to
the Examination Computer. Error messages relating to missing ‘DiskX’ files can be skipped, as shown in

Figure 469 below:

Figure 469: Error message copying Live Boot sessions.

" Itern Mot Found

Could not find this itern

and try again.

Partition1

Do this for all current items

Try Again

Fewer details

Date created: 13-5ep-16 2:56 PM

Skip

This is ne longer located in ChUsers\Ownern\Documentst Forensic
ExplorertCases\NIST Hacking Case\Live Boot\MIST - 4Dell Latitude CPi
16-09-18 143638\MIPDisks 16-09-18 145638\Diskd. Verify the item's location

Cancel

2. Copy the forensic image files to a folder on the Examination Computer (unless they are stored on a central
server that is accessible to both the Forensic Workstation and the Examination Computer). In this example,
the image files have been copied to a folder on the Examination Computer within the Live Boot working

folder, as shown below:

Figure 470: Examination Computer with Live Boot working folder and forensic image files

L]

%3 Dropbo Name

@ Onelriv

3 This PC

.ﬂ = | MIST
“ Home Share
= w y MIST »

View

MIST - 4Dell Latitude CPi 16-09-17 113938
MIST Forensic Image Files

1

3.  Run Mount Image Pro (as local administrator). It can be run either from the desktop icon, or the Windows
System tray. Important: If this is the first time Mount Image Pro has been run on the Examination Computer

Copyright GetData Forensics Pty Ltd 2010 - 2024, All rights reserved.



460 | Page Chapter 28 — Live Boot

a Reboot is required to install the mount drivers. Check that the drives are correctly installed as shown in
Figure 471.

4. In the Mount Image Pro GUI, click the Mount button and in the Device Selection window click the Add

Image button to add the required image file, as shown below in Figure 472. Once added, highlight the image
file, and click the Mount button:

Figure 472: mounting an image using the MIP GUI

M Mount Image Pro v6.42 (1839) - Activated - O
File Options Help
a- Mount... G [ Device Selection — O >
Filename Select the image file, or other device to Mount:
Device Label

= _.t/ Image Files

I h NIST - 4Dell Latitude CPi.E01 D:\2. Testimages\WMIST - Hacking C... lfl Add Image
]& My Computer E: Add RAID

@ Remote

@ Remove

ﬂ Refresh

[l Mount... Cancel

) ol

Disk x64 wb.5.0(58), Service Started FileSystem x64 v6.5.0(56), Service Started
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5. The image must be mounted with the following options:

Figure 473: Mount Image Pro settings when mounting for a deployable Live Boot

|] Mount: THGAMIST - 4Dell Latitude CPiLEDT >

Mount A
(@) Dizk
() File System

kaunt Paints:

Location or -

Dirive Letter(z): | Mone [Physical Only] v
Digk Options:

Plug-and-Play: [ ]

Access Mode: |'wiite to Cache -

512

T R el la I S TS T - 4D ell Latitude CF) 16-09-17 1133938

File System Options:
k1P Filezpztem Disk

] Cancel

Use the following Settings:

Mount As: Disk

Mount Points: | None (Physical Only)

Plug and Play: | Off

Access Mode: Write to Cache

Cache Folder: This is the path to the Live Boot working folder on
the Examination Computer (the cache file with the
extension .gdcache is in this folder).
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Figure 474: Mounted Physical Device showing Physical Drive Mount Point number.

Click OK to mount the image. Note the Physical Drive Mount Point number, as shown in Figure 474 below:

|] Mount Image Pro v6.42 (1839) - Activated

File Options Help

@Mﬂunt.. - B_ Unmount - @\\ﬁew “J| Options @gpdate a Help

=B MIST - 4Dell Latitude CRiED 454GE  Disk

Filename Capadty  Mounted As Partition | Mount Point
WAPHYSICALDRIVEZ

B Local Disk 453G 1 [Active]

<

Disk %64 w6.5.0(56), Service Started FileSystem x84 v6.5.0(36), Service Started

Property  Value

In the Live Boot folder open the .vmdk file in an editor (notepad++ is shown below).

IMPORTANT: vmdk files may be hidden files. Check your Windows file display settings to set hidden files

to be visible.

The PHYSICALDRIVE number in the Mount Image Pro GUI must match the physical drive number in the

.vmdk file. If it does not match, edit, and save the .vmdk file:

Figure 475: Match the PHYSICALDRIVE number in the .vmdk with MIP

[M Mount Image Pro v6.42 (1859) - Activated

Forensic Explorerv5 » Cases > New Case36 » ] File Options Help

Name ~ @Mﬁunl. = El Unmount ~ @\\nm.. [T options @deale @) bel

yiikdow

File Edit Search View Encoding Language Settings Tools Macro Run Plugins

NIST - 4Dell Latitude CPi-liveboot Filename Capadty MountedAs  Partiton  MountFPoint Propeny
) NIST - 4Del Lattude CPigdcache = B NIST - 4DelLatiude CFIEDT  454GE Disk ALAPHYSICALDRIVES
- B Local Disk 453GB 1 (totivel
N# NIST - 4Dell Latitude CPi-livebootvmdk '
*
.9
*
’
*
< * >
Disk xB4 v6.5.0(56), Service Started _ FileSystern x64 v6.5.0(56), Segyice Started
& *
*

= B | || 2 x| BE|S
IS ReaRlip_BaieslD 74775 SAMlog £ [ NIST - 4Dell Latitude CPiiveboot. vmdkﬂ‘ 2
1 # Disk DescriptorFile P\
2 wersion=l *
CID=35a3ee3l o
4 parentCID=fffffFff .‘
5 createType="fullDevice" *

# Extent description
RW 9514260 FLAT "\\.\PHYSICALDRIVES" 0

10 # Tne disk Data Base
11 #DDB

ddb.virtualHWVersion = "¢"
ddb.adapterType="ide"

ddb.geometzy. cylinders="9438"
ddb.geometry.heads="16"

ddb.geometTy. Sectors="63"

ddb.wuid. image="3d63f=32-b74=-4c28-b0a0-ccB0==06=c45"
ddb . wuid.parent="00000000-0000-0000-0000-000000000000"
ddb.uuid.modification="9055¢b3d-8937-4c87-babb-71636585338D"

1 ddb.uuid.parentmodification="00000000-0000-0000-0000-000000000000"
22  ddb.geometry.biosCylinders="592"

23  ddb.geometry.biosHeads="255"

24 ddb.geometry.bios5ectors="es"
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9.

In the Live Boot folder navigate into the folder ending with ‘~liveboot’ to locate the .vbox file:

Figure 476: Virtual Box .vbox file

|ﬂ- = | MIST - 4Dell Latitude CPi-liveboot

Home Share View

“— v AP « Cases » Mew Case 36 » Virtual Live Boot » MNIST - 4Dell Latitude CPi 19-10-01 121642 »  NIST - 4Dell Latitudé
I This PC ~ Mame Date modified Type
. 30 Objects Logs 01-Oct-2019 12:17...  File folder
I Deskiop \'i MIST - 4Dell Latitude CPi-liveboot.vbox 01-0ct-2019 12:16...  VirtualBox Machin...
|j MIST - 4Dell Latitude CPi-liveboot.vbox-prev 01-Oct-2019 12:16...  VBOX-PREV File

|if'| Documents
; Downloads
J‘! Music

Open the .vbox file in a text editor (notepad++ is shown in the screenshot below). Ensure that the HardDisk
location tag points to the correct .vmdk file in the copied Live Boot folder:

Figure 477: Edit the HardDisk location path in the .vbox file.

File Edit Search View Encoding Language Settings Macro Run  Plugins Window 7 X
cEEHE GQLEM |§) |ﬂbﬁ|%%|l—'!.t_!.|‘=‘d-z:ELj'—l"
[ NIST - 4Dell Latitude CPiHiveboot vbax 3 l
- 4Dell Latitunde CPi-liveboot" OS5Tyvpe="WindowsHP" snapshotFolder= ~
"Snapshots" last3tateChange="2016-09-17T0%:10:18Z">
10 = <Description>Created By: &lt;bigt;Forensic Explorer v3.6.8.5753
&lt; /bagt;
11 &¥#xD;Created Date: &lt;bagt;17-Sep-2016 06:14 PMalc; /bagt;
12 &£¥xD;Device: &lt;bigt;NIST - 4Dell Latitude CPi-liveboot&lt;/bagt:
13 L¥xD;Folder: &lt:bigt;C:\Uszers\Owner\Documentsz\Forensic
Explorer\Cases\Nist Hacking Case\Live Boot\NIST - 4Dell Latitude CPi
F16-09-17 181425%\&lt; /bagt;</Description>
14 = <MediaRegistry>
1L E—% <HardDisks>
16 <HardDisk uuid="{f71957d7-f22b-4228-810d4-391cc628£718}"
location="C: /Users/Owner /Desktop/NIST - 4Dell Latitmde CPi
16-09-17 181425/NIST - 4Dell Latitmde CPi-liveboot.wvmdk"
format="VMDK" type="Normal" />
17 - </HardDisks>
18 <DVDImages/ >
19 <FloppvImages/>
20 + </MediaRegistry>
21 H <ExtraData>
22 <ExtraDataltem name="GUI/LastCloseAction" wvalue="PowerOff"/>
i) <ExtralDataltem name="GUI/LastNormalWindowPosition" wvalue=
"640,259,640,522" />
24 - </ExtraData> o
length: 7397 lines: Ln:1 Col:22 Sel: 0|0 UMIX UTF-8 INS

Double click the .vbox file to launch the virtual machine.
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28.9.3 METHOD 2

Method 2 does not require a Mount Image Pro. It does however require the re-acquisition of the mounted
physical drive from the forensic workstation so for this reason is a longer process.

On the Forensic Workstation:

1. Follow the instructions in Chapter 28 to Live Boot the forensic image. Ensure to bypass Windows login
information and make any other changes needed to the running virtual machine. Once booted, power off
the virtual machine and close Virtual Box. Leave Mount Image Pro running.

2. Inthe Mount Image Pro GUI, take note of the physical drive number that was used during the Live Boot.

3. Useyour forensic imaging tool (e.g., Forensic Imager, or FTK Imager) to forensically image the physical drive
identified in the previous step. Create the image as a single DD file (do not segment). Once the DD image
is created, unmount all drives and close Mount Image Pro.

On the Examination Computer:

1. Copy the Forensic Explorer Live Boot working folder from the Forensic Workstation to the Examination
Computer.

2. Move the DD image of the physical drive in a location accessible by the Examination Computer.

3. Locate the .vmdk file in the Live Boot folder. Edit the file in notepad and ensure that the PHYSICALDRIVE
points to the location of the newly created DD image. For example, in a test case the line was changed
from: “RW 9514260 FLAT "\\.\PHYSICALDRIVE4" to “RW 9514260 FLAT "F:\NIST - Hacking
Case\NIST_Live_Boot.001". Save the .vmdk file.

4. In the Live Boot folder navigate into the folder ending with ‘~liveboot’ to locate the .vbox file. Open the
.vbox file in a text editor. Ensure that the HardDisk location tag points to the .vmdk file in the Live Boot
folder.

5. Double click on the .vbox file to launch the virtual machine. The image will now boot without the need for
Forensic Explorer or Mount Image Pro.
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29.1 FORENSIC IMAGE CONVERTER

Forensic Image Converter is a standalone command line tool that is licensed with Forensic Explorer.

As the name suggests, this tool is used to convert forensic image files from one format to another. Forensic
Image Converter currently supports conversion of:

e ADltolOl1
(Additional conversion formats will be added).

Forensic Image Converter has the following key features:
e  MDS5 validation of source and destination MD5 hash during the conversion process;
e Set compression level and segment size;

e  Batch process multiple input files using wildcards.

Doesn’t Forensic Explorer already convert AD1 to L01?

Yes. It is possible to export data that has been added into Forensic Explorer by selecting the required files from
the File System module and using the right-click menu option to export to LO1 (For more information see Chapter
9.7.2).

Why would | use Forensic Image Converter?

Forensic Image Converter is most used by agencies that have a need to convert many AD1 files into
corresponding LO1 files. Forensic Image Converter’s batch processing capability means that this process can be
setup and run from a Windows Command Line with a minimum of user configuration.

29.2 DOWNLOAD AND INSTALL FORENSIC IMAGE CONVERTER

Contact support@getdata.com for a download link for Forensic Image Converter.

To install Forensic Image Converter:
1. Run the downloaded setup application (i.e., ForensicimageConverter(vX.X.X.XX).exe;

2. Follow the onscreen instructions, as shown below:
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Figure 478: Forensic Image Converter Setup

ﬁl Setup - Forensic Image Converter — X

Select Destination Location
Where should Forensic Image Converter be installed?

Setup will install Forensic Image Converter into the following folder.

To continue, dick Next. If you would like to select a different folder, dick Browse.

|C:'|,Prograrn Files\GetData \Forensic Image Converter v1| Browse...

At least 11,3 MB of free disk space is required.

Important: Forensic Image Converter is a Command Line Application. At the completion of install the setup
will NOT create a desktop icon.

Forensic Image Converter will be installed into the default installation path:
C:\Program Files\GetData\Forensic Image Converter vX

And will install the default files shown in Figure 479 below:

Figure 479: Forensic Image Converter default installation path installed files.

| Iﬂ < | Fore e Converte
Home Share View
« v s ThisPC » Local Disk (Ct) » Program Files » GetData * Forensic Image Converter vl
Documents (o) Name Date modified Type 5if
Pictures [&] 7zdl 14-Mar-201812:39...  Application extens...
[ Thiz PC %] AffLib.dll 14-Mar-2018 12:39 Application extens...
| apli 4-Mar-2018 12:39...  Applicati
B 3D Objects %] aplib32.dil 14-Mar-2018 12 Application exten
%] bzip2.dll 14-Mar-2018 12:39... Application extens...
I Desktop \ P
67 ConvertTol01.exe 03-Apr-2018 221...  Application
| Documents ] libcaes.dll 14-Mar-201812:39...  Application extens...
¥ Downloads [ LicenseManager.DE 03-Apr-2018 12: DE File
J& Music | | LicenseManager.ES 03-Apr-2018 12: E5 File
| Pictures G LicenseManager.exe 03-Apr-2018 12: Application
m Videos | | LicenseManager.ID 03-Apr-2018 12: 1D File
i 03-Apr-2018 12: LFi
% Local Disk (C) | | LicenseManager.TR 03-Apr-20181 TR File
| | LicenseManager.ZH 03-Apr-201812:29... ZHFile
- OetData (Dv) - L o
%] MuixFileSafe.dll 03-Apr-2018 12:24...  Application extens...
= Images (\\192.168 [ unins00D.dat 01-0ct-201912:51..  DAT File
= FileShare (W1927¢ © 451 uninsD0D.exe 01-Oct-2019 12:47...  Application

The command line executable is:

ConvertTolLOl.exe
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29.3 ADD FORENSIC IMAGE CONVERTER TO THE WINDOWS PATH

Frequent users of Forensic Image Converter may choose to add the program into the Windows Path
Environment Variable so that the executable can be run from any command line folder without the need for

typing the installation path.
To add Forensic Image to the Windows Path Environment Variable:
1. Open the System Properties window by:
a. Typing: sysdm.cpl; or

b. Open the Control Panel, search for system and select the Edit the system environment

variables option shown in Figure 480 below:

Figure 480: Windows 10 Control Panel

system - Control Panel - O ot

- =2 « 4 » Control Panel v O | system ®

T n
System

== WP Edit the system environment variables <4

Show which operating systemn your computer is running
0 View advanced system settings

View system rescurce usage in Task Manager

& Allow remote access to your computer

Check processor speed

®) Create a restore point
P - . hd

In the System Properties window select the Advanced tab then the Environment Variables button, as shown in

Figure 481 below:

Figure 481: System Properties (Windows 10 shown)

System Properties *

Computer Name  Hardware ystern Protection Remote

You must be logged on as an Administrator to make most of these changes.

Performance
Visual effects, processor scheduling, memory usage, and virtual memory

User Profiles
Desltop settings related to your sign-n

Settings...
Startup and Recovery
System startup, system failure, and debugging information
Settings...
Environment Variables. ..
QK Cancel Apphy
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In the Environment Variables window, in the System Variables box,

shown in Figure 482 below:

Figure 482: Edit the Windows Path System Variable (Windows 10 shown)

select Path, then press the Edit button, as

Environment Variables

User variables for Vera

Variable

Onelrive
OneDriveConsumer
Path

TEMP

TMP

Value

C\Users\Vera\OneDrive

Ci\Users\Verz\OneDrive
Ci\Users\Vers\AppData\Local\Microsoft\WindowsApps;
ChUsers\Vera\AppDataiLocal\Temp
C\Users\Verz\AppData'\Local\Temp

NUMBER_OF_PROCESS0RS

New... Edit... Delete
System variables
Variable Value G
ComSpec CAWINDOWS\systemn32\cmd.exe
DriverData CAWindows\System32\Drivers\DriverData

12

Windows_NT
CAWINDOWS\system32;
PATHEXT .COM; EXE;.BAT;.CMD; VBS;. VBE; J5;.JSE; W5F, WSH; . M5C
PROCESSOR ARCHITECTURE AMDG4

AWINDOWS; CAWINDOWS\System32\Whb...

New... Edit... Delete

In the Edit environment, variable window, click the new button and add the Forensic Image Converter Path:

C:\Program Files\GetData\Forensic Image Converter vX as shown in Figure 483 below.

Figure 483: Adding the Forensic Image Converter path to the Environment variables

Edit envirocnment variable *
FeSysternRoot I\ systern32 Mew
FSystemRoot?

FeSystemRoote\ System 32\ Whem Edit
HSYSTEMROCOT %\ System32\WindowsPowerShellw1.0
FSYSTEMROQT %\ Systemn32\OpenS5HY Browse..,
C\Program Files\ GetData\Forensic Image Converter vl
Delete
Move Up
Move Down
Edit text...
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Once the variable has been added, close any existing command windows. Open a new command window to a
folder other than in the installation folder and type the command line filename ConvertTolLOl.exe. The
conversion tool will then launch, as shown in Figure 484 below which has been executed from the folder “C:\":

Figure 484: Running ConvertTolLO01 after changing the Windows Path variable.

BN Command Prompt — O ey

ConvertTolLel

Convert to LB1 wl.¢
Mo input filename
No input filename(

29.4 LAUNCHING THE WINDOWS COMMAND LINE

Important: To avoid Windows permissions errors, it is recommended to run Forensic Image Converter from a
Command Prompt launched with Administrator permissions.

To launch a Windows Command prompt with Administrator permissions:
1. Type CMD in the Windows search assistant bar;

2. Inthe display list, right-click on Command Prompt Desktop app and select Run as administrator, as
shown Figure 485 below:

Figure 485: Running a Windows Command Prompt with Administrator user rights

=& O 0O K& n L
Best match

o  Command Pra
Desktop app Run as administrator
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29.5 CONVERTTOLO1.EXE - USAGE

To convert an AD1 forensic image to a LO1 forensic image open a Command Line window and run the

ConvertTolL01 program located in the default installation folder.

29.5.1 CONVERTTOLO1.EXE - HELP

Launch a Windows Command Line window (as described in xx above) and navigate to the Forensic Image
Converter installation folder:

C:\Program Files\GetData\Forensic Image Converter vX
There are two help switches:
e ConvertTol01 /?; and,
e ConvertTolL01 /Help.

The output of these switches is shown below:

Figure 486: ConvertToL01 /? - Switch

BN Administrator: Command Prompt — O x

Converter vi1xConvertTolel /:

t filename
input fil
The output filenames will g

]- Min is 1,
None and 2 =

stnew.le1"”

Converter

The /? Switch gives general usage information and examples.

Copyright GetData Forensics Pty Ltd 2010 - 2024, All rights reserved.



472 | Page Error! Reference source not found.

Figure 487: ConvertTolL01 /help - Switch

BN Administrator: Command Prompt — O b

Converter wvl»ConvertTolL@l /Help

[options]

sion Level (@=ncne, 1l=normal (default), 2=best)
e ouptut

\GetData\Forensic Image Converter

The /help switch gives specific information relating to program command line switches.

29.5.2 EXAMPLE CONVERSION

In the examples below the file TEST.AD1 is in the C:\ folder. Forensic Image Converter has been added to the
Windows Path Environment Variable to enable its execution directly from the C:\ folder.

DEFAULT CONVERSION
The command:
e ConvertTolL01 TEST.AD1

Is used to create a LO1 file of the same name in the same folder:

BN Administrator Command Prompt = O >

onvertTolel TEST.A
Lel vi.e -
Input filename: TEST.A
tput filename:

Mumber of HASH Matche
Mumber of HASH Mismat
Mumber of Mo HASH files
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SPECIFYING INPUT AND OUTPUT FILE PATHS
The command:
e ConvertTolL01 “C:\TEST.AD1” “C:\This is a test.L01”

Specifies the input and output paths of the files:

BN Administrator Command Prompt = O X

»ConvertTolel "C:\

Convert to L&1 v’
Input filename:
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éBATCH CONVERSION USING DEFAULT OPTIONS
The command:
e ConvertTolL01 /*.AD1

Is used to convert all AD1 files in the current folder to LO1 files of the same name to the same output folder:

BN Administrator Command Prompt — O X
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29.6 VALIDATION OF CONVERSION

An MD5 hash validation is conducted during the conversion process. The sequence is as follows:

1. Forensic Image Converter reads the data in the source file and calculates the hash of each file during
the read process;

2. Forensic Image Converter compares the calculated hash against the hash that is stored within the
source file;

3. Forensic Image Converter writes each file to the output file and stores within the file the calculated
hash.

Any difference between the hash stored in the source file and the calculated hash stored in the output file is
reported as a Mismatch.

The Number of No HASH files are those files in the source file that did NOT have a hash value stored (e.g.,
Folders).

INDEPENDENT VALIDATION

To validate the conversion both source and output files should be added to a forensic tool. Individual file hashes
between source and output file should match.
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30.1 ITUNES BACKUPS

iOS backups can be a source of high value information for the forensic investigator, particularly if the original
iOS device cannot be located. iOS backups can contain call logs, SMS/MMS/Message history, application data,
photos, email, device settings and other such data. This paper describes the processing of iOS device backups
with Forensic Explorer software (https://getdataforensics.com).

30.1.1 ICLOUD BACKUP

Apple’s iTunes software is used to backup an iOS device. In early versions of the iPhone (v 2, 3, 4), iOS backups
were made to a computer only. At about the time of the release of the iPhone 5 in 2012, Apple introduced the
additional option to backup to Apple iCloud online storage. Combined with other additional iCloud features,
such as the ability to share data between different devices and to track, lock, or wipe a device remotely, iCloud
accounts have become popular and in 2015 there are a projected 500 million iCloud accounts.

Figure 488: projected iTunes and iCloud usage (Source: http://www.asymco.com/2014/11/15/how-big-is-iCloud (17))

iTunes Accounts and iCloud Accounts iTunes accounts
800 m 0

700m
600 m
500 m o
iCloud accounts
400 m o

300 m

200 m o

B EE e A ARG EE B A AL m N E e E RN R LN NEEE AN AR B RNEEE AR ER D

iCloud backups occur when the backup option is selected in iTunes and the device is locked and connected to
Wi-Fi and a power source. A default iCloud account has a size limit of 5 GB (as of July 2015,), although additional
storage space can be purchased from Apple. iCloud accounts are password protected and the online storage is
encrypted. Once an iCloud account is lawfully accessed the backup files can be processed using the techniques
described below for computer-based backups.

30.1.2 ITUNES BACKUP

Apple’s iTunes software is used to backup an iOS device to a computer. The backup can be performed via Wi-Fi
or using a USB connection. The iTunes ‘sync’ option enables the end user to automate this process each time
the device connects. If the sync option is disabled, then the user must manually initiate the backup process.
These options are shown in the iTunes screenshot in Figure 489 below:
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Figure 489: iTunes backup options

Backups
Automatically Back Up Manually Back Up and Restore
iCloud Manually back up your iPhone to this computer or restore a
Back up the most important data on your iPhone to backup stored on this computer.
iCloud.

(® This computer
A full backup of your iPhone will be stored on this Latest Backup:
computer. 21-Jun-15 1:40 AM to this computer

Encrypt iPhone backup

This will also back up account passwords used on this iPhone.

30.1.3 BACKING UP AN I0S DEVICE FOR THE FIRST TIME

When an iOS device is connected to a computer for the first time and synced (or backed-up) with iTunes, a folder
is created using the Unique Device Identifier (UDID), (referred to in this document as a ‘backup folder’.)

ITUNES UDID BACKUP FOLDERS

A backup folder is created using information specific to the iOS device. Backup folders are very distinctive as
they are 40 hexadecimal characters in length. When an original device is connected via iTunes the UDID can be
found in the phone summary window by clicking on the serial number, as shown in Figure 490 below:

Figure 490: iTunes options showing the UDID.

iPhone 5
Capacity: 12.59 GB i05 8.4
Phone Number: 0431906645 Your iPhone software is up to date. iTunes will automatically
|UDID: 48BE275DB912427EG1FIANT4CACEOF2CEA2ERD20 check for an update again on 31-Jul-15.

Check for Update Restore iPhone...

For more information on how UDIDs are created, see: https://www.theiphonewiki.com/wiki/UDID (18).

FULL, INCREMENTAL AND DIFFERENTIAL BACKUPS

When an iOS device is backed up for the first time it is a full backup. Subsequent backups are incremental where
only the data that has changed since the last backup (be it full or incremental) is backed-up.

When an iOS device is updated or restored, an automated backup is initiated as a differential backup. A
differential backup contains all files that have changed since the last full backup. A differential backup folder is
created with the same UDID appended with the date and time of the backup, for example:

e 48be275db912427e61f1a074c6ce0f2c6a2e8920-20150719-170306
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ITunes provides the option to encrypt backups (as shown in Figure 489 above). During the backup process the
user is prompted to enter a password to encrypt all files in the backup:

Figure 491: iTunes encrypted backup password request.

@ Set Password

Erter a password to protect your iPhone backup.

Fazsword: || |

Werify Password: | |

Set Passwond Cancel

Dealing with encrypted backups is further discussed in section 30.1.15 below.

The default paths for iTunes backups are:

Windows C:\Users\[username]\AppData\Roaming\Apple
7/8 Computer\MobileSync\Backup\

Windows XP | C:\Documents and Settings\username\Application
Files\MobileSync\Backup\deviceid\

MAC OS X [User HomeDirectory]\Library\Application
Support\MobileSync\Backup\
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30.1.6 LOCATING APPLE BACKUP FOLDERS WITH FORENSIC EXPLORER

ITunes backup folders can be quickly located in the Forensic Explorer File System module by using the iTunes
Backups folders filter, as shown in Figure 492 below:

Figure 492: ITunes Backups filter applied in the File System module (two backup devices shown)

Folders Categories

Filter: ||'|'unes Backups v| &9

Ex ] g MNew Case & (1) [Local Time]
= T[] A c (29) LLocal Time]
= [ W = Root (74)
= > m Users (5)
B Cr [ Owner (45)
=+ C>[®m] [ AppData (3)
£ Cr [m] Roaming {50)
= C> ] Apple Computer (7)
B MobileSyne (1)
=R Backup (7)

> [ Iy 1e856ffabe2a4fa0fcdfb 13995ef45208d78bb3 (17955)
C 43be275db% 12427e6 1f 1a074c6ce0f 2068228520 (274)
C 48be275db9 124276 1f18074c6ce0f2c6a 2289 20-20150719-170306 (342
T [7] [z b334e085febca 7 1fcfc7i6044d 258020856 12bda (5139)
C> dd015946 2cac 3df99ae4b 169F 10414eh33ba7147a (1518)

The iTunes Backups filter can be viewed (and edited) in the Scripts module. The filter identifies relevant files by
searching file paths containing \MOBILESYNC\BACKUP\.

30.1.7 INSIDE AN ITUNES BACKUP FOLDER

A typical iTunes backup folder contains many files, each with forty-character unique file names and no file
extension, as shown in Figure 493 below:

Figure 493: Example content of an iTunes backup folder

[] File List Gallery View Video View [ Disk View @ Category Graph

= A#Z* Filename A2 Ext || A-2™ File Signature A-2/¥ Extension Mismatch

3

0

Filename Extenszion  File Signature Extension Mismatch

1 48be275db312427e61f 1la074c6ce0f2c6az. .. Folder
2 D 000cae3437db21095585771716e6874f92¢. ..

3 D 00dbce3b26b339efa5789e 7 10e9fbcl6EE6T. ..

4 D 0119&25ee440a806c8 7794 56b 2f 10df585. .,

5 D 012707525234d77a28b 162924430 780ea4. ..

6 D 012707a2ae34d77a28b 16a%e443b 780ea4. ..

7 D 01722562244dfdfcb& 1470a609a52b8a2ab. ..

8 D 02080c751f0cd33738a2e8ccfFc 13301978, ..

9 D 023660cf4f4a29dd 36f30ff3dedbfc0fe2 127, ..
10 [0 02436351e7199aeb9c0b95ce48e6c5ca217. .
11 D 027cd7 149eccfd83268ado62cd4fa 79f0aaba. ..
12 D 02d2181fb 1f29f3cd 78b75bd 28c 29558 5eb0. . .
13 D 02dcc29d 169dda289f340 2fe07dabe 526d6f. .
14 D 02ddfafse 2ae 205dcdc58ba0 25773368790, ..
15 D 0354ef572fa6cf5f20370be41aa8 16bda9ch 2, ..

OooooooooOooooOnO

Copyright GetData Forensics Pty Ltd 2010 - 2024, All rights reserved.



483 | Page Chapter 30 — Working with

The forty-character file names are generated by a SHA1 hash of the file name as it would appear on the iOS
device, together with the path and domain name. For example, on the physical iOS device, the file:

HomeDomain-Library/SMS/sms.db, becomes:
3d0d7e5fb2ce288813306e4d4636395e047a3d28, as a backup folder.

Websites such as https://md5hashing.net/hashing/shal allow this process to be performed for a file.

Note: When dealing with logical iPhone acquisitions created with tools like Cellebrite, the iOS file names will
appear in plain text and will not be SHA1 encoded.

30.1.8 THE IMPORTANCE OF FILE SIGNATURE ANALYSIS

It is important to note that because an iTunes backup file has no extension a File Signature analysis is
required to identify the file type. This can affect the data displayed in Forensic Explorer, for example:

o Ifa Gallery view of an iTunes backup folder is conducted prior to a signature analysis, the gallery will be
empty. Once a signature analysis has been conducted the same gallery view will show the thumbnail
pictures contained within the backup folder;

o Aplist file will only be passed and displayed in the File Metadata view if its signature is known.

This underlines the importance of running a File Signature Analysis early in the case. Figure 494 below shows
the same list of files in Figure 493 after a File Signature Analysis has been run:

Figure 494: Example content of an iTunes backup folder after running a file Signature Analysis

[F7] File List Gallery View Video View [ Disk View @l Cateqgory Graph
%}_ = A-Z¥ Filename AZ¥ Ext || AZ™ File Signature A-Z™ Extension Mismatch
Filename Extension  File Signature Extension Mismatch
] 1 48be275db912427261f 120 74c6ce0f2c6a2. . Folder
] 2 [ 000cae3437db2109528577171626874f92C. Flist (Binary)
| 3 [ 00dbce3b2ebaisefas7aoe7 10e0th0666%. . Plist (Binary)
O 4[] 0119323ee440a306C87734c56b2f10df585. . Unknown
| 5 [0 012707a2ae34d77228b 165924430 750ea4. .. Plist (Binary)
| 6 |[Z) 012707a23e34d77a28b 16294430 780204, . Plist (Binary)
O 7 2] 0i722552244dfdfch81470a509a5208a23b. . Text
| 8 [C) 02080c751f0cd98733a2290ccf 7013301978, Plist (Binary)
O 9 | 023660cf4f4a29dd36FI0fFadedbfc0fa21e7. . IFG
] 10 [ 02436361e719%acb9c0baSce48e6c5ca217. . 5QLite
] 11 ¥ 027cd714eccida3268ad662cd4f679f0aa55. . G
e 12 [ 02d2181fb1f29f3cd78b75bd28c295535¢h0. . Plist (Binary)
e 13 [ 02dcc29d169ddagacfi402fen7dabss26def. .. XML
e 14 [ 02ddfafse2ae205dcdc58ba25773368790. . Unknown
e 15 ] 0354ef572fasf5f20370bead1aa816bdeoch2. . Plist (Binary)
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30.1.9 KEY USER FILES IN AN ITUNES BACKUP

The following table lists iTunes backup files that may be of interest to the forensic investigator:

Contents Domain iOS Path and file name SHA-1 backup file name

Calendar HomeDomain Library/Calendar/Calendar.sqglitedb 2041457d5fe04d39d0ab481178355df6781e6858
Call History WirelessDomain Library/CallHistory/call_history.db 2b2b0084albc3abac8c27afdfl4afb42c6lalca
Chat — KikChat AppDomain-com.kik.chat Documents/kik.sqlite 8e281be6657d4523710d96341b6£86ba89b56df7
Chat — Line AppDomain-jp.naver.line Documents/talk.sqglite 534a7099p474£f4fb3£f2cd006£8e59578d58fb44a
Chat — MessageMe  |AppDomain-com.littleinc.MessageMe |Library/Application Support/MessageMe/MessageMe.sqlite 8c625842c0b74fefff30d92eeced4d4alda30d2e8e
Chat — Skype AppDomain-com.skype.skype Library/Application Support/Skype/[user]/main.db

Chat —Touch AppDomain-com.enflick.ping Documents/Touch.sqlite b18a30b£f72824a7d024a95178ae42d8339£83633
Chat — Viber AppDomain-com.viber Documents/Contacts.data b39%bac0d347adfafl72527£97c3a5fa3df726a3a

Chat — WeChat AppDomain-com.tencent.xin

Documents/[chat-UDID]/DB/MM.sqlite

Chat - WhatsApp AppDomain-net.whatsapp.WhatsApp

AppDomain-net.whatsapp.WhatsApp

1b6b187alb60b%ae8b720c79e2c67£472bab09c0

Contacts HomeDomain Library/AddressBook/AddressBook.sqlitedb 31bb7ba8914766d4bad0d6dfb6113c8b614bed42
Keyboard HomeDomain Library/Keyboard/dynamic-text.dat Changes with language installed
Locations RootDomain Library/Caches/locationd/consolidated.db 4096c9ec676£2847dc283405900e284a7c815836%*

Maps History HomeDomain

Library/Maps/History.plist

P60c382887dfa562166£099£24797e55c12a9%4e4

Notes HomeDomain

Library/Notes/notes.sqglite

ca3bc056d4dal0bbf88b5fb3be254£3b7147e639¢

Safari History HomeDomain

Library/Safari/History.plist

1d6740792a2b845f4cle6220c43906d7f0afe8ab

SMS HomeDomain

Library/SMS/sms.db

3d0d7e5£fb2ce288813306e4d4636395e047a3d28

Wifi Networks SystemPreferencesDomain

SystemConfiguration/com.apple.wifi.plist

ade0340£576ee14793c607073bd7e8e409%9af07a8

Removed from iOS backup (not the device) after iPhone 4.
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30.1.10ITUNES BACKUP CONFIGURATION FILES

In every iTunes backup folder, there are four configuration metadata files:

e Info.plist

e  Manifest.plist
e  Status.plist

e  Manifest.mbdb

These files are described in more detail below.

NFO.PLIST

The info.plist file contains device details, including:

e device name

e  build version

e |IMEI

e phone number

e last backup date

e product version

e product type

e serial number

e  sync settings, and

e alist of application names that were installed on the device.

Forensic Explorer fully decodes the info.plist file in the File System module, Metadata data view, as shown in

Figure 495 below:

Figure 495: Manually examine the content of an iTunes info.plist file

I:I File List Gallery View Video View (| Disk View @ Category Graph

= — info.plist Vlaz> Ext |azw A a
3 (= pl Jlazw Ext |z ; at
Filename Extension  File Signature Extension Mismatch
=] 1! || Info.plist plist Tunes Backup Info XML Mo
<

1 of 1044 Visible [13 KB] 1 Highlighted [13 KBE]

0 Checked [0 bytes] 9 AUG 15 - Tahn iPhone 5.L01\New Case \C\Root\Users\ Own

Property Value Raw Value Type

EF Ttem Information
E Accessed 19-1ul-2015 5:24: 23 PM 19-Jul-2015 5:24:23 PM Date
@ Atributes N — e UString
Eﬂ BIAS Time -600 -600 Inte4
15 Bates # 614 614 Integer
|#4] Bookmark Folder Binary
o Bookmarked False False  Boolean
) Byte Start 39,523,305 33523905 Int64
Eﬂ Classification 1} 0 LongWord
:E Created 19-Jul-2015 5:24:23 PM 19-Jul-2015 5:24:23PM Date
Eﬂ Data Size 13,585 13585 Into4
Eﬂ Directory Level 13 13 Integer
a] Extension plist plist Ustring
(ﬂ Extension Mismatch Mo Mo UString
(ﬂ File Categary Artifacts Artifacts Ustring
(ﬂ File Signature iTunes Badkwp Info XML iTunes Backup Info XML Ustring
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| STATUS.PLIST

The status.plist file contains the details about the backup, including the date, version, backup state, etc. This
plist file is decoded using the File Metadata view as described above.

MANIFEST.PLIST

The manifest.plist file contains third party application details, as well as an additional source of serial, product
type, UDID and date information. This plist file is decoded using the File Metadata view as described above.

 MANIFEST.MBDB

The manifest.mbdb binary file contains information about all other files in the backup along with the file sizes
and file system structure data. (Note: In older iOS versions, there were two files to perform this task,
Manifest.mbdx and Manifest.mbdb). The mbdb file structure is provided in detail at:
http://www.securitylearn.net/tag/manifest-mbdb-format/ (19).

30.1.11PROCESSING ITUNES BACKUPS IN FORENSIC EXPLORER

Forensic Explorer automates processing of iTunes backups to assist the investigator to quickly identify relevant
data.

30.1.12STEP 1 - IDENTIFY AND BOOKMARK ITUNES BACKUP FOLDERS

The first step in the process is to locate and bookmark any iTunes backup folders located in the case:
To identify and bookmark ITunes Backup folders:

e Inthe File System module, under the Analysis Programs button, select iTunes Backups — Identify and
Bookmark, as shown in Figure 496 below:

Figure 496: ITunes Backups - Identify and Bookmark

ng-g)e - ﬂ T File
@ Registry Info
=] Chart File Types
] Chart Partitions
] Chart Sub-folder Sizes
=] Chart Time Line

Count Files

s
el

Encrypted Files

Entropy Analysis

Export File Types

File Name Search

Regex Keyword Search
Distance From Coordinates

GoogleEarth KML Create

Highlighted File Information (All Fields)

iTunes Backup - Identify and Bookmark

io| =il @kE 2L T EH

Skin Tone Analysis
Timeline to CSV

Video - Extract Thumbnail Key Frames
Volume ID and Partition Information
Win7 Thumbcache - Parse Windows.edb

E NN | <

.3

ZIP - Internal File Names
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Figure 497: iTunes Identify and Bookmark Options window.

B iTunes Backup - Identify and Bookmark - O *

About  Options

Identify and Bookmark iTunes Backups

Display Summary Report

Add iTunes Backup Domain and Name columns: from column 3 w

Bookmark Additional Files

Files of Interest Files by iTunes Domain

] Address Book s

[ call History Cmov

[ chat (Common Apps) Cenc
[Jkeyboard [OsaLite
[ Maps History [ select Al
[JPhoto Streams Data

[recordings

[ safari History
[sms attachments
[ wireless Networks
[ select Al

Camera Roll
] camera Roll

Cancel

The Identify and Bookmark script automates the following functions:
1. Locates iTunes backup folders in the case;

2. Bookmarks the backup folders and uses the information contained within the info.plist to create a
parent folder constructed of device name, device model and device serial number, as shown in Figure
498 below:

Figure 498: Bookmarks module, iTunes backup folders

= madwps )]

=[O S aimes iPhone - Phone3, 1 - DMNRGQELNDPON (1)

C D S 46cccs2c5chd5ec19732d39d49bare 77842192 (1
=[O S Bilbe's iPhone - iPhone3, 1 - BQN3TWIVALS (1)

C D S 32214962 129299501d77406adc 227 1dcab0f4a41 (1)
=[O S Bilbe's iPhone - iPhone3, 1 - BQN3TWIVALS (1)

C D S 32214962 129299501d77406adc 227 1dcab0f4a41 (1)
=[O S Jordan’s iPhone - iPhone1, 2 - SKO147T2Y7H (1)

C D S f9a873758dfcc59c019 1008 1aabf3bc 15c897F59 (1
=[O S Jordan’s iPhone - iPhone1, 2 - SKO147T2Y7H (1)

C D S f9a873758dfcc59c019 1008 1aabf3bc 15c897F59 (1
=[O S Jordan’s iPhone - iPhone2, 1 - 3212319KEDG (1)

> [ 7 9dc19b0fbaassocbadndech4c3f753397bF1876 (1)
- = Mary Thonas idev - iPhone4, 1 - C39GGBGGDTFC (1)

T [ 75 e3e78b22d258459c760c88d985f936575a19bc1 (1)

T 17 Triage 1 ()

S

i, L A A

b— e A A i ey

Click on the bookmarked file to display the bookmark comment containing additional information extracted
from the info.plist file:
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Figure 499: Info.plist bookmark comment for Aimee iPhone

The following iTunes Backup Info was found:

Build Version = 11D257
Device Name = Aimee iPhone
Display Name = Aimee iPhone

ICCD = 8901260261774999902
IMEI =012961004973953

Product Name = iPhone 4
Product Type = iPhone3,1
Product Version =7.1.2

Serial Number = DNRGQ6LNDPON

Target Type = Device

GUID = 5DFA1D9CD6F29408E684F94747754870

Last Backup Date = 2015-01-17T21:19:45Z

Target Identifier = 46ccc52c5¢cbd5ec19732d39d49ba7e778b4a2192

Unique Identifier = 46CCC52C5CBD5EC19732D39D49BA7E778B4A2192

3. Performs a File Signature Analysis of the content of the backup folders;

4. Options: Extract domain and backup filename to columns
Selecting this option decodes the forty character SHA1 hashed file name and makes information

available as separate columns in Forensic Explorer List views, as per Figure 500 below. Adding these

names to Forensic Explorer can greatly assist the investigator navigate through backup folders and
identify relevant files. An example is shown in Figure 500 below:

Figure 500: File list of an iTunes Backup with Backup Domain and Backup Name columns added.

[ File List Gallery View video View () Disk View ) Category Graph

grz_. = AZ¥ Filename AZ¥ Ext | A2* File Signature AZ™ Tunes Backup Domain
Filename Extension  File Signature iTunes Backup Domain

I:‘ 1 43be275db912427e61f1a074c6ce0f206a2. .. Folder

fid] 2 D 000cae3437db21095a85771716e6874f92c. .. Plist (Binary) HomeDomain

fid] 3 D 00dbce3b26b839ef95789e 710e9fbc06669. . Plist (Binary) AppDomain-com. kik.chat

i 4 D 0119a2aee440a80608 7794c56b 21 10df585. .. Unknown AppDomain-com. firsttouch. score

fid] 5 [C] 012707a23e34d77a28b 16394430 780ea4. . Flist (Binary) HomeDomain

fid] 6 [_] 012707aZae34d77a28b16a%443b780ea4. . Flist (Binary) HomeDomain

fid] 7 D 01722562244dfdfchba 1470a609a52b8a2ab. .. Text AppDomain-tv, twitch

fid] 8 D 02080c751f0cd98738a2e9ccf7c 13301978, .. Plist (Binary) HomeDomain

O 9 & 023660cf4f4a29dd 3630 3dedbfcf621e7. . PG CameraRollDomain

fid] 10 D 02436361e7199aeb9c0b95ce48e6c5ca217. . SQLite AppDomain-com.skype.skype

O 11 | 027cd714eccfd33268ad662cd4f6 790554, . PG CameraRollDomain

fid] 12 D 02d2181fb1f29f3cd78b75bd 28029558 5eb0. .. Plist (Binary) HomeDomain

I:‘ 13 D 02dcc29d 169dda989f3402fe07d8be526d6 .. XML HomeDomain

iTunes Backup Mame

Library/SpringBoardPushStorefcom. ...
Documents /AddressBook bloomStor., ..
Documents rcd_60_2.dat
Library/Preferences/com.apple. Tele...
Library/Preferences/com.apple. Tele...
Library/Application Support/INFOnlin. ..
Library/Preferencescom.apple.ids.s...
Media/PhotoData, Thumbnails /v 2/DC. ..
Library/Application Support/Skype/t...
Media/PhotoData, Thumbnails /v 2/DC. ..
Library/Preferencescom.apple.ids.s...
Library/Preferencescom.apple.secu. ..

a. Extract Manifest MAC date/times to columns

The Manifest.mbdb file contains Created, Modified and Accessed (MAC) date/time stamps in
UNIX time format. Selecting this option makes this MAC data available in columns.
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30.1.13STEP 2 - ITUNES BACKUP ANALYZE

The second step in Forensic Explorer is to analyze the contents of the located UDID folders to identify files of
interest.

To Analyze and bookmark the content of an iTunes backup folder:

e Inthe File System module, under the Analysis Programs button, select iTunes Backup — Identify and
Bookmark, as shown in Figure 496 above. Select the Files of Interest, files by iTunes Domain and/or
Camera Roll in Bookmark Additional Files in below Figure 417:

Figure 501: ITunes Backups - files of interest, by iTunes Domain, camera roll

About Options

Identify and Bookmark iTunes Backups

Display Summary Report

Add Tunes Backup Domain and Mame columns: from column 3 w

Bookmark Additional Files

Files of Interest Files by iTunes Domain
Address Book PG
Call History Moy
Chat (Common Apps) PMNG
Keyboard SQLite
Maps History select All
Photo Streams Data
Recordings
Safari History
SMS Attachments
Wireless Networks
Select All

Camera Roll
Camera Foll

Run Cancel
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Each of the options in this window runs an individual script located in the Scripts module: Scripts\Files
System\ITunes Backup\ folder. The purpose of these scripts is to bookmark files of interest for easy access by
the investigator. A typical output from running these scripts is shown in Figure 502 below:

Figure 502: Bookmarks module showing output from Analyze iTunes Backups scripts.

TSty s Batkaps (7
=+ C» [ =) Aimee iPhone - iPhone3, 1 - DNRGQELNDPON (1)
= [ ] ") 96cces2c5chdSec19732d39d49baTe778b4a2192 (14)
C> [ 7= Address Book (1)
C: O 7 call History (1)
C> [~ cameraRoll {2)
C: [~ bomain - PG (4)
T O 3 Domain - MoV (2)
C> [ 7 Domain - PNG (3)
C> O 7= Domain - SQLite {13)
Cr [ - keyboard (1)
+ [ ] ) Phone Chat Apps (1)
T [ ) Photo Streams Data (124)
C» [ - recordings (5)
- Cr ] ) safari History (2)
C» O sMs Attachments (22)
= [ S Bilbo's iPhone - Phane3, 1 - 6Q037WIVALS (1)
= > [ 71 82214962 1e92995b1d77406adc2e 7 1dcab0f4a4 (12)
C» [~ address Book (1)

e H e

e R e S e

wuu-\,,,_._au\.-..._,,_.m.,_.--qHLﬂuy—vhuuwvuvwquuhvuuw\a\z

z
i

The bookmark folders are described in more detail at Appendix 9 —iTunes Backup Files.

30.1.14 STEP 3 — EXAMINING ITUNES BACKUP FILE CONTENT

An investigator will usually seek to extract call logs, SMS/MMS/Message history, application data, photos, email,
device settings and other such data from individual iOS device applications. This data is often held in one of the
following file types:

e SQlite

e Binary Plist
e MBDB

e DAT

e Media files, such as JPG, PNG, TIF, MOV etc.

Historically investigators have exported iOS backup files to examine their content with third party applications,
such as:

e  http://www.sqliteexpert.com/

e  http://sqlitebrowser.org/

Files can be extracted from Forensic Explorer using the right click Extract Files menu option and exporting files
to disk. Individual files can also be written to a logical LO1 evidence file to be read by other forensic applications.
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FORENSIC EXPLORER DATA VIEWS

Individual iOS device backup files can be examined using Forensic Explorer data views. The following table
summarizes the best data views for each file type:

Figure 503: Examine iOS backup files with Forensic Explorer data views.

File Type Best Forensic Explorer Data View

SQLite or DB Display view (shows SQL tables and data rows)

Binary PList File Metadata view (decoded Plist) or Display view (XML format)
MBDB HEX or Text view

DAT HEX or Text view

JPG, PNG, TIF, Display view

MOV etc.

30.1.15 WORKING WITH ENCRYPTED BACKUPS

ITunes provides the option to encrypt backups (as shown in Figure 489 above). During the backup process the
user is prompted to enter a password to encrypt all files in the backup.

Figure 504: iTunes encrypted backup password request.

@ Set Password
N Enter a password to protect your iPhone backup.
'.k Password: ||
€
Werify Password:

et Password Cancel

This password is stored within the backup itself to enable access to the backup if the physical device is not
present. For more information on password storage see Forensic Analysis of iPhone Backups, Decrypting
Encrypted backups, reference Satish, B. (20) and (21).

30.1.16IDENTIFYING ENCRYPTED ITUNES BACKUPS

To identify an Encrypted iTunes backup:

1. Run a Signature Analysis on the iTunes backup folders. An encrypted backup will show backup files
with no valid file signature; or,

2.  Runthe ITunes Backup Analyze as described 30.1.13 above and select the Encryption Check (launching
the script Scripts\File System\iTunes Backup\iTunes Backup Encryption Check.pas). When an
encrypted backup is located it will add a warning folder to the Bookmarks module, as shown Figure
505 below:
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Figure 505: Bookmarks module, possible encrypted backup

=Rl S Jordan’s iPhone - iPhone1,2 - SKO147T2Y7H ]
= OO 79 f22873758dfcc5900 191008 1aabf3bc 15897153 (5)
> O 5 F WARNING - Backup may be Encrypted - (0) |
C O S Address Book (1)
T [ call History (1)
T [ £ keyboard (2)

3. Or, by executing a Live Boot of the suspect’s computer (see Live Boot section 30.1.18 below) and
running third party application, e.g. Tenorshare’s iPhone Backup Unlocker (22), to locate encrypted
backups.

Figure 506: Encrypted iTunes backup identified by Tenorshare iPhone Backup Unlocker

C:\Users\lohn Thamas Hamilton\AppData\FoamingApple Computer

Mame Backup Time Seral Mumber
D Jordan’s iPhone 2015-01-15 18:14:05  3212319KEDG
D Mary Thonas idev 2015-01-15 16:59:58  C39GGEBGGDTFC

D JTH Mistrust iPhone 2015-01-15 19:08:17| 328307 TH

D_.. Jordan’s iPhone 2015-01-15 17:05:41  SK0147T 27 H

1

30.1.17DECRYPTING AN ITUNES BACKUP

As the password is stored within the iTunes backup, it is susceptible to a password attack by brute-force, or
dictionary methods. There are several commercial tools available to decrypt then export files, including:

e Tenorshare’s iPhone Backup Unlocker (6), http://www.tenorshare.com/products/iphone-backup-

unlocker.html (password breaking and decryption).

e |Phone Backup Extractor Pro, http://www.iphonebackupextractor.com (23) (used to extract files once

password is known).
ITunes backup password breaking, and decryption can be:

e Rundirectly on the suspects computer during a Live Boot session (see Live Boot section 30.1.18 below);
or,

e Run on encrypted files exported from the case to the forensic workstation (recommended for faster
processing speed).

If a complex password is suspected, it can be beneficial to use Forensic Explorer to create a customized
dictionary file using keywords located on the suspect’s computer. This is done in the Index Search module by
indexing the device (or part thereof) and exporting the list using the Export Words button.

RE-IMPORTING DECRYPTED BACKUP FILES TO FORENSIC EXPLORER

To add decrypted iTunes backup files to a Forensic Explorer case:
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1. Ensure that the path to the backup files contains \MobileSync\Backup\ (required for some Forensic
Explorer scripts).

2. Preview the device on which the backup files are located.
3. Check and export the backup files to a LO1 file.

Add the LO1 file as evidence to the required case.

Forensic Explorer Live Boot enables an investigator to boot a forensic image or write-protected physical hard
drive. The investigator can then operate the suspect’s computer in a forensically sound virtual environment.

In iOS device investigations, this gives the investigator the ability to launch iTunes on the suspect’s computer
and confirm settings such as:

1. iTunes account names and passwords.

Figure 507: iTunes account information in a Live Boot session

Enter Password for "(tjohnthomas &gmail .com™

To view your Apple 1D information, enter your password and cick View Account, To

- Apple 1D Password Forgot?
|{ljuhrrthnmas@gmail.cam ||

_?l Sign Out | | Wiew Sccournt I Cancel

2. Applications, including version number information, in the iTunes library:

Figure 508: iTunes Library in a Live Boot session

—
| BR ’ =l B8

P Py — . @~ se...
.D E = A oL My Apps My iPhone Apps My iPad Apps Updates App Store Apps v

ComicBook! Epic Eric
3DTOPOInc. 232 Studios Google, Inc

S

Spotify Music Stegais WhatsApp Messe..,
Spotify Ltd. Roman Cinkais WhatsApp Inc.

Aok | File |

WhatsApp Messenger

title

developer WhatsApp Inc.

version 2.11.8

[<[>]| AddFied | cancel ||
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30.1.19 SHADOW COPY

Consideration should be given to Shadow copies (Windows Restore Points) present on the suspect’s computer.
These Shadow copies may hold historical iTunes backup folders and provide additional information not present
in the existing file system.

To identify Shadow copy files, in the File System module, click the Shadow Copy button:

14

Shadow
Copy

Existing Shadow copies will then be displayed in the Shadow Copy options window:

Figure 509: Shadow Copy options

Process Mame:
|Shadow Copy
Available Volumes: | Partition @ 206843 ~
List of Snapshots # Date (UTC) MName [
17 21-Jan-2018 9:15:17 FM Windows Update {768E75D8-FEEF-11E7-AF.
16 22-Dec-2017 10:43:01PM Microsoft Visual C++ 2015 Redistributable (..
15 20-Dec-2017 12:30:17 AM Windows Update {9B31C068-E51B-11E7-B6..
14 20-Dec-2017 12:29:25 AM Microsoft Visual C++ 2015 Redistributable (..
13 19-Dec-2017 11:43:34 PM Windows Update {8AD19C11-E515-11E7-B7.
12 03-Jan-2017 1:02:44 AM Windows Update {SE2D&732-D14F-11E6-58.
4 20-Dec-2015 3:28:52 AM Restore Operation {1031BB15-A6C3-11E5-B.
2 19-Dec-2015 8:02: 13 FM Windows Update {34F75F37-A685-11E5-34..
1 19-Dec-2015 7:14:00 PM Windows Update {97AEB7ED-AG3F-11E5-A..
11 19-Dec-2015 4:25:10 PM Windows Update {97AEB6FB-AG3F-11E5-AC.
10 14-Jun-2015 2:40:58 AM 13th of Jun and we are almost there big we., w
< >
Options
Mount method: | Cnly files that are different w
Color: | I Green ~
Logging: | Mormal ~ Priority: | Normal ~

Select and add the Shadow copy to the case (For more information about shadow copies see the Shadow Copy
section in the Forensic Explorer user manual). Apply the procedures described in this document to examine the
iTunes backup files within the mounted Shadow copy files.
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30.2 THUMBNAILS

In Windows operating systems up to and including Windows XP, a Thumbs.db file is created to store picture
thumbnails that are used for display in Windows Explorer. The Thumbs.db is in the same folder in which the
pictures represented by the thumbnails reside.

From Windows Vista, onward, Thumbs.db were largely replaced by Thumbscache (described below). However,
it is still possible to locate Thumbs.db files in more recent Microsoft operating systems which are created when
viewing remote or mapped drives in Windows Explorer.

Beginning with Windows Vista, a “Thumbcache” database is created and stored under a user’s profile in the
path:

C:\Users\{UserName}\AppData\Local\Microsoft\Windows\Explorer
The files containing the thumbnails are named per their maximum pixel size, that is:
thumbcache_32.db
thumbcache_96.db
thumbcache_256.db

thumbcache_1024.db

As Parsonage (2012) observes, “A large proportion of computer users have no knowledge of the presence of
Windows thumbnail databases so that whilst they might delete incriminating pictures the evidence of their illicit
activity often remains in the thumbnail databases”. (24)

Further suggested references:

e Larson, Troy. Windows 7 Thumbnail Cache. Slideshare. [Online] October 2010
http://www.slideshare.net/ctin/windows-7-forensics-thumbnaildtird

e Hurlbut, Dustin. Thumbs DB Files Forensic Issues. [Online] September 2014 https://ad-
pdf.s3.amazonaws.com/wp.Thumbs DB Files.en us.pdf

For this section, the term “Thumbnail-Files” is used to describe both Thumbs.db and Thumbcache_xxx.db files.

Like any other file types, Thumbnail-Files can be sorted, filtered, bookmarked, etc. in the modules of Forensic
Explorer.
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A Thumbs.db file can be previewed directly in the Forensic Explorer Display view. The content of each image can
be displayed by clicking the image name in the left of the Display view, as shown in Figure 510 below:

Figure 510: Thumbs.db Display view

[E] File List Gallery View Video View (| Disk View @3 Category Graph

%L‘ = AZ¥ Filename AzZ* Ext |18 Classificatior |18 Flags r
Filename % Extension Classification Flags I

O 1 & untitled.png png A

O 2 & untited 1.png png

=] 3 & Thumbs.db db

=] 4 [ 5L370827 (Medium).doc doc

=] 5 [2] 5L370826 (Medium).doc doc

=] 6 [ 5L370825 (Medium).doc doc v

<

>
16 of 16 Visible [69.9 MB] 1 Highlighted [35 KB] 0 Checked [0 bytes] 1801JT01 Dell Laptop.ED1\Partition @

Click filename to preview thumbnail:

5L370819 (Medium). PG
5L370820 (Medium). PG
5L370821 (Medium). PG
5L370822 (Medium). PG
5L370823 (Medium). PG
5L370825 (Medium). PG
5L370826 (Medium). PG
5L370827 (Medium). PG
5L370818.AVL

1801JT01 Dell Laptop.E0T\Partition @ 206848\Root\Users\John Thomas Hamilton\Desktop\My Stuff\Stuff to sort]
ffl Hex |= Text = Info

ookm... || Byte Plot | [FE) Display || = Filesys... | = FileM... |=|FileEx..

Running Pracesses:0 ;:

THUMBNAIL-FILES FOLDERS FILTER

A fast way to view all Thumbnail-Files in a case is to branch plate all files in the case, and then apply a folders

filter. A separate folders filter is available for Thumbs.db and Thumbcache_xxx.db. A Thumbs.db Folders filter as
shown in Figure 511 below:
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Figure 511: Folders Thumbs Thumbcache filter applied in the File System module.
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The filter code is accessible in the Scripts Module, in the path:

e  Filters\FileSystem\Thumbcache. WindowsEDB.pas

EXPANDING COMPOUND THUMBNAIL-FILES

Thumbnail-Files are Compound files because they act as containers for content.

To work with compound files, it is first necessary to identify them as such by running a Signature Analysis (a
Signature Analysis can be run at any time in the File System module by clicking the Signature Analysis toolbar
button). A correctly identified Thumbnail-File will show “Thumbnail” or “ThumbCache” in the File Signature

column when a signature analysis is complete.

EXPAND A SINGLE THUMBNAIL-FILE

To expand a single compound Thumbnail-File:

1. Run aSignature Analysis (if not already done);

2. Right click on the Thumbnail-File and select Expand Compound File from the drop-down menu (if this

menu option is not active, run a Signature Analysis).

3. Once expanded, the icon of the Thumbnail-File file will change to the compound file icon. Click on the
the

Thumbnail-File to show

files it contains, as
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Figure 512: Expanded Thumbs.db file.

olders Categories ile List | (22| Gallery View [2Z] Video View () Disk View
| Fold ;] [ File List | [32] Gall 23] vid L Disk
Filter: |;FThumbsThumbcache v| = Qi = AZ¥ Filename ’
CO = New Case 59 (1) [Local Time] Filename ;
=- D|:| oEMG 7801 (1) L ocal Time] ] 1} 1—1_'| 1 :
& DO Root @) ] 2 ® 2
B COE aw- st sequence (2 [ 3 H 3
@) DB - Thumbs.db (3) | 4 [ catalog
L DO R snake (1) ] 5 [] OLEFAT
B OLE Header
O B d
7 Root Entry
O B
8 |;| Unallocated dusters on OLE volume
] I dd I
9 |;| Unallocated dusters on Small OLE wolume
] I dd I I

EXPAND MULTIPLE THUMBNAIL-FILES

It can be advantageous to expand multiple compound Thumbnail-Files files.
To expand multiple Thumbnail-Files:
1. Inthe File System module, select Expand Files icon;
IMPORTANT: For speed purposes, before running the script, turn off any running Folders filter.
2. Select the Thumbs checkbox and run the script.
3. All Thumbnail-Files in the case will then be expanded.

4. Use the branch plate and then filter with the File Signature column to display only Thumbnail-Files in
the list view.

30.3 VIDEO KEY FRAMES (KEYFRAMES)

In animation and filmmaking, a key frame (or keyframe) is a drawing or shot that defines the starting and
ending points of a smooth transition. These are called frames because their position in time is measured in
frames on a strip of film or on a digital video editing timeline. (https://en.wikipedia.org/wiki/Key frame,
Accessed June 2023). Many software programs have the ability to extract keyframes as a method to represent
the visual content of an entire file.

In Forensic Explorer, video keyframes are extracted using:
1. The right-click Expand compound file(s) menu option.

2. Orthe Expand Files icon in the toolbar.
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Figure 513: Video keyframes, right-click Expand compound files(s).
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An expanded file will change the icon and color in the File List to represent that it is now a container with

children (the keyframes).

Figure 514: Video keyframe, expanded file.

—T =

[1 110 [Z] from Bilbo's Phone 052,MOV Moy Mo Mo Video
[1 111 =) from Bilbo's Phone 053.MOV Moy Mo Mo Video
[1 112 [Z] my new stuff 003.mov mav Mo Mo Video
[1 113 [Z] my new stuff 018.mov mav Mo Mo Video
[1 114 [Z] my new stuff 020.mov mav Mo Mo Video

A new folder is created in the Folder Tree to contain the extracted keyframes as bmp files.

Figure 515: Video keyframes.

~ = @ AZT Filename AZY Ext ||AZ™ File Signal
& Filename w Extension File Signature
=] ) from Bilbo's Phone 053.MOV (1) 1 Track 1 - Video Stream [Bates 154297] Folder
l—DD Track 1 - Video Stream [Bates 154297] (3) e = l—ﬂ from Bilbo's Phone 053.MOV Track 1 - Frame 2010000.bmp bmp Bmp
| (27) s & from Bilbo's Phone 053.MOV Track 1 - Frame 1008333.bmp bmp Emp
HC-O 87 O =4 & from Bilbe's Phone 053.MOV Track 1 - Frame 0.bmp bmp Bmp
| (18)

A similar technique is used to extract time sliced video frames, available when running Expand Files from the

icon the toolbar.

Figure 516: Video keyframes, time slice.

Video Frames

B video
i) Key Frames
0 Time sliced: Every &0 =
() Divided: 10 =

seconds
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30.4 JUMP LISTS

Jump Lists were introduced in Windows 7 to give users quick access to recently accessed application files and
actions. Jump Lists appear in both the Windows Start menu and the Windows Task Bar, as shown in Figure 517
and Figure 518 below :

Figure 517: Start Menu, MS Word Automatic Destinations Jump List (Windows 8 shown)

mﬁ Outlock 2013 y  Recent

Forensic Explorer User Guid...
@ Start Securepoint S5L VPN
E Windows 8 Menu

ﬂﬂa Motepad++ »
@ Word 2013 N

g

T T e

Figure 518: Task bar, MS Word, Automatic Destinations Jump List (Windows 8 shown)

Recent

M= Forensic Explorer User Guid...

B word 2013

= Pin this program to taskbar
El Close window

There are two types of Jump Lists:

e Automatic (autodest, or *.automaticDestinations-ms) files, created by the Windows Operating
System. These files are in the path:

C:\Users\%USERNAME%\AppData\Roaming\Microsoft\Windows\Recent\AutomaticDestinations
\[AppID].automaticDestinations-ms

e  Custom (custdest, or *.customDestinations-ms) files, created by software applications. The files are
in the path:

C:\Users\%USERNAME%\AppData\Roaming\Microsoft\Windows\Recent\CustomDestinations\[A
ppID].customDestinations-ms
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A list of Jump List AppID’s are located on the Forensics Wiki:
http://www.forensicswiki.org/wiki/List of Jump List IDs

30.4.1 FORENSIC VALUE OF JUMP LISTS

Jump Lists are becoming increasingly prevalent as software vendors increasingly use them in preference to the
Windows Registry to store MRU (Most Recently Used) or MFU (Most Frequently Used) lists.

From a forensic examiners perspective, Jump Lists can indicate recently used resources, (including files,
applications and web sites. They can be a reliable indication of a user’s recent behavior.

30.4.2 AUTOMATICDESTINATIONS JUMP LISTS IN FORENSIC EXPLORER

Automaticdestinations Jump List files are in a compressed OLE file format within which are LNK files that hold
metadata relevant to the investigator.

éAUTOMATED EXTRACTION OF AUTOMATICDESTINATIONS JUMP LIST METADATA
To automatically extract automaticdestinations Jump List metadata:
In the File System module click the Extract Metadata button and run;
e  Extract MS Jump List script; or,
e Bookmark MS Jump List LNK.

Metadata from the embedded LNK files is extracted and put into File System module columns. The
columns include:

e LNK Target Accessed (UTC)
e LNKTarget Drive Type

e LNKTarget Local Base Path
e LNK Target Volume Serial

When the Bookmark MS Jump List LNK option is used, relevant LNK metadata is bookmarked by file name, as
shown in Figure 519 below:

Figure 519: Bookmarked automaticDestinations Jump List Files

= C» [ 7 Script Qutput (1)
= Cr 7 M5 Jump List Files (5)

C: S 12dc1eafe 340536, automaticDestinations-ms (1)
C: [0 1badds7£29cb 1952 automaticDestinations-ms {35
C:[] 9 469&43Hﬂkeaﬁ4.aummaﬁﬁesﬁnaﬁnns-ms ()
C:[] S 7e4dcas0246863e 3. automaticDestinations-ms (8)
C:[] S shocdcssc1c24e2h. automaticDestinations-ms (4
C: ] S 9ffcr573e4a429¢. automaticDestinations-ms (1)

Metadata LNK columns can also be added to the Bookmarks module.
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MANUALLY VIEW AUTOMATICDESTINATIONS JUMP LIST METADATA

OLE COMPOUND FILE FORMAT

AutomaticDestinations files are in a compound OLE (Object Linking and Embedding) format. To access the
content of an automaticDestinations the OLE structure must first be decompressed. This is done in the File
System module by:

e Selecting a file, then right-click and select the Expand Compound File menu option; or

e  Run the Expand Compound Files.pas script from the File System module toolbar button or the
Expand Files menu item.

For more information about expanding compound files See 9.6.

LNK FORMAT

Once the OLE file is decompressed its internal data streams are exposed. These are very like Windows LNK files
and running a Signature Analysis on the files will identify them as such.

To examine the metadata of a file, click on the LNK file and look at the File System > Extract Metadata > Extract
All Metadata to Columns to see the embedded metadata fields. These are the fields that are extracted to
columns in the automated process.
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30.5 UTILIZING 3R° PARTY TOOLS IN FORENSIC EXPLORER

There are many well regarded stand-alone software applications that can be used in computer forensics
investigations to process specific artifacts. It is important, where possible, to use multiple tools to corroborate
analysis results. In Forensic Explorer, this can be achieved by running 3" Party Tools.

To add 3™ Party Tools to the Forensic Explorer interface:
1. Click on the Tools icon in the File System module.

2. Select Add/Remove — 3™ Paty Tools from the drop-down menu.

Figure 520: Add in the 3rd Party Tools button to the toolbar.

& &

Tools | 3rd Party
Toaols

ﬁ Add/Remaowve - Artificial Intelligence

Add/Remove - Bookmark CETS Categories
Add/Remove - Bookmark Interpol Categories
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Add/Remaowve - Log File Viewer
Add/Remaove - Quick M5Word Report
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Add/Remove - Program Shortcuts
T, Add/Remove - 3rd Party Tools

Copyright GetData Forensics Pty Ltd 2010 - 2024, All rights reserved.



504 | Page Chapter 30 — Working with

3. Select the Forensic Explorer modules where the 3™ Party Tools button will be displayed.

Figure 521: Select the modules to show the toolbar button.

B Add Button — O >

3rd Party Tools

Add/Remove button:
B artifacts
B Gookmarks
B Email
B cvidence
B File System
B ke=yword Search
H Registry
B soipts

Fun Cancel
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4.

Once the 3™ Party Tools button is added, individual programs are selected from the drop-down menu.

Figure 522: 3rd Party Tools menu.

3rd

-

Party

Tools

Beyond Compare

Elcomsoft Encrypted Disk Hunter
ExifTool

IrfanView Thumbs Gallery
iLEAPP - 105 Parser

Mirsoft ESEDatabaseView
MirSoft ExifDataView
MirSoft FullEventLogWiew

(M) MirSoft MetworkUsageView

MirSoft Turned OnTimesView

Mirsoft USBDeview

MirSoft WifiHistoryView

RegRipper

TrlD File ldentifier

Zimrmerman - AppCompatCacheParser (ShimCache)

Zimrmerman - Jurmp List Examiner (JLECmd)

Zimmerman - Link Examiner (LECrmd)

= Zimmerman - MFT Examiner (MFTECrd)
1 Zimmerman - Prefetch Parser (FECmd)

Zimrmerman - Recycle Bin artifact (INFO2/51) parser (RBCrmnd)
Zimmerman - Shell Bag Explorer (SBECrmd)

Open 3rd Party Tools Folder

30.5.2 CONFIGURING 3RP PARTY TOOLS

3 Party Tools are not distributed with Forensic Explorer. Each tool is independent of Forensic Explorer had

has its own license agreement and terms and conditions. By running 3™ Party Tools in Forensic Explorer, the

user is accepting and license of the program author.

3RD

PARTY TOOLS APPLICATION FOLDER

Individual tools must be downloaded and setup in the Forensic Explorer 3" Paty Tools installation folder, in

their respective sub folders.

C:\Program Files\GetData\Forensic Explorer v5\3rd_Party_Tools
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IMDISK (RAMDISK)

In most cases, the bridge between Forensic Explorer and the 3™ Party Tool is a RAM Disk. Forensic explorer
uses ImDisk, a free Virtual Disk Driver created by Olof Lagerkvist. A RAM Disk is a block of random-access
memory that a computer's software treats as if it were a disk drive. When a 3™ Patry Tool is run in Forensic
Explorer:

1. A Forensic Explorer script:
a. Locates relevant files in the case.
b. Creates a RAM Disk and exports the relevant files to the RAM Disk.
c. Executes the 3" Party Application and directs it to process the files on the RAM Disk.

d. Closes the RAM Disk.

30.5.3 LAUNCHING 3%P PARTY TOOLS

When a 3™ Party Tool is launched in Forensic Explorer, the following window will appear:
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Figure 523: NirsoftTurnedOnTimesView

B MirSoft TurnedOnTimesView = O >

About  ImDisk License MirSoft License

Title: MirSoft TurnedOnTimesView

Script: MIRSOFT_TURMEDOMTIMESVIEW .PAS

Author: GetData

ImbDisk: This script uses ImDisk (http: /fwww . ltr-data.se) to create a

RamDisk, Files are exported to the RamDisk and processed with a
third party tool. On completion the RamDisk is removed,

Toolk TurnedOnTimesView is a NirSoft toal (www.Nirsoft.net) to
analyze Windows event logs and determine computer turn on/foff
times, induding: Startup Time, Shutdown Time, Duration,
Shutdewn Reason, Shutdown Type, Shutdown Process, and
Shutdown Code,

Requires: Third party applications must be installed to use this script:

? | ImDisk: Installed

? || TurnedOnTimesView: Installed

B 1 have read and agree to ImDisk and MirSoft License Agreements,

Cancel

This identifies if ImDisk and the 3™ Party Tool are installed. Additional information is available by clicking on the
help button, which gives specific download information:

Figure 524: 3rd Party Tool configuration information.

Download: TurnedOnTimesView.zip at

hitps:/fwanw.nirs oft.net/utils/computer_turned_on_times.html
[URL copied to clipboard.)

UnZip to FEX installation folder:

Ch\Program Files\izetData\Forensic Explorer
vS'\3rd_Party_Tools\Mirsoft\TurnedOnTimeasViaw',

Ok
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3" Party Tool results depend on the application used. Some tools run the GUI of the application, and results

are saved using that application. Other tools pipe output to text or csv files, which are saved in the Forensic
Explorer case.
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Chapter 31 — FEX Viewer
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31.1 FEX VIEWER

FEX Viewer is a free program that allows a third party to open and review a Forensic Explorer Case (created by
Forensic Explorer, CLI, or Triage). It is intended to be used by case officers, other investigators, prosecutors, etc.
without the need to tie up a Forensic Explorer license.

FEX Viewer is a simplified version of Forensic Explorer. It is intended that a forensic investigator will have
prepared the FEX Viewer case by running relevant processing, such as signature analysis, triage, metadata
extraction, carving, keyword search, artifact extraction etc.

FEX Viewer enables the reviewing party to:
e Open and review an existing FEX case including bookmarks and search results.
e Run new keyword searches.
e Search available DTSearch indexes.
e  Create new bookmarks and reports.

e Save new results to the case.

FEX Viewer is a stand-alone program. It does not require Forensic Explorer to be installed on the same computer.
FEX Viewer is a 64-bit application. Minimum recommended system requirements are:

o |7

e 16 GBRAM

e Windows 10

A FEX Viewer case must link to the relevant forensic evidence files (i.e., E01, LO1) for the case. Sufficient storage
space and data access speed is required for this purpose.

Download FEX Viewer at https://getdataforensics.com/product/fex-viewer/

Follow the on-screen installation steps. No product activation is required.
The default program installation folder is:

C:\Program Files\GetData\Forensic Explorer Viewer v5\
The default working folder is:

C:\Users\[username]\Documents\Forensic Explorer Viewer v5\
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31.1.3 LAUNCH FEX VIEWER

FEX Viewer is launched from the desktop icon:

Figure 525: FEX Viewer Desktop icon

The FEX Viewer interface is very similar to Forensic Explorer. The primary difference is that there are no

toolbars and limited processing options (it is expected that a case will be pre-process by the forensic
investigator):

Figure 526: FEX Viewer Evidence module
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Case Path C:\FEX Viewer Cases\2020-08-31- ... Bytes Per Sector 512
Investigator Graham Henley Total Sectors 12273597
Created 31-Aug-20 5:29:10 PM Current Filename D:\DEMO 7\DEMO 7.E01
Modified 31-Aug-20 9:29:12 PM Acquisition Hash (MD5) 8cec?01511cfc88841963c8c19c 77947
Age 1day Acquisition Hash (SHAL) 1f694d438470a12726aed58 3826 759¢64e 58031
Case Notes Device Size 5.85 GB (6,254,081,664 bytes)
Evidence 1 Image: DEMO 7.ED1 Encase Examiner Graham Henley

Encase Case Number
Encase Evidence Number
Acquiring Program

<

DEMO 7
ADI3.1.3 Open Complete: Complete
Time Taken: 00:00:01 8:1%:43PM

-

Case: New Case

Running Processes:0 (g

31.1.4 PREPARING A FEX VIEWER CASE IN FORENSIC EXPLORER
The process and requirements to open a case in FEX Viewer is identical to opening a case in Forensic Explorer.
FEX Viewer requires:

1. The case folder structure, i.e.: ...\My Documents\Forensic Explorer v5\Cases\[Case Name]\

2. Access to the forensic image files or physical disk for the case.

Whilst it is possible to copy and paste a Forensic Explorer case folder, the user should be aware that it may
contain previous saves, exports, reports etc. that may not be relevant to the third party.
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CREATE FEX VIEWER CASE

The alternative is to run the Create FEX Viewer Case script found under the configuration cog in the top global
Forensic Explorer toolbar (shown in Figure 527 below). By default, this script includes the minimal data
required for the case:

Figure 527: Create FEX Viewer Case

H&~&~-e
£ Evidence File Syg {9 Backup Current Case eyword Search
i:é} Backup Settings —
Q O% k m Create FEX Viewer Case
Recover File Name File N Extract
Folders Search Carve Copy Analysis Files Metadata
Folders Categories [E] File List Gallery View
Filter: [LJ No Fiter | %= AE¥ Ficname
This opens the following window:
Figure 528: Create FEX Viewer Case script.
B ' Create FEX Viewer Case - A Test Case - O ot
About Options
Create FEX Viewer Case: A Test Case
Setup: Run a Signature Analysis (recommended)
[IMDS Hash Files
Include: Created Indexes (34.85 ME)

Case "Exported” folder (572,45 MB)
[ ]caze "Reports” folder (0 KE)

[

Destination Folder

| C:\FEX Viewer Cases

Reset Run Cancel

Setup options allow for additional processes to be run (a Signature Analysis is recommended to correctly
identify file types as it is not possible to run a Signature Analysis from within FEX Viewer).

Include allows for the selection of additional data to be copied with the case.
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When the Run button is pressed the script executes a case save prior to the export. This ensures that any
processing just done is included.

If the FEX View case is being created from a Forensic Explorer Preview (i.e., not an existing case) the user will
be prompted to create a case name.

. ROBOCOPY

The Create FEX Viewer Case script uses Windows ROBOCOPY (see: https://en.wikipedia.org/wiki/Robocopy)
to copy the case data to the desired destination folder.

The FEX Viewer case folder name is prefixed with the date and time of creation (this folder can be renamed if
needed).

A DOS Window will appear where the ROBOCOPY execution can be viewed. Ensure to wait for the ROBOCOPY
process to complete.

Figure 529: Open the destination folder of the FEX Viewer case.

Create FEX Viewer Case

o FEX Viewer case export:

CHFEX Viewer Cases\2020-09-03 - 19-53-04 - A Test Case

Wait for the ROBOCOPY export to complete,

N

Open This Folder?

Now that the case folder is created, use FEX Viewer to open the case on the third-party computer. Ensure
when prompted by FEX Viewer that the case is pointing to the required evidence files (or physical device).

Further information relating to the use of FEX Viewer is contained in that programs PDF user guide.
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32.1 ARTIFICIAL INTELLIGENCE (FEX-AI)

Artificial intelligence is the simulation of human intelligence processes by machines.

The purpose of artificial intelligence in Forensic Explorer (FEX-AI) is to categorise and/or extract data from a
file based on its content. FEX-Al currently supports:

e  Face detection.

e  Face recognition.

Vehicle license plate recognition.

Object detection.
e Weapon detection.

IMPORTANT: GetData Forensics provides advanced Al-based tools designed to assist in the analysis and
investigation of digital content, including graphics files. It is important to note that while our Al algorithms
strive to accurately predict the content of graphics files, there are inherent limitations and uncertainties
associated with such predictions.

The accuracy of Al predictions may be influenced by various factors, including but not limited to the complexity
of the graphics file, the presence of encryption or compression, and the quality of the data being analyzed.
Additionally, advancements in technology and changes in file formats may impact the performance of Al
algorithms over time.

Users should exercise caution and consider Al predictions as supplementary information rather than
conclusive evidence. It is crucial to rely on a combination of Al insights, traditional forensic methodologies, and
expert analysis to make informed decisions in the context of digital investigations.

GetData Forensics cannot guarantee the absolute accuracy of Al predictions, and users should interpret results
with awareness of the inherent uncertainties in Al-based analysis. Our tools are designed to aid professionals
in their investigative processes, and users are encouraged to exercise due diligence and critical judgment when
interpreting the results generated by our software.

By using GetData Forensics tools, users acknowledge and accept the inherent limitations of Al technology in
predicting the content of graphics files and agree to use the information provided by our tools responsibly and
in conjunction with other investigative techniques.

32.1.1 TENSORFLOW

Forensic Explorer uses TensorFlow, a free and open-source software library for machine learning and artificial
intelligence. TensorFlow was developed by the Google Brain team for internal Google use in research and
production. (https://en.wikipedia.org/wiki/TensorFlow, accessed December 2022).

In machine learning, a model is a function with learnable parameters that maps an input to an output. The
optimal parameters are obtained by training the model on data. A well-trained model will provide an accurate
mapping from the input to the desired output. (https://www.tensorflow.org/js/guide/models_and_layers,
accessed December 2022). Unless otherwise stated the models used by FEX-Al are licensed under Apache 2.0.
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32.1.2 FEX-AIL.EXE

FEX-Al.exe is Forensic Explorers’ stand-alone artificial intelligence engine.

FEX-Al.exe was introduced in version 5.5.8.3386 and above and is included with a standard installation in the
default folder path:

C:\Program Files\GetData\Forensic Explorer v5\FEX_AI

Launching FEX-Al.exe from the executable will provide version number information, as shown in Figure 530
below:

Figure 530: FEX.Al Installation Path

» Program Files » GetData » Forensic Explorervd » FEX_AI

s

Mame Date modified Type
E] FEX-Al.exe L\} 12-Dec-2022 %:05 AM Application

File description: FEX-AI

Company: GetData

File version: 1.14.79.28

Date created: 12-Dec-2022 9:08 AM
Size: 346 MB
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Figure 531: Launching FEX-AI.EXE

C:\Program Files\GetData\For X = | & _ o x

Server started on port: 3601
Not an admin user
PID: 4

1.14.79.28

Loading Common Model

Loading GP Detection Model
Loading Emotion Model

Loading Object Detection Model
Loading Text Sentiment Model
Loading Face Recognition with Age and Gender Model
Loading NSFW Model

Loading Face Comparison Model
Loading Face Landmark Model
Elasticsearch is offline
SQLite database 1s disabled
Model Load Time: 4.5 seconds

TENSORFLOW: Version 3.21.80
FFMPEG: version 2822-10-27-git-08b83331af-full
IMAGEMAGICHK: Version: 7.1.8-18 Q16 x86_6U

DE disabled

32.2 RAMDISK (IMDISK VIRTUAL DISK DRIVER FOR WINDOWS)

FEX-Al.exe uses a third-party RAM disk program ImDisk (a virtual disk driver for Windows) to export and
process files. You must agree to the ImDisk license agreements to use this software.

Website: http://www.ltr-data.se/opencode.html|/#ImDisk or

https://sourceforge.net/projects/imdisk-toolkit

Installation: http://www.ltr-data.se/files/imdiskinst.exe

If ImDisk is not installed the following message will appear:
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Figure 532: ImDisk not installed.

B | FEX Al - Face Detection - File System = O X

About Process  Advanced

Source - File System

O 2ll Ttems (197755 items)

() Checked Ttems (0 iterns)

ImDisk Installation X
|

o Download "ImDisk Virtual Disk Driver” (imdiskinst, exe]
http:/fwww ltr-data.sefopencode. html/#FImDisk
hittp:/fwwew ltr-data.sefiles/imdiskinst. exe

[URL copied to clipboard.)
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32.3 ADDING TOOLBAR BUTTON

The Artificial Intelligence toolbar button is added from the File System module by clicking the Tools > Add/
Remove - Artificial Intelligence menu item and selecting the required modules. These settings are
remembered, and the toolbar icons added will be present on the next launch.

Figure 533: Add Artificial Intelligence toolbar button.

o

Tools

@ Add/Remove - Artificial Intelligence

Add/Remove - Bookmark CETS Categories
Add/Remove - Bookmark Interpol Categories

Figure 534: Add/Remove Artificial Intelligence toolbar button.

B Add Button - O x

Artificial Inteligence

Add/Remove button:

Run Cancel

The following drop-down menu items will appear:

Figure 535: Artificial Intelligence toolbar button.

)

Artificial
Intelligence

| Q Face Detection (male, female, child, adult)
| f@ Face Recognition (from Checked items)
| & License Plate
'@ Object Detection
P* Weapon Detection
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32.4 PROCESSING

FEX-Al creates and updates a sqlite database. This database is in the same folder as fex-ai.exe, i.e.: C:\Program
Files\GetData\Forensic Explorer v5\FEX_AI\fex-ai.db

Figure 536: SQLite database, fex-ai.db.

Program Files » GetData » Forensic Explorervd » FEX Al =
Mame Date modified Type

_ audiomodel 12-Dec-2022 3:15 AM File folder
_ custommodel 12-Dec-2022 9:15 AM File folder
& fex-ai.db 12-Dec-2022 4:36 PM DE File
. FEX-Al.exe 12-Dec-2022 9:05 AM Application

The primary functions of the database are:
1. Improve processing speed.
2. To enable information transfer between cases.

FEX-AI processing is summarized as follows:
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Figure 537: FEX-AILEXE processing overview.

FEX-AI
Processing

MD5 Hashed
File

FEX
column has
value?

Yes Yes

l Y

Add to
column

Next File

Process with

fex-al.exe

Database information is accessible from the Advanced tab, including:

e  The number of unique files (by MD5) in the database.

e The number of unique files processed for data types (faces, license plates, objects, weapons).

e The number of unique files where those data types have been found.
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Figure 538: Advanced options.

B " FEX Al - Face Detection - File System = O *

about Process Advanced

Global Database

C:\Program Files‘zetData\Forensic Explorer
VENFEE AINfex-ai.db

Unigue Recs. 4435 Processed Found In
Faces 3612 T1le
License Plates a [u]
Ckjects a [u]
Weapons 4437 4437

Open Database Folder
Open Database

Backup Database

Other

B show fex-ai.exe CMD window

Clear Column: Al Face Count

s

Run Cancel

Open Database Folder: A shortcut to the database folder.

Open Database: Opens the database in an associated application (e.g., DB Browser for SQLite).
Backup Database: Copies the database to a sub-folder titled with the date/time of the backup.
Show CMD Window: Makes the fex-ai.exe processing window visible to the end user.

Clear Column: Clears the associate column data.

An estimate (Est.: hh:mm:ss) of remaining processing time is provided in the process window:

Figure 539: Forensic Explorer process window

FEX AT - Object Detection - File System
Processing (3658 of 5377) Est.: 00:03:24...

| -
Running Processes: 1
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32.5 FACE DETECTION

Face Detection is used to identify graphics that contain faces. The Al Face Count column stores an integer
value for the number of faces identified. Additional count columns are added for Male, Female, Child, and
Adult.

Figure 540: Face detection.

@

Artificial
Intelligence

.g- Face Detection (male, female, child, adult)
L@ Face Recognition (from Checked items)
&= License Plate

P Object Detection

F* Weapon Detection

s

Figure 541: FEX-AIl Face Detection process options.

B ' FEX Al - Face Detection - File System = O >

About Process  Advanced

Source - File System

© all Ttems (197755 items)
() Checked Ttems {0 items)

Al Process - Create Columns

ﬂ Face Count

B Face Count - Child
B Face Count - Adult
@ Face Count - Female
B Face Count - Male

Settings

Minimum Filesize: | 10 kt:{\_‘ ~

B Exclude Temporary Internet Files

Run

Cancel
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Minimum Filesize: Excludes files less than the minimum file size

Exclude Temporary
Internet Files:

Excludes the file path regex match:
Temporary Internet

Stable\\cache\\/Safari\\Cache

Files [InetCache [ MicrosoftEdge\\Cache[Cache2|Google\\Chrome\\|Opera

Face Detection results are filtered using numeric column count values.

Figure 542: Face Detection columns.

! @l Category Graph

—_—
hE T E,t I\'l o _':.D :l 1-8 A Fa,:E 1-8| A& F&-:E FE 1-8 A F&-:E 1-8

Al Face

JPG
JPG
JPG
JPG
doc
doc
avi

JPG

I T T Yy Sy i i U L TN T Sy SO U I o T L B 1% T SO S T L Ry
L T == I S e e Y o Y e e A O o L O = I L I % I o ISR e’ BT

L e T I B e T T = B s N i U P o N e Y o Y o Y o [N A T (% [ o
o R o Y Y o Y o [ IO N o Y o N Y o Y o Y o [ O o Y Y o N o N o N o Y o [ o Y s

=)

3

Extension AI Face Count Al Face Male AIFace Female  AI Face Child  AI Face Adult

I I T T e e L o T e i = Y O 5 ST S I

=

-
8 = |:|

b

|
Files containing faces can be shown in the File List using the column filter: L

|
Files without faces can be filtered in the File List using the column filter: L

b
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32.6 FACE RECOGNITION

Face Recognition is used to identify pictures containing specific individuals.

Figure 543: Face Recognition.

°

Artificial
Intelligence

£ Face Detection (male, female, child, adult)
™ Face Recognition (from Checked items)

& License Plate |>5
P Object Detection

PF" Weapon Detection

IMPORTANT: Face recognition compares a checked picture with each other picture in the case. Adding
multiple source files can extend processing time. Consider the following:

e Keep checked source files to a minimum.

e Run Face Detection first (faster) so that files with no faces can be ignored.

e Use quality checked source files with a single clear image.

e  Custom name source files by individually adding them to the case.

Figure 544: Face Recognition showing checked source file.

" | FEX Al - Face Recognition (Checked) - File System  — O X | B ey Ve [
%00

About Process Advanced
Match using:

© Checked Items (1 items)

Checked Items (1) [“]|_}ohn Thomas Hamilton.JPG

John Thomas Hamilton.JPG

Settings
Minimum Filesize: 10kb v

8 Exclude Temporary Internet Files

Cancel
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Figure 545: Output of Face Detection in Bookmarks module.

- Bookmarked Items List ; Gallery View Video View
Filter: [ No Filter viili= ! - e e
Bookmark Name 2 {§’OQ / i T
DO M1 () o W
=0 5 My Bookmarks (14) PN o ‘
—D> [ Artifacts (0) - : |
|= s i
_gg j__g S:Crmf:ts © [“1[HJohn Tho... dSRLTD454 |:| g! SROGYAZ.. [] ﬂ134 PG @135 PG
O Email (0) : ; - .
DO Evidence (2)
—> [ (5 Files (0) ; 4 - :
:gg g ilrl:zgn;'aegf;%) O l!135 LI ﬂ L T I:l :!170199 O d250b6e53 e

—> [ Internet (0)
> 5 Keyword Search (0)

—C 0O pictures (0)
:g% -g cizge'::zogo) O ﬂSSBereS [ sh6de24991... [] dGefcadefc

=D () Fex_AI (1)
=[] ) Face Recognition (1)
[ fif John Thomas Hamilton. JPG (3¢

[ =8 Big (20... [] g8mr Big In... [] g8Mr Big wi... [] sfOur Secre...

[ s Accounts ... [] s860038777.... [] s Accounts ... [] s Accounts.... [] s Home.doc
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32.7 LICENCE PLATE

Licence Plate will return a True/False value for vehicle registration plates. The minimum file size setting will
impact accuracy.

Figure 546: License Plate.

°

Artificial
Intelligence

-g- Face Detection (male, fermale, child, adult)
Lﬁ Face Recognition (from Checked iterns)
faty Licenze Plate

P Object Detection

P Weapon Detection

License Plate results can be filtered with a True/False column text filter.

Figure 547: Output of License Plate.

%= 8 18 Hash (MD5) (2] Galery view

Al License Plate  Hash (MD5) @ O Q

[T True 65ac147062d7d:

[ True 31cb 104bfa7ccf

=3 True 678488e8096fd!

s True 5c64539bd46a4

s True f598b7fc967412

Os True ffaf51a3fea37s!

Oz True 7581a72d7595b

s True 44fc001cd 1a6eS

s True ca53dccd34bfe4

[ w0 True ba15bf1e3d5dot

O u True 6d302509ce5f3t

O 12 True b5ca46e7c745dt

O 13 True ec4404d3ea5f6¢

[ 14 True 9436c4dccabebe

[ 15 True 326947c761706!

[ 16 True 672a5c19781ac(

[Flitz True 2325adbda3adb 0 <
= [] & 278ceab1377f... [] & naughty but n... [] & naughty but n...
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32.8 OBJECT DETECTION

Object Detection is used to identify specific objects in pictures.

Figure 548: Object Detection.

)

Artificial
Intelligence

G License Plate
0 Object Detection
P* Weapon Detection

.g- Face Detection (male, female, child, adult)

E@] Face Recognition (from Checked items)

The following objects are identified:

airplane
apple
backpack
banana
baseball bat
baseball glove
bear

bed

bench
bicycle

bird

boat

book
bottle
bowl
broccoli
bus

cake

car

carrot

cat

cell phone
chair

clock
couch

cow

cup

dining table
dog

donut
elephant
fire hydrant
fork

frisbee
giraffe
hair drier
handbag
horse

hot dog
keyboard
kite

knife
laptop
microwave
motorcycle
mouse
orange
oven
parking meter
person
pizza
potted plant
refrigerator
remote
sandwich
scissors
sheep

sink
skateboard
skis
snowboard
spoon
sports ball
stop sign
suitcase
surfboard

teddy bear
tennis racket
tie

toaster
toilet
toothbrush
traffic light
train

truck

tv

umbrella
vase

wine glass
zebra
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Objects are grouped and counted in the Al Objects output column. Object results can be filtered with a
True/False column text filter, or the object name.

32.9 WEAPON DETECTION

Weapon Detection is used to identify guns and knives in pictures.

Figure 549: Weapon Detection.

)

Artificial
Int=lligence

B Face Detection (male, female, child, adult)
E@j Face Recognition (from Checked items)
f License Plate
ﬁ Object Detection
P Weapon Detection I

by

Weapon results can be filtered with a True/False column text filter, or the weapon type.

Figure 550: Weapon Detection output.

;

i (=) 8| AZ" Filename AZ™ Ext G

Filename Extension Al Weapon
] 18 & knife_55.jpg ipg True - Knife
O 19 & knife_555,jpg ipg True - Knife
] 2o & knife_557.jpg ipg True - Knife
O 21 & knife_558,jpg ipg True - Knife
] 22 & knife_56.jpg ipg True - Knife
O 23 & knife_560,jpg ipg True - Knife [ & knife_56.jpg [ & knife_S60.jpg | &1 knife_561.jpg
] 24 i knife_561.jpg ipg True - Knife | il : y ;
O 25 | 001_0022-co...  ipg True - Gun Fﬂ: | = ,g
] 25 i 001_0022.jpg ipg True - Gun |
E] z= ] 001_0025.jpg ipa True - Gun : h%
] 28 & 001_0030.jpg ipg True - Gun e

(w001 _0035.jpg [ & 001_0042jpg [ i 001_0043,jpg

& Weapons_50_Knives.L014OD-WeaponDetection-m...\knife_561.jpg [P— i
37 of 167 Visible [LS 1.8 MB PS 1.8 ME] 1 Highlightll .
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33.1 THIS USER GUIDE

This user guide is provided for information purposes only. All information provided in this user guide is subject
to change without notice.

Please check the website, https://getdataforensics.com/ for the latest version of the software and
documentation.

33.2 COPYRIGHT

This user guide and its content is © copyright of GetData Forensics Pty Ltd. All rights reserved.

Any redistribution or reproduction of part or all the contents in any form is prohibited without the express
written permission of GetData Forensics Pty Ltd.

Products and corporate names appearing in this user guide may or may not be registered trademarks or
copyrights of their respective companies and are used only for identification or explanation into the owners’
benefit, without intent to infringe.

Specific trademark owners who are well established in the field of computer forensics software and whose
products and terminology have become synonymous with forensics include:

Guidance Software (www.guidancesoftware.com), EnCase®;

Access Data (www.accessdata.com), Forensic Tool Kit® (FTK®);

Xways forensics (http://www.winhex.com), X-ways forensics®.

Other company products include:

Cisco ClamAV® (https://www.clamav.net/).
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33.3

LICENSE AGREEMENT

GetData® Forensics Pty Ltd (“GetData”) — ACN: 143458039

IMPORTANT — END USER LICENSE AGREEMENT

PLEASE READ THIS SOFTWARE LICENSE AGREEMENT (“AGREEMENT”) CAREFULLY BEFORE USING FORENSIC
EXPLORER (“the SOFTWARE”). BY USING THE SOFTWARE, YOU ARE AGREEING TO BE BOUND TO THE TERMS
AND CONDITIONS OF THIS LICENSE SET OUT BELOW. IF YOU DO NOT AGREE TO BE BOUND BY THE TERMS AND
CONDITIONS SET OUT BELOW, DO NOT INSTALL AND/OR USE THE SOFTWARE. PLEASE TERMINATE
INSTALLATION IMMEDIATELY AND DO NOT USE THE SOFTWARE.

1.

1.1.

2.1.

2.2.

2.3.

3.1.

3.2.

3.3.

3.4.

3.5.

3.6.

3.7.

Software Covered by This License

This license agreement applies only to the version of the Forensic Explorer software package with which
this agreement is included. Different license terms may apply to other software packages from GetData
and license terms for later versions of Forensic Explorer may also be changed.

General

GetData is and remains the exclusive owner of the Software. You acknowledge that copyright in the
Software remains at all times with GetData.

The Software and any other materials included under this license, are licensed, not sold to you by GetData
for use only under the terms of this Agreement.

GetData or its licensors own the Software, including all materials included with this package. GetData
owns the names and marks of ‘GetData,” and ‘Forensic Explorer’ under copyright, trademark and
intellectual property laws and all other applicable laws.

Permitted License Uses and Restrictions

Subject to the terms and conditions of this License, a single License of the Software permits you to run a
single Licensed instance of the Software. Where multiple Licenses have been purchased, the License
permits you to run concurrent instances of the Software equal to the number of Licenses purchased.

You are solely responsible for the protection of your data, your systems and your hardware used in
connection with the Software. GetData will not be liable for any loss or damage suffered from the use of
the Software.

You and others are not permitted to copy (except as expressly permitted by this Agreement), decompile,
reverse engineer, disassemble, attempt to derive the source code of, decrypt, modify (except to the
extent allowed in the documentation accompanying this Agreement) or remove or alter any proprietary
legends contained in the Software.

You are not permitted to share the product activation information provided to you for this Software with
other users.

You may not publicly display the Software or provide instruction or training for compensation in any form
without the express written permission of GetData.

GetData reserves the right to check any and all license details at any time in any reasonable manner.

GetData may from time-to-time revise or update the Software and may make such revisions or updates
available to you subject to payment of the applicable license fee.
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3.8.

3.9.

4.1.

4.2.

4.3.

4.4.

5.1.

5.2.

5.3.

5.4.

5.5.

5.6.

The Software is protected under United States law and international law and international conventions
and treaties. You may not rent, lease, lend, sell, redistribute, or sublicense the Software without the
express written permission of GetData.

If you purchase a site license, there will be terms and conditions listed in the appendix of the site license.

Disclaimer of Warranty

To the extent not prohibited by applicable law, by using the Software, you expressly agree that all risks
associated with performance and quality of the Software is solely held by you. GetData shall not be liable
for any direct, indirect, special or consequential damages arising out of the use or inability to use the
software, even if GetData has been advised of the possibility of such damages.

To the extent not prohibited by applicable law, the Software is made available by GetData ‘As Is’ and
‘With all Faults,” GetData or any GetData authorised representative does not make any representations
or warranties of any kind, either expressly or implied concerning the quality, safety, accuracy or suitability
of the Software, including without limitation any implied warranties of merchantability, fitness for a
particular purpose, non-infringement or that the Software is error free.

GetData or any GetData authorised representative makes no representations or warranties as to the
truth, accuracy or completeness of any information, statements or materials concerning the Software.

No oral or written information or advice given by GetData or a GetData authorised representative shall
create a warranty. Should the Software prove defective, you assume the entire cost of all necessary
servicing, repair or correction. Some jurisdictions do not allow the exclusion of implied warranties or
limitations on applicable statutory rights of a consumer, the above exclusions and limitations may not

apply to you.
Limitation of Liability

To the extent not prohibited by applicable law, in no event will GetData, its officers, employees, affiliates,
subsidiaries or parent organisation be liable for any direct, indirect, special, incidental, exemplary,
consequential or punitive damages whatsoever relating to the use of the Software.

Any and all data obtained from the use of the Software becomes the user’s sole responsibility and liability.

Any and all data obtained from the use of the Software in any civil or criminal jurisdiction that results in
wrongful conviction, erroneous charges, misrepresentation of data or death or any other civil or tortious
wrong against a person, company, corporation or any other entity, GetData shall bear no liability for any
death, wrongful conviction or any other civil or tortious wrong against a person, company, corporation
or any other entity.

Any and all data obtained from the use of the Software is the sole responsibility of the user. In the event
the user misconstrues, misinterprets or misunderstands the data and causes it to be used in any and all
civil or criminal jurisdictions, GetData shall bear no liability.

In no event will GetData’s liability to you, whether in contract, tort (including negligence) or otherwise,
exceed the amount paid by you for the License under this Agreement.

In the event that a company bearing the name of GetData operating as a separate legal entity, leases the
Software to you, and you misconstrue, misinterpret or misunderstand the data that results in any
wrongful conviction, erroneous charges, misrepresentation of data, death or any other civil or tortious
wrong against a person, corporation or any other entity, GetData ACN: 143458039 shall bear no liability
to you, the liability shall be borne by whatever company bearing the name of GetData operating as a
separate legal entity.
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6.1.

6.2.

7.1.

8.1.

9.1.

10.

10.1.

Applicable Law

This Agreement and any dispute relating to the Software or to this Agreement shall be governed by the
laws of the State of New South Wales and the Commonwealth of Australia, without regard to any other
Country or State choice of law rules.

You agree and consent that jurisdiction and proper venue for all claims, actions and proceedings of any
kind relating to GetData or the matters in this Agreement shall be exclusively in Courts located in NSW,
Australia. If any part or provision of this Agreement is held to be unenforceable for any purpose, including
but not limited to public policy grounds, then you agree that the remainder of the Agreement shall be
fully enforceable as if the unenforced part or provision never existed. There are no third-party
beneficiaries, or any promises, obligations or representations made by GetData therein.

Export

You acknowledge that the Software is subject to Australian export jurisdiction. You agree to comply with
all applicable international and national laws that apply to the Software including destination restrictions
issued by GetData.

Termination

This Agreement is effective on the date you receive the Software and remains effective until terminated.
If you fail to comply with any and all terms set out above, your rights under this Agreement will terminate
immediately without notice from GetData. GetData may terminate this Agreement immediately should
any part of the Software become or in GetData’s reasonable opinion likely to become the subject of a
claim of intellectual property infringement or trade secret misappropriation. Upon termination, you will
cease use of and destroy all copies of the Software under your control and confirm compliance in writing
to GetData.

Entire Agreement

This Agreement constitutes the entire Agreement between you and GetData relating to the Forensic
Explorer Software herein. This Agreement supersedes all prior or contemporaneous oral or written
communications, proposals, representations and warranties and prevails over any conflicting or
additional terms of any quote, order, acknowledgement or other communication between the parties
relating to its subject matter during the term of this Agreement. No modification, amendment or
addendum to this Agreement will be binding, unless it is set out in writing and signed by an authorised
representative of each party.

Translations

This agreement is translated into other languages. It is the English version which is the language that will
be controlling in all respects. No version of this agreement other than English shall be binding or have
any effect.
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Appendix 1 - Technical Support

APPENDIX 1 - TECHNICAL SUPPORT

GetData Forensics Pty Ltd has its headquarters in Sydney, New South Wales, Australia.

Documentation: https://getdataforensics.com/
Email Support: support@getdata.com
Phone Support: USA: +1.844.300.0552

x801 - Sales

x802 - Support
x804 - Training (866)
Or;

Sydney, Australia: +61 (0)2 8208 6053
Hours: Australian Eastern Standard Time, 9am - 5:30pm Mon - Fri

GetData Forensics Pty Ltd
P.O.Box 71

Engadine, New South Wales, 2233
Australia

GetData Forensics Pty Ltd

Suite 204, 13A Montgomery Street
Kogarah, New South Wales, 2217
Australia

Phone: +61 (0)2 82086053
Fax: +61 (0)2 95881195
Hours: Australian Eastern Standard Time (AEST), 9am - 5:30pm Mon - Fri
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Appendix 2 - Write Blocking

APPENDIX 2 - WRITE BLOCKING

IMPORTANT:

An accepted principle of computer forensics is that, wherever possible, source data to be analyzed in an
investigation should not be altered by the investigator.

If physical media such as a hard drive, USB drive, camera card etc. is a potential source of evidence, it is
recommended that when the media is connected to a forensics workstation it is done so using a write block
device.

A write block is usually a physical hardware device (a write blocker) which sits between the target media and
the investigators workstation. It ensures that it is not possible for the investigator to inadvertently change the
content of the examined device and maintain “forensic integrity”.

There are a wide variety of forensic write blocking devices commercially available. Investigators are
encouraged to become familiar with their selected device, its capabilities and its limitations.

Shown below is a Tableau USB hardware write block. The source media, an 8 GB Kingston USB drive is attached
and ready for acquisition or analysis:

Tableau USB write block with USB as the source drive.

=ZTABLEAU _____ Forensic USB Bridge |
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Appendix 3 - File Carving

APPENDIX 3 - FILE CARVING

The following file types are supported by Forensic Explorers inbuilt file carving component. Refer to Chapter 24
- Data Recovery, for more information:

=+ [JED Archives
-] E@ 7ZIP (. 7z . 7zip . 7=i)
=[] € Android Backup (.ab)
~ [ #] BZip2 (.bz2 .bzip2)
-] E Cabinet compression file {.cab)
~ [JED &zIP compression file (.gz .gzip .tgz)
-] @ LZH compression file {Izh)
~ [ Miliki Super Compression (.gcf)
=B, Ms Backup File {.bkf)
-] ; RAR compression file {.rar)
~[] #)| Retrospect Backup (.rfb .rdb)
-] @ TAR. archive file {.tar)
-] g§ ¥AR (extensible ARchiver) (.xar .pkg)
~ [JED Zip compression file (.zip .zipx .jar .afz .ipa .ipsw)
O © Artifacts
~[] #] Calendar i05 (.sqlite .db .db2 .db3)
~[] ), Chrome Cache Data
- [] =4 Chrome Cache Index
~[] #] CoCo Android {.sqiite .db .db2 .db3)
~[] #] CoCoi0S (.sglite .db .db2 .db3)
~[] #] Contacts Android (.sglite .db .db2 .db3)
=[] #] ContactsiOS (.sglite .db .db2 .db3)
=[] ™, Dynamic Dictionary (.dyn)
— ] iPhone Bug Report XML {.xml .xsl .svg .xms .nib .opf .ncx .gpx plist . tet)
=[] @ Munes Backup Info plist {.plist .itxb)
= []}#Y Tunes Backup Info XML {.xml .xsl .svg .xms .nib .opf .ncx .gpx plist . txt)
- ﬂ iTunes Manifest (SQLite) (.sglite .db .db2 .db3)
=[] [ Kik Android (.sqlite .db .db2 .db3)
= Kikios {.sqlite .db .db2 .db3)
[ & Lineios (.sglite .db .db2 .db3)
- ] @ Mapsios (.plist .itxib)
~ [ #] MessageMe iOS (.zglite .db .db2 .db3)
-] ﬂ Messenger i05 (.sglite .db .db2 .db3)
~[] &] MotesioS (.sqlite .db .db2 .db3)
~[] #] Skype Messages (.sqglite .db .db2 .db3)
=[] @] 5Ms Android (.sqlite .db .db2 .db3)
~[] #] 5Msi0S v3 (.sglite .db .db2 .db3)
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SMS i05 v4 {.sqlite .db .db2 .db3)
Touch i05 (sglite .db .db2 .db3)
Viber Android (sglite .db .dbZ .db3)
Viber i05 (.sglite .db .dbZ .db3)
WhatsApp i05 (.sglite .db .db2 .db3)
&) WiFi Android (.sqlite .db .db2 .db3)
@ WiFii0s (.plist .itdb)

Camera

#| Canon Raw graphics file {.crw)

HD Photo file {,wdp)

JPEG Digital Camera file (.jpa .jpeg)
Minolta RAW file (.mrw)

Clympus RAW file (.orf)

Panasonic Graphics file (rwz)

TIFF Graphics file { tif . tiff .epx .nef .arw .cr2)
tabases and Finandials

AL AL A2

= [

=+ 0O
Access Database {.mdb .mny .mn7)

Access Project (L adp)

: Ancestry Family Tree (aft)

8 CanTax T1Personal (.p0& .p07 .p03 .p0%9 .p10.p11.p12 .p13.p14 .p15 .pl6 .pl17 .p13)
CanTax T2 Corporate (.c06 .c07 .c08 .c09 .c10 .c11.c12 .c13 .c14 .c15.c16 .c17 .c18)
Chrome History {sqglite .db .db2 .db3)

DBase-FoxPro Database file (. dbf .scx .dbc)

Endiote (.enl)

Exchange Private Store Database ( edb)

Extensible Storage Engine (.dat .ese .edb)

FileMaker (. fp7 .fp3 .fp5 .fp& .fp2)

FoxPro Executable { fup)

Interbase Backup (.abk)

Interbase Database (.gdb)

Lacerte Tax {.mdx)

Lacerte Tax Individual (,idS .id0 .sd0 .5d9 .pd0 .pd2 . fd0 . fd9)
MBDE Manifest Database {.mbdb)

MicroSim PCBoard Log (. flg)

Microsoft Money {.mny)

MS Works 4 Database (.wdb)

MS-50L Server Database [ .mdf)

MS-50L Server Log {.Idf)

MYQB Data (.dat .prm .pls .myo .box)

Omnis Database file (,df1 .lbr .ohf .lbs)

Plist (Binary) (.plist .itwib)

Quickbooks Backup file (.gbb)

Quu:kl:u:u:uks QBW file (.gbw)

H Quicken QDF file {.qdf)

QuickTax file (.q04 .99 .q00 .q01 .02 .q03)

SAS ASCII Data File (.sas)

SAS Binary Data file {.sas7bdat .sd2)

Spotlight DB {.db)

@@@5@@@@@@{@@@@@@@@%@@5LLLL;L

LS g

OO00O0O0O0O0O0O0O0O0O00OOO0O0OoooooooooobodoOowdooooodse0oooOodnd

115 |, 2
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SQLite - open source 5CL database engine (.sglite .db .db2 .db3)

] ﬁ Sqlite SHM (.shm .db-shm .sglite-shm)
] g sqlite WaL [ wal .db-wal .sglite-wal)
(] @] TaxAct(.ta5)
C12E TaxCut file (2000-3) (.00 .t01 .t02 .t03)
(] B TurboTax file {tax)
(] & web Browser Cache Database {.edb)
[] &] Windows Live Contacts Datsbase (.edb)
O ﬁ Windows Search Database (.edb)

- |:| @ Documents
] E Adobe PageMaker (.pmd .p&5)
] g Adobe Premier Project (.ppi)
] 5-] Adobe Type 1 Font (,pfh)
] Apple Document (.pages .numbers keynote)
1 avery DesignPro (.zdp)

Blackberry Encrypted file (.rem)

Casio Disk Title {.ctw)

CoolPage (.cpg)

Corel Presentation File . shw)

Crystal Reports (rpt)

Diablo2 Save (,d2s)

Efax file {.efx)

Electronic Publication {.epub)

E Family TreeMaker (. ftw)

] Familysearch file {.paf)

(1 |#] Final Draft (.fdr .fdt)

O ﬁ Final Fantasy 7 (.ff7)

] _‘1.L Fudemane Greeting Card (. fwa)

1@ Fudeou {.fzd)

] Hangul Document {.hwp)

] @ HotDocs {hfd)

[]a® 13F Fax i3

(1= Ichitaro Document (,jitd)

(] & Interactweb Reports (.rpt)

(] &) Label Mighty (.jib)

[ &) spss (.sav)
O &

OO00o0odoon
CoiCALAE M, |yl

(]2 Lotus 123 (wk3 wkl w2 .wk4 .wks .fm3 .wb1.123)
] Q Lotus WordPro file (.wp)

[] #] Mapsource 2 file {.mps)

] Microsoft Encrypted File ()

] Microsaft Excel Worksheet [ xls \xla xlt)

Il Microsoft Excel Waorksheet - XLSX (L xdsx)

] L@ Microsoft OneMote file {.one)

] Microsoft PowerPoint Presentation {.ppt)

] Microsoft PowerPoint Presentation - PFTY (.pphx)
] Micrasoft Project (.mpp)

] Microsoft Publisher Document (. pub . puz)

(] [ Microsoft Visio Drawing ( ved .vss ,vst)

] Microsoft Waord Document (. doc .dot .asd)

] Micrasaft Ward Dacument - DocX (docx)

Il @ Microsoft Write/WordPad (.wri)
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MS R.SS Feed (. feed-ms)

MS Warks 4 Document (.wps)

M3 Waorks Spreadsheet (wks)

MASCAR Racng 2003 (.sim)

OLE Document (eg. MS Office) ()

COpen Office Document ( odt)

Open Office Spreadsheet ( ods)

1 Open ¥ML Paper Document {xps .oxps)

POF document {.pdf .ai)

QuattroPro 7 File {.gpw)

] @ Rich Text Document (.rif)

[] = sureThing CD Labeler {.dsn .std)

] Uyap (.udf .usf)

[ &) vidata (i)

[ %] WordPerfect & to 10 {wpd .wem .wpt .wpg)
@ WardPerfect Documents and Graphics va {.wpag)

|:| . ¥ML Documents {.xml .xsl .svg .xms .nib .opf .nox .gpx plist . tt)

Email

Exchange Private Store Database ( edb)

Generic Email (.eml .mht .mbx  txt)

Lotus Motes (.nsf)

Mime Email {.eml .mht .mbox . tt)

Mime File {.eml .mht .mboc , tt)

COffline Qutook Email file { ost)

Outlook Address file (.wab)

Outlook Email file [ pst)

COutlook Express Email file {.dbx)

Outlook M5G { msg)

CutLook ME2 (nk2)

Personal Address Book (pab)

Usenet Item (.eml .mht .mbx . tt)

Web Browser Cache Database (.edb)

aphlcs

30 Studio (. 3ds)

3d Studio Max {.max)

Adobe Indesign file {indd)

R B e ) L%

[+
Y
[+
[ &
[ &
O
O]
[
L
Cf=

=[]

a@ﬁﬁ@@ﬂbﬁ@@@@@

[ L &

Adobe Photoshop (psd)

AutoCAD Drawing file (.dwg)

AutoCad DX File {.dxf)

AutoCad DX File {.hpal .hp .hpg .plt)
Autosketch (.skf)

Bentley Microstation w7 Drawing (.dgn)
Bentey MicroStation va Drawing (.dan)
Bitmap (.bmp)

Canaon Raw graphics file {.orw)
COREL Draw file (.cdr)

esignCAD file { dcd)

ICOM {.dcm . dicom)

[ R

O
OOOOoOoooOogOonod DDD%DDDDDDDDDDDDDD@

f@ﬁ&f@@ﬁ@@&@
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] %’ Encapsulated Postscript file {.eps .epsf .epsi)
] %’ Enhanced Metafile {.emf)

4. FormZ Document (.fmz .fzh)

@] Freehand 10 {.fh10 .fh11)

[] @] Freehand 7 to 9 (.fh9 .fh7 .fhE)

(] & Fuji Camera Raw (.raf)

GIF graphics file {.qif)

Il @ IS ShapeFiles (.shp)

] . GLIE Map file {.gue .gmp)

HD Photo file { wdp)

[ #| High Efficency Image Format {.heic .heif)
] _'| ICO File (oo .cur)

(] & sig2 (.ib2)

[ & JPEG 2000 (.jp2 .jZk .jpx .j20)

(] ®] IPEG Digital Camera file (.jpg .jped)

b= Lightwave object (Iwo)

e Lightwave scene (ws)

] ﬁ MapSource 1 file {.gdb)

] ﬁ Maya 3D file {.mb)

] Microsoft Photodrawe (mix)

] @ Microsoft Visio Drawing (vsd .vss vst)
[] & Minolta RAW file (.mrw)

[] & oClympus RAW file {.orf)

[] =L Paintbrush file {.pcx)

(] [ Paintshop Pro (.psp)

Il i-] Panasonic Graphics file {rw2)

] E PaperPort {.max)

] %’ PMNG Graphics file {.png .jng .mng)

[ *. Portable Graphics Map {.ppm .pam .pbm)
] @ PrintMaster { hcr Jbiz)

] @ QuarkXPress file {.gxp .qud .qub .gxl .qgpt)
[ #] QuideCAD (.cad)

[ &] siama X3F Raw (.x3f)

[ ¢ smartDraw file (.sdr .sdt)

Il ;:\ SwishMax [, swi)

=) Targa {.tga .exttga .ich .vda .vst)

I:II:I
| &

™
L,

L]
=, |, 1

=

I:ID

& Thumbnail Cache {.db)
&) Thumbnail file (.db)
h1 Thumbnail Index (.db)

-1 TIFF Graphics file (. 4f .6ff .epx .nef .arw .cr2)
%E TurboCAD for Windows (. tow)

) Visi CAD {.wkf)

%’ Windows Metafile {wmf)

g XARA Graphic file { xar)

Internet

Bit Torrent (. torrent)

(] & Chrome Autofil (.sglite .db .db2 .db3)

[] =L Chrome Cache Data

] =L chrome Cache Index

]
O]
O
O]
O
L
L
L
O
€]
O]
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Chrome Favicons (.sglite .db .db2 .db3)
Chrome History (.sglite .db .db2 .db3)
Chrome Logins (.sglite .db .db2 .db3)
Chrome Shortouts (Lsglite .db .db2 .db3)
Chrome Topsites (.sglite .db .db2 .db3)
Firefox Cookies { sglite .db .db2 .db3)
Firefox Form History {.sglite .db .db2 .db3)
Firefox History (.sglite .db .db2 .db3)
HTML Documents (htm .himl .shiml .phtml .php .php5 .asp .txt)
ﬂ Internet Explorer v4-2 History (.dat)

']':]’ Internet Favarites (,url)

5-] Safari Bookmarks (sqglite .db .db2 .db3)
@] Safari Cache (.sglite .db .db2 .db3)

ﬂ safari Cookie ( binarycookies)

C] @ safari History { safari-history)

] @ Safari Recent Searches (. plist .itwib)

| ﬂ Usenet Ttem (.eml .mht .mbx .txt)

] ﬁ Web Open Font [ woff)

] 2 Yahoo Messenger (.dat)

Bl | | | ||,

()

- [ @ Microsoft Office

1 @ Arccess Database (mdb .mny .mn7)

] Microsoft Encrypted File [.)

] Microsoft Excel Worksheet (Lxds \wla . xlt)
] Microsoft Excel Warksheet - XLSX ( xlsx)
] Microsoft PowerPaint Presentation [ ppt)
| Microsoft PowerPoint Presentation - PPTY (.pptx)
] Microsoft Word Document (. doc .dot .asd)
] Microsoft Word Document - DocX (.docx)
] Offline Qutook Email file (,ost)

1 Open Office Document (,odt)

] Open Office Spreadsheet { ods)

] Open XML Paper Document {,xps .oxps)
] Outlook Email file {.pst)

[] s CutLock MKZ {.nk2)

| Personal Address Book (.pab)

- [] @ Multimedia

] Eﬂ 3GPP Multimedia file (Quicktime) (.3gp .302 .3gpp .3gp2 .mp4)
[] @#] Adaptive MultiRate Audio (.amr)

] E ASF WMA WY Multimedia file (wmv . asf .wma .asx)
[] g8 Audio Interchange file format (.aif .aiff)

Il CakeWalk Pro (.owp)

] 5-] Digital Speech File {.dss)

] 5-] Digital Voice File { .dvf .msv)

] 5] D5_Store ( ds_store)

] _—H Finale Music file {.mus .fan)

] 5-] Flash (.fla)

C1 B Fruity Loops file (.fip)

] h] High Efficiency Image Format (.heic . heif)

(14 et voice File (.sc4)
Il 5-] Kaydara FEX Binary (. fbx)
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Logic Audio (.lso)

Ogg VorbisMedia (. ogg .oom .oga .ogv .ogx)
RealMedia file {.ra .ram .rm .rmvh)

Reason (.rns)

RIFF Multimedia file {.rif .riff .npr .rmi .rmid .veqg)
Sibelius Music file (.sib lib)

WAVE Multimedia file (.wav)

WMA Multimedia file {.wmv .asf .wma .asx)

WMV Multmedia file {.wmv .asf .wma .asx)

O

Al Sound File {.au)
Core audio file {,caf .caff)
Free Lossless audio codec (. flac)
iTunes audio file {.m4a .m4b .m4p .mp4)
MP3 Music file {.mp3 .mp .mp1.mp2)
Musical Instrument Digital Interface file {mid .midi)
WAVE Multmedia file {.waw)
WMA Multimedia file (.wmv .asf .wma .asx)
wt (WARMING: Slows Search)

150M Document {.json . txt)

Text (Shift JI5) Documents (,jis)

Text (UTF-16) Documents (, tit)

Text (UTF-5) Documents (, tat)

Text Documents (L tut  text)

%%%H@&H&g%@%ﬂ&&@&@ﬂ

O

[0 A S PSS

=
[l
m
=]

O
O000000«0000 OO000000000OO00000mO0000000000000000000

IEEEE&Q%%@@@

3GPP Multimedia file (Quicktime) (.3gp .3g2 .3gpp .3gp2 .mp4)
ASF WMA WMV Multmedia file {wmv .asf .wma .asx)

AVCHD Multimedia file (.mts .m2ts .hdtw)

AVI Multimedia file {.avi)

Cine (.cne)

MOV Multimedia file (Quicktime) (.mov .mp4 .m4v)
MPEG Multimedia file (.mpg .mpeqg .m1v .vro)
Oagg Vorbis/Media (.ogg .ogm .0ga .ogv .ogx)
RealMedia file {.ra .ram .rm .rmvh)

ShockWave Flash { swf)

@@&@@&f@@@@

ShockWave FlashVideo ( fiv)

LINIMO Video (umv)

Windows Recorded TV {wtv)

WMV Multimedia file (. wmv .asf .wma .asx)
ple OS5

Apple Disk Logger {.dsl)

Apple System Log (. asl)

macDs Terminal Save State (data)

MBDE Manifest Database {.mbdb)

Plist (Binary) (.plist .itwib)

| Spotlight DB (.db)

¥AR (eXtensible ARchiver) (xar .pka)

2

Matroska Multimedia Container {.mkyv .mk3d .mka .mks .ebml .webm)

Matroska Multimedia Container {.mkv .mk3d .mka .mks .ebml .webm)
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] 5-] Windows
|:| g ELF {.elf .s0)
@ Event Log (Windows XML) (.evhx)
1 @ Event Log (Windows) (.evt)
EXE/DLL file (.exe .sys .dll .drv .ocx .5c7)
Help (.hip .gid})
Installation File {.mst .msi)
MTFS Log file
Print Spool (.spl)
Print Spool Shadow (. shd)
Registry File {,dat .old .log)
RPM (.rpm)
TrueType Font file (. tif .otf)
V55 Catalog
V55 Store
VS5 Store Information
V55 Volume Header
Windows Jump List (. automaticdestinations-ms)
Windows Link (.Ink . link)
Windows Memory Dump {.dmp)
Windows Prefetch (.pf)
Windows Recyde Bin
erating System
exFAT Volume (. exfat)
FAT Volume (.fat)
GMU Machine Object (.mo)
Hierarchical File System Plus (.hfs+)
NTFS IND¥ Data (.indx)
MTFS Yolume (.ntfs)

O
OO0O000O0%000000000000000000

||| | | |, g &, "-:Iiliﬂ:lili.li.li | 1 ) [) © 1,
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APPENDIX 4 - SUMMARY OF DATE AND TIME

the directory data.
(32 bytes)

in the MFT record of the
file.

file in the directory
data. (32 bytes)

the Catalogue file.
(70 bytes)

the catalogue file.
(88 bytes)

File System Type FAT NTFS exFAT HFS HFS+ EXT2/3/4
Time Type Local uTc Local Local uTc uTtc
Source FAT record of the file in $10 Standard attribute $85 exFAT record of the | The files HFS record in The files HFS record in The files inode record.

Calculation Method

DOS Date & Time.

100ns since 1% Jan

DOS date & time.

Seconds since

Seconds since

Seconds since 1°t Jan

Created Date (2 bytes).

Created msecs (1 byte).

Total=5 bytes

Accessed Date.
Total=8 bytes.

Created Date (2 bytes).
Created msecs (1 byte);
Total=5 bytes.

Total=4 bytes.

Total=4 bytes.

1601. midnight 15t Jan 1904. | midnight 1% Jan 1904. | 1970.
Modified Written Time (2 bytes); Written Time. Created Time (2 bytes). Content Modified Date Content Modified Date Last Date & Time that
Written Date (2 bytes). Written Date. Created Date (2 bytes). & Time. & Time. the content was
Total=4 bytes. Total=8 bytes. Created msecs (1 byte); The date and time the The date and time the modified.
Total=5 bytes. file's contents were last | file's contents were last | Total=4 bytes.
changed by extending, changed by extending,
truncating, or writing truncating, or writing
either of the forks. either of the forks.
Total=4 bytes. Total=4 bytes.
Accessed Accessed Date. Accessed Time. Accessed Time (2 bytes). | N/A Last accessed Date & Access Date & Time.
Total=2 bytes. Accessed Date. Accessed Date (2 bytes). Time. Total=4 bytes.
Total=8 bytes. Total=4 bytes. The date and time the
file's content were last
read.
Total=4 bytes.
Created Created Time (2 bytes). Created Time. Created Time (2 bytes). Created Date & Time. Created Date & Time. N/A

Modified Record

N/A

Modified Time.
Modified Date.
Total=8 bytes.

N/A

N/A

The last date and time
that any field in the
file's catalogue record
was changed.

Total=4 bytes.

Modification Date &
Time of the file record
(the “Change” time).
Total=4 bytes.
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Alternate Data Stream An Alternate Data Stream (ADS) is a feature of the NTFS file system. ADS were
originally included in Windows NT for compatibility with Macintosh HFS file
systems resource fork and a data fork. The ADS provides a means to allow
programmers to add additional metadata to be stored for a file, without adding
this data directly to the file. The additional data is attached as a stream which is
not normally visible to the user.

ANSI character set The ANSI character set was that standard character encoding for English versions
of Microsoft Windows, including Windows 95 and NT. The ANSI format stores
only the 128 ASCII characters and 128 extended characters, using 1 byte per
character. Not all the Unicode characters are supported.

ASCII The American Standard Code for Information Interchange (ASCII) is a 7-bit
character encoding scheme that allows text to be transmitted between
electronic devices in a consistent way. The ASCII character set comprises codes
0-127, within which codes 0-31 and 127 are non-printing control characters.
The addition of Codes 128-255 make up the Extended ASCII character set (see
http://www.ascii-code.com/ for more information) (9).

Bookmarks Forensic Explorer enables any item (file, folder, keyword, search hit etc.), or
sections of items, to be marked and listed in the Bookmarks module. Bookmarks
are used to note items of interest.

BpB “Bytes per Block”. Used in the Forensic Explorer File Extent tab to display the
number of Bytes per Block (cluster) for the highlighted file.

BpS “Bytes per Sector”. Used in the Forensic Explorer File Extent tab to diplay the
number of Bytes per Sector for the highlighted file.

Byte Plot view A view in Forensic Explorer which includes for a selected file: A graphical

(Forensic Explorer) representation of a binary file; A Character Distribution graph representing the
frequency that each ASCII character is displayed in the file. See “Byte Plot and
Character Distribution” page 115.

Carved (file) Files located by “file carving” with Forensic Explorer are displayed as “Carved_
[filetype].ext. This is because a file system record for these files no longer exists,
so they are in effect lost to the file system.

Because file and folder information are only stored with the file system record,
a carved file does not retain its original file or folder name.
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Case File

ClamAV (Clam
AntiVirus)

Clear Columns

Cluster

Cluster Boundaries

Codepage

Computer forensics

A case file is the store of investigational activities for an individual case in
Forensic Explorer. The case file records the location of the examined devices and
holds the results of searching, sorting, bookmarks, reports etc.

A case file is designed to build over time as a record of an investigation, in the
same way as would a paper based file in a traditional matter.

ClamAV® is an open source (GPL) anti-virus engine. It is free software and can be
redistributed and/or modified under the terms of the GNU General Public
License as published by the Free Software Foundation; either version 2 of the
License, or (at your option) any later version.

GetData Pty Ltd have modified parts of the ClamAV engine to allow Forensic
Explorer to scan evidence files. Those modifications, including the source code,
are available upon written request to GetData at support@getdata.com. ClamAV
and Clam AntiVirus are trademarks of Cisco Systems, Inc. 2017.

In Forensic Explorer additional data can be calculated (e.g., Entropy, MD5 Hash,
etc.) or given (e.g., Classification, Flag, Signature, etc.) to an entry. This
information is usually displayed in columns in a File List view. In some
circumstances it may be beneficial to clear all information from these columns
and re-apply the process. To do this, in the File System module, select Tools >
Clear Column Content. To clear an individual column, right-click on the column
header and select Clear Column from the menu.

A cluster is the smallest logical unit of disk storage space on a hard drive that can
be addressed by the computers Operating System. A single computer file can be
stored in one or more clusters depending on its size.

A cluster boundary refers to the start or the end position of a cluster (a group of
sectors). If a file is fragmented (stored in non-contiguous clusters), the
fragmentation happens at the cluster boundary, as there is no smaller unit of
storage space that can be addressed by a computer.

Examining data at cluster boundaries can be an important technique to improve
the speed of some search routines. For example, when file carving for file
headers, it is faster to search the cluster boundary (i.e., the beginning of a
cluster) rather than a sector-by-sector search of the drive.

Codepage is another term for character encoding. It consists of a table of values
that describes the character set for a language. When a keyword search is
conducted in Forensic Explorer, the correct codepage should be selected.

Computer forensics is the use of specialized techniques for recovery,
authentication, and analysis of electronic data with a view to presenting
evidence in a court of law.
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Compound File

Data carve

Data View

Deleted File

Delphi Basics©

Device

Directory

Directory Entry (FAT)

Disk Slack

Disk view (Forensic
Explorer)

A compound file is a file that is a container for other files or data, such as a .Zip
or .Pst (Microsoft Outlook mail file). See Error! Reference source not found.9.6 -
Expand compound file.

See file carve.

A data view describes the different methods available in Forensic Explorer to
examine evidence. For example, a single file may be examined in the Hex, Text
or Display data views, with each view giving a different perspective on its
content.

A deleted file is one which has been marked as deleted by the file system (usually
because of being sent to and emptied from with Recycle Bin). A deleted file can
be recovered by reading the file system record for the file, then reading and
restoring the file data. If the data for the file is intact (i.e., the space once
occupied by the file has not been used to store new data) the recovered file will
be valid.

In some cases, the file system record itself can be overwritten and destroyed. If
this is the case the file can only be recovered by “file carving” (see 22.4- File
carving). Because file and folder information are only stored with the file system
record, a carved file does not retain its original file or folder name.

Delphi Basics© is a documentation package for the Delphi programming
language (see http://www.delphibasics.co.uk/). Delphi Basics© is installed with
and licensed for use only with Forensic Explorer. Delphi Basics© is provided as
a reference guide only. Not all commands/features in the documentation are
available in Forensic Explorer.

A device refers to the electronic media being examined. It usually refers to a
physical device, such as a hard drive, camera card etc., but can also mean the
forensic image of a device in DD, EO1 or other formats.

See Root Directory

A component of the FAT file system. Each file or folder on a FAT partition has a
32-byte directory entry which contains its name, starting cluster, length and
other metadata and attributes.

The area between the end of a partition and the end of the disk. It is usually
considered to be blank but can hold remnants of previous disk configurations or
could be used to purposely hide data.

A graphical representation in Forensic Explorer of sectors on the examined
device. Disk view can be used to:

e Examine the content of the data in a specific sector/s;

e Quickly navigate to a desired sector position on the device;
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DST

dtSearch®

Entropy

EO1

Evidence Items

Explorer View

FAT

FAT Slack

Files carve

File Signature

e Obtain a graphical overview of the file types which make up the drive
and where they are position on the examined media;
e Identify the location and fragmentation of individual files.

Daylight Savings Time

dtSearch® (www.dtsearch.com) is third party index search software built into
Forensic Explorer and accessed via the Index Search module tab (see Chapter 14
- Index Search Module, for more information).

The concept of information entropy was introduced by Claude Shannon in his
1948 paper "A Mathematical Theory of Communication”. It is also referred to as
Shannon entropy (https://en.wikipedia.org/wiki/Entropy (information_theory).

Entropy is an expression of disorder or randomness. It is used in computer
forensics to measure the randomness of data. For example, a compressed file
will have a high entropy score. A text file will not. An entropy score is included in
Forensic Explorer the Byte Plot data view of the File System module.

A forensic file format used to create disk image files. Developed by Guidance
Software (http://www.guidancesoftware.com/)

Items of evidence that have been added to the case, such as forensic image files,
email files, registry files etc.

File display technology written by GetData and used in the Forensic Explorer File
Display tab to show the contents of more than 300 different file types.

FAT (File Allocation Table) is the file system that pre-dates NTFS. Once popular
on Windows 95, 98 and XP, it is now primarily used on memory cards, USB drives,
flash memory etc. due to its simplicity and compatibility between Operating
Systems (e.g., Windows and MAC).

For more information see: http://www.forensicswiki.org/wiki/FAT

The unused space in the last cluster of the FAT where the logical size of the FAT
does not fill the complete cluster.

File carving is the process of searching for files based on a known content, rather
than relying of file system metadata. This usually involves searching for a known
header and footer of a specific file type.

Forensic Explorer has built in code to data carve for more than 300 file types.
The header component of a file which has unique identifiers that assigns it to a

type, e.g., a jpeg. Most common file types have a signature set by the
International Organization for Standardization (ISO). Identifying a file by its
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signature is a more accurate method of assessment that using the file extension,
which can easily be altered.

File Slack The unused space in the last cluster of a file where the logical size of the file does
not fill the complete cluster. The file slack can contain fragments of old data
previously stored in that cluster.

File system The organization of files into a structure accessible by the Operating System. The
most common types of file systems used by Widows are FAT and NTFS. Others
include EXT (Linux) and HFS (MAC).

Fileprint A byte level graphical representation of a file content that may “serve as a
distinct representation of all members of a single type of file” (8). See “Byte Plot
and Character Distribution” page 115.

Flag In Forensic Explorer, a flag is used to mark a file as relevant. It is a colored box
(flag) that is applied to a List view when the “Flag” column is displayed. Eight
colored flags are available for use. Flags are applied by highlighting and item and
double clicking the opaque flag color in the flag column, or by using the right
click “Add Flag” menu. Flags can also be applied by running Forensic Explorer

scripts.
Folder See Root Directory
Forensic Image A "forensic image” is a file (or set of files), used to preserve an exact "bit-for-bit"

copy of data residing on electronic media.

Using non-invasive procedures, forensic software is used to create the image file.
The image contains all data, including deleted and system files, and is an exact
copy of the original.

Most forensic imaging software integrates additional information into the image
file at the time of acquisition. This can include descriptive details entered by the
examiner, as well as the output of mathematical calculations, an "acquisition
hash", which can be later used to validate the integrity of the image. The forensic
image file acts as a digital evidence container that can be verified and accepted
by courts.

Forensic Integrity In computer forensics the term “forensic integrity” commonly refers to the
ability to preserve the evidence being examined so that it is not altered by the
investigator or the investigative process. This enables a third party to conduct an
independent examination of the evidence on an identical data set. Forensic
integrity is usually achieved using write blocking devices (to protect original
media from being changed) and the forensic image process (the acquisition of
an identical copy which can be re-verified later.)

Fragmented File The distribution of a file on a disk so that it's written in non-contiguous clusters.
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Free Space

GeoTag (Geotagging)

GREP

Hard Link

Hash

Hash Set

Hex

Free space: Space on the disk that does not form part of any partition but is
available for future allocation.

(Free space can also exist as sectors between the MBR and the first partition,
and space at the end of the disk that was not used in any partition).

Free space in Partition: Space inside the partition that is not used by a volume
(this is usually a small section of space at the end of a partition). If there is no
volume, then this is the entire partition.

Also see Unallocated Clusters: Aavailable volume storage not yet used to store
files.

Geotagging is the process of adding geographical identification metadata to files,
usually photographs or videos. This data is usually latitude and longitude co-
ordinates.

Stands for Generalized Regular Expression Parser. Originally a command line text
search utility in UNIX. It is now an acronym to describe the format of a search. It
uses a concise but flexible structure to match strings of text, including
characters, words, or patterns of characters. Forensic Explorer utilizes PCRE (Perl
Compatible Regular Expressions) for keyword searching, of which GREP is a
subset.

A hard link is the file system representation of a file by which more than one
path references a single file in the same volume.

A Hash is a mathematical calculation to generate a unique value for specific data.
The chances of two files that contain different data having the same hash value
are exceedingly small. The most common hash algorithms in use are MD5, SHA1
and SHA256.

A Hash Sets is a store of mathematical calculations (hash values - usually created
by the MD5 algorithm) for a specific group of files. The hash values are a “digital
fingerprint” which can then be used to identify a file and either include or
exclude the file from a data set.

Hash Sets are often grouped in the forensic community into two groups:

Good Hash Sets: Operating System files, program installation files, etc.; and Bad
Hash Sets: virus files, malware, Trojans, child pornography, Steganography tools,
hacking tools etc.

Hash sets can be created in Forensic Explorer or downloaded from a trusted
source.

Hexadecimal is a base 16 numbering system. It contains the sixteen sequential
numbers 0-9 and then uses the letters A-F. In computing, a single hexadecimal
number represents the content of 4 bits. It is usually expressed as sets of two
hexadecimal numbers, such as “4B”, which gives the content of 8 bits, i.e., 1 byte.
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Image File See Forensic Image.

Index Search An Index Search is the process of creating a database of search words in the case
so that after the index is created an instant search is possible. Forensic Explorer
uses the third-party application dtSearch® (www.dtsearch.com) for this process.

INFO2 Windows automatically keeps an index of what files were deleted including the
date and time of the deletion. The index is held in a hidden file in the Recycle Bin
called INFO2.

When the Recycle Bin is emptied, the INFO2 file is deleted.
Recovery and analysis of deleted INFO?2 files can provide important information
about files that were once located on the computer.

Investigator In this user guide “Investigator” is used to describe the computer forensics
examiner, i.e., the user of Forensic Explorer. The investigator is responsible for
creating and developing the case file.

Initialized Size In Microsoft NTFS the logical size of a file can represent additional disk space for
future operations. For performance purposes the file initialized size enables
Windows to load only the actual required data.

Item In Forensic Explorer, the term “item” is a generic term used to describe a piece
of data. The data could be a file, folder, partition, metadata entry, FAT, MFT,
unallocated clusters, or other such data that can be isolated and examined.

ITunes Backup ITunes Backups are created by iTunes. When an Apple device (iPhone, iPad, iPod)
is connected to a computer for the first time and synced with iTunes, a folder is
created using the unique device ID (UUID). These ITunes Backup folders are very
distinctive, in that they are 40 hexadecimal characters long. ITunes Backups can
be processed with Forensic Explorer.

Keyword A keyword is a string of data created by the forensic examiner so that the case
can be searched for instances of that data (a keyword search).

A keyword can be an actual word but can also be raw data.

Complex keywords are usually created using RegEx expressions.

Video Key Frame In animation and filmmaking, a key frame (or keyframe) is a drawing or shot that

(Keyframe) defines the starting and ending points of a smooth transition. These are called
frames because their position in time is measured in frames on a strip of film or
on a digital video editing timeline. (https://en.wikipedia.org/wiki/Key frame,
Accessed June 2023).

Many software programs have the ability to extract keyframes as a method to
represent the visual content of the entire file. A similar method is to time slice a
video, where frames are extracted at set intervals.
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LEF

LFN (also see SFN)

Link Files

Live Boot

Logical Evidence File

(LEF)

Logical file space

Lost OS Clusters

In Forensic Explorer, keyframes and time slicing is performed using Expand
Compound File(s).

See Logical Evidence File

Long File Name refers to a file or folder on a FAT file system which has a name
greater than 8 characters and 3 for the file extension (or one which contains
special characters). The storage of the additional file name information makes it
necessary for Windows to create an additional LFN directory entry (or entries)
to hold the extra information.

Link files (.Ink) are Microsoft Windows shortcut files. Link files have their own
metadata and can provide valuable information about files stored on the
computer. (25)

‘Live Boot’ is a component of Forensic Explorer that enables an investigator to
boot a forensic image or write protected physical hard drive. The investigator
can then operate the computer in a real time, forensically sound, virtual
environment. The boot process is achieved through and integration of Mount
Image Pro and VMWare or VirtualBox.

A Logical Evidence File is a forensic image containing specific files, rather than
the traditional image of an entire volume or physical disk. They are usually
created during a preview where an investigator identifies file-based evidence
worthy of preservation, when an image of the entire volume or device is not
warranted.

Common Logical Evidence File formats are LO1, created by EnCase® ® forensic
software (www.guidancesoftware.com) or AD1 by Access Data’s Forensic Tool
Kit ® (www.accessdata.com).

Forensic Explorer enables files in a case to be exported to a logical evidence file
(LEF) in .LO1 format (see 9.7.2 for more information).

The actual amount of space occupied by a file on a hard drive. It may differ from
the physical file size, because the file may not completely fill the total number of
clusters allocated for its storage. The part of the last cluster which is not filled is
called the file slack.

Clusters in a volume that have no file data. For NTFS this is calculated from
accumulating all clusters associated with all the files in the MFT (including the
Unallocated clusters as that was derived from the S$BITMAP record), then
working out the space left over. For NTFS, this is space that the OS might not be
able to allocate without a check disk or equivalent. For normal uncorrupted
NTFS, this would be non-existent or small. For FAT, typically this is non-existent,
as the FAT table is used both in cluster allocation of files and the working out of
Unallocated clusters on [type] volume.

Copyright GetData Forensics Pty Ltd 2010 - 2024, All rights reserved.


http://www.guidancesoftware.com/
http://www.accessdata.com/

Appendix 6 - Definitions 567 | Page

Master boot record
(MBR, Boot Sector)

Master File Table
(MFT)

Metadata

Module

Mount Image Pro
(MIP)

MRU

Multi-core processing

NTFS

The very first sector on a hard drive. It contains the startup information for the
computer and the partition table, detailing how the computer is organized.

“On an NTFS volume, the MFT is a relational database that consists of rows of
file records and columns of file attributes. It contains at least one entry for every
file on an NTFS volume, including the MFT itself. The MIFT stores the information
required to retrieve files from the NTFS partition”. (26))

Metadata is often referred to as “data about data”. Windows metadata can
include a file create, last accessed and modified dates, as shown in File List view
of Forensic Explorer. File metadata includes information such as camera make
and model in a JPEG, or author name in Microsoft Word.

The File Metadata view (tab) at the bottom window of Forensic Explorer is used
to show all metadata properties for a file.

Metadata from the File Metadata view can be extracted and placed in columns
using the Extract Metadata button in the File System module toolbar. See 8.13.1
for more information.

Refers to the horizontal tabs (Evidence, File System, Keyword Search, Index
Search, Bookmarks, Reports, Scripts, Email, and Registry) at the top of the
Forensic Explorer main program window. Each module tab is used to access a
function of the program, for example, the Registry module enables the
investigator to add and browse registry files.

A computer forensics software tool written and sold by GetData
(www.mountimage.com) which enable the mounting of forensic image files as a
drive letter on a Windows computer system. MIP is sold with Forensic Explorer.
It is installed as a separate program but can be run from a shortcut in the
Forensic Explorer toolbar.

Most Recently Used (MRU) is a term used to describe a list of the most recently
opened files by an application. Many Windows applications store MRU lists as a
way of allowing fast and consistent access to most recently used files. Most MRU
lists are stored in the Windows registry.

A multi-core processor is a single computing component with two or more
processors ("cores"). Each core is responsible for reading and processing
program instructions. A multi-core process should be faster than the same
process run on a single core. However, users are encouraged to test their
workstations as different hardware configurations can affect multi-core speed.

Forensic Explorer provides the option to use multi core processing in File Carving,
Hashing and Keyword Search. The option is set using the “Priority” options,
where Minimum is single core, and Normal, High and Maximum are multi-core.

The Windows New Technology File System (NTFS) superseded FAT. It was
released with Windows NT and subsequently Windows 2000, Windows XP,
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NTLM Hash

Ophcrack

Pane

Pascal

Partition

PCRE (Perl Compatible
Regular Expression)

Pre-processing (a

case)

Priority

Preview (Evidence
Module)

Windows Server 2003, Windows Server 2008, Windows Vista, and Windows 7. It
uses a Maser File Table (MFT) to store the information required to retrieve files
from the NTFS partition.

An NTLM hash is the cryptographic format in which user passwords are stored
on Windows systems. NTLM hashes can be extracted in Forensic Explorer using:
File System > Tools > 3 Party Tools > GetData NTLM Hash Extract.

To break an NTLM hash, various programs can be used, such as John the Ripper
and Hashcat. These programs are capable of performing dictionary attacks,
brute-force attacks, and other techniques to crack the hashes and reveal
passwords.

Ophcrack is a free open-source program that recovers Windows passwords by
processing LM hashes through rainbow tables. Ophcrack ISO images can be used
with Forensic Explorer Live Boot.

An area of the Forensic Explorer module. The Forensic Explorer module is broken
down into three panes, Folders view, File List view and File Display. A pane can
contain multiple different windows, such a Hex view, Text view, Disk view,
Console etc.

A programming language used to create scripts in Forensic Explorer. See Module
Chapter 19 - Scripts Module.

A part of a hard disk that can have an independent file system.

Perl Compatible Regular Expressions (PCRE) is a regular expression (RegEx)
library. The PCRE library is incorporated into a number of prominent open-
source programs, such as the Apache HTTP Server and PHP language. RegEx
expressions can be used to keyword search evidence in Forensic Explorer.

Pre-processing describes the setup of a case so that core analysis functions are
automatically run prior to investigator review. Core analysis functions can
include hashing, carving and signature analysis.

Pre-processing options are set in Forensic Explorer when a device or forensic
image file is added. See 0 for more information.

In Forensic Explorer priority refers to the use of threaded multi-core processing.
See “Multi-Core Processing”.

The Preview button in the Evidence module enables an investigator to quickly
add a device or forensic image to Forensic Explorer without first having to go
through the steps to create a new case. The investigator can choose to save a
preview to a case, or if not, when the preview is closed, no data is saved.
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RAID

RAM

RAM Slack

Record View (Forensic
Explorer)

Recover My Files

Regex (Regular
Expression)

Registry

Ribbon (Toolbar)

Root Directory/Folder

Redundant Array of Independent Disks.

Random Access Memory, where programs are loaded, and computer code is
executed. The content of RAM is lost when the computer is turned off.

RAM slack is the data between the end of the logical file and the rest of that
sector. For example, a sector is written as a block of 512 bytes, so if the last
sector contains only 100 bytes, the remaining 412 bytes is padded with RAM
slack. In older Operating Systems, e.g., Windows 95, RAM slack could contain
data from RAM unrelated to the content of the file. In more recent Operating
Systems, RAM slack is filled with zeroes.

Record View displays information directly from the FAT or MFT record. It
provides more complete details for a file than the limited information displayed
in File List view.

Data Recovery Software authored and sold by GetData at

www.recovermyfiles.com

A regular expression provides a concise and flexible means to "match" (specify
and recognize) strings of text, such as particular characters, words, or patterns
of characters. “The concept of regular expressions was first popularized by
utilities provided by Unix distributions, in particular the editor ED and the filter
grep q” (http://en.wikipedia.org/wiki/Regex).

The Windows Registry is a hierarchical database that stores configuration
settings and options for the Microsoft Windows operating systems. For the
computer forensics examiner, it can be a wealth of information on all aspects of
the computer and its use, including hardware, applications, and user
configuration.

The ribbon refers to the Forensic Explorer toolbar and the top of each module.
The contents of the toolbar are controlled by scripts.

A directory is a container used to organize folders and files into a hierarchical
structure. The root (also referred as the root folder or root directory) is the first
level folder of the hierarchy. It is analogous to the root of a tree, from which the
trunk and branches arise.

A directory that is below the root is called a subdirectory. A directory above a
subdirectory is called its parent directory. The root is the parent of all directories.

“Directory” was a more common term when DOS use was prolific (The “DIR”
command is used in DOS to list the contents of a directory). Directories are now
more commonly referred to as “Folders”.
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Script

Sector

SFN (see also LFN)

Signature Analysis

Shadow Copy

Skin Tone Analysis

Slack

Steganography

Tesseract Open-
Source OCR Engine

User Datagram
Protocol (UDP)

A script is a computer program written to perform a specific task. Forensic
Explorer has a scripts module which allows the investigator to write Pascal
language scripts.

A sector is a specifically sized unit or storage on a hard disk. A sector on a hard
disk usually contains 512 bytes. A group of sectors forms a cluster, which is the
lowest level of storage space which can be addressed by an Operating System
(e.g., Windows).

Short File Name refers to a file or a folder on a FAT file system that has a file
name that can be stored in the 8.3 file name format (8 name characters with 3
characters for the extension). The name and metadata for a SFN file can be
stored within a standard FAT directory entry.

Signature analysis compares a files header with its extension. A mismatch may
justify closer examination. Identifying a file by its signature is a more accurate
method of classification than using the file extension (e.g. .jpg), as the extension
can easily be altered.

“Shadow Copy” (also known as Volume Snapshot Service, Volume Shadow Copy
Service, VSC or VSS), is a technology included in Microsoft Windows that allows
taking manual or automatic backup copies or snapshots of data, even if it has a
lock, on a specific volume at a specific point in time over regular intervals”
(https://en.wikipedia.org/wiki/Shadow Copy). Forensic Explorer enables
investigators to add and examine the content of Shadow Copies. See Chapter 26.

Skin tone analysis is the automated detection of skin tone colors in graphics files.
It is often used to identify pornographic pictures on a suspect’s computer. In
Forensic Explorer, skin tone analysis is run using a script.

See File Slack, Disk Slack, FAT Slack.

Steganography is the art and science of writing hidden messages in such a way
that no one, apart from the sender and intended recipient, suspects the
existence of the message, a form of security through obscurity (Definition from:
http://en.wikipedia.org/wiki/Steganography).

Tesseract (https://tesseract-ocr.github.io/) is an optical character recognition
engine for various operating systems. It is free software, released under the
Apache License. Originally developed by Hewlett-Packard as proprietary
software in the 1980s, it was released as open source in 2005 and development
has been sponsored by Google since 2006.

Definition from: (https://en.wikipedia.org/wiki/Tesseract (software)).

UDP is one of the core members of the Internet Protocol Suite (the protocols
used for the Internet). Forensic Explorer can use UDP to access remote drives.
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Unallocated Clusters

Unicode

uuiD

Volume

Word List

Write Block

VSC or VSS

Unallocated clusters (also referred to as unallocated space) are the available
clusters not yet allocated to file storage by a volume.

Unallocated clusters can be a valuable source of evidence in a computer
forensics examination because they can contain deleted files or remnants of
deleted files created by the Operating System and / or computer users.

In Forensic Explorer the display format is: Unallocated clusters on [type]
volume. For NTFS, this is calculated using the SBITMAP record, for FAT this is
calculated from the FAT Table.

Unicode is an international standard for processing and displaying all types of
text. Unicode provides a unique number for every character for all languages on
all platforms.

An Apple device (iPhone, iPad or iPod Touch) has a Unique Device Identifier
(UDID). It is a sequence of 40 letters and numbers. When a backup of the device
is made to a PC, the backup files for the device are stored in the UUID folder. See
chapter 30.1 for more information.

A collection of addressable sectors that are used to store data. The sectors give
the appearance of being consecutive, but a volume may span more than one
partition or drive.

A list of words exported from an index in the Index Search module. The word list
can be used for password breaking or other purposes.

A hardware device or software program that prevents writing to an examined
device. A write block is designed to maintain the ‘forensic integrity’ of an
examined device by demonstrating that changes to the content of the device
were not possible.

Volume Shadow Copy, or Volume Shadow Service: - See “Shadow Copy”
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Appendix 7 - Sample Script

APPENDIX 7 - SAMPLE SCRIPT

Sample script showing some of the common features of Delphi / Pascal scripting. A fully commented version is
provided in the Quick Reference folder in the Script Module.

{INAME: Help File - Sample Script 1.pas}

{IDESC: Counts years to 21}

{!INFO: Shows basic Pascal programming elements }
{!AUTHOR: GetData}

{!VERSION: v1.00}

program Help_File_Sample_Script_1;

uses
GUI, SysUtils;

const
starting_age = 10;

var
my_age: integer;

begin
my_age := starting_age;
ShowMessage('Your current age is: ' + inttostr(starting_age));
Progress.Log('Your current age is: ' + inttostr(starting_age));
if my_age > 21 then ShowMessage('You are already older than 21" + #13#10 + 'The program will now
end');
while my_age <21 do
begin
my_age :=my_age +1;
if my_age =21 then
begin
ShowMessage('WOW, happy 21st!");
Progress.Log('Congratulations. You made it from "+inttostr(starting_age)+' to: ' + inttostr(my_age));
end
else
begin
ShowMessage('Next year you will be: ' + inttostr(my_age));
Progress.Log('Next year you will be: ' + inttostr(my_age));
end;
end;
end.
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APPENDIX 8 - ICON KEY

Forensic Explorer icons sorted by Category:

Icon | Category Description

g Case A Forensic Explorer case

EI Shadow Copy A mounted shadow copy volume

_Q Compound file | A folder holding the contents of an expanded compound file
1 Date Categorize dates - File System > Folders view > Category view
] Device A physical device, e.g., a hard drive

E Device A logical device, e.g., C: drive.

= File A deleted file

[1. | File A FAT “dot” directory entry

[ .. | File A FAT “double dot” directory entry

[ File A system file

= File An active file

File An alternate data stream

[Eé File Windows hard link (http://en.wikipedia.org/wiki/Hard_link)
h Folder A folder holding the results of a Forensic Explorer file carve
) Folder A deleted folder

) Deleted items Categorize deleted items - File System > Folders view > Category view
= Folder An active folder

= Free space Free space in partition

Image A forensic image file

Image A corrupt forensic image (see Add Image)

@ Image folder Select an image from a folder

Navigation An expandable branch (folder structure)
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[E Navigation Active branch plate
C Navigation Inactive branch plate
[ Navigation A child branch plate is active
) Partition A partition
- Partition An active partition
= Unallocated Unallocated clusters
Disk View

The start sector of a file

Currently selected sector

opf

One type of file overlay another

MBR/VBR (Red)

FAT 1 (Dark Violet)

FAT 2 (Web Violet)

SMFT (Dark Violet)

System files (Web Tomato)

SMFT resident file (the file overlays the SMFT)

Folder (Deep Sky Blue)

Allocated File (Corn Flower Blue)

Unallocated space (Lt Gray)

Deleted file (A deleted file overlays unallocated space)

Z iz mEocEmEpEER

Carved file (Dark Orange: Carved file overlays unallocated space)

Icons in Forensic Explorer include those supplied by:

e Silk Icons: http://www.famfamfam.com/lab/icons/silk/

e http://www.softicons.com

e https://icons8.com
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Appendix 9 — iTunes Backup Files

APPENDIX 9 — ITUNES BACKUP FILES

The following table lists iTunes backup files that may be of interest to the forensic investigator:

Contents Domain iOS Path and file name SHA-1 backup file name

Calendar HomeDomain Library/Calendar/Calendar.sqlitedb 2041457d5fe04d39d0ab481178355df6781e6858
Call History WirelessDomain Library/CallHistory/call_history.db 2b2b0084albc3abac8c27afdfl4afb42c6lalOca
Chat — KikChat AppDomain-com.kik.chat Documents/kik.sqglite 8e281be6657d4523710d96341b6f86ba89b56df7
Chat — Line AppDomain-jp.naver.line Documents/talk.sqglite 534a7099p474£f4fb3f2cd006£8e59578d58fb44a
Chat — MessageMe  |AppDomain-com.littleinc.MessageMe |Library/Application Support/MessageMe/MessageMe.sqlite 8c625842c0b74fefff30d92eeceddalda30d2e8e
Chat — Skype AppDomain-com.skype.skype Library/Application Support/Skype/[user]/main.db

Chat —Touch AppDomain-com.enflick.ping Documents/Touch.sqlite b18a30b£f72824a7d024a95178ae42d8339£83633
Chat — Viber AppDomain-com.viber Documents/Contacts.data b39%bac0d347adfafl72527£97c3a5fa3df726a3a

Chat — WeChat

AppDomain-com.tencent.xin

Documents/[chat-UDID]/DB/MM.sqlite

Chat - WhatsApp

AppDomain-net.whatsapp.WhatsApp

AppDomain-net.whatsapp.WhatsApp

1b6b187alb60b%ae8b720c79e2c67£472bab09c0

Contacts HomeDomain Library/AddressBook/AddressBook.sqlitedb 31bb7ba8914766d4bad0d6dfb6113c8b614bedd2
Keyboard HomeDomain Library/Keyboard/dynamic-text.dat Changes with language installed
Locations RootDomain Library/Caches/locationd/consolidated.db 4096c9ec676£2847dc283405900e284a7c815836%*

Maps History

HomeDomain

Library/Maps/History.plist

P60c382887dfa562166£099£24797e55c12a9%4e4

Notes

HomeDomain

Library/Notes/notes.sqglite

ca3bc056d4dal0bbf88b5fb3be254£3b7147e639¢

Safari History

HomeDomain

Library/Safari/History.plist

1d6740792a2b845f4cle6220c43906d7f0afe8ab

SMS

HomeDomain

Library/SMS/sms.db

3d0d7e5£fb2ce288813306e4d4636395e047a3d28

Wifi Networks

SystemPreferencesDomain

SystemConfiguration/com.apple.wifi.plist

ade0340£576ee14793c607073bd7e8e40%9af07a8

* Removed from iOS backup (not the device) after iPhone 4

Copyright GetData Forensics Pty Ltd 2010 - 2024, All rights reserved.




578 |Page

Appendix 9 -

iTunes Files

The following table summarizes the results of running the File System > Analysis Scripts > iTunes Backup > Analyze scripts:

Bookmark Folder Bookmarked File/s

Description

Best FEX Viewer

Address Book AddressBook.sglitedb (SQLite)

31bb7ba8914766d4bad0d6dfb6113c8b614bed42

Contacts

Display.
Phone module.
External SQLite viewer.

reside. This is especially useful for identifying applications installed on the iOS
device that may be of value to the investigator.

Call History call_history.db (SQLite) Last 100 calls. Display.
2b2b0084albc3a5ac8c27afdf14afb42c61al9ca Phone module.
External SQLite viewer.
Camera Roll Photos and Movies Files in the CameraRoll domain. Display/Gallery
Domain - JPG JPG files JPG files are bookmarked according to the Apple Domain in which they Display/Gallery
reside. This is especially useful for identifying applications that use JPG files
(such as chat/messaging apps).
Domain - MOV MOV files MOV files are bookmarked according to the Apple Domain in which they Display.
reside. This is especially useful for identifying applications that use MOV files
(such as chat/messaging apps).
Domain - PNG PNG files PNG files are bookmarked according to the Apple Domain in which they Display/Gallery
reside. This is especially useful for identifying applications that use PNG files
(such as chat/messaging apps).
Domain - SQLite SQlite files SQlite files are bookmarked according to the Apple Domain in which they Display.

External SQLite viewer.

Keyboard dynamic-text.dat

0b68edc697a550c9b977b77cd012fa9a0557dfch

“This file is sometimes referred to as a key logger for the iPhone, which is
mostly true. Words get populated in this database by the user from keyboard
inputs from numerous applications on the iphone. Since this is a dynamic file,
the data continues to grow.” Morrissey, S. (27) page 150.

Text.
Hex.

Copyright GetData Forensics Pty Ltd 2010 - 2024, All rights reserved.




Appendix 9 — iTunes Files 579 | Page
Phone Chat Apps Display.
- Kikchat 8e281be6657d4523710d96341b6f86ba89b56df7 SQlite files containing communication history from Phone/Chat applications. Phone Apps module.
- Line 534a7099b474f4fb3f2cd006f8e59578d58fb44a External SQLite viewer.
- MessageMe 8c625842c0b74fefff30d92eeced4alda30d2e8e
- Skype N/A (changes with user account)
- Touch b18a30bf72824a7d024a95178ae42d8339f83633
- Viber b39bac0d347adfaf172527f97c3a5fa3df726a3a
- WeChat N/A (changes with user account)
- WhatsApp 1b6b187a1b60b92e8b720c79e2c67f472bab09c0

Maps History History.plist

b60c382887dfa562166f099f24797e55c12a94e4

“The History.plist file located in the Maps directory will give you a list of
previous searches using the Maps app, as well as routes that were
generated” Morrissey, S. (27) page 155. This can include GPS co-ordinates
and names of locations.

File Metadata

ed50eadf14505ef0b433e0c4a380526ad6656d3a

Safari history contains browsing information. This includes the URL, page
title, last visited date (converted from MAC absolute date UTC) and visit
count.

Photo Streams Data | Media files Media streamed to the phone with Apple PhotoStream. Display/Gallery

Recordings Audio files Recordings (and configuration files) located in the Media/Recordings/ Display.
domain.

Safari History History.plist Folders are given page titles. File Metadata

SMS Attachments Media files

File attachments sent by SMS

Display/Gallery

WARNING -Backup N/A
may be Encrypted -

The backup may be encrypted (see 30.1.15 below).

N/A
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Wifi

com.apple.wifi.plist
ade0340f576ee14793c607073bd7e8e409af07a8

List of Wi-Fi networks that the device joined (or auto joined). Information
includes:

¢ SSID (Service Set Identifier is used to uniquely identify any given wireless
network) and.

* BSSID (Basic Service Set Identifier is a unique address that identifies the
access point/router that creates the wireless network).

» Date/Time of last connection (UTC)

File Metadata
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APPENDIX 10 - INDEX

Accessed
Date, 201
Activation
Dongle, 45
Evaluation version offline, 24
Evaluation version online, 22
AD1 to L01, 466
Add Partition, 96
Add with Options
Add Image, 180
Apple Backups, 479

Artifact
Selected, 138
Artifacts
Definition, 210
Module, 210
ASCII

Character distribution, 116
Attributes, 200
Auto Save, 191
Bitlocker Encryption, 327
Blur
Gallery view, 103
Bookmarks
Module, 258
Bookmarks Module, 255
Boolean
Index search, 238
BpB - Bytes per block, 128
BpS - Bytes per sector, 128
Branch plate, 90
Byte Plot, 115
Examples, 116
Carve
About file carving, 394
Cluster, Sector, Byte, 397
Disk view icon, 93, 576
Evidence Processor, 188
Hex Selection, 110
Case
Close, 192
New, 170
Open, 173
Recent, 174
Save, 190

Categories, 198
Cell phone. See Phone
Checked
Count, 138
Items, 138
Clam
Anti Virus, 203
Classification, 104
Custom, 108
Remove classification, 106
Close
Case, 192
Columns
Add, 139
Compound file
Expand, 142
Copy
Rows to clipboard, 165
Copyright, 536
Created, 201
Credentials
Evidence module, 182
Crypto Hash, 355
Data fragment, 385, 391
Data Views
Summary, 85
Data-store, 234
Date and Time
Adjust for Case, 346
Adjust for evidence, 344
Adjust in Evidence Processor, 188
Daylight Saving (DST), 342
Overview, 338
Regitry Time Zone setting, 339
Date range filter
Filter - Date Range, 157
Deleted Files
FAT, 385
NTFS, 391
Delphi Basics, 320
Differential Hash, 355
Disk view, 91
Custom color script, 316
Custom colors, 93
Display view, 112
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docking, 72
Dongle. See Activation
DOS Mask, 163
Duplicates
De-duplicate, 361
Email
Module, 244
Email Module, 243
Evidence
Add, 174
Evidence Processor, 184
Explorer Tool, 164
Export
Delimited rows, 149
Files, 144
to LO1, 146
Using a script, 146
Export Word List, 240
Extension, 200
Extract Metadata
Evidence Processor, 188
File Info
Button, 127
File List view, 199
File Name, 200
File signature analysis, 378
File slack
Definition, 563
Index search, 234
File System module, 195
File tree
File System workspace, 195
Filter
COLUMN filter tool, 158
File System module, 89
Scripts, 89, 165, 315
Filtering, 157
Flags
Apply, 156
Clear, 157
Flat File Hash set, 364
Forensic Image Converter, 466
Fragmentation
File (FAT), 385
Full Path, 200
Fuzzy. See Index Search
Fuzzy hash, 360
Gallery View, 99
GUID
Preview, 169, 192
Hash
Acquisition hash display, 187
Flat File Hash Set, 364

Forensic Imager Acquisition, 67
Verify (Evidence Processor), 187
Verify LO1, 148
Hash set, 362
Hex view, 110
Hit Offset (Device), 229
Hit Offset (File), 227
Hit Offset (Partition), 228
Hits
Keyword Result List, 226
HPA, 61
Hyperlinks
Reports, 274, 290, 298, 306
Icon Key, 575
Index Search
Creating an index, 233
Logging, 241
Module, 232
Searching an index, 237
Info view, 112
information.
test, 244
Installation, 33
Investigators
Add, Edit, Delete, 172
Is Deleted, 201
JBOD, 404
Jump List, 500
Keyboard Shortcuts
Disk View, 94
Keyword
Add, 218
Edit or Delete, 220
Group, 220
Import, 221
Regular expression (RegEx), 218
Keyword Search, 216
Results, 224
Run, 222
L01
Export, 146
Verify, 148
Language
FEX GUI Languages, 42
License agreement, 537
License Manager
GetData License Manager, 49
List view, 91
Live Boot, 421, 466
VMWare Workstation Shared Folders, 424
Logical Size, 201
MBR
Search for known, 186
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MD?5, 350, See Hash
Metadata
Extract to columns, 122
View, 120
Mobile Phone. See Phone
Modified, 201
Module
Bookmarks, 255
Email, 243
Evidence, 167
File System, 194
Index Search, 231
Keyword Search, 215
Registry, 247
Reporting, 263
Scripts, 311
Network Licensing. See Licensing
Network Server
UDP Network Server, 176
OCR, 150
Offset
Keyword Search
File, Partition, Device, 226
Open
Case, 173
Ophcrack, 434
Orphans
NTFS, 392
Path
Case folders, 39
Program, 38
Registry keys, 39, 40
Working, 38
PCUnlocker, 437, 445
Phone
Carve, 397
Phonic. See Index Search
Photo DNA, 360
PhotoDNA, 360
Physical size
Column, 201
Preview
Evidence, 169
Project VIC, 372
Purchase orders, 28
RAID, 404
Hardware, 405
Software, 407
Recover Folders
FAT, 389, 393
NTFS, 393
Recover Partition. See Add Partition
RegEx
Column filter, 162

Keyword Search, 218
Quick start guide, 162
Registry
Location of registry files, 248
Module, 248
Registry file
Add from File System module, 249
Add standalone, 249
Report
Hyperlinks, 274, 290, 298, 306
Save
Case, 190
Scripting
Data recovery, 400
Scripts
Introduction to scripting, 320
Open, Copy, Rename, Delete, 319
Send to Module, 153
Servelet. Network Server
SHA. See Hash
Shadow Copy, 414
Background, 410
Mount in Forensic Explorer, 414
Shared Folders
VMWare Workstation, 424
Signature Analysis
Evidence processor, 188
Similarity Hash, 355
Sort
Multi column, 154
Persistent, 155
Remove, 155
Single column, 153
Startup.pas
Installation folder, 39
Script, 316
Stemming. See Index Search
Technical support, 541
Text view, 111
Thumbcache, 495
Thumbs.db, 495
Time Zone. See Date and Time
Tree view, 88, 195
Triage Report, 270
un-blur
Gallery view, 103
Undelete Partition. Add Partition
Undocking, 72
Uninstall, 43
User Datagram Protocol (UDP), 176
uuID
Apple Backup, 480, 565
VCard
Investigator, 172
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VCF

VCard Investigator Details, 172
Verification Hash

Verify Device Hash, 350
Video

Thumbnail viewing, 114
Virtual Box

Live Boot, 422
VMWare

Live Boot, 422

Volume Shadow Copy. See Shadow Copy
VSC or VSC. See Shadow Copy
Wibu CodeMeter Control Center, 51
Wildcards
Index search, 239
Windows Event Log
.evtx, 212
Word List, 240
XMP Metadata, 126

Copyright GetData Forensics Pty Ltd 2010 - 2024, All rights reserved.



